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ЧАСТЬ 1. ОСЕННИЙ СЕМЕСТР 

 
1 ВВОДНАЯ ЛЕКЦИЯ 

 
1.1 Необходимость применения САПР 

 
 

Интегрирование РБ в мировую экономику невозможно без повышения эф-
фективности производства за счет внедрения новых прогрессивных технологий 
и организации труда. Осуществить это возможно лишь при условии внедрения 
различных систем автоматизации, как разработки, так и изготовления и внедре-
ния изделий. 

Кроме того, постоянное ужесточение требований к электронной аппарату-
ре (ЭА) по точности, помехозащищенности, чувствительности, надежности  ве-
дет к значительному усложнению изделий и, в конечном счете, - к возникнове-
нию противоречия между требованиями к ЭА и конкретным производственным 
возможностям их удовлетворения: 

1. чем сложнее ЭА, тем более трудоемка ее разработка (Сроки разработки 
увеличиваются); 

2. увеличивается вероятность получения негативного результата (Быстрое 
моральное старение ЭА, при длительной разработке ЭА может устареть до 
окончания ее разработки). 

 

Снижение сроков разработки достигается 2 путями: 
1. Увеличение количества разработчиков 
Недостатки: 
а) Количество специалистов ограничено; 
б) уменьшается удельная производительность труда; 
в) снижается эффективность управления процессом проектирования и 

производства; 
г) Увеличивается стоимость разработки; 
д) Увеличивается число ошибок в проекте (добавляются ошибки согласо-

вания между отдельными частями проекта). 
 

2. Применение автоматизированного проектирования 
 

Проектирование - процесс составления описания, необходимого для соз-
дания в заданных условиях еще не существующего объекта, на основе первич-
ного описания этого объекта и (или) алгоритма его функционирования. 

Модель удовлетворения общественных потребностей в изделиях (рисунок 
1.1). На всех стадиях возможно применение автоматизированных систем. 

Этапы «рождения», «жизни» и «смерти» изделия взаимосвязаны (см. рису-
нок 1.1) и решение задач по их оптимальному проектированию и производству 
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должно осуществляться комплексно на основе учета всех этапов. Необходимо 
целостное всестороннее рассмотрение всех вопросов проектирования и произ-
водства изделий с учетом их развития на других этапах в процессе взаимодей-
ствия с окружающей средой и человеческим обществом. Такой подход к проек-
тированию и производству называется системным. 

 

Проектирование

Конструирование
Изготовление Эксплуатация

Потребность Утилизация

Ремонт

 
Рисунок 1.1 – Жизненный цикл изделий производства 

 

Для избавления разработчиков от значительного объема «нетворческой» 
втоматизацию проектирова-

ского описания некото-
х кация, а также уровень развития совре-
н

 сфер деятельности между 
человеко

орчество; 

•

изделий ЭА, достаточно легко решае-

1. о бо-
р

ня в модули высшего иерархического уровня (например, ИМС на пе-

 документации. 

ания 

2. ности труда инженеров в проектных организаци-
ях

3. у

работы при проектировании ЭВМ используют а
ния, т.к. имеется возможность формального математиче
ры  конструкторских задач и их унифи
ме ных ЭВС позволяет создавать САПР. 

т разделениеПри применении АПР происходи
м (инженером) и ЭВМ. 

Инженеру, как правило, остаются такие виды деятельности:  
• принятие решений и инженерное тв
• осмысление целей, проблем и содержания проекта;  

постановка задач прое ктирования;  
• выбор критериев оценок при решении задач;  
• выбор наилучшего решения и т. п. 

 

Основные задачи конструирования 
мые автоматизированным способом:  

птимальное проектирование топологии и фотошаблонов ИМС, микрос
ок и печатных плат;  

2. проектирование проводного монтажа; 
3. компоновка (размещение) различных модулей низшего иерархического 

уров
чатные узлы, ячеек в панели и т. д.);  

4. выпуск графической и текстовой конструкторской
 

Преимущества применения автоматизированного проектиров
1. сокращение трудоемкости и сроков разработки конструкций ЭА,  

повышение производитель
, 
лучшение качества и технологического уровня изделий ЭА,  
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4. снижение стоимости разработки. 
5. Уменьшение количества разработчиков 
6. Использование уже готовых правильных решений (из баз данных) 
7. И

оектирования, взаимосвязанных с необходимыми 
подр

онно-техническая система, со-
стоя

 

О нного проектиро-
вания ания объектов и их составных 
частей

 

мы автомати-
заци

3. Ав П 
4. Ав ия производством  
5. Ав ных испытаний 

 
Конструк ческая подготовка производства  
В проц устройств различают следующие эта-

пы: 

рское,  

спользование новейших достижений (облегчение обмена информации ме-
жду базами + Internet …). 

 

Система автоматизированного проектирования (САПР) - комплекс 
средств автоматизации пр

азделениями проектной организации или коллективом специалистов (поль-
зователем системы), выполняющей автоматизированное проектирование. 

 

САПР (по ГОСТ 23.501.0-79) – организаци
щая из комплекса средств автоматизированного проектирования, связан-

ных с подразделениями проектных организаций, и выполняющую автоматизи-
рованное проектирование. 

 

САПР – инструмент проектирования, включающий различные обеспече-
ния и предназначенный для автоматизированного проектирования на всех эта-
пах от выдачи ТЗ до выпуска готового изделия. 

сновная функция САПР - выполнение автоматизирова
 на всех или отдельных стадиях проектиров
. 

В сфере производства ЭА можно выделить следующие систе
и труда: 

1. Автоматизированные системы научных исследований 
2. Системы автоматизированного проектирования 

томатизированные системы ТП
томатизированные системы управлен

емы комплекстоматизированные сист

торская и технологи
ессе разработки сложных ЭО 

1. Системное проектирование, 
2. Структурное проектирование,  
3. функциональное,  
4. схемотехническое, 
5. конструкто
6. технологический синтез. 

 

При системном проектировании используются идеи и методы системного 
анализа. На основе многофакторного анализа проводится исследование ТЗ на 
разработку изделия и принимаются решения относительно методики построе-
ния и путей реализации процесса (Используются системы автоматизации 
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науч
овании технического задания 

разрабатыв

пользу-
ются

вном используются творческие возможности че-
лове аниях). 

тываются подробные 
функ ЭВМ, которые разъясняют 
опре л ие в отдельных функциональных цепях или 
устр с рмацией между ними. 

атериальными затратами (при помощи САПР). 
мотехническом (логическом) проектировании разрабатываются 

подр н елен-
ные 

ри конструкторском проектировании (или, иначе, конструировании) 
выби  временных взаимо-
связ

чественные нормы 
(для делие, 
соот

ая и принципиальная схемы устрой-
ства

ь следующие задачи: 

ных исследований). 
При структурном проектировании на осн

ается структурная схема, определяющая основные структурные час-
ти ЭА (устройства, блоки и т. п.), их назначение и взаимосвязи. Выбираются 
системы команд, диагностики и контроля, решаются вопросы обмена информа-
цией между ЭА и внешними устройствами и абонентами процесса (Ис

 системы автоматизации научных исследований). 
На данных этапах в осно
ка (ЭВМ – как помощник в исследов
При функциональном проектировании разраба
циональные схемы устройств проектируемой 
де енные процессы, протекающ
ой твах в целом и детализируют обмен инфо
В результате получают функциональные схемы устройств. 
Критерии оптимизации: 
− минимизация числа типов узлов 
− достижение максимальной однородности блоков 
− возможность эффективного моделирования 
− простота диагностирования 
− максимальный учет требований К и ТП. 
Результат – получение математической либо физической модели устройст-

ва. Для ЭА – чаще математической.  
Работа с моделями позволяет создать устройство требуемого качества с 

минимальными временными и м
При схе
об ые принципиальные схемы устройств, ориентированные на опред
системы элементов. Схемотехническое проектирование ЭА характеризует-

ся большой трудоемкостью и, следовательно, требует большого количества 
разработчиков. Основные задачи схемотехнического проектирования хорошо 
формализуются и позволяют использовать машинные методы решения (авто-
матизация проектирования). 

Задача: 
− Покрытие функциональной схемы ячейками из заданного набора. 
П
рается структура пространственных, энергетических и
ей частей конструкции, связей с окружающей средой и объектами, опреде-

ляются материалы и виды обработки; устанавливаются коли
 связей, материалов и обработок), по которым можно изготовить из
ветствующее заданным требованиям (часто используется САПР). 
Входная информация – функциональн
. 
На этом этапе необходимо решат
1. Компоновка элементов схемы в ТЭЗы, в панели, в рамы … (компоновка 
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высшего иерархического уровня элементами более низкого) 

трол льности получения топологии. 
4 очно-

сти, н е
5 ентации на из-

готовление ЭА. 

ние технологической документации 
авления технологическим оборудованием 

нологической оснастки. 

и изделий и выпуска 
конст и ОКР, а также определяет основные этапы  
выпо

тов 
-

рите

2. Размещение элементов в конструктивах по различным критериям 
3. Распределение цепей по слоям платы. Трассировка соединений. Кон-
ь прави

. Моделирование и расчет ЭМ и тепловых полей, механической пр
ад жности, вибропрочности … 
. Автоматизированное получение конструкторской докум

При технологическом синтезе изготавливают отдельные устройства, бло-
ки, происходит их наладка, общая сборка устройства и испытания (САПР ТП). 

Цель:  
− автоматизированное получе
− разработка алгоритмов упр
− разработка и изготовление тех

 

ГОСТ 2.103 — 68 устанавливает стадии разработк
рукторской документации пр
лнения работ на этих стадиях:1). 
− техническое предложение,  
− эскизный проект, (САПР) 
− технический проект (САПР) 
относятся к проектным стадиям. Соответственно и документацию на изде-

лие, выпускаемую на этих стадиях, называют проектной. 
− рабочий проект (САПР). 
Техническое предложение — совокупность конструкторских документов, 

которые содержат технические и технико-экономические обоснования целесо-
образности разработки документации изделия на основании анализа ТЗ и раз-
личных вариантов возможной реализации изделии, сравнительной оценки ре-
шений с учетом конструктивных и эксплуатационных особенностей разрабаты-
ваемого и существующих изделий, а также патентные исследования. 

При разработке ЭА на стадии технического предложения прорабатываются 
следующие основные вопросы: обзор научно-технической литературы, патен-

и нормативно-технических документов по рассматриваемой тематике; оп-
ределение принципиальной возможности создания заказываемой ЭВМ; предва

льные предложения по структуре ЭА и ее элементной базе; формулировка 
общих рекомендаций по разработке нескольких возможных вариантов конст-
рукции ЭА; предварительное определение состава математического обеспече-
ния; составление перечня организаций-соисполнителей ОКР, уточнение объе-
мов, стоимости и сроков разработки, выработка предложений по уточнению ТЗ. 

После уточнения, согласования и утверждения заказчиком ТЗ и приемки 
технического предложения приступают к разработке эскизного проекта. 

Эскизный проект — совокупность конструкторских документов, содер-
жащих принципиальные конструктивные решения, дающие общие представле-
ния об устройстве и принципе работы изделия, а также данные, определяющие 
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назначение, основные параметры и габариты изделия. На этой стадии выбран-
ный вариант конструкции подвергается детальной проработке для выявления 
возможности наиболее полного удовлетворения всех предъявляемых к нему 
требований. Прорабатываются в основном следующие вопросы: теоретико-
экспериментальные исследования по направлениям, намеченным на стадии 
технического предложения; выбор оптимального по ряду признаков варианта, 
подлежащего дальнейшей разработке, т. е. осуществляется выбор главного на-
правления конструирования ЭА и ее составных частей; разработка технических 
решений, направленных на обеспечение показателей надежности ЭА, техноло-
гичн

.; обосно-
вани

 
прое

енивать паразитные связи, тепловые ре-
жим

плек

тии, серийного (массового) производства. Рабочий 
прое

аний ос-
новн

ости, стандартизации и унификации конструкций, эргономики, техниче-
ской эстетики, техники безопасности и конкурентоспособности и др

е и выбор схемной реализации; составление технического задания на раз-
работку новых компонентов, а также контрольно-измерительной аппаратуры; 
описание ЭВМ в целом и по устройствам; макетирование для отработки элек-
трических схем, тепловых режимов, электромагнитной совместимости; пред-
ложения по уточнению технического задания. 

После согласования, защиты и утверждения эскизный проект служит осно-
ванием для следующей проектной стадии — технического проекта. 

Технический проект — совокупность конструкторских документов, со-
держащих окончательные технические решения, дающие полное представление 
об устройстве разрабатываемого изделия и исходные данные для разработки 
рабочей документации. Здесь проводится детальная отработка схемных и кон-
структорских решений (на уровне чертежей на все важные узлы, блоки, устрой-
ства), отрабатывается система математического обеспечения; разрабатываются 
технология изготовления составных частей ЭВМ и средства автоматизации ее

ктирования и изготовления; выполняются пространственные компоновоч-
ные эскизы и макеты, позволяющие оц

ы, удобство монтажа, ремонта, эксплуатации и защиту от внешних воздей-
ствий, изготавливаются узлы и блоки, которые проходят необходимые кон-
трольные испытания; проверяются и оцениваются технологичность конструк-
ций, степень соответствия их современному уровню микроэлектроники и ком-

сной микроминиатюризации, степень унификации и стандартизации и т. д. 
После согласования, защиты и утверждения технического проекта перехо-

дят к рабочему проектированию ЭВМ. 
Рабочий проект — это совокупность рабочей конструкторской и техноло-

гической документации, предназначенной для изготовления и испытания опыт-
ного образца, опытной пар

кт является завершающей, наиболее ответственной стадией разработки ЭА. 
На стадии рабочего проекта разрабатывается полный комплект КД, необ-

ходимых для изготовления, проверки, изучения и эксплуатации ЭА, технология 
изготовления отдельных узлов и ЭА в целом, изготавливаются опытные образ-
цы ЭА, составляются программы предварительных (заводских) испыт

ых узлов и ЭА, проводятся эти испытания, корректируется по результатах 
испытаний документация.  
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При этом под опытным образцом понимают обычно ЭА, изготовленную 
по вновь разработанной рабочей документации для проверки его соответствия 
техническому заданию, проверки конструкторских решений, определения объ-
ема и характера последующей и необходимой корректировки конструкторских 
документов и подготовки технологического оснащения производства. 

Для оценки качества опытного образца ЭА создается государственная или 
межведомственная комиссия. Она оценивает степень соответствия разработки 
всем

тся также ряд этапов 
конструкторских и технологических работ: изготовление и испытание опытной 
(уста

там изготовления и испытания составных частей 
ЭВМ серии ЭВМ по 
полн ь енному технологическому процессу; корректировка конструк-
торских и огических документов по результатам изготовления и испыта-
ния ов оизводство ЭА. 

ля всех этапов проектирования изделия можно выделить типовые опера-
ции 

иск и выбор из различных источников информации 
. Анализ 

 

А оектирования – сущность современ-
ной С

 

 
1
 

П

ино- и приборостроении; 
а; 

строительстве; 

 требованиям технического задания, полноту и качество выполнения кон-
структорской и технологической документации, дает рекомендации по целесо-
образности передачи новых ЭА в серийное производство. При необходимости 
определяется перечень нужных доработок и проводятся дополнительные испы-
тания ЭВМ. Приемкой опытного образца ОКР практически завершается, и ком-
плекты конструкторской и технологической документации передаются на про-
изводство для организации серийного или массового выпуска ЭВМ. 

В серийном или массовом производстве выполняе

новочной) серии изделий; корректировка конструкторских и технологиче-
ских документов по результа

 опытной серии; изготовление головной (контрольной) 
ост ю оснащ

 технол
гол ной серии; непосредственно пр
 
Д
обработки информации: 
1. По
2
3. Расчет 
4. Принятие проектных решений 
5. Оформление проектных решений
 
втоматизация 1-5 на всех стадиях пр
АПР. 

.2 Классификация САПР (по ГОСТ 23501.8-80) 

о типу объекта проектирования.  
1) САПР изделий машиностроения;  
2) САПР изделий приборостроения; 
3) САПР технологических процессов в маш
4) САПР объектов строительств
5) САПР технологических процессов в 
6) САПР программных изделий;  
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7) САПР организационных систем.  
П
1 тей до 102;  
2

5 сокой сложности (число составных частей свыше 106). 
 

П оектирования.  
дур); 

—50%); 
 50%).  

 

П

пускаемых проектных документов.  
, выпускающих документы:  

3) на фотоносителях (в виде микрофильмов, микрофиш, фотошаблонов и 

нные (выполняют документы на двух носителях данных 

 САПР (обеспечения) (ГОСТ 22487-77) 

тодов, моделей и алгоритмов проектирования, необходимых для его 
выпо

ия схем на подсхемы меньшей сложности,  

о сложности объекта проектирования.  
) простых объектов с числом составных час
) объектов средней сложности (102—103); 

3 43) сложных объектов (10 —10 ); 
4 объектов (104—106);  ) очень сложных 
) объектов очень вы

о уровню автоматизации пр
1) низкоавтоматизированные (до 25% проектных проце
2) среднеавтоматизированные (25
3) высокоавтоматизированные (свыше

о комплексности автоматизации проектирования.  
1) одноэтапные; 
2) многоэтапные; 
3) комплексные (все этапы). 

рактеру выПо ха
АПРС
1) на бумажной ленте и (или) листе;  
2) на машинных носителях;  

др.); 
4) комбинировва

или более). 
и т.д. 
 
1.3 Составные части

 
1. математическое,  

. программное,  2
3. лингвистическое,  
4. информационное,  
5. методическое, 
6. организационное, 
7. техническое.  
1-4 – программно-информационное 
5,6 – организационно-методическое 
 
Математическое обеспечение САПР — это совокупность математиче-

ских ме 
лнения.  
В настоящее время для АПР ЭВМ широко применяются 
– модели и алгоритмы разбиен

 16 



– алгоритмы размещения конструктивных модулей (перестановки, сило-
вые и 

– а нений различного уровня 
и т. д

 САПР), 

руирования, обеспечивают возможность модерни-
заци йки конкретной САПР.  

ания программных средств необходимо лин-
гвис

ечение САПР — это совокупность языков проек-
тиро

-
мати

ганиза-
ции 

ря-
док р

др.),  
лгоритмы разводки (трассировки) межсоеди

.  
 

Программное обеспечение САПР – совокупность всех программ и экс-
плуатационной документации к ним, необходимых для выполнения АПР и 
представленных в заданной форме. 

Различают  
1) Общесистемное ПО (обеспечивает ввод, вывод и определение инфор-

мации в процессе функционирования
2) Специальное (прикладное) ПО 
В специальном ПО реализуются методы автоматизированного проектиро-

вания. Оно определяет специализацию системы, характер и степень использо-
вания ЭВМ в процессе конст

и и перестро
Для подготовки и использов
тическое обеспечение. 
 

ингвистическое обеспЛ
вания, включая термины и определения, правила формализации естествен-

ного языка и методы сжатия и развертывания текстов, необходимых для авто
зации проектирования. 
Выделяют: 
а) Языки программирования 
б) Языки проектирования 
в) Языки управления 
 

Информационное обеспечение САПР - совокупность сведений, необходи-
мых для выполнения автоматизированного проектирования в заданной форме.  

Т.е. основная функция ИО - обеспечение создания, поддержки и ор
доступа к данным. 
 

Методическое обеспечение САПР - комплект документов, устанавли-
вающих состав и правила отбора и эксплуатации средств обеспечения проекти-
рования.  

Как правило, оно включает методические материалы по САПР, позволяю-
щие проводить единую техническую политику по автоматизации проектирова-
ния на межотраслевом, отраслевом уровнях, уровне предприятия и т. д. 

 

Организационное обеспечение САПР - комплект документов, устанавли-
вающих состав проектной организации и ее подразделений, связи между ними, 
их функции, а также форму представления результата проектирования и по

ассмотрения проектных документов. 
 

Техническое обеспечение САПР включает универсальные и специализиро-
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ванн но-вычислительной техники для автома-
тиза

а ввода-вывода информации (принтеры, 
скан ры, плоттеры, графопостроители, манипуляторы, кодировщики и т.п.). 

 специализированным техническим средствам САПР относят: 
абочие места (АРМ) (за рубежом используется 

термин «рабочая станция»),  

 
ЭВМ проекти-
руем

 
1
 

живании проектных задач одного 
этап

Т

ь ранее): 

о проектирования 

каждой п/системы есть свои пакеты прикладных программ. В настоя-
щее  
больш с

П/системы

2. Обслуживающие 

проектирующих 
сист м.  

) 
 
 
1
 

Н ием создания САПР на предприятии 
являет ественный выигрыш от ее применения с уче-

ые технические средства электрон
ции процессов проектирования, изготовления и контроля. 
К универсальным техническим средствам относятся средства обработки 

информации, т.е. ЭВМ, а также средств
е
К
− автоматизированные р

− пункты выпуска документации,  
− автоматизированные средства для изготовления и контроля конструкций
 (современные САПР позволяют кроме КД изготавливать макеты 
ых устройств, ПО для ГАП и т.п.). 
 

.4 Подсистемы САПР 

Специализация части САПР на обслу
а проектирования приводит к выделению этой части как п/системы САПР. 
Специализация САПР затрагивает, в основном, МО, ПО, ЛО, О. 
 

Для САПР ЭА выделяют подсистемы (указывалос
кого проектирования 1. Системотехничес

2. Схемотехническог
3. Конструкторского проектирования 
4. Технологического проектирования 

 

Для 
время стремятся разрабатывать комбинированные ППП, включающие
ин тво п/систем. 

 САПР можно разделить на 2 группы: 
1. Проектирующие 

1) – обеспечивают выполнение проектных работ 
2) – предназначены для поддержки работоспособности 
е
В зависимости от отношения к объекту проектирования САПР делятся на: 

1. объектные (выполняют одну или несколько процедур непосредствен-
но зависящих от объекта проектирования) 

2. инвариантные (унифицированные объектные процедуры и операции

.5 Основные требования и принципы создания САПР 

еобходимым и достаточным услов
ся количественный или кач
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том до
С ебования): 

 системы 

ными взаимозаменяемыми алгоритмами 
ование (ЭА, РЭА, ИМС, …) 

полнительных затрат, которые она вызывает. 
АПР должна иметь возможности (тр
1. последовательного расширения и совершенствования
2. активной связи специалист – система 
3. оперирования оптималь
4. специализацию системы на проектир
5. увеличения мощности системы 
6. легкой настраиваемости 
7. стыковки со специальными устройствами 
8. изменения критериев оптимизации 
9. расширения и дополнения библиотек программ 
10. свободного доступа к данным на всех этапах проектирования 
11. изготовления КД и ТД 

 

Работоспособность САПР зависит от: 
1. Уровня унификации входной и выходной информации 
2. Единства методов записи информации на носителях 
3. Правильности распределения памяти ЭВМ 

летворения требований к САПР при ее создании должны соблю-
дать

ежду ее 
п/си ь работоспособность и целостность САПР как 
един

вня. 
ытости). 

новления основных компонентов м п/систем. 

а в целом. На всех стадиях осуществить согласо-
вани тируемых элементов м системы в 
цело

ельных 
прог

т возможность включения или исключения отдельных 
прог иные процедуры,  без нарушения функциони-
рова

4. Правильности выбора алгоритмического языка 
 

Для удов
ся следующие основные принципы: 
1. Принцип системности. 
Заключается в том, что при создании САПР взаимные связи м
стемами должны обеспечиват
ой системы. 
2. Принцип включения. 
Его реализация позволяет включать данную САПР в систему более высо-

кого уро
3. Принцип развития (откр
Необходимо предусматривать возможность совершенствования, развития 

и дополнения, а также об
4. Принцип комплексности. 
Позволяет обеспечить взаимосвязанное проектирование, как отдельных 

элементов, так и всего объект
е, увязку и контроль характеристик проек
м. 
5. Принцип модульности. 
Относится к ПО и предполагает построение ПО САПР в виде отд
раммных модулей. 
Это обеспечивае
рамм, реализующих те или 
ния всей системы САПР. 
6. Принцип информационного единства. 
Отделение всех видов данных от программ и использование в п/системах 
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САПР единых условных обозначений, терминов и способов представления ин-
форм ующей нормативной документацией. 

. принцип совместимости. 
Использование языков, кодов, символов, информационных и технических 

характеристик связей между п/системами, которые должны обеспечить их со-
вместное функционирование, а также возможность развития всей системы 
САПР в целом. 

8. Принцип стандартизации. 
Осуществление унификации, типизации и стандартизации п/систем и ком-

понентов, инвариантных к проектируемым объектам и проектным процедурам. 
 

ации в соответствии с действ
Реализация данного принципа предполагает создание и функционирование 

самостоятельной БД. 
7
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2 Математическое обеспечение САПР 
 
 

Математическое обеспечение (МО) – это совокупность математических 
методов и моделей алгоритмов проектирования, необходимых для их выполне-
ния. 

 
Основу МО САПР составляет математический аппарат для моделирования, 

анализа и оптимизации. 
В МО САПР выделяют: 

1. Специальную часть 
2. Инвариантную часть 

 

1) – отображает специфику объекта проектирования, физические и инфор-
мационные особенности его функционирования. Специальная часть тесно при-
вязана к этапам проектирования. 

2) – включает методы и алгоритмы, слабосвязанные с особенностями ма-
тематических моделей и используется на различных этапах проектирования. 

Основу инвариантной части в 1-ю очередь составляют методы параметри-
ческого синтеза и многовариационного анализа. 

 
 
2.1 Требования к МО САПР 
 

1. Универсальность 
2. Алгоритмическая надежность 
3. Точность 
4. Затраты машинного времени (min) 
5. Используемая память 

 

1) Под универсальностью МО понимается его применимость к широкому 
классу проектируемых объектов. 

Высокая степень универсальности МО необходима для того, чтобы САПР 
была применима к большинству объектов, проектируемых на предприятии. 
Степень универсальности не имеет количественной оценки. 

Если методы и модели сформулированы интуитивно, то они называются 
эвристическими. 

 

2) Свойство компонента МО давать при его применении правильные ре-
зультаты называется алгоритмической надежностью. 

Количественной оценкой алгоритмической надежности служит вероят-
ность получения правильных результатов при соблюдении оговоренных огра-
ничений на применение метода. 

 

3) Точность определяется по степени совпадения расчетных и истинных 
результатов. 
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Оценка точности производится с помощью специальных вычислительных 
экспериментов, в которых создаются условия раздельной оценки погрешностей, 
вносимых математическими моделями элементов, алгоритмами анализа и оп-
тимизации. В этих экспериментах используются специальные задачи (тесто-
вые). 

Количественная оценка погрешности результата решения тестовой задачи 
есть одна из нормалей вектора относительных погрешностей. 

 

4) Универсальные модели и методы характеризуются большим объемом 
вычислений, растущих с ростом размерности решаемых задач.  

Затраты машинного времени являются главным ограничивающим фак-
тором при повышении сложности проектируемых на ЭВМ объектов.  

 

Требования высокой степени универсальности , алгоритмической надеж-
ности, точности с одной стороны и малых затрат машинного времени с другой 
– основное противоречие при создании МО САПР. Поэтому при создании 
САПР целесообразно использовать библиотеки с наборами моделей и методов, 
перекрывающих потребности всех пользователей САПР.  

 

5) Затраты используемой памяти являются вторым фактором после затрат 
машинного времени экономическим показателем САПР. Она определяется объ-
емом программы и используемых массивов. 

Несмотря на значительный объем памяти в современных ЭВМ требования 
по экономичным затратам памяти остаются актуальными, т.к. современные 
системы работают в мультипрограммном режиме и задачи с большим запросом 
объема памяти получает более низкий приоритет.  

 
 
2.2 Методы повышения эффективности МО САПР 
 

Увеличение эффективности САПР может быть достигнуто следующими 
путями: 

1. разработкой экономичных моделей и алгоритмов, имеющих частный 
характер 

2. совершенствования используемых общих принципов, создания МО 
эффективного по затратам машинного времени и памяти. 

 

К таким принципам относятся: 
1) учет разряженности матриц 
2) исследование сложных систем по частям 
3) макромоделирование 
4) событийность анализа 
5) рациональное использование эвристических способностей человека в 

интерактивных (диалог) процедурах 
 

1) – позволяет во многих алгоритмах в которых используются операции 
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над матрицами добиться существенного сокращения затрат времени и памяти. 
Т.к. в памяти ЭВМ хранят только ненулевые элементы матриц и выполняют 
арифметические действия только над ними. 

Сильно разреженными матрицами при проектировании ЭА являются: 
а) матрицы коэффициентов систем разностных уравнений при анализе 

п/проводниковых компонентов электронных схем 
б) матрицы Якоби – в мат. Моделях электронных схем 
в) матрицы смежности и инцидентности в задачах компоновки, трассиров-

ки и размещения. 
Если учитывать разреженность матриц, то затраты времени и памяти мож-

но сделать линейно зависимыми от показателя сложности анализируемого объ-
екта (если нет – то квадратичная либо кубическая зависимость). 

 

2) – реализуется в диаконтических методах исследования. 
Диаконтические методы исследования отличаются от блочно-

иерархических использованием структурных особенностей исследуемых схем и 
выражающих их матриц. Принятие упрощений производится расчленением ма-
тематических моделей на части, которые исследуются самостоятельно. 

 

3) – Макромоделирование связано с рациональным выбором мат. модели. 
Оно реализует возможность системы использования при анализе одного и того 
же объекта  нескольких моделей, различающихся сложностью, точностью и 
полнотой отображения объекта.  

Экономическая эффективность системы повышается путем деления схемы 
на более крупные блоки с использованием для них макромоделей. 

 

4) – событийность анализа заключается в том, что при иммитации процес-
сов, протекающих в исследуемом объекте в каждый отдельный момент времени 
вычисления производятся только для небольшой части мат. модели объекта. 
Эта часть включает в себя те элементы, состояние которых на данном времен-
ном шаге может измениться.  

Использование данного принципа повышает экономичность анализа на 
функциональном, системном и логическом этапах проектирования. 

 

5) – позволяет инженеру (опытному) вмешиваться в ход вычислений и вы-
бирать наиболее перспективные продолжения на основе эвристических оценок. 
Процедура наиболее эффективна на этапе конструкторского проектирования. 

 
 
2.3 Основы теории графов 
 

Под графом G(X, U) понимают совокупность непустого множества Х и 
изолированное от него подмножество U, возможно нулевое, представляющее 
собой множество всех упорядоченных пар xi xj,  где xi, xj принадлежат X; i, j 
=1…n, где n – мощность множества. 

Элементы множества X и U соответственно называются вершинами и 
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ребрами графа.  
Существует 3 вида графов: 

1. Неориентированные 
2. Ориентированные 
3. Смешанные 

 

Граф G(X, U) называется неориентированным, если для каждого его реб-
ра несущественен порядок двух его концевых вершин. 

 X1 

X2 

X3 

X4 

 

X1 

X2 

X3 

X4 

 
а б 

Рисунок 2.1 – Примеры графов: 
а – ориентированный, б - смешанный 

 

Граф, у которого 2 вершины соединены более чем одним ребром – муль-
тиграф. 

Ребра, у которых обе концевые вершины совпадают, называются петлями. 
Вершина неинцедентная (не принадлежит) никакому ребру называется 

изолированной. 
Число ребер инцидентных некоторой вершине xi называется степенью 

вершины. 
Граф, состоящий только из изолированных вершин называется нуль-

графом. 
Граф конечен, если содержит конечное число вершин и ребер. 
Конечный граф, у которого отсутствуют петли и изолированные вершины 

называется регулярным. 
Граф называется однородным степени t, если степень всех его вершин = t. 
Пример однородного графа (t=4) 

 

 
Рисунок 2.2 

 

Данный бесконечный граф широко используется для трассировки печат-
ных плат. Он позволяет разбивать коммутационное поле платы на элементар-
ные ячейки. 

 

Граф, все вершины которого попарно смежны называется полным графом. 
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Полный граф, у которого при каждой вершине имеется петля, называется 
плотным. 

Граф, в котором перемещаясь по ребрам из вершины в вершину можно по-
пасть в каждую вершину называется связным графом. 

Число, характеризующее разность между числом верши графа (мощно-
стью) n и числом компонент связности p называют рангом графа (R(G)). 

 

Один и тот же граф может иметь различные геометрические реализации 
(получаются изоморфные графы). 

 

Циклом называется последовательность ребер, при которой в результате 
обхода вершин графа по этим ребрам возвращаются в исходную вершину. 

Последовательность ребер при переходе от одной вершины к другой назы-
вается цепью. 

Цикл – это замкнутая цепь. 
Эйлеров цикл – это цикл, в котором содержатся все ребра графа. 
Задача отыскания эйлерова цикла имеет важное прикладное значение при 

выборе рационального пути движения рабочего инструмента, позволяя осуще-
ствить обход контура сложной геометрической фигуры без отведения рабочего 
инструмента, т.е. без холостых ходов. 

 

Цикл называют гамильтоновым, если он проходит через каждую верши-
ну графа только один раз. 

 

Связной неориентированный граф, не содержащий циклов, называется де-
ревом. 

Несвязной граф без циклов, отдельные компоненты связности которого яв-
ляются деревьями называется лесом. 

Под расстоянием между вершинами графа понимается длина кротчайшей 
цепи. Соединяющей эти вершины. 

Диаметр графа – это максимальное расстояние между вершинами графа. 
Объект H(X, E) считается гиперграфом, если он состоит из множества 

вершин X и множества ребер E, причем каждое ребро ei, принадлежащее Е яв-
ляется некоторым подмножеством множества Х. Т.е. множество Х должно 
включать любое ребро ei. 

При этом каждое ребро может соединять не только две вершины, но и лю-
бое подмножество множества вершин графа. 

 
 
2.4 Матричное представление графов 
 

Удобной формой описания графов является представление их в виде мат-
риц. Методики формальной обработки матриц хорошо разработаны. 

1. Матрица смежности. 
Если задан граф G(X, U), то ему можно поставить в соответствие квадрат-

ную матрицу (матрицу смежности) размерностью n x n, где n – мощность мно-
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жества вершин графа 

nnijaA
×

=
, где 

 
( )

⎩
⎨
⎧

=
нет - если                          ,0

смежные_ , если   ,, i jji
ij

xxxxm
a

 
 
где m – кр
 

атность смежных ребер. 

Пример: 
 

X1

X2

X3

X4  
Рисунок 2.3 

 

01204
10133
21012
03101

x
x
x
x

A =

4321 xxxx

 

2. Матрица весовых соотношений. 
 При решении целого класса задач проектирования ЭА приходится опери-

ровать матрицами, которые строятся аналогично матрицам сти, но зна-
чени  ределяются весом ребра графа. Такие матрицы называ-
ются трицами весовых соотношений. 

 

 смежно
я их элементов оп
 ма

nnijcC
×

=
, где 

 
ежные , если   , iij

ij

xxT
c

 

3. Матрица длин. 

⎩
⎨
⎧

=
нет - если                          ,0

см_j

где  – вес связи. ijT

 

Это квадратная матрица 
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nnijdD
×

=
, где 

 

⎩
⎨
⎧ −

=
нет - если                          ,0

смежные , если   , i jij
ij

xxL
d

 
где ijL  – длина ребра. 
Для примера однородного графа: 

( ) ( )22
jijiijL = ttss −+−

, 
i i

(s , t ) – координата 2-й точки 

 вы-
числение произвольной координаты: 

где (s , t ) – координата 1-й точки 
j j

 
При расчете конструктивных параметров ЭА, в котором производится

( ) ( )kji
k

jiij ttssL −+−=
. 

 1-3 используются в конструировании ЭА, 
3 используется в задачах трассировки. 

 
4. Матрица инцидентности. 
редставляет собой прямоугольную матрицу 

 
Матрицы
Матрица 

П

rnijbB
×

=
 

размерностью n x r, где ,xn =  ur = . 
Строки матрицы соответствуют вершинам, а столбцы – ребрам графа. 
 

⎩
⎨
⎧ −

=
нет - если                          ,0

смежные , если   ,1 i j
ij

ux
b

. 
 
Пример: 

X1

X3

X2U2

U3

U4

 
Рисунок 2.4 

U1
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11003
01112xB =
1011
4321

x

uuuu

 
5. Матри ности ребер. 
Э м

1x

 

ца смеж
та атрица, элементы которой образуются по правилу 

nnijwW
×

=
, где 

 

⎩
⎨
⎧ −

=
нет - если                          ,0

смежные , если   ,1 i j
ij

uu
w

 
 
Пример: 
Граф – из предыдущего примера 
 

01114u . 
 

10113

1

u

 

о
з

ации. 

 

11012uW =
1101

4321
u

uuuu

 
2.5 Основы теории алгоритмов
 

Алг ритм – это конечная совокупность точно заданных правил решения 
прои вольного класса задач. 

Алгоритм состоит из отдельных конечных действий – шагов. 
Существует три основных универсальных алгоритмических моделей: 

1. Понятие алгоритма связывается с вычислениями и числовыми функ-
циями. 

2. Алгоритм представляется как некоторое детерминированное устрой-
ство, способное выполнять в определенные моменты времени 
типовые (простейшие) опер

3. Производится преобразование слов произвольных алфавитов. 

Детерминированный алгоритм - если он выражен системой правил, одно-
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значн
ь только ста-

тистически, то такой алгоритм называется вероятностным или стахостиче-
ским

 вероятностно, ни детерминированно, но 
можно  

 гарантирует нахождение оптималь-
ного варианта, а только – квазиоптимальное решение. 

2. Результативность - св
зуль через конечное число шагов. 

3. Область применения – множество процессов, для которых алгоритм 
результативен. 

4. Определимость - свойство алгоритма аключающееся в том, что ка-

6. Алгоритмы является э
ти применимости и результаты обработки любого процесса из данной области. 

дающие действия этих алгоритмов. 

ффективность алгоритмов: 

р й

 объемом 
памяти

бщее время реализации алгоритма: 

о определяющих результат процесса при заданных исходных данных. 
Если правила неоднозначны и результаты можно представит

. 
Если правило нельзя задать ни

 сформировать содержательные указания о целенаправленности процес-
са, то такой алгоритм называется эвристическим. 

 

Расшифровка укрупненных операторов алгоритма в командах языка ЭВМ  
называется программированием, а запись алгоритма на входном языке ЭВМ - 
программой. 

 

Эвристическое программирование не

 
 
Свойства алгоритмов 
 

1. Массовость – свойство алгоритма отображать широкий класс процес-
сов. 

ойство алгоритма обеспечивать получение ре-
тата 

, з
ждый его шаг определяется точно. 

5. Алгоритм имеет вход и выход. 
квивалентными – если совпадают их облас-

7. Алгоритмы равны – если равны соответствующие им операторы и 
совпадают системы правил, за

 
 
Э
 

Оценка максимального числа элементарных опе аци , выполняемых при 
работе алгоритма – эффективность. 

Оценка эффективности зависит от длины исходных данных (числа элемен-
тов схемы, цепей …) и характеризуется числом операций N и общим

 V, необходимых для его реализации. 
О

∑=
=

iitQT , (2.1) 

 операций i-го типа, n – число типов операций в алгоритме, ti – 

n

 
i 1

где Qi – число
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врем
и ввести условную простейшую элементарную операцию, то можно 

опре

я выполнения i-й операции. 
Есл
делит общее число приведенных к ней операций: 

∑=
n

=
iiэ QBN , (2.2)  

i 1

где 

э

i
i t

tB =
, 

tэ – в ентарной операции. ремя выполнения элем
Тогда общее время реализации алгоритма: 

 ЭЭ tNT ⋅= . (2.3) 
 
Объем памяти, кот. необходимо зарезервировать в ЭВМ для реализации 

алгоритма определяется, как 
 

 ВЫХПРВХП VVVVV +++= , (4.4) 
 

где Vп – объем памяти для размещения программы, VВХ, VВЫХ - объем памяти для 
размещения исходной входной и выходной информации, VПР - объем

ходимой для размещения промежуточной информации. 
 памяти, 

необ
К
 
 
2.6 С иси алгоритмов 
 

Пра ических и арифметических опе-
раторов. 

А  непосредственное преобразование инфор-
маци

огические - определяют последовательность выполнения арифметиче-
ских операторов. 

следовательностью приказов специального вида. Ка-
жды  номер и содержит следующие указания: ка-
кую 

ыполнить действие над результатом данной операции.  

оэффициент сложности алгоритма тем выше, чем выше NЭ и V. 

пособы зап

ктически все алгоритмы состоят из лог

рифметические – выполняют
и. 
Л

 
1) Операторный алгоритм Ван-Хао 
Алгоритм задается по
й приказ имеет определенный
операцию следует выполнить над заданным объектом и приказ с каким 

номером следует далее в
Общий вид приказа: 

βαω:i  
где i – номер приказа, ω - элементарная операция над объектом, α и β - но-
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мера некоторых приказов. 
 в операторе алгоритма – значит найти 

числ ию приказа α. Если значение W(X) не-
опре

, составленные из 
опер ждого 
логи

Для записи алгоритмов используют основные типы операторов: 
тся начальными заглавными 

- операторы проверки логических условий (малые буквы латинского 
алфавита), 

- операторы переадресации (обозначается буквой F (..). В скобках ука-
зан изменяемый адрес или параметр), 

- операторы переноса, 
- операторы формирования. 
Например 
 

Аор1↑1А1↓1р2↑2А2А3↓2А4Ак
 
где – Ао , Ак – операторы начала и конца, 
А1… А4 – операторы, 
р1 , р2 – логические условия. 
сли р  = 1, то произойдет переход на оператор А1, если = 0, то произойдет 

пере
я р . 

 

3) В виде тма. 
( зями меж-

ду соб

4) Словесное задание алгоритмов 
 

 блоки, которые отображаются в 
виде

ывающими связи между ними. 
Если логические условия передают управления другим блокам, то на 

стрелках этих блоков указываются условия, при которых процесс разветвляет-
ся. 

Кроме этого имеются блоки ввода и вывода. 
Примеры записи вершин графа при графической записи алгоритма: 

Выполнить приказ i над числом X
 W(X) и затем перейти к выполнено
делено, то перейти к выполнению над числом X приказа с номером β. 
 

2) форма логической схемы алгоритма. 
логической схемой алгоритма называются выражения
аторов и логических условий, следующих один за другим. После ка
ческого условия ставится стрелка, которая оканчивается у какого-либо 

оператора (↑ - начало, ↓ - конец). 

- арифметические операторы (обозначаю
буквами латинского алфавита), 

Е 1
ход на оператор р2. 
Аналогично – дл 2

 структурной схемы алгори
обычно – в виде различных блоков, связанных логическими свя
ой). 

 

3) Алгоритм расчленяется на отдельные
 геометрических фигур. Блоки нумеруются и внутри них указываются дей-

ствия, которые записываются в виде формул или словестно. 
Блоки соединяются стрелками, показ
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Ао Ао 

Начальная 
вершина 

Конечная 
вершина 

Операторная 
вершина 

Условная 

 

Граф-схема ранее записанного алгоритма (см рисунок 2.4). 
остоинства: 

 вершина  
Рисунок 2.3 

. 
Д

1. Обеспечивается возможность обмена структурными схемами алгорит-
мов между специалистами. 

2. Обеспечивается наглядное чтение и понимание алгоритмов. 
3. Уменьшается число ошибок при программировании. 

 
 1     Ао 

3     А1 2  р1 
да 

нет 

4  р2 
не

да 

т

5     А2 

6     А3 

7     А4 

8     Ак 

 
Рисунок 2.4 

) Словесное задание алгоритмов 
тма и 

в ни огические условия. 

 

4
При данном способе задания алгоритма перечисляются блоки алгори
х записываются л
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3 Формальное описание коммутационных схем 

как не-
кото

 
Любая коммутационная схема ЭА состоит из набора элементов заданным 

образом соединенных между собой. Поэтому схему можно представить 
в XL: рое подмножество элементо

{ }nxxxX K21 ,=  
ых межСоединенн ду собой цепями из множества Е 

{ }meeeE K21,=  
яя гиперграф H (X, E) матрицей инцидентности получаем удоб-Представл

ную ф
 
Э

орму представления схемы в памяти ЭВМ. 

лектрическую схему задают также в виде матрицы цепей: 

mnijtT =
×  

контактов (наиболее 
част в элементов с 
максимальным числом контактов. 

 
Строки матрицы Т соответствуют элементам схемы, а столбцы – контактам 

элементов. 
Если в схеме имеются элементы с различным числом 
о встречается), то в качестве  m принимается число контакто

 
Пример: 
 

С03С01 
 

X1 (VT1)

 
X3 (R1) 

 
X2 (VT2) 

 

С02 С04

e
2

e5 1

C11 CC1

e

e4 

212 C22C C  

l3 

e6 
C31 C41C32

C42 C33

X4 (R2) 

13 23

 
 

Рисунок 3.1 Схема электрическая 
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654321 llllll

0001111
1110010

X
X

0111003
0101102X

1100004X  
 

X

B =

lllX

3.1 Основные модели представления коммутационной схемы ЭА  

в памяти ЭВМ 

4321
65410 llllX

05232 lllX
T =

03211

05343 lllX
00654 llX  

 
 

 
одель 1М  

Схема строится в виде мультиграфа G  где Х – множество элементов 
схемы, U – множество ребер, каждое из которых соответствует соединению 
между i-тым и j-тым элементами схемы. 

Обычно модель представляется в ЭВМ в виде матрицы смежности. 
Характеристики модели: 

1. Модель широко используется при решении задач компоновки и разме-
щения. 

2. Описание данной модели обладает избыточностью, т.к. число ребер, 
инцидентных отдельным вершинам модели оказывается больше 
фактического осуществления трассировки. 

3. Алгоритм обработки достаточно прост. 
4. Переход от объекта к модели достаточно прост. 
5. Недостаток: Требуется значительный объем памяти, пропорциональ-

ны

(X,U),
 

й квадрату числа элементов схемы. 
 
Модель 2. 
Вершины графа G(X,U) сопоставляются выводам элементов, а соединения 

между ними – ребрам. 
Модель применяется для решения задач трассировки. 
Ее характеристики аналогичны характеристикам Модели 1. 
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Модель 3. 
Электрическая схема представляетс  гипер-графом, который в памяти 

ЭВМ

ении элементов. 
 

ности о

я
 представляется матрицей инцидентности.  
Характеристики модели: 

1. Обычно используется при компоновке и размещ
2. Позволяет достаточно точно определить основные конструктивные

параметры устройства. 
3. Установление однознач бъекта и модели не вызывает затрудне-

ний. 
4. Недостатки: Алгоритмы обработки модели достаточно сложны. 
5. Требуется большой объем памяти ЭВМ. 

 
Модель 4. 
Для построения модели необходимо пронумеровать все цепи схемы. Вер-

шины модельного графа сопоставляются элементам схемы. Выводы контактов 
элементов и цепи нумеруются. 

Исходными данными для ввода является матрица цепей. 
Характеристики модели: 

1. Универсальна. 
2. Обладает достаточной степенью тализации и позволяет точно опи-

сать объект. 
Объем памяти значительно меньше, чем у модели 1-3. 

4. Недостатки: Алгоритмы обработки достаточно сложны (сложнее чем 
у моделей 1 и 2). 

5. Переход от объекта к модели достаточно сложен. 
 

.2 Основная модель монтажного пространства 

 конструкций называется неко-
тора

ре рн ое 
Регулярное МП имеет прямоуг ну  ра

ты, расположенные с р

. 
ажением: 

де

3. 

 
3
 

Монтажным пространством элементов
я область, ограниченная габаритами этих элементов. 
В монтажном пространстве данного модуля размещаются элементы низ-

шего иерархического уровня и осуществляется их электрическое соединение. 
Двумерное монтажное пространство называется монтажным полем. 
 
Различают регулярное и не гуля ое монтажн поле (МП). 

оль ю форму и вные по размеру элемен-
авным шагом по горизонтали и вертикали. 

Нерегулярное МП характеризуется тем, что элементы имеют разные раз-
меры и не имеют точно определенных посадочных мест

Минимальный размер ячейки определяется выр
 

sh 2+≥δ , 
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– ширина проводника, s – минимальногде h е расстояние между проводниками. 
 число дискретных ячеек: 

 

 
Общее

mN n ⋅= . 
 

 
 

X δ 

1 2 n 

n+1

Y  
Рисунок 3.2 – Модель монтажного пространства 

ачно может быть 
указано его координатами (xi, yi) в системе дискретных координат, либо индек-
сом I, значение которого через координаты xi и yi  выражается следующим об-
разом: 

 
Место любого i-го дискрета на монтажном поле однозн

 
( ) nyxi ii ⋅−+= 1 . 

 
В зависимости от того, проходит ли через текущ й дискрет проводник, ли-

бо в каком направлении проходит этот проводник можно рассматривать неко-
торо конечное множество состояний каждого дискрета. 

 в соответствие некоторое число, код. 
ашинным эквивалентом дискретного монтажного поля может служить 

некоторый двумерный массив 

и

е 
Каждому дискрету можно поставить
М

( )YXB , , значения каждого элемента которого 
соответствуют состоянию дискрета с координатами X, Y. 

Уменьшая шаг координатной сетки δ можно с какой угодно точностью 
описать монтажную плату. 

Однако при значительно уменьшающемся размере дискрета увеличивается 
объем памяти. 

Аналогично можно поставить в соответствие каждой ячейке вершину гра-
фа,  

тогда модель можно описать графом G (X, U), вершины которого соответ-
ствуют вершинам дискретов, а ребра – отображают связи между дискретами. 

Модель монтажного пространства описывается также матрицой расстоя-
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ний:  

mnijdD
×

=
, 

где 
 

⎩
⎨
⎧ −

=
нет - если                          ,0

смежные , если   , i jij
ij

xxL
d

 
где  – длина ребра. 

 
 
3.3 Модель электрической схемы 
 

Правила построения модели электрической схемы включают те же задачи, 
что и при построении модели монтажного пространства: 

роизводится ф ереход от эле-
ментов схемы к граф х представле-
ний. 

иненные между собой цепями из множества 

. 
Каждый элемент схемы имеет некоторое множество соединительных вы-

водов, которые называются множеством контактов

 ijL

П ормализация задачи, т.е. осуществляется п
у, а граф представляется одним из матричны

Схему рассматривают как некоторое множество элементов 
X = { }nxxx K,, 21 , соед

{ }meeeE K,, 21=

 { }scccC K,, 21= . 
Кроме контактов элементов в схеме имеются внешние контакты С0, кото-

рые осуществляют связь рассматриваемой схемы с другими элементами. 
При этом схему можно задать в виде  
 

( )UCEXG ,UU , 
 

где вершины Х соответствуют элементам схемы, Е – вершины графа, соот-
ветствующие цепям схемы, С – множество вершин графа, соответствующие 
контактам элементов, 

множество ребер 
WFU U= , 

 
где F – определяет принадлежность контактов из множества С элементам 

Х и задается парами 
 

( )si cxf ,=
; 
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ребра подмножества W задаются вхождением контакта из множества С в 
цепи  и описываются парами  Е

( )js ecw ,=
; 

Граф вида ( )UCEXG ,UU  задается обычно в виде двух матриц А1, 
А2. 

CEijaA
×

= 1
1

, 
 

⎧ ∈ если   ,11 s ec

⎩
⎨=

нет - если      ,0
j

ija
 

 

CXijaA
×

= 2
2

, 
⎧ ∈

=   если   ,1 s2 xc
a

⎩
⎨ нет - если      ,0ij

 

i

 
Пример см. ( . рисунок 3.1) 
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электрической G 
 

Рисунок 3.3 – Граф схемы 

( )UCEXG ,UU  доделать самим. В данном Остальную часть графа 
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графе вершины X+E+C, а ребра U=F+W. 
0 условно не показаны: 
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4 Алгоритмизация задач конструкторского проектирования 

 
4
 

При
поиском
техн озможности технологи-
ческ

 связи с трудностями соз-
дани

гическо-функционального или 
схем у, 

ура которых известна) 
2) Покрытие (преобразование функциональной схемы в схему со-

следующие 
1) м
2) 
3) с
4) ий и т.д. 

 
граничениями обычно являются требования на совместную или раздель-

.1 Покрытие функциональных схем модулями 

 конструкторском проектировании ЭА решаются задачи, связанные с 
 наилучшего варианта конструкции, удовлетворяющего требованиям 

ического задания и максимально учитывающего в
одстваой базы произв . Тесная взаимосвязанность задач и большая размер-

ность каждой из них обычно не позволяют предложить метод поиска опти-
мального конструктивного решения в едином цикле в

я общей математической модели, комплексно учитывающей особенности 
конструкторско-технологической базы производства.  

Существуют алгоритмы решения отдельных задач:  
1. компоновки,  

 2. размещения, 
3. трассировки. 

 
Компоновка – процесс перехода от ло
ого описания устройства к конструктивномн
Т.е. это процесс распределения функциональных элементов схемы по 

группам, соответствующим модулям различного уровня. 
Различают 3 типа задач компоновки: 

1) Типизация (разбиение функциональной схемы на части, номенк-
лат

единений элементов, номенклатура которых известна) 
3) Разрезание (разбиение Э3 на части, минимально связанные меж-

ду собой) 
 
Математическая формулировка покрытия. Исходными данными для 

реше задачиния  покрытия являются: функциональная схема устройства и схе-
мы типовых конструктивных элементов используемого набора модулей.  

Необходимо найти такое распределение логических функций покрываемой 
схемы по отдельным конструктивным элементам, при котором достигается экс-
тремум целевой функции.  

Изве нст ые в литературе алгоритмы покрытия оптимизируют в основном 
показатели качества:  
марную стоимсу ость модулей, покрывающих схему; 

общее число модулей, необходимое для  реализации схемы; 
ло типов используемых модулей;  чи

число межмодульных соединен

О
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ную ом модуле элементов функциональной 
схем о

Математически – необходимо минимизировать целевую функцию  

й i-го типа, 
которые необходимы для покрытия схемы. 

го i-го типа, входящих во все покры-

• , независимо от числа за-

 
Дополнительные условия качества могут усложнять целевую функцию 

(на оторых функций внутри 
нек

В
альной схемы подсхемы (группы 

максимально связанных между собой логических элементов),  
• перебирают все или достаточно большое их число и проверяют на 

ов подсхем и компонентов 
модулей используемого набора.  

наибольшее количество ее логических функций.  
ного распределения элементов функ-

дулям. 
 
Р е

 компоновку в едином конструктивн
ы, связанные с беспечением нормального теплового режима, помехоза-

щищенности и простоты диагностики. 
Наиболее распространенный вариант задачи  - критерием качества являет-

ся суммарная стоимость модулей. Для ее решения используют методы целочис-
ленного линейного программирования. 

( ) ∑
=

=
n

i
ii XCXF

1
min

, 
 

где Сi - стоимость i-го конструктивного модуля, Хi - число модуле

При ограничениях: 
• число логических функций любо

вающие модули, должно быть не меньше общего числа элементов соот-
ветствующего типа в реализуемой схеме; 
любой модуль используется только полностью
действованных в нем компонентов. 

пример, условие максимального расположения нек
оторых модулей). 

 основу алгоритмов покрытия положены следующие этапы: 
• выделяют из заданной функцион

совпадение логических функций элемент

• Подсхема закрепляется за тем модулем, в состав которого входит 

• Процесс продолжается до пол
циональной схемы по мо

еш ние задачи покрытия , как правило, в 2 этапа: 
1. Предварительного 
2. Окончательного 

 
Алгоритм покрытия (эвристического типа): 
1. Из списка элементов схемы, подлежащей покрытию, выбирают очеред-

ной элемент Mmi ∈ . 
Если список пуст – переходим к п. 9. 
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2. Определяем все логические элементы схемы из числа непокрытых и свя-
занных с mi. 

3. Выбираем ячейки с числом выходов, равном числу взаимосвязанных 

 все удовлетворительные варианты 

ответствии с номером ячейки. Пере-
ходи

езультата при окончательном покрытии 
осущ

 
4.2 Компоновка конструктивных элементов по оммутационным платам 

ьный метод проектирования предусматривает расчленение ЭА на 
отдельные конструктивно законченные единицы (модули) различных уровней: 
стой

ии основным критерием оптимальности компоновки модулей 
явля

 

ичности разрабатываемого устройства. 

логических элементов функциональной схемы. 
4. Производим позиционное сравнение логических функций выбранных 

ячеек и логических функций взаимосвязанных элементов исходной 
функциональной схемы. Фиксируем
и переходим к п. 7. 

Если ни одна ячейка не подходит переходим к п. 5 
5. Уменьшаем число выбранных взаимосвязанных логических элементов 

исходной схемы на 1 и переходим к п. 3. 
Если число выходов равно 1 – переходим к п. 6. 
6. Выбираем все ячейки, имеющие один выход и производим позиционное 

сравнение логических функций ячейки и элементов исходной функциональной 
схемы. Фиксируем возможные варианты покрытия. 

7. Выбираем ячейку с минимальной стоимостью. 
8. Всем логическим элементам (выбранным) исходной функциональной 

схемы присваиваем порядковый номер в со
м к п. 1. 
. Проводим ручную доработку покрытия. 9

 
Для улучшения полученного р
ествляют парные перестановки однотипных логических элементов раз-

личных ячеек. Критерием удачной перестановки является увеличение внутрен-
них связей ячеек. 

 

 к
 

Модул

ки, блоки, субблоки, функциональные узлы.  
При разработке конструкции ЭА необходимо распределить элементы схе-

мы (модулей предыдущего уровня) по коммутационным платам (коммутацион-
ным пространствам) данного уровня иерархии.  

При ее решен
ется минимизация числа межмодульных связей, что необходимо для  

• повышения надежности схем (за счет уменьшения числа разъемных 
соединений),  

• уменьшения влияния наводок и времени задержки сигнала в цепях
(вследствие минимизации суммарной длины соединений),  

• упрощения конструкции и  
ия технолог• повышен
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Мат
Эле тиграфом 

G(X, U)
отве

, 

где U

я количеством контактов используемого разъема, чис-

• 
ыми соображениями и условия-

 алгоритмы; 
. 

д

 осуществляют по-
следовательный выбор вершин (из числа нераспределенных) и присоединение 
их к формируемому куску графа. После образования первого куска переходят 
ко второму и т. д. до получения желаемого разрезания исходного графа. 

3) В итерационных алгоритмах начальное разрезание графа на куски вы-

ематическая формулировка.  
ктрическую схему интерпретируют ненаправленным муль

, в котором каждому конструктивному элементу (модулю) ставят в со-
тствие вершину мультиграфа X, а электрическим связям схемы - его ребра 

U. Требуется «разрезать» его на отдельные куски G1(X1, U1), G2(Х2, U2), …, 
Gk(Xk, Uk) так, чтобы число ребер, соединяющих эти куски, было минимальным, 
т. е. 

jiU
k

i

k

j
ij ≠∑∑

= =

,min
1 1

 
ij - множество ребер, соединяющих куски Gi(Xi, Ui) и Gj(Хj, Uj). 

 
Конструктивные ограничения в задачах компоновки: 

• Число кусков разрезания графа k; 
• число вершин в каждом из кусков гpaфа (определяется числом конструк-

тивных элементов, которые необходимо разместить на коммутационной 
плате, пластине БИС, подложке БГИС и т. д.); 

• максимальное число внешних связей каждого отдельно взятого куска 
графа (определяетс
лом 

• выводов стандартного корпуса БИС или БГИС); 
требование на раздельную компоновку отдельных вершин в различных 
кусках графа (обусловлено конструктивн
ми электромагнитной совместимости). 

 
 
4.3 Классификация алгоритмов компоновки 
 

. 1 алгоритмы, использующие методы целочисленного программирова-
ния; 

. 2  последовательные алгоритмы;  
3. итерационные алгоритмы; 
4. смешанные

. 5 алгоритмы, основанные на методе ветвей и границ
 

1) ля устройства реальной сложности фактически не реализуемы на ЭВМ, 
2) При использовании последовательных алгоритмов сначала по опреде-

ленному правилу выбирают первую вершину графа, затем
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полн гается парны-
ми или групповыми перестановками вершин графа из различных кусков. Про-
цесс ого экс-
трем а. 

 для получения начального ва-
рианта «разрезания» используется алгоритм последовательного формирования 
куск

 собой точку в многомерном пространстве. 
Процесс последовательного сечения исходного множества решений L гиперп-
лоск

ножествами. Чтобы уменьшить объем перебора, производят оценку 
обра

отрения те подмножества, для которых ожидаемое значение 
целевой

 2) 

яют произвольным образом; оптимизация компоновки дости

 перераспределения вершин заканчивают при получении локальн
ума целевой функции, удовлетворяющего требованиям разработчик
4) В смешанных алгоритмах компоновки

ов; дальнейшая оптимизация решения осуществляется перераспределением 
вершин между отдельными кусками графа. 

5) Метод ветвей и границ сводится к последовательному разбиению 
множества допустимых планов задачи целочисленного программирования L на 
подмножества. Процесс разбиения продолжается до тех пор, пока каждое под-
множество не будет представлять

остями представляет собой построение дерева ветвлений с соответствую-
щими подм

зуемых подмножеств по наибольшему (наименьшему) значению для задач 
максимизации (минимизации) целевой функции. Это позволяет на каждом шаге 
исключать из рассм

 функции оказывается наихудшим. 
 

Чуть подробнее рассмотри алгоритмы 1) и
 
Последовательный алгоритм: 
 

«разрезание» исходного графа G(X, U) на куски Gi(Xi, Ui) сводится к сле-

дующему. В графе G(X, U) находят вершину Xxi ∈  с минимальной локаль-
ной степенью ρ: 

( ) ( )jXxi xx
j

ρρ
∈

= min
 

 

Число ребер инцидентных некоторой вершине xi называется степенью 
вершины. 

 

Из подмножества вершин, смежных с вершинами формируемого куска 
графа G1(X1, U1), выбирают ту, которая обеспечивает минимальное приращение 
связей куска с еще нераспределенными вершинами. Данную вершину хj вклю-
чают в G1(X1, U1), если не происходит нарушения ограничения по числу внеш-
них связей куска. 

Указанный процесс продолжается до тех пор, пока множество X  не будет 
содер

1
жать п элементов либо присоединение очередной нераспределенной вер-

шины хj, к куску G1(X1, U1) не приведет к нарушению ограничения по числу 
внешних соединений куска. 

Процесс повторяют для формирования второго, третьего и т. д. кусков ис-
ходного графа с той лишь разницей, что рассмотрению подлежат вершины, не 
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вошедшие в предыдущие куски. 

• позволяет быстро получить решение задачи компоновки. 
 

Д ограни-
чения  графа. В этом случае каж-
дая та
мирован й вер-
шины

ального «разре-
зани ис ю последовательного 
мето  ко ю итерационного 
парного и  кусков. При этом для ка-
ждой

енению числа только тех свя-
зыва и ам.  

дится к перестановке соответствую-
щих

 
 элементов в диагональных подматри-

цах, то равносильно минимизации числа соединительных ребер. 

– на-
скол . 

– 

ое качество решения задачи. 
 Для сокращения числа итераций обмена вершин между кусками в 

смеш

Достоинства: 
• прост,  
• легко реализуется на ЭВМ и  

анный алгоритм может эффективно применяться и при наличии 
 на совместную компоновку отдельных вершин
кая вершина жестко закрепляется за определенным куском графа и фор-
ие очередного куска начинается с непосредственного выбора это

 в качестве исходной. 
 
 
Итерационный алгоритм: 
 

Сущность алгоритма заключается в выборе некоторого нач
я» ходного графа на куски (вручную или с помощь
да мпоновки) и последующего его улучшения с помощь

ли группового обмена вершин из различных
 итерации осуществляется перестановка тех вершин, которая обеспечивает 

максимальное уменьшение числа связей между кусками графа или максималь-
ное улучшение другого выбранного показателя качества с учетом используе-
мых ограничений (например, на максимальное число внешних ребер любого 
отдельно взятого куска). 

Парная перестановка вершин  приведет к изм
ющ х куски ребер, которые инцидентны этим вершин
Операция парного обмена вершин сво
 строк и столбцов матрицы смежности А.  
Процесс оптимального разрезания графа на куски заключается в отыска-

нии на каждой итерации таких парных перестановок строк и столбцов матрицы
А. При которых максимизируется сумма

ч
 

Недостатки 
 Оптимальность решения в значительной степени зависит от того, 

ько удачно было произведено начальное разделение графа
Требуют больших затрат машинного времени, чем последовательные 

алгоритмы.  
Достоинства: 
– Обеспечивают высок
–
анных алгоритмах для получения начального «разрезания» графа приме-

няют последовательные методы формирования его кусков. 
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5 Алгоритмы размещения конструктивных модулей 

 
5.1 Постановка задачи размещения конструктивных модулей   

различных уровней иерархии 

я каждой полученной в результа-
те к

аются предъявляемые к ап-
пара

ями установки и крепления данной сборочной едини-
цы в

ество и геометрические размеры конструктивных элементов, под-
лежа

тимизируется выбранный показатель ка-
чест

 
на печатных платах. 

ещения - выбор целевой 
функции  размещения является 
созд

о-
ляют создать благоприятные для трассировки условия, но не гарантируют по-
лучение оптимального результата.  

Если для оценки качества размещения элементов выбрать критерий, непо-
средственно связанный с получением оптимального рисунка металлизации пе-
чатной платы, то конечный результат может быть найден только при совмест-
ном решении задач размещения, выбора очередности проведения соединений и 
трассировки, что трудно осуществить вследствие огромных затрат машинного 

 

После распределения конструктивных элементов (КЭ) ЭА в монтажном 
пространстве различного уровня иерархии, дл

омпоновки сборочной единицы производят размещение включенных в ее 
состав элементов предыдущего уровня, т.е. выбирают такое их взаимное распо-
ложение, при котором наилучшим образом учитыв

туре требования. 
 
Постановка задачи. Исходными данными при решении задач размещения 

являются:  
1. данные о конфигурации и размерах коммутационного пространства, 

(определяются требовани
 аппаратуре);  
2. колич
щих размещению;  
3. принципиальная схема узла (или КЭ);  
4. ограничения на взаимное расположение отдельных элементов, учиты-

вающих особенности разрабатываемой конструкции.  
 
Задача размещения сводится к отысканию для каждого размещаемого эле-

мента таких позиций, при которых оп
ва и обеспечиваются наиболее благоприятные условия для последующего 

электрического монтажа.  
собое значение эта задача приобретает при проектировании аппаратурыО

Основная сложность в постановке задач разм
. Связано это с тем, что одной из главных целей

ание наилучших условий для дальнейшей трассировки соединений, что не-
возможно проверить без проведения самой трассировки.  

Любые другие способы оценки качества размещения (минимум числа пе-
ресечений ребер графа, интерпретирующего электрическую схему соединений, 
разбиение графа на минимальное число плоских суграфов и т. д.), хотя и позв
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времени. 
Поэтому все применяемые в настоящее время алгоритмы размещения ис-

пользуют промежуточные критерии, которые лишь качественно способству-
ют решению основной задачи: получению оптимальной трассировки соедине-
ний. 

1) минимум суммарной взвешенной длины соединений;  
2) минимум числа соединений, длина которых больше заданной;  
3) минимум числа пересечений проводников;  
4) максимальное число соединений между элементами, находящимися в 

соседних позициях либо в позициях, указанных разработчиком;  
5) максимум числа цепей простой конфигурации. 

 

Наибольшее распространение в алгоритмах размещения получил первый 
критерий, что объясняется следующими причинами: уменьшение длин соеди-
нений  

– улучшает электрические характеристики устройства,  
– упрощает трассировку печатных проводников и  
– сни
 сра

ри практической реализации алгоритмов размещения часто используют 
пред оммутационной плате 
точками, совпадающими с их геометрическими центрами, а все соединения ме-
жду 

s 1 , 

T

 между элементами i и j по s-той цепи. 

жает трудоемкость изготовления печатных плат;  
внительно прост в реализации. –

 

П
ставление конструктивных элементов и позиций на к

элементами приводят к попарно взвешенным связям. Весовые оценки свя-
зей учитывают такие характеристики схемы, как  

– число электрических цепей между элементами,  
– теплонагруженность элементов,  
– условия распространения сигналов в цепях и т. д.  
 

Широкий класс таких оценок описывается формулой, определяющей зна-
чение коэффициента взвешенной связности: 

∑=
g

s
ij

s
ijij Tac

=
 

где ij  - вес s-той цепи, связывающей элементы i и j. 
s

s

aij  - элемент матрицы смежности
g – число цепей, по которым связаны элементы i и j. 

s
ijT  определяет важность s-той цепи с точки зрения минимизации ее длины 

с учетом условий распространения сигнала, теплонагруженности, электромаг-
нитной совместимости и т.д. 
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В общем виде задача размещения конструктивных элементов на коммута-
ционной плате формулируется следующим образом. Задано множество конст-
рукт

сли критерием качества размещения является минимум суммарной взве-
шенн

ивных элементов Х и множество связей между этими элементами U, а так-
же множество установочных мест (позиций) на коммутационной плате Т. Найти 
такое отображение множества Х на множестве Т, которое обеспечивает экстре-
мум целевой функции F. 

Е
ой длины соединений, то задача состоит в минимизации функции 

∑∑
= =

 (коммутационная плата) имеет форму прямоуголь-
ника м и

размещаемых элементов. В результате получим 
фикс

сходя из конструктивных соображений, могут выделять области для раз-
мещ  контактных зон схемы (разъемов), а также запрещенные 
области зоны крепления 
плат

условно 

з

коммутационных платах. Так как разъемы обычно помещают на 
внешней стороне коммутационной платы, то эти элементы желательно распола-
гать  границы коммутационного поля. 

ых на плате заранее 
определено

изацию размещения осуществляют, как правило, локально из неко-
торо

ользующие непрерывно-дискретные и дискретные ме-
тоды

=
n

i

n

j
ijij dcF

1 1
min

 
 
Обычно поле позиций
 aхb с координата и 0 ≤ х ≤ а  0 ≤ у ≤ b. 
Вся площадь платы разбивается на ряд областей (позиций), число которых 

должно быть не меньше числа 
ированные позиции для установки элементов. 
И
ения выводных

, в которых не должны помещаться элементы схемы (
ы, конструктивные вырезы и т. п.). 
Все конструктивные элементы, подлежащие размещению, можно 

разделить на три группы 
1) нефиксированные элементы, местоположение которых на плате заранее 

не и вестно. 
2) граничные элементы, к которым относятся элементы, связанные с разъ-

емами, осуществляющими электрическую связь с элементами, расположенны-
ми на других 

у
3) фиксированные элементы, местоположение котор

 (указано разработчиком). 
 

Оптим
го случайного или интуитивно выбранного первоначального размещения. 
 
 
5.2 Классификация алгоритмов размещения  
 
По принципам реализации известные алгоритмы  размещения можно раз-

делить на алгоритмы, исп
 оптимизации (рисунок 5.1). Эффективность того или иного алгоритма 

обычно оценивают по результатам решения типовых конструкторских задач. 
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Алгоритмы 
размещения 

 

Непрерывно-
дискретные методы 

 
Дискретные 
методы  

Градиентные 
методы 

оптимизации 

Построение 
динамических 
моделей  

 
Алгоритмы 
назначения  

 
Алгоритмы 

случайного поиска 

 
Эвристические 
алгоритмы  

 
Линейного 
назначения  

 
Квадратичного 
назначения  

 
Алгоритмы парных 
перестановок  

Алгоритмы 
последовательной

установки 

 

 

го набора посадочных мест не обязательно. 
Разм  осуществляется на непрерывной плоскости. 

ние;  

Алгоритмы, исрользующие градиентные методы 
 

Получили наибольшее развитие. 
При использовании градиентных методов для отыскания оптимального 

размещения элементов на плате по критерию минимума суммарной взвешенной 
длины соединений решение задачи сводится к минимизации целевой функции 
F. Так как целевая функция является многомерной, то градиент аналитически 
выражают в виде суммы частных производных по всем нефиксированным ко-
ординатам xi и yi: 

Рисунок 5.1 – Классификация алгоритмов размещения 
 
 
5.3 Непрерывно-дискретные методы размещения 
 

Для них задание фиксированно
ещение элементов
Представляют наибольший интерес для конструкций, содержащих разно-

габаритные элементы (ППП + гибридные ИМС + дискретные элементы). 
При использовании данных методов оптимизации, задача размещения ре-

шается в два этапа: 
1) определяют координаты местоположения центров элементов, при кото-

рых целевая функция F имеет экстремальное значе
2) полученные координаты «округляются» в фиксированные целочислен-

ные значения координатной сетки, нанесенной на поверхность коммутацион-
ной платы. 
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∑∑
== ∂∂ i

i
ii

i
i yx 11 . 

 
Для нахождения минимального значения целевой функции F используют 

пошаговый градиентный метод, подробно рассмотренный ранее. Движение по 
координатам осуществляют до

→→ ∂∂ hq FF
+=∇ yxF

динатной сетки платы. 

остоинства: 
ие затраты машинного времени на отыскание 

экстремума целевой функции,  

во  экстремума;  
низкая ме, так как раньше време-

ни п

ия не используют. Их применяют в сочетании с 
мето тыскивая при этом глобальный экстремум целе-
вой ф

исрользующие динамические модели 

я

 

 тех пор, пока на очередной итерации частные 
производные не будут меньше некоторой фиксированной величины (погрешно-
сти). 

При использовании градиентных методов местоположение конструктив-
ных элементов на плате получается в непрерывных координатах. Поэтому на 
втором этапе проводят «округление» полученных величин до ближайших цело-
численных координат, т.е. все нефиксированные элементы сдвигаются в фик-
сированные позиции коор

 
Д
1) сравнительно небольш

2) наличие стандартных программ для решения данного класса задач 
 
Недостатки: 
1) зможность получения лишь локального

)  эффективность при пологом экстрему2
риходим к условному решению;  
3) большая неравномерность распределения элементов на плате до «ок-

ругления» координат. 
В связи с указанными недостатками в чистом виде градиентные методы 

для решения задач размещен
дами случайного поиска, о
ункции. 

 
 
Алгоритмы, 
 

Процесс размещения элементов на плате представляется механической 
моделью. 

Элементы считаются материальными точками, на каждую из которых дей-
ствуют силы притяжени  и отталкивания. 

Силы притяжения, действующие между любыми двумя материальными 
точками xi и xj пропорциональны числу электрических связей между данными
конструктивными элементами/ 

Состояние равновесия такой системы соответствует минимуму суммарной 
длины всех соединений.  
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Введение сил отталкивания материальных точек друг от друга аниц 
платы исключает возможность слияния двух любых точек и способствует их
равномерному распределению по поверхности монтажного поля

и от гр
 

ча оптимального размещения элементов сводится к нахождению тако-
го местоположения точек, пр

ий минимума суммарной взвешенной длины связей, 
прои

 поля. Полученное решение используют в 
качест  размещения на втором этапе,  

 силы притяжения и от-
талк
нию

платы при минимально 
возможных изменениях их взаиморасположения. 

поиска к вычислительным процедурам, для которых имеются 
разработанные  методы. 

и-
ентов для силовых связей);  

 числа кон-
стру
сти и

етод целесообразно использовать в тех случаях, когда позиции для уста-
новки элементов на коммутационной плате заранее не фиксированы, что имеет 
мест ых элементов (печатные платы аналого-
цифровой техники, топология микросхем и т.п.). 

.  
Чтобы устранить возникновение в системе незатухающих колебаний, вво-

дят силы сопротивления среды, пропорциональные скорости движения матери-
альных точек. 

 

Зада
и котором равнодействующие всех сил обращают-

ся в нуль.  
Решение задачи осуществляют в три этапа.  
1) используя критер
зводят размещение материальных точек на условном поле позиций без 

учета требования равномерности их распределения по поверхности и попада-
ния точек в фиксированные позиции

ве начального
2) на материальные точки начинают действовать
ивания. Под влиянием этих сил точки начинают перемещаться к положе-
 равновесия системы, при котором обеспечивается приемлемая степень 

равномерности их размещения на поле позиций.  
3) точки сдвигаются в фиксированные позиции 

 

Достоинства: 
1) возможность получения глобального экстремума целевой функции,  
2) сведение 

 численные
 

Недостатки: 
1) трудоемкость метода и сложность его реализации (подбора коэффиц

2) необходимость фиксирования местоположения некоторого
ктивных элементов на плате для предотвращения большой неравномерно-
х размещения на отдельных участках платы. 

 

М

о при размещении разногабаритн
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5.4 Алгоритмы, использующие дискретные методы оптимизации 
 

В дискретных методах оптимизации модель коммутационного пространст-
ва представляют в виде множества фиксированных координат позиций. Задача 
размещения сводится к сравнению различных вариантов, закрепления элемен-
тов в этих позициях и выбору того из них, который обеспечивает экстремальное 
знач

начения 

 линейного назначения 

снованы на комбинаторно-аналитическом алгоритме Штейнберга, в ко-
торо

ное размещение конструктивных элемен-
тов.  матрице связности С выделяем максимальное
подмножество Ri, т. е. максимальную совок

 rj с элементами 
подмножества R\Ri (мн-во R за исключением п/мн-ва Ri), где R - множество кон-
стру е.  

ение целевой функции F.  
В этих условиях для нахождения глобального экстремума F необходим 

полный перебор всех возможных вариантов размещения, т. е. для оптимального 
размещения п элементов в k позициях следует осуществить !nC n

k  перестановок, 
что уже при п = 10 практически невозможно, так как минимальное число вари-
антов размещения (k = п) оказывается равным 3 628 000. Поэтому дискретные 
методы оптимизации позволяют отыскивать обычно только локальные экстре-
мумы целевой функции. 

 
 
Алгоритмы наз
 

По основным принципам построения алгоритмы назначения делят на две 
группы.  

1. Алгоритмы
2. Алгоритмы квадратичного назначения 
 
1) Алгоритмы линейного назначения 
О
м объектами рассмотрения являются несвязные подмножества конструк-

тивных элементов, т.е. такие подмножества, для которых матрица связности С 
полностью состоит из нулей. 

Суть метода Штейнберга: 
Пусть имеется некоторое началь
По  внутренне устойчивое 

упность несвязных между собой 
элементов.  

Из начального размещения исключаем элементы, принадлежащие Ri.  
Для всех элементов из подмножества ищем такие позиции из числа сво-

бодных, которые соответствуют минимуму целевой функции F.  
Так как элементы подмножества Ri не связаны друг с другом, то на выбор 

позиции для любого ij Rr ∈
 оказывают влияние только связи

ктивных элементов, размещаемых на плат
Таким образом, оптимизация размещения элементов подмножества Ri на 

плате сводится к решению задачи о назначениях (см. линейное программиро-
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вание). 
После нахождения оптимального размещения всех элементов ij   вы-

деляем следующее внутренне устойчивое подмножество и т.д.  
Рассмотренный итерационный процесс оптимизации размещения приводит 

к монотонному уменьшению значения целевой функции F. Условием оконча-
ния поиска на z-ом шаге является незначительное уменьшение целевой функ-
ции при оптимизации размещения очередного внутренне устойчивого подмно-
жества: 

 

Rr ∈

ε≤−
−

−

1

1

z

zz

F
FF

, (5.1) 
 

где F орог чувст-
вите

стро сходится. 

квадратичного назначения 

е получили алгоритмы, основанные на методе 
ветв

. возможность получения глобального экстремума целевой функции,  
 задач квадратичного назначения. 

едостатки: 
ть качественного начального размещения  

 алгоритмы случайного поиска делят 
на тр

z-1 и Fz - значения целевой функции на (z-1)- и z-м шагах; ε - п
льности алгоритма. 
 

Эффективность алгоритма Штейнберга зависит от числа нулей в матрице 
связности С. Обычно такая матрица содержит более 60% нулей, вследствие че-
го процесс поиска бы

 

Недостатки: 
1. большой объем требуемой памяти ЭВМ  
2. возможность нахождения только локального экстремума целевой функ-

ции (глобальный оптимум на каждом шаге ищется лишь для внутренне устой-
чивого подмножества, а не для всей системы в целом). 

 
2) Алгоритмы 
Основаны на использовании методов нелинейного программирования. 
Наибольшее распространени
ей и границ. 
 

Достоинства: 
1
2. наличие типовых программ решения
 

Н
1. необходимос
2. сравнительно большие затраты машинного времени, не позволяющие 
решать задачи большой размерности. 
 
 
Алгоритмы случайного поиска 
 

По основным принципам построения
и группы.  
1. Алгоритмы слепого поиска 
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2. Алгоритмы случайного блуждания 
3. Комбинированные алгоритмы случайного поиска 

онтажной плоскости из числа не-
заня  с первого) подлежащий раз-
мещ -
тивн с-
ляют ммарную взвешенную длину со-
един

ивает равновероятное попадание элементов на различные пози-
ции 

йденного варианта размещения значе-
ние 

дыдущих шагах. Если имеет место улучшение значения целевой функции, 
то д  
неуда

 

Д
А тва области до-

пустимых  опти-
миза

число вариантов размещения, практич
бору

 

Число просматриваемых вариантов q можно сократить, если отыскивать не 
оптимальное, а близкое к нему размещение, для которого значение целевой 
функ * на величину, не превосходящую не-
кото

 
1) Алгоритмы слепого поиска.  
Выбирают наугад какую-либо позицию м
тых и на ней закрепляют (по порядку, начиная
ению элемент. Эту операцию продолжают до тех пор, пока все конструк
е элементы не будут установлены. Для полученного размещения вычиы

 значение целевой функции, например су
ений.  
Аналогично проводят второе, третье и т. д. случайные размещения элемен-

тов, начиная с закрепления второго, третьего и т. д. элементов. Подобная про-
цедура обеспеч

и осуществляется с помощью датчика псевдослучайных чисел, равномерно 
распределенных на отрезке [—1, +1].  

Вычисленное для каждого вновь на
целевой функции сравнивают с наилучшим результатом, достигнутым на 

пре
анное размещение запоминают, в противном случае — отбрасывают как
чное. 

остоинство: 
лгоритмы не накладывают никаких ограничений на свойс

 значений параметров и целевую функцию, позволяя проводить
цию одновременно по нескольким показателям качества.  
 

Недостаток: 
ля нахождения глобальноД го экстремума требуется просмотреть огромное 

ески равное полному регулярному пере-
. 

ции F отличается от оптимального F
рую заранее заданную погрешность ε. Поиск ведется до тех пор, пока на q-

ом шаге не будет выполнено условие 
ε≤− FF *

,  q (5.2) 
где F

 
, 

..., z
 

 

q - наилучшее значение целевой функции, достигнутое за q шагов.  
Приближенное значение F* можно определить следующим образом. В

процессе работы алгоритма накапливается информация о значениях Fi, i = 1, 2
 (z≤q). На z-ом шаге, экстраполировав монотонно изменяющуюся последо-

вательность значений Fi, находят предел Fe, к которому стремится целевая
функция. Это значение и принимается за искомое F*. При большом z данный 
метод обеспечивает достаточно высокую точность оценки F*.  
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2) Алгоритмы с
П в

лучайного блуждания. 
мального решения вследст-

вие у уемой функции. Например, 
мож о при оптимальном расположе-
нии 

ти попадания связанных элементов в соседние 
позиции  

расстояния от данных позиций. С помощью 
датч пределенных в интервале [0,+ 1] с макси-
маль зи нуля, осуществляют случайны  выбор позиции та-
ким иваемого 
элем ьшим номером,  чего производят перенумера-
цию х позиций, принимая во внимание связи следующего 
закр

м данный алгоритм не отличается от предыдущего. 

3) Комбинированные алгоритмы случайного поиска. 
Суть: 
Представляют собой комбинацию метода случайного поиска и какого-либо 

регу

 простота учета конкретных конструкторско-технологических ограниче-
ний, 

зацию одновременно по нескольким по-
казателям качества, 

3. наличие типовых программ, обеспечивающих случайный поиск.  
 

Недостатки: 
еров размещаемых эле-

ментов л
2. быстрый рост затрат машинного времени ри повышении точности на-

хожд льного экстремума целевой функции. 
 

Достоинства: 
1. Эвристические алгоритмы позволяют сократить время решения задачи 

при вполне приемлемом для практики качестве получаемого результата.  
2. Они лучше приспособлены для учета конкретных конструкторско-

техн

оз оляют снизить трудоемкость поиска опти
изирчета характерных особенностей оптим

о воспользоваться тем обстоятельством, чтн
элементов на плате вероятность установки сильно связанных между собой 

элементов в соседние позиции выше, чем в удаленные. 
Для повышения вероятнос

 перед каждой очередной установкой элемента выявляют те позиции, в
которых располагаются связанные с ним элементы. Все свободные позиции ну-
меруются в порядке возрастания их 

ика псевдослучайных чисел, рас
ной плотностью вбли й
образом, чтобы наиболее вероятным было попадание устанавл
ента в позицию с мен
оставшихся незаняты

 после
 
епляемого элемента и т.д.  
В остально
 

лярного метода. 
 

Достоинства: 
1.

2. возможность проводить оптими

1. требование одинаковых геометрических разм
 (ус овие регулярности)  

 п
ения глоба

 
5.5 Эвристические алгоритмы 
 

ологических ограничений.  
К данной группе алгоритмов относятся 
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1. итерационные,  

ное размещение получают с помощью последова-
тельного закрепления элементов в позициях, а улучшение размещения достига-
ется

) итерационные алгоритмы 

 перестановок, 

льной установки 
ения 

льзуют общие идеи последовательных 
приб ются комбинаторными аналогами градиентных методов 
опти

 
, для выделения в нем размещения с мини-

мальным значением целевой функции F. 
ачальное и процесс повторяет-

ся. 

ение целевой функции размещения 

 
 неко-

торо

2. последовательные и  
3. смешанные (началь

 в результате их парных перестановок). 
 

1
К ним относятся  
а) алгоритмы парных
б) алгоритмы групповых перестановок 
в) алгоритмы последовате
г) параллельные алгоритмы на основе метода обратного размещ
 
Структура итерационных алгоритмов 
Алгоритмы данной группы испо
лижений и явля
мизации. 
В любом итерационном алгоритме исследуется некоторое подмножество

размещений, близких к начальному

Найденное значение вновь принимается за н

Итерационные алгоритмы имеют сходную структуру и содержат этапы: 
1. Преобразование очередного размещения. 
2. Вычисл
3. Выбор наилучшего варианта размещения по п. 2. 
4. Переход к следующей итерации и правило остановки.  

 

Как правило, итерационный процесс заканчивается, как только разность
значений целевой функции между (z-1) и z-й итерациями не превосходит

й заранее заданной величины ε: 

 ε≤−
−

−

1

1

z

zz

F
FF

. (5.3) 
 

Для итерационных алгоритмов характерно неравенство: 
...)2()1( >> FFF нач >  

 
Алгоритмы парных перестановок 
Имеется 2 разновидности, которые различаются по способу конструктив-

ных элементов, подлежащих обмену. 
) Содержательно описывается следующим образом: 

б) меняют его местами со всеми остальными, рассчитывая для всех вари-

1
а) выбирают первый по порядку КЭ,  
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антов значение показателя качества. 
в) сравнивают полученные результаты, включая и исходное размещение. 

ло

) Для отыскания оптимального размещения элементов при данном алго-
ритме производится перестановка i-й пары , для которой уменьшает-
ся значение целевой функции. 

ммарная длина всех связей между элементами i и j равна: 

г) в качестве исходной принимают ту схему размещения, которой соответ-
ствует наилучшее значение целевой функции. 

д) после того, как найдена наилучшее перестановка для 1-го модуля, ана-
гичную процедуру выполняют для 2. 3 … КЭ. 

 

Достоинства: 
1. алгоритм обладает быстрой сходимостью 
2. алгоритм прост в программировании 

 

2
 элементов

 

Математически алгоритмы парных перестановок можно обосновать сле-
дующим образом: 

пусть dij – матрица расстояний, 
 cij – матрица связи, 
огда сут

ijijij cdl =
 

для конкретных i и j. 
 

Рассматривая это выражение на все n элементов, подлежащих размеще-
нию, получим: 

( ) ∑=
n

ijij
i cdL

=j 1  
 

Если выделить из множества элементы i и j, то суммарная длина связей 
этих элементов со всеми остальными определится: 

( ) ( ) ( ) ijij

n

t
jtjtititijij

iji cdcdcdcdLL 22
1

, ∑
=

 в данном выражении отсутствует, т.к. при 

−+=−=
 

 

При попарной перестановке i и j элементов их суммарная длина со всеми 
остальными элементами станет равной 

( ) ( )∑
=

+=
n

t
itjtjtit

ji cdcdL
1

,

 
 

лен 
2 ijijcd

Ч
jtit == ,

 
элементы 
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0,0 == jtit dd
 

 
Изменение суммарной длины связи между КЭ i и j со всеми остальными, 

полученное при их перестановке будет равно: 

( ) ( )
n

jiij ,, ( )(∑
=

−−−=−=∆ )
t

jtitjtit ccddcdLLL
1

2
. 

 

На основании этой формулы можно определить матрицу приращения и на-
ходить пары, перестановка которых уменьшает суммарную длину связи между 
КЭ. 

Размещение элементов заканчивается если в матрице приращений не име-
ется

становок 
 

Возможен не только обмен двух КЭ, но и целых групп элементов. 
Недостаток: 
сложность вычисления приращений целевой функции не окупается точно-

стью полученного размещения. 
 связи с этим такие алгоритмы не нашли широкого применения. 

Так по экспертным данным эффект о циклических перестановок 3-х эле-
ментов и размещения полученного по алгоритму парных перестановок состав-

ь элементы, максимально связанные 
друг

ельном закреплении заданного набора конструк-
тивн ационной плате относительно ранее установлен-
ных.  качестве первоначально  н лате ементов обычно вы-
бирают разъемы, которые кусс нно здви т» д аев платы 

азъемов равномерно распределяются по секциям 
(столбцам и строкам координатной сетки). На каждом s-ом шаге для установки 

на коммутационную плату выбирают элемент из числа еще неразмещенных, 

ijij

, 
 отрицательных чисел. 
 
 
Алгоритмы групповых пере

В
т 

ляет всего лишь несколько процентов. 
 

Достоинства: 
перспективно использовать для улучшения качества размещения, получен-

ного другими способами. 
 
 
Алгоритмы последовательной установки 
 

Основаны на допущении что для получения оптимального размещения не-
обходимо в соседних позициях располагат

 с другом.  
Сущность: в последоват
х элементов на коммуты

 В закрепленных
тве

а п
гаю

 эл
о кр ис «ра

 

При этом все контакты р

 
s
ix  
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имеющий максимальную степень связности с ранее закрепленными элементами 

. В большинстве используемых в настоящее время алгоритмов оценку сте-
связности производят по одной из следующих формул: 

1−sR
пени 

( ) ∑
−∈

=
1sJj

ij
s

i cФ
 

( ) ∑∑
=∈

−=
−

n

j
ij

Jj
ij

s
i ccФ

s 11

2
 

 
где cij - коэффициент взвешенной связности элементов i и j; Js-1 - множество ин-
дексов элементов, закрепленных на предыдущих s-1 шагах; п - общее число 
размещаемых элементов. 

 

Если установочные размеры всех размещаемых на плате элементов одина-

ковы, то выбранный на очередном шаге элемент закрепляют в той позиции 

и ля которой значение целевой функции с учетом 

ране нтов минимально.  
терием оптимальности является минимум суммарной 

взве

 
s

ir  
s
jt

 
s
jF  з числа незанятых, д

 1−sR  е размещенных элеме
 частности, если криВ

шенной длины соединений, то 
 

∑
−

− ∈
∈

= mins dcF
1

1\
s

sf Jj
fjijTTtj

, 

где d цией раз-
мещ j; Ts-1 - множество позиций, занятых элементами 
после (s-1)-го шага алгоритма. 

 

fj - расстояние между f-й позицией установки элемента 
s

ir  и пози
енного ранее элемента r

Процесс размещения элементов заканчивается после выполнения п шагов 
алгоритма.  

 

Рассмотренный алгоритм можно использовать и для размещения разнога-
баритных элементов, если их геометрические размеры кратны или близки к 
кратным. При этом поверхность платы условно покрывается прямоугольной 
координатной сеткой, линейные размеры ячеек которой равны соответствую-
щим линейным размерам позиций минимальных КЭ.  

Для повышения эффективности в алгоритме предусмотрена проверка це-
лесообразности удаления ранее размещенных простых конструктивных элемен-
тов, препятствующих закреплению на плате более сложных.  
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Так при установке элемента у(состоящего из 4 минимальных) в зоне его 
предполагаемого закрепления просматриваются состояния четырех элементар-
ных ности представляющих собой 
уста ейки свободны, то элемент у 
закр ния ранее 
закр е позиции 
плат

мы являются в настоящее время самыми быстро дейст-
вующ

к: 
учаемого решения – хуже других итерационных. 

ове метода обратного размещения 

ячеек (свободны они или заняты), в совокуп
и эти ячновочное место этого элемента. Есл

епляют, в противном случае оценивают возможность перемеще
пленных в данных ячейках минимальных элементов на новые
ы. 
После размещения на коммутационной плате всех элементов полученное 

решение может быть улучшено за счет парных перестановок в пределах каждо-
го класса (типоразмера). 

 

Достоинство: 
Данные алгорит
ими. 

 

едостатоН
по качеству пол
 
 
араллельные алгоритмы на оснП

 

 В методе обратного размещения выполняется предварительная оценка ка-
ждого размещенного элемента xi и каждого места печатной платы ti. 

После этого элементы размещаются одновременно. 
 
Пусть заданы матрица связей и длин: 

nnijcC
×

=
 

mmijdD
×

=
 

nm ≥  
 

а xi по матрицам С и D находим суммарное число свя-
зей этого элемента с остальными: 

K2,1=

(С – элементы, D – места на печатной плате). 
Для каждого элемент

cc iji ,=∑
n

ni
j 1=
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dd
m

iji ,=∑
j

mi K2,1=  

1=

 возрастанию характеристики сi
т места печатной платы по убыванию характеристики d

 di

 
t1 t2 t3 t4 t5 t6 

 
di – определяет суммарное расстояние от i-й позиции до всех остальных пози-
ций. 

Позиции в центральной части платы имеют меньшее di чем на периферии, 
поэтому центральные позиции наиболее благоприятны для размещения элемен-
тов с большим значением сi. В связи с этим 

Алгоритм размещения: 
. Упорядочивают элементы по1

2. Упорядочиваю i
3. Определяется размещение, где каждый соответствующий элемент сi за-

крепляется за соответствующим местом
 
Пример. 
Задана монтажная плата 

 
и матрицы связей и длин 
 

0118764
1107459
8703103
743012
8310102
448220

=C

  012345
101234
210123
321012
432101
543210

=D

 
 
 

   36
36
31
17
24
20

6

5

4

3

2

1

=
=
=
=
=
=

⇒

C
C
C
C
C
C

C

15
11
9
9
11
15

6

5

4

3

2

1

=
=
=
=
=
=

⇒

D
D
D
D
D
D

D
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1) Сi = 3, 1, 2, 4, 5, 6 
 

2) Di = 1, 6, 2, 5, 3, 4 

, 4 → 5, 5 → 3, 6 → 4. 

анный алгоритм прост и может использоваться даже при ручном разме-
ении. 

 
 
5.6 Особенности алгоритмов размещения при многоцелевой  

оптимизации модулей 
 

Особенностью оптимального конструирования ЭА является трудность ус-
тановления единого критерия качества, приводящего к действительно опти-
мальной конструкции.  

Например, при решении задач размещения элементов на печатных платах 
нужно не только учесть возможность последующей реализации печатного мон-
тажа в соответствии с применяемой технологией, но и обеспечить нормальный 
тепловой режим и надежность создаваемой конструкции при минимальных за-
тратах на ее производство и эксплуатацию. Кроме того, часто следует учиты-
вать еще такие показатели качества, как коэффициент заполнения монтажной 
плоскости, ремонтопригодность и целый ряд специальных требований, связан-
ных с особенностями разрабатываемой аппаратуры. Все это привело к необхо-
димости создания методов многоцелевой оптимизации, среди которых наи-
большее распространение получили следующие методы: 

 

1) использования единого функционала;  
2) выбора ведущего показателя;  
3) параллельной оптимизации по нескольким показателям. 
 

1) Метод использования единого функционала  
 Fi 

свой показатель 
эффективности ) от-
дель

 

Д
В ыми коэффициентами и простота реали-

зации
 

крет-
ного

 

3) Размещаем 3 элемент в 1 ячейке, 1 → 6, 2 → 2
 

Д
щ

Используется единый функционал F, но каждому показателю качества
 весовой коэффициент ki учитывающий его важность, а общий 

 представляют  в виде взвешенной суммы (произведения
ных показателей.  

остоинство: 
озможность варьирования весов
 на ЭВМ. 

Недостаток: 
Трудность обоснования важности каждого показателя и значения кон
 значения весового коэффициента. 
 
2) Метод выбора ведущего показателя 
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Основан на использовании принципа последовательной субоптимизации 
результатов, получаемых на каждом этапе поиска. Все показатели качества рас-
пола

 них. Остальные показатели выступают в роли ограничений, затем 
опре

ние по второму показателю и т.д. 

. 

Н
Быс ат машинного времени и объема памяти при расшире-

нии с
 
3
Закл енке различных вариантов размещения одновременно по 

всем о
К

гают в порядке важности и сначала отыскивают оптимальное решение по 
первому из

деляют допустимую обметь в которой значение первого показателя отли-
чается от оптимального на некоторую величину ε (например, на 5-10%) и в этой 
области ищут оптимальное реше

 

Достоинство: 
Возможность учета в виде списка ограничений большого числа различных 

требований, предъявляемых к конструкции ЭА
 

едостаток: 
трый рост затр

писка ограничений. 

) Метод параллельной оптимизации по нескольким показателям 
ючается в оц

птимизируемым показателям. 
ачество полученного размещения оценивается с помощью функционала: 

0
1 ii

i F

0 s
i

n FiF
kL

−
= ∑

=

где k

сли L > 0, то новое размещение считают лучшим и принимают за базовое, 
в про ное.  

 первом шаге в качестве базовых значений показателей качества выби-
рают

30) не будут 
мень черпан 
лими

ожность получения действительно оптимального решения по всем 
выбр

: 
ого времени. 

 
 
i — коэффициент, учитывающий важность i-го показателя, n – число пока-

зателей, 
s

iF , 
0

iF  - соответственно, значение текущего показателя качества и 
базового. 

Е
тивном случае его отбрасывают как неудач
На
 заведомо большие числа (из области допустимых), поэтому при оценке 

первого варианта размещения функционал L > 0. Процесс поиска продолжается 
до тех пор, пока значения функционала L, соответствующие выбору нового ба-
зового размещения, на протяжении большого числа шагов (20—

ше некоторой наперед заданной погрешности ε или пока не будет ис
т времени на решение задачи. 

 

Достоинство: 
Возм
анным критериям качества. 
 

остатокНед
Большие затраты машинн
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6 АЛГОРИТМЫ И МОДЕЛИ ТРАССИРОВКИ СОЕДИНЕНИЙ В ЭА 

 
 
.1 Классификация алгоритмов 6 трассировки 

 
Алгоритмические методы

трассировки

Трассировка проводных
соединений

Трассировка печатных
соединений

Получение списка
соединений

Построение связывающих
деревьев

Трассировка проводов в
каналах

Графо-теоретические методы Топологич
трассировки

еские методы
трассировки

Построение
граф-схем

Анализ
планарности

Планаризация

Выделение
плоских графов

Изображение граф-схем
на плоскости

Получение эскиза
на плоскости

Получение списка
соединений

Расслоение

Очередность
прокладки соединений

Трассировка

Контроль
и коррекция трассировки

 
Рисунок 6.1 – Классификация алгоритмов трассировки (часть 1) 
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Топологические методы
трассировки

Получение списка
соединений

Расслоение

Очередность
прокладки соединений

Трассировка

Контроль
и коррекция трассировки

Алгоритмы построения
кратч их связывающих

деревьев
айш

Метод раскройки
графа пересечений

Ортогональное расслое
с минимизацией пересеч

ние
енийОцен

ений и др.
ка длин соединений,

числа пересеч

Динамические
схемы упорядочения

Волновые
алгоритмы

Ортогональные
алгоритмы

Эвристические
алгоритмы

 
Рисунок 6.1 – Классификация алгоритмов трассировки (часть 2) 
 
Исходная информация для решения задач трассировки соединений: 

 список цепей, 
 параметры конструктивных элементов 

контактных площадок. 
логический аспект связан с выбором допустимого пространственного 

расп  на 
числ

тных соединений (рису-
нок 

ста, т.к. цепи электрически 
изол  друга. Глобальная оптимизация обеспечивается локальной 
опти

 параметры монтажного поля 
 данные по размещению конструктивных элементов 
 координаты выводов элемента 

 

Задача трассировки имеет метрический и топологический аспекты. 
Метрический аспект предполагает учет конструктивных размеров эле-

мента и соединений 
Топо
оложения отдельных монтажных соединений на плате при ограничениях
о пересечений и число слоев монтажной платы. 
Различают методы трассировки проводных и печа

6.1). 
Трассировка проводных соединений более про
ированы друг от
мизацией отдельной цепи. 
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Трассировка печатных соединений сложна из-за согласования метриче-
ских емы соединений и монтажного простран-
ства

Соединения должны соответствовать принципиальной схеме и быть 

 приближаться к рав-

оведенных соединений; 
5. Минимальная протяженность параллельных участков соседних про-

6. минимум числа изгибов проводников; 

 

 соединений 

е печатного монтажа, удельный вес провод-
ных 

ьзуют при электрическом объединении модулей третьего 
(суб

о
2) с помощью жгутов. 

1) -  
Трассировка заканчивается построением кратчайших деревьев (этап 1, см. 
нок 6.1, Ч1

 и топологических параметров сх
. 
Требования к трассировке соединений: 

1. 
кратчайшими; 

2. Число пересечений трасс в монтажном поле должно быть минималь-
ным для МПП, либо не допускается – для ОПП 

3. Распределение цепей в монтажном поле должно
номерному; 

4. Минимум числа непр

водников; 

7. минимум числа слоев металлизации и числа переходов из слоя в слой 
(применяется при проектировании многослойных печатных плат). 

 

Так как все перечисленные критерии являются противоречивыми, то при 
выборе обобщенного показателя качества указывают важность или очередность
учет отдельных критериев оптимизации. а 

 
 
6.2 Трассировки проводных
 

Несмотря на быстрое развити
соединений в ЭА остается еще достаточно большим. Как правило, провод-

ной монтаж испол
блоков, кассет) и четвертого (блоков, рам) уровней иерархии. 
Трассировку проводных соединений производят двумя способами:  
1) по прямым, соединяющим отдельные выводы модулей (м нтаж внавал);  

 

рису ). 
Д.: 

 простота выполнения 
 высокая помехоустойчивость 
 позволяет до минимума сократить общую длину проводников и протя-

женность участков их параллельного прохождения, 
 уровень паразитных наводок и время задержки сигнала в электрических 

соединениях относительно невелики.  
 

Н.: 
 высока вероятность появления в процессе монтажа ошибок (неправиль-

 66 



ное подсоединение отдельных выводов, пропуск некоторых соединений и т. п.),  
 контроль правильности трассировки сложен.  
 при высокой плотности монтажа обладает малой ремонтопригодно-

стью. 
 

2) - предполагает объединение отдельных проводников в жгуты, которые 
укла

х связывающих деревьев (сетей) 

 жгутов,  
 проще процесс контроля и устранения ошибок, допущенных при мон-

таже.  
Н.: 

.О. задача трассировки проводных соединений формулируется следую-
щим образом: 

В некоторой системе координат XYZ, связанной с коммутационным про-
странством модуля, задано местоположение множества выводов  

М = {m1, m2,..., mn}. 
В соответствии с электрической схемой соединений разобьем множество 

М на непересекающиеся подмножества М(1), М(2),..., М(Р), каждое из которых 
включает в себя выводы, подлежащие электрическому объединению.  

Для каждого подмножества требуется определить последовательность со-
единения выводов и конфигурацию проводников, обеспечивающих при задан-
ных ограничениях минимальную суммарную длину соединений.  

Необходимо учитывать также назначение цепей. 
Среди различных вариантов соединения вершин (выводов) подмножества 

М(i) целесообразно рассматривать лишь древообразные структуры (если нет – 
дублирование проводов).  

 
Алгоритмы построения оптимальных связывающих сетей 
Все известные алгорит йших связывающих сетей 

(КСС основаны на последовательном выборе самых коротких связей, не обра-
зующ  с ранее отобранными. Процесс продолжается до тех пор, пока 
не бу  дерево.  

 

дываются в специальные каналы, предусмотренные в монтажном поле. 
При трассировке проводных соединений данным методом  решаются сле-

дующие задачи (рисунок 6.1, Ч1): 
1. Получение списка соединений  

оение кратчайши2. Постр
3. Выполнение трассировки проводов в каналах 
Д.: 

 более технологичен, так как позволяет разделить операции вязки и рас-
пайки

 практически неприемлем для создания высокочастотной и чувствитель-
ной к электрическим помехам аппаратуры. 

 

Т

мы построения кратча
) 
их циклов
дет получено минимальное
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Алгоритм Краскала (Вайнберга – Лобермана) 
 
Пусть в некоторой сист  координат XYZ задано местоположение множе-

ства точек  
М = {m , m ,..., m }. 

еме

1 2 n
1. Строим на множестве М полный граф Gn(M, U).  
2. Вычисляем длину всех ребер графа G (M, U) и  n
3. упорядочиваем список ребер с точки зрения их длины так, чтобы выполня-

лось условие 

( )( )[ ]1+≤∈∀ iii ududUu
, 

( )
2

11 −
=<≤

nnri
, 

где d(ui) —длина ребра ui. 
Это условие построения кортежа с возрастанием каждого очередного реб-

ра. 
Для построения дерева необходимо выбрать n-1 ребер из кортежа, которые 

не образуют циклов. 
Существуют две возможные процедуры, приводящие к построению одного 

и того же минимального дерева. 
П
Н
роцедура 1. 
а каждом шаге просматривают список, ребер (начиная с ребра, сле-

дующего за вошедшем в решение на предыдущем шаге) и к строящемуся под-
дереву присоединяют то ребро, которое не образует цикла с ребрами, уже 
включенными в решение. 

Данная процедура допускает возможность параллельного построения не-
скольких поддеревьев, которые затем объединяют в единую связную сеть крат-
чайшими ребрами.  

Н.: 
необходимость наблюдения за различными компонентами связности и  
проверки при выборе каждого очередного ребра условия необразования 

цикла для всех параллельно строящихся поддеревьев.  
Эти недостатки частично устраняются во второй процедуре, которая пре-

дусматривает построение только одного поддерева. 
Процедура 2.  
На каждом шаге прос ер (начиная с первого) и к 

строящемуся поддереву при торое:  
) еще не включено в решение;  

н из концов ребра должен 
прин анной вершине). 

матривают список реб
соединяют то ребро, ко

а
б) присоединяет к поддереву новую вершину (оди
адлежать вершине поддерева, другой —изолиров
Н.: 
необходимость на каждом шаге алгоритма начинать просмотр списка с 
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первого ребра, причем значительная часть просматриваемых при этом ребер 
может не удовлетворять условиям включения их в строящееся поддерево. Это 
прив

е, 
пред

щегося поддерева с новыми, еще не присоеди-
ненн

сновные принципы построения КСС при наличии дополнительного огра-
ничения на локальные ст

одит к увеличению времени решения задачи.  
Указанный недостаток в значительной мере устраняется в алгоритм
ложенном Р. К. Примом. 
 
Алгоритм Прима 
 

Позволяет организовать просмотр только тех ребер графа Gn(M, U), кото-
рые связывают вершины строя

ыми вершинами.  
О

епени вершин связывающей сети:  
 

( )[ ]kmMm ii ≤∈∀ ρ
. 

Шаги алгоритма: 

1) любая произвольная вершина Mmi ∈  соединяется с ближайшей сосед-
ней, образуя исходное поддерево.  

Для определенности построения КСС можно начинать с ребра, инцидент-
ного вершине m1.  

На каждом последующем шаге к строящемуся поддереву присоединяют 
очередное ребро минимально возможной длины, связывающее новую, еще не 

присоединенную вершину тj с одной из вершин поддерева Mmi ∈ *, локальная 

степ ( ) km <iρ , т. е. ень которой 

( ) ( )
*M\Mgm*Mfm ∈ ,

gfji m,mdminm,md
∈

=

, 
( )gf mmd ,где  - длина ребра, соединяющего вершины  

ого алгоритма первоначально составляем матрицу длин  
 

Для реализации эт

NN× , 
общий элемент которой d

ij

ы первой строки матрицы D и находим минималь-
ный  оказался элемент g-гo столбца, тогда весь 
первый и g-й столбцы матрицы D исключаем из рас
нение проводим между точками m1 и тg.  

dD =

ij равен расстоянию между i-й и j-й точками (N - 
число объединяемых вершин).  

Просматриваем элемент
из них. Пусть таким элементом

смотрения, а первое соеди-

Просматриваем первую и g-ю строки матрицы с оставшимися элементами. 

 69



Из элементов этих строк находим минимальный. Предположим, что им оказал-
ся элемент, принадлежащий j-му столбцу. Если этот элемент находится на пе-
ресечении с первой строкой, то точку тj соединяем с mi, если же он находится 
на пересечении c g-й строкой, то точку тj соединяем с тg, после чего из матри-
цы D

.д. 
ыполнение ограничения на локальную степень вершин обеспечивается 

проверкой в каждой просматриваемой i-й строке числа уже выбранных для по-
строения КСС элементов K(i). При K(i) = k все оставшиеся элементы i-й строки 
исключаются из рассмотрения. 

Пример.  
На плоскости в декартовой системе координат задано местоположение де-

вяти точек (рисунок 6.2). Расстояние между любыми двумя точками тi и тj рав-
но  

 

 исключаем все элементы j-го столбца.  
Просматриваем первую, g-ю и j-ю строки и т
В

jijiij yyxxd −+−=
 

 
Требуется для заданного множества точек М определить минимальное свя-

зывающее дерево при условии: 
 

( )[ ]3≤∈∀ ii mMm ρ
. 
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Рисунок 6.2 – Пример 

 
Решение.  
Составляем матрицу длин: 
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0614513131711219  
 
1) Просматриваем первую строку матрицы и выбираем элемент д

6089771113158
1480115971577

137580441085
117964066

987654321

-
сом 

м) все элементы первого и третьего столбцов. 
 нт d35; К[3] = 

2, К[ ты пятого столбца. 
 

 

ив  = 40. 

выбраны  d13, d35, d54, d42,  

211571681041001

104
1711712460843
111315610680102

=D

5911086126166

13, яв-
ляющийся минимальным в этой строке (при наличии нескольких элементов с 
одинаковыми минимальными значениями выбираем элемент с меньшим индек

j).  
2) Помечаем элемент d13; К(1) = К(3) = 1. Исключаем из рассмотрения (вы-

черкивае
3) Просматриваем первую и третью строки. Выбираем элеме
5] = 1. Исключаем из рассмотрения элемен
4) Просматриваем первую, третью и пятую строки. Выбираем элемент d54; 

К(5) = 2, К(4) = 1. Исключаем из рассмотрения элементы четвертого столбца. 
5) Просматриваем первую, третью, четвертую и пятую строки. Выбираем 

элемент d57; К(5) = 3, К(7) = 1. Так как К[5] = k, то исключаем из рассмотрения 
элементы седьмого столбца и пятой строки. 

6) Продолжая процесс построения КСС аналогичным образом, выбираем
элементы d42, d26, d69, d98.  

Минимальное связывающее дерево, полученное в результате решения, 
пр едено на рисунке 6.3. Суммарная длина его ребер равна D

Если локальная степень вершин не должна превышать двух, то в результа-
те решения будут  элементы  d26, d69, d98, d17.
Суммарная длина ребер при этом равна 42. 

Алгоритм Прима находит широкое применение в системах автоматизиро-
ванного проектирования проводных соединений ЭА.  
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Рисунок 6.3 – Решение 

ических соединений модулей третьего и четверто-
го у

акую канальную конструкцию можно представить в виде ортогональной 
неси метрической сети G (A, В) со множеством узлов A и множеством дуг В.  

писанием каждой дуге 
b , с

опу-

 
 
Алгоритмы трассировки проводов в каналах 
 

При выполнении электр
ровней иерархии обычно используют жгутовой монтаж, при котором про-

водники укладывают в нормализованные каналы, расположенные в монтажном 
пространстве во взаимно перпендикулярных направлениях.  

Т
м
Термин «сеть» используется для того, чтобы подчеркнуть характерную 

особенность рассматриваемой задачи, связанную с при
ij оединяющей узлы аi, аj  некоторого положительного числа cij, определяю-
щего максимальное число проводников, которое можно укладывать в соответ-
ствующем канале, интерпретируемом дугой bij. Величину сij называют пр
скной способностью дуги b .  

При любом допустимом варианте трассировки 
 

ij

 [ ]ijijij cxBb ≤≤∈∀ 0 , (6.1) 
 

где xij - дуговой поток или поток по дуге bij, равный числу проводников в кана-
ле, с

 подмножество узлов, в которых допускается изменение направления 
прок

оединяющем точки i и j. 
Разобьем множество А на два непересекающихся подмножества: 
A1 - подмножество узлов, соответствующих электрическим контактам мо-

дулей и разъемов схемы;  
А2 -
ладывания проводников (точки пересечения вертикальных и горизонталь-

ных каналов).  
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Подмножество A  в свою очередь сост  из двух непересекающихся под-

 модулей и разъемов.  

оит1
множеств:  

As - источники и at - стоки, определяющие, соответственно, электрические 
контакты

Для любого узла  

2AAAAa TSj ∪∪=∈
 

сети G (А, В) должно выполняться условие 

 

⎪
⎨

⎧

∈
∈−

=−∑∑ j

Sjj

jkij Aaесли
AaеслиX

xx ,0
,

2 , (6.2) ⎪
⎩ ∈ Tjj

ki AaеслиX ,
где Xj ≥ 0. 
Первая сумма берется по дугам, ведущим в узел аj, а вторая - по дугам, ве-

дущим из этого узла.  
жительПоло ное число Хj определяет величину потока, входящего (выхо-

дяще

 
потока

го) в j-й узел.  
Таким образом, в каждый узел aij, за исключением источников и стоков, 

вход тит акое же количество потока, какое из него выходит (условие сохранения
 (=0)).  

Полный поток из AS в АT

 ∑∑
∈∈ SjTj AaAa

(6.3) 

В реальных конструкциях пропуск

−== jj XXX
. 

ные способности каналов ограничены, 
поэт естественна постановка задачи отыскания максимального потока в се-
ти, к оков (проводни-
ков)  функцию (6.3) 
при 

еток. 

ому 
оторая сводится к нахождению такого распределения пот
по отдельным каналам, которое максимизирует целевую
ограничениях (6.1) и (6.2).  
Решаются данные задачи методами линейного целочисленного програм-

мирования либо на методе расстановки пом
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7 алгоритмы и модели трассировки печатных соединений в эа 

 
Проектирование печатного монтажа является одной из самых сложных за-

дач автоматизации проектирования ЭА. Для ее решения предложено большое 
число различных алгоритмов. 

 
 
7.1 Постановка задачи трассировки печатных соединений  
 

Задача проектирования печатного монтажа может быть сформулирована
следующим образом.  

На коммутационной поверхности за

 

2, ..., CL}, 
где каждое l-е подмножество Сl объединяет nl выводов конструктивных элемен-
тов из множества R в соответствии с принципиальной электрической схемой.  

роме того, заданы расположение групп контактных  разъемов и 
х

оению бесперекрестного минимального леса и  

крестного  минимального леса сводится к поиску 
таки

даны своими координатами (х, у) мно-
жество конструктивных элементов R = {r1, r2, ..., rt}. Выводы этих элементов 
образуют некоторое множество из L связных подмножеств: ε = {C1, C

К  площадок
монтажны  отверстий, а также ряд требований, предъявляемых к топологии 
платы:  

• минимальная ширина проводников и зазора между ними,  
• размеры контактных площадок,  
• число слоев металлизации и способы перехода с одного слоя на другой 

и т. п.  
Требуется с учетом заданных конструкторско-технологических ограниче-

ний соединить выводы конструктивных элементов внутри каждого подмноже-
ства Сl ⊂ ε так, чтобы полученные соединения отвечали выбранному показате-
лю качества. 

В общем виде задачу трассировки печатных соединений можно свести 
к  

1) постр
2) отысканию кратчайшего пути между его вершинами (трассировка со-

единений).  
Обе эти задачи можно рассматривать как независимые, алгоритмически 

разрешимые. 
1) Построение беспере
х связывающих деревьев Gl, для каждого из подмножеств Сl, которые ми-

нимизируют целевую функцию 

( )∑∑
=

−

=

=
L

l

N

n
l

n
ij

l

dF
1

1

1 , 
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где ( )
l

n
ijd  - длина n-й связи в выбранной метрике между точками i и j (контак-

тами

динственно достоверным способом получения оптимального результата в 
этих является полный перебор вариантов последовательностей по-
стро но. 

ия типа «вывод-проводник» и «проводник-проводник».  
Оптимизация подобных цепе ет построение для каждого мно-

жества объединяемых вершин Мi = { (i)} минимальных деревьев, 
допу

разветвления 
печа

мальных связывающих деревьев 
не у

Указанный недостаток, а также большое время, затрачиваемое на построе-
ние минимальных связывающих деревьев, привели к тому, что данные алго-
ритмы применяют лишь для отыскания пар контактов, подлежащих соедине-
нию. 

 
2) Трассировку соединений осуществляют с помощью алгоритмов, осно-

ванных на методах динамического программирования.  
Общим для этих алгоритмов является разбиение монтажного поля на ячей-

ки, размер и форма которых определяют плотность и конфигурацию печатных 
проводников (равносторонние треугольники, квадраты, шестиугольники). 

Наибольшее распространение  получило разбиение рабочего 
поля на правильные квадраты, ч ает простую адресацию ячеек в 
прям

Так
 один вывод или  проводник, максимальные 

 выводов), принадлежащими подмножеству Сl, объединяющему Nl контак-
тов. 

Применение алгоритмов Краскала (Вайнберга-Лобермана) и Прима позво-
ляет найти минимальное связывающее дерево лишь относительно ранее прове-
денных цепей, поэтому при трассировке печатных соединений практически не 
применяются. 

Е
 условиях 
ения бесперекрестного леса, что на практике невозмож

 Характерной особенностью печатного монтажа является возможность 
кроме соединений типа «вывод-вывод», применяемых в проводном монтаже, 
использовать соединен

й предполага
т (i), т (i), ..., m1 2 n

скающих введение произвольного числа дополнительных вершин, обра-
зующих множество D = {d1, d2, …, dk}. (т.е. точки соединения и 

тных проводников) 
Практически все методы построения мини
читывают ограничения на размеры монтажного поля, толщину печатных 

проводников и величину зазора между ними. В результате значительную часть 
найденных деревьев оказывается невозможным реализовать в виде электриче-
ских цепей печатной платы. 

 на практике
то обеспечив 

оугольной системе координат и привычную форму соединений.  
Покрытие поля равносторонними треугольниками является наименее 

удачным, так как при реализации алгоритма трассировки потребуется введение 
дополнительной операции сглаживания углов. Кроме того, использование тре-
угольных и шестиугольных ячеек усложняет их адресацию. 

Размеры ячеек определяются конструктивно-технологическими требова-
ниями, предъявляемыми к печатному монтажу.  как в каждой ячейке обыч-
но размещается только печатный
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размеры ячеек определяются допустимой точностью воспроизведения провод-
ников.  

Минимальные размеры ячеек обусловливаются возможностью ОЗУ ЭВМ и 
соотношением 

lbd n −≥
 

где d  ячеек; bn - минимальная ширина 
печа

льной (соединения проводятся оптимальным образом 
лиш

й) число разведенных цепей и их конфигу-
раци  определяются последовательностью трассировки отдельных соединений. 

условно разбить 
на тр

ест-
вующ

твием, чем алгоритмы 1)  

 со сквоз-
ным

эвристическом приеме поиска 
пути

 - расстояние между центрами соседних
тного проводника; l - минимальное расстояние между соседними провод-

никами. 
Соединение выводов конструктивных элементов осуществляется в резуль-

тате последовательного заполнения ячеек трассами, конфигурация которых яв-
ляется локально оптима

ь по отношению к ранее построенным проводникам) в соответствии с вы-
бранными критериями трассировки.  

При последовательном процессе проведения трасс (поскольку многие со-
единения конкурируют между собо

я
Известные алгоритмы трассировки печатных плат можно 
и большие группы: 
1) волновые алгоритмы,  
Основаны на идеях Ли. Получили широкое распространение в сущ
их САПР,  
Д.:  

 позволяют легко учитывать технологическую специфику печатного 
монтажа со всей совокупностью конструктивных ограничений.  

 всегда гарантируют построение трассы, если путь для нее существует; 
 

2) ортогональные алгоритмы,  
Д.: 

 обладают большим быстродейс
 реализация их на ЭВМ требует в 75—100 раз меньше вычислений по 

сравнению с волновыми алгоритмами.  
Н.: 

 получение большого числа переходов со слоя на слой,  
 отсутствие 100%-ной гарантии проведения ряда трасс,  
 большое число параллельно идущих проводников. 

Такие алгоритмы применяют при проектировании печатных плат
и металлизированными отверстиями.  
 

3) алгоритмы эвристического типа,  
В настоящее время широко распространены (критичны к объему памяти и 

быстродействию ЭВМ). Частично основаны на 
 в лабиринте. При этом каждое соединение - проводится по кратчайшему 

пути, обходя встречающиеся на пути препятствия. 
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7.2 Волновые алгоритмы. Волновой алгоритм Ли 
 

Классический пример использования методов динамического программи-
рования для решения задач трассировки печатных соединений. 

Основные принципы построения трасс с помощью волнового алгоритма:  
Все ячейки монтажного поля подразделяют на занятые и свободные.  
Занятыми считаются ячейки, в которых уже расположены проводники, 

построенные на предыдущих шагах, или находятся монтажные выводы элемен-
тов, а также ячейки, соответствующие границе платы и запрещенным для про-
кладывания проводников участкам.  

Каждый раз при проведении новой трассы можно использовать лишь сво-
бодные ячейки, число которых по мере проведения трасс сокращается. 

На множестве свободных ячеек коммутационного  моделируют волну 
влияния из одной ячейки в другу ых впоследствии общим провод-
нико

 источ-
нико приемником волны.  

 поля
ю, соединяем

м.  
йку, в которой зарождается волна влияний, называютПервую яче

м, а вторую - 
Чтобы иметь возможность следить за прохождением фронта волны влия-

ний, его фрагментам на каждом этапе присваивают некоторые веса: 
 

( )gkk fffPP ,,, 211 Kψ+= −  
 

где P
етр которой 

fi(i =

остраняется только на соседние ячейки, которые имеют с 
ячей

анения волны продолжается до тех пор, пока ее рас-
шир

и, которая могла бы быть включена в очередной фронт, 
что соответствует случаю невозможности проведения трассы при заданных ог-
раничениях. 

Если в результате распространения волна достигла приемника, то осуще-
ствляют «проведение пути», которое заключается в движении от приемника к 
источнику по пройденным на этапе распространения волны ячейкам, следя за 
тем, чтобы значения Рk монотонно убывали. В результате получают путь, со-
единяющий эти две точки.  

Из описания алгоритма следует, что все условия, необходимые для прове-
дения пути, закладываются в правила приписания веса ячейкам. 

k и Рk-1 - веса ячеек k-го и (k-1)-го фронтов; ψ(f1,f2, …,fg) - весовая функция, 
являющаяся показателем качества проведения пути, каждый парам

 1, 2, ...,g) характеризует путь с точки зрения одного из критериев качества 
(длины пути, числа пересечений и т. п.).  

На Рk накладывают одно ограничение - веса ячеек предыдущих фронтов не 
должны быть больше весов ячеек последующих фронтов.  

Фронт распр
ками предыдущего фронта либо общую сторону, либо хотя бы одну общую 

точку. Процесс распростр
яющийся фронт не достигнет приемника или на ξ-ом шаге не найдется ни 

одной свободной ячейк
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ленностьЧтобы исключить неопреде  при проведении пути для случая, ко-
гда н к

три-
ваем   на-
правление, тем меньший числовой код оно имеет.  

ядком проведения пути сверху, 
спра х путевых координат будут 00, 
01, 10 и 11. 

При производят на этапе распространения вол-
ны. При и к ячейке осуществляют по путе-
вым коор

ес олько ячеек имеют одинаковый минимальный вес, вводят понятие пу-
тевых координат, задающих предпочтительность проведения трассы. Каждое 
направление кодируют двоичным числом по mod q, где q - число просма

х соседних ячеек. При этом чем более предпочтительно то или иноеы

Например, если задаться приоритетным пор
ва, снизу и слева, то коды соответствующи

писание путевых координат 
проведении пути движение от ячейк
динатам. 

 
Примеры 
(при использовании различных критериев качества)  
Во всех примерах задан приоритетный порядок проведения пути: сверху, 

справа, снизу и слева: 
00

01

10

11

 
Рисунок 7.1 

 

Вместо числовых кодов для обозначения соответствующих путевых коор-
дина ем использовать стрелки, указывающие их направление 

тво ячеек коммутационного поля, на котором построено не-
кото ежду 
точками X и Y так, чтобы он не пересекал ранее построенные проводники и 
имел

т буд
 

Проведение пути минимальной длины 
Задано множес
рое число проводников (рисунок 7.2). Построить новый проводник м

 минимально возможную длину. 
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Рисунок 7.2 
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Из точки Х, вес которой положим равным нулю, строим расширяющийся 
фрон

ая ячейка первого фронта генерирует следующий фронт волны, кото-
рый 

т волны влияний, распространяющийся на все свободные и соседние с 
этой точкой ячейки.  

Кажд
занимает все свободные и соседние с первым фронтом ячейки и т. д.  
Вес ячейки k-го фронта считаем равным весу соседней ячейки (k-1)-го 

фронта плюс единица:  
11 += −kk PP

 
Процесс распространения волны продолжаем до тех пор, пока не достиг-

нем ячейки с точкой Y.  

 числом пересечении 

чейки, в которых направление проводников совпадает с путевой коор-
дина

ллельное прохож-
дени

ри этом в k-й фронт включаем лишь те ячейки, которые имеют мини-
маль щемуся фронту волны пере-
сечь

ник достигнута не будет, то фронт сразу 
пере

Процесс поиска пути из X в Y в соответствии с рассмотренным алгорит-
мом для данного варианта трассировки показан на рисунке 7.2. В каждой ячей-
ке указаны приписанные ей на этапе распространения волны путевые коорди-
наты и веса. Ячейка и достигается при построении 6-го фронта волны. 

Проведение пути начинаем с ячейки Y.  
Просматриваем окрестность точки приемника и находим ячейку, которая в 

наиболее предпочтительном направлении имеет вес на единицу меньше. Пере-
мещаемся в эту ячейку и отмечаем след перехода. Процесс продолжаем до тех 
пор, пока след не приведет в точку X. На рисунке 7.2 вновь проведенный путь 
изображен пунктиром.  

В данном случае путевая координата несет избыточную информацию. 
Действительно, при проведении пути использовались только данные о весе 
просматриваемой ячейки, а приоритет его проведения учитывался последова-
тельностью просмотра этих ячеек. 

 
Проведение пути с минимальным
При такой постановке задачи занятыми считают ячейки, в которых: 
а) находятся выводы конструктивных элементов,  
б) имеются изгибы или пересечения ранее построенных проводников,  
в) я
той строящегося пути.  
Такое определение занятости допускает пересечение проводников во вза-

имно пендикулярных направлениях и запрещает их пара пер
е в одной ячейке. 
Вес незанятой ячейки k-го фронта считаем равным весу соседней ячейки 

(k-1)-го фронта, если в этой ячейке нет ранее построенного проводника и на 
единицу больше в противном случае.  

П
ный вес. Это условие не позволяет расширяю
 построенные проводники до тех пор, пока окрестность ячейки-источника 

не заполнит замкнутую область, ограниченную проводниками и занятыми 
ячейками. Если при этом ячейка-прием

секает все проводники, образующие границу области.  
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При втором и последующих пересечениях процесс повторяется. 
 пу-

тевы
чками X и Y для рас-

смат
ка с ранее проведенными. 

дой очередной области, ограниченной проводни-
ками асти к другой по мере их заполнения. 

После достижения ячейки-приемника проводник проводится согласно
м координатам, присвоенным ячейкам в процессе распространения волны. 

На рисунке 7.3 показан вариант проведения пути между то
риваемого случая. Вес, присваиваемый ячейке Y, равен числу пересечений 

строящегося проводни
В этом алгоритме избыточной информацией, которая не учитывается при 

проведении пути, является вес ячейки. От его присвоения можно отказаться, 
если последовательно, учитывая приоритет направления, присваивать путевые 
координаты всем ячейкам каж

, переходя от одной обл
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Рисунок 7.3 

 

Параллельная оптимизация пути по нескольким параметрам 
Возможна.  
Практ в прихо-

дится учитывать не один, а несколько критериев качества. Если удается задать 
коли

 качестве примера рассмотрим один из возможных вариантов присвоения 
веса

 нет ранее построенных 
пров

ков, 
k k-1 , 

е построенного проводника, но в соседней ячейке такой 
проводн

ь связь между Х и Y c учетом 
данных ограничений. 

ически в любой задаче трассировки печатных проводнико

чественную оценку важности отдельных критериев, то задача может быть 
решена с помощью алгоритма Ли. 

В
 незанятой ячейке k-го фронта:  
1) Рk = Pk-1 + 1 если в данной и соседних ячейках
одников и путевая координата не меняет своего направления;  

водни-2) Рk = Pk-1 + 2, если в соседних ячейках нет ранее построенных про
но путевая координата меняет свое направление;  
3) Р  = P  + 3 если в данной ячейке путевая координата не меняет своего 

направления и нет ране
ик есть;  

4) Рk = Pk-1 + 5, если в данной ячейке происходит пересечение с ранее по-
строенным проводником. 

!!! Для платы (рисунок 7.3) построит
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Недостатки волн
. малое быстродействие; 

 
1. Метод встречной волны. 

 объединению. При этом на каждом k-ом шаге поочередно 
стро

 не попадет во фронт второй волны или наоборот. Прове-
дени ществляют изданной ячейки в направлении обоих источников по 
прав

2. возможность построения лишь соединений типа «вывод - вывод».  
 
Метод соединения комплексами: 
Пусть необходимо объединить некоторое множество точек М = {т1, т2, ..., 

mn}.  
1. Выбираем в качестве источника произвольную точку  

ового алгоритма Ли: 
1
2. большой объем оперативной памяти ЭВМ, необходимый для хранения 

информации о текущем состоянии всех ячеек коммутационного поля;  
3. возможность построения лишь соединений типа «вывод - вывод».  
 
 
7.3 Модификации волнового алгоритма 

2. Метод соединения комплексами. 
3. Лучевой алгоритм трассировки. 

 
Метод встречной волны 
В данном методе источниками волн являются обе ячейки, подлежащие 

электрическому
ят соответствующие фронты первой и второй волн, распространяющихся 

из этих ячеек. Процесс продолжается до тех пор, пока какая-либо ячейка из 
фронта первой волны

е пути осу
илам, описанным в волновом.алгоритме Ли. 
Д.:  
1. время, затрачиваемое на этапе распространения волны, уменьшаются 

примерно вдвое. 
Н.: 
1. необходимость выделения дополнительного разряда памяти на каждую 

рабочую ячейку поля для хранения информации о принадлежности ее к первой 
или второй волне.  

Mmi ∈  
и распространяем из нее волну влияний до встречи с какой-либо точкой  

Mmj ∈  
2. Проводим путь, соединяющий точки mi и тj.  
3. Вновь перейдем к процессу «распространения волны», выбрав в качест-

ве источника  встре-
че с как

 только что построенный проводник, и закан иваем его при
ой-либо точкой  

ч
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4. Проведя п ества М. 
. Теперь источником волны является дерево, состоящее из построенных 

пров

вывод - проводник» и «про-
водн

едной 
точки

о 
уже 

 лучей для каждой ячейки-

уть, получаем соединение уже трех точек множ
5
одников, и т. д.  
 

Д.:  
1. возможность присоединения каждой очередной точки (начиная с треть-

ей), к любой точке ранее построенных соединений, 
2. сокращение общей длины печатных проводников 
3. увеличение числа разводимых цепей 

. возможность построения соединений типа «4
ик - проводник». 
 

Быстродействие алгоритма можно повысить, применив метод встречной 
волны, если это позволяет объем памяти ЭВМ. В данном случае источниками 
«распространения волн» являются все ранее построенные проводники и ячейки, 
подлежащие объединению. 

Для дополнительного сокращения затрат машинного времени производят 
неполную очистку ячеек рабочего поля после подсоединения каждой очер

 к строящейся цепи. Для этого достаточно запомнить в специальном счет-
чике радиус R окрестностей, построенных до встречи на предыдущем шаге, и 
перед следующим шагом очистить окрестности радиусом R только тех двух ис-
точников, которые только что были соединены. Для вновь проведенного соеди-
нения строят окрестность радиусом R. Если не произошло встречи с какой-либ

построенной окрестностью, дальнейший процесс «распространения волны» 
продолжается для всех источников, если встреча состоялась, то вновь перехо-
дят к проведению пути и т. д. 

 
Лучевой алгоритм трассировки 
В данном алгоритме выбор ячеек для определения пути между соединяе-

мыми точками А и В производят по заранее заданным направлениям, подобным 
лучам.  

Д.: 
1. Это позволяет сократить число просматриваемых алгоритмом ячеек, а 

следовательно, и время на анализ и кодировку их состояния,  
Н.: 
1. приводит к снижению вероятности нахождения пути сложной конфигу-

рации,  
2. усложняет учет конструктивных требований к технологии печатной пла-

ты. 
 

Работа алгоритма заключается в следующем.  
Задается число лучей, распространяемых из точек А и В, а также порядок 

присвоения путевых координат (обычно число
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источника принимается одинаковым).  
и, если они 

расп ноименных источников А или В.  
Лучи А  разноименными по отношению друг к другу.  

 ситуация, когда все соседние 
ячей ированным и его рас-
прос

Лучи А(1), А(2), ..., А(n) и В(1), В(2),..., В(n) считают одноименным
ространяются из од

(i) и В(i) являются
Распространение лучей производят одновременно из обоих источников до 

встречи двух разноименных лучей в некоторой ячейке С.  
Путь проводится из ячейки С и проходит через ячейки, по которым рас-

пространялись лучи. 
 

При распространении луча может возникнуть
ки будут заняты. В этом случае луч считается заблок
транение прекращается. 
 
Пример (рисунок 7.4). 

Y 
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1 4

1 
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С

 
Рисунок 7.4 – Пример для лучевого алгоритма трассировки 

 

вом шаге просматривают ячейки с координатами (2,4), (5,2) и (6,3).  
рованными. 

няты (имелись 
пров

Выбираем для источников А и В по два луча с противоположными направ-
лениями: А(1) - вверх, влево; А(2) - влево, вверх; В(1) - вниз, вправо;  В(2) - вправо, 
вниз. 

Если ячейка В располагалась бы не справа, а слева от А, то путевые коор-
динаты влево и вправо необходимо было бы поменять. 

 

На пер
На втором шаге луч В(1) и луч А(2) оказываются заблоки
Лучи В(2) и А(1) встречаются в ячейке С с координатами (4,3) на четвертом 

шаге.  
Проводим трассу. 
 

Например, если бы ячейка с координатами (4,3) была за
одники), то все лучи оказались бы заблокированными и решение найдено 

не было, хотя путь из А в В провести можно. 
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Рисунок 7.5 –Путевые координаты для лучей 

 
Обычно с помощью лучевого алгоритма удается построить до (70-80)% 

трасс, остальные проводят, используя волновой алгоритм или вручную.  
Его применение особенно выгодно при проектировании печатных плат с 

невысокой плотностью монтажа. 
 
 
7.4 Эвристические алгоритмы трассировки 
 

Д.: 
1. относятся к числу наиболее быстродействующих и простых в програм-

мировании.  
Н.: 
1. заложенный в их основу приоритетный (постоянный) порядок построе-

ния трассы и обхода препятствий влечет за собой неоптимальность получаемо-
го результата.  

Поэтому эти алгоритмы применяют в тех случаях, когда основным являет-
ся скорость решения задачи, а к качеству трассировки жестких требований не 
предъявляется. 

 

Пример. 
На каждом шаге из числа свободных соседних ячеек выберем ту, в которой 

расстояние до ячейки-цели уменьшается (увеличивается) на максимально (ми-
нимально) возможную величину. При прочих равных условиях выбираем на-
правление, соответствующее минимальному номеру путевой координаты. Если 
на пути движения встречается препятствие, то его обход осуществляем по пер-
вому свободному направлению, исследуя состояния соседних ячеек в порядке 
выбранного приоритета. 
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Рисунок 7.6 –Пример для эвристического алгоритма трассировки 
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Рисунок 7.7 – Путевые координаты для лучей 

 
Зададим следующий приоритетный порядок проведения пути: вверх, впра-

во, в нт I).  

нимальн ожно, по прямой, соединяющей объеди-
няемые т

Счи , если на очередном шаге алго-
ритма р

 

Пусть ьное расстояние до прямой АВ на первом шаге алгоритма 
(движени н ует верхней и правой ячейкам. Вы-
бираем в х прав-
лени

движения
т обойдено справа (вариант 2).  

зобра-
жен  помощью волнового алгоритма при оптимизации 
соединения по двум критериям: минимуму длины и числа изгибов проводника. 

низ, влево (вариа
Общее направление движения должно происходить по ломаной линии ми-

ой длины или, если это возм
очки.  
таем, что трасса удаляется от цели
асстояние до данной прямой возрастает. 

минимал
е ачинаем из точки А) соответств
ер нюю ячейку, так как она находится на более приоритетном на

и. Повторяем аналогичную процедуру для только что выбранной ячейки и 
т. д. В результате строящийся проводник обойдет препятствие слева. 

 

При изменении порядка : вправо, вверх, влево, вниз - конфигура-
ция трассы изменится и препятствие буде

 

Построенные с помощью данного алгоритма трассы не являются опти-
мальными. Для сравнения на рисунке 7.7 штрихпунктиром (вариант 3) и

путь, найденный с
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нени

проводника и числа возможных пересечений его 
с ран енными трассами. При этом выбирается 
то н

ного препятствия в программе предусмотрена проце-
дура

ой процедуры позволяет сократить число неразведенных 
цепе

с, при котором все монтажное поле разбива-
ется

 память по мере необходимости при прокладывании проводника 
внут

и многослойных печатных плат 
(МП

го слоя приводит к увеличению средней длины печатных провод-
нико

ельные соединения в разных слоях платы, ис-
поль

я по двум критериям: минимуму длины и числа изгибов проводника. 
 

Другой вариант эвристического алгоритма, не требующий разбиения 
монтажного поля на ячейки, основан на проведении соединений по кратчайше-
му пути в обход препятствий, представляемых в виде прямоугольников, зада-
ваемых координатами своих углов. Размеры прямоугольников выбирают таки-
ми, чтобы по его сторонам могли прокладываться новые проводники. При 
встрече с препятствием трасса проводится по периметру соответствующего 
прямоугольника. Каждое конкретное направление обхода оценивается с точки 
зрения удлинения строящегося 

ее построенными и еще непровед
аправление, которому соответствует лучшее значение оценки. При невоз-

можности обхода очеред
 возврата к предыдущему препятствию и выбору иного варианта его обхо-

да. Использование эт
й. Для экономии оперативной памяти ЭВМ в алгоритме применен принцип 

фраг-ментального проведения трас
 на отдельные дискреты, хранящиеся во внешнем ЗУ и вызываемые в опе-

ративную
ри соответствующего дискрета. Это создает благоприятные условия для 

трассировки плат практически любого размера. 
 
 
7.5 Особенности трассировки соединений в многослойных  

печатных платах 
 

Высокая плотность компоновки элементов современной ЭА привела к не-
обходимости использования для их коммутаци

П). В зависимости от способа выполнения межслойных соединений разли-
чают МПП:  

1) с открытыми контактными площадками;  
2) со сквозными металлизированными отверстиями. 
В первом случае переход из слоя в слой разрешается только по ножкам 

модулей, что делает данный способ реализации МПП достаточно технологич-
ным. Однако, необходимость построения каждого соединения в пределах како-
го-либо одно

в и усложнению их конфигурации, в результате чего коэффициент запол-
нения проводниками каждого слоя получается сравнительно низким, а число 
слоев платы - относительно большим. Поэтому основным критерием оптимиза-
ции данного вида МПП является минимум числа слоев платы. 

Во втором случае для исключения пересечений печатных проводников 
разрешается трассировать отд

зуя в качестве контактных переходов сквозные металлизированные отвер-
стия, что позволяет уменьшить число слоев металлизации по сравнению с пре-
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дыдущим вариантом МПП. Однако данный способ изготовления печатных плат 
менее технологичен, так как требует дополнительной механической обработки 
(свер а в . 

переходов ниже надежности печатных проводников, что 
прив о-
сти. 

имо учитывать для 
обос

к

ков. 

ированными отверстиями 
ом все соединения проводят 

параллел азуя систему горизонтальных и верти-
кальных ды из 
слоя в слой

 

ление отверстий) и г ль анопокрытия контактных переходов Кроме того, 
надежность подобных 

одит к снижению выхода годных плат, а следовательно, к росту их стоим
Поэтому основным критерием оптимизации таких МПП является минимум 

числа переходов из слоя в слой. 
Таким образом, каждый из рассмотренных методов изготовления МПП 

имеет свои достоинства и недостатки, которые необход
нованного выбора конкретного варианта печатных плат. 
 

МПП с открытыми контактными площадками. Процесс проектирова-
ния МПП с открытыми контактными площад ами можно условно разбить на 
три э ат па:  

1) построение оптимальных связывающих деревьев;  
р2)  азбиение ребер минимального леса на непересекающиеся подмноже-

ства, определение очередности построения соединений каждого слоя платы;  
) трассировка печатных проводни3

 

МПП со сквозными металлиз
Используется ортогональный монтаж, в котор

ьно координатным осям, обр
 магистралей, которые располагаются в разных слоях. Перехо

 осуществляются в местах пересечения магистралей. 

 87



8 Пр акет P-CAD 2000/04 

 

.1 Общие сведения о системе проектирования P-CAD 
 

До последнего времени наиболее популярной в России программой разра-
ботки печатных плат (ПП) являлась система P-CAD для DOS версии 4.5, поя-
вившаяся в конце 1989 г. Для нее созданы кириллические шрифты, обширные 
библиотеки и драйверы для сопряжения с используемым технологическим обо-
рудованием, разработаны подробные инструкции по применению.  

Сравнительно недавно получили распространение более поздние версии P-
CAD 8.x, в которых, по сравнению с P-CAD 4.5, изменен формат файлов баз 
данных, что затрудняет передачу технической документации на предприятия-
изготовители ПП. Дополнительным препятствием к их применению служит от-
сутствие возможности непосредственного нанесения на чертежи надписей по-
русски. Все версии P-CAD для DOS обладают примерно одинаковыми возмож-
ностями. При этом P-CAD 8.7 значительно отличается от P-CAD 4.5, но не так 
существенно, как хотелось бы. 

Система P-CAD несколько раз меняла владельцев, в настоящее время она 
принадлежит австралийской компании Protel International (www.protel.com). Ее 
предыдущий владелец ACCEL Technologies (www.accelfech.com) преобразован в 
американский филиал этой компании, интересы которой в странах СНГ и ал-
тии представляет моск rodn.ik.ru}. 

Система P-CAD для Windows выпущена в феврале 1996 г. и получила на-
зван

ескую трассировку провод-

ограммное обеспечение САПР. П

 
8

Б
овская фирма «Родник Софт» (www.

ие ACCEL EDA. После смены владельца ей в начале 2000 г. вернули ста-
рое название P-CAD (ACCEL EDA 15.1 стала называться P-CAD 2000).  

Возможности: 
P-CAD выполняет полный цикл проектирования ПП, включающий в себя  

• графический ввод схемы,  
• «упаковку» (перенос) схемы на ПП,  
• ручное размещение компонентов,  
• ручную, интерактивную или автоматич

ников, 
• контроль ошибок в схеме и ПП  
• и выпуск конструкторской и технологической документации.  

Применение сопутствующих программ позволяет выполнять моделирова-
ние схем и анализ паразитных эффектов, присущих реальным ПП, до их изго-
товления, что обеспечивает преимущества P-CAD по сравнению с другими 
САПР. 

Недостатки предыдущих версий: 
В P-CAD 4.5 разрешающая способность редактора ПП была недостаточ-

ной: 1 мил (0,001 дюйма) в английской системе и 0,01 мм в метрической. 
В P-CAD 6.0—8.7 з 
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• а счет перехода на 32-разрядную арифметику точность повышена на два 
порядка, что излишне,  

• при этом система единиц задается в начале работы с проектом и в даль-
нейшем не может быть изменена.  

В P-CAD 2000 и 2001 в редакторе ПП установлена дискретность измере-
ния линейных размеров 0,1 мил в английской и 0,001 мм в метрической систе-
ме, п

 

х
с

ри этом за счет резерва точности внутреннего представления 32-разрядных 
данных обеспечивается возможность изменения системы единиц на любой ста-
дии работы со схемой или ПП. 

 

Преимущества ПП P-CAD 2001 
По сравнению с OLD PCAD  для DOS система P-CAD для Windows имеет 

и другие преимущества: 
• применение интерфейса в стиле Windows упрощает работу с системой и 

ознакомление с ней; 
• обеспечивает вывод результатов проектирования на современные мони-

торы и периферийные устройства; 
• решена проблема нанесения на схемы, ПП и фотошаблоны надписей по-

русски; 
• возможна тонкая настройка стратегии автоматической трассировки (за-

дание разных типов переходных отверстий при переходе проводников со слоя 
на слой, трассировка одной и той же цепи сегментами разной ширины и др.); 

• усовершенствованы алгоритмы автотрассировки проводников, включая 
трассировку многослойных ПП, имеющих внутренние слои металлизации; 

• обеспечена координация библиотек символов и корпусов компонентов. 
Поддержка текстовых форматов баз данных DXF, PDIF, ALT и др. позво-

ляет обмениваться информацией с такими распространенными пакетами, как 
AutoCAD, OrCAD, P-CAD old, «Компас» и др. 

Очередная версия P-CAD 2001 вышла в начале января 2001 г. Австралий-
ская фирма Protel International внедрила в схемный редактор P-CAD Schematic 
интерфейс с собственной программой моделирования аналого-цифровых уст-
ройств Circuit Simulator, используемой в системе Protel 99 SE. 

кВ омплект поставки P-CAD 2001 снова включена программа анализа па-
разитны  эффектов ПП Signal Integrity фирмы INCASES Engineering (она вхо-
дила в остав ранних версий ACCEL EDA 13—15, но была исключена из P-
CAD 2000). 

Еще одна программа, включенная в интерфейс редактора печатных плат P-
CAD РСВ, — программа доработки управляющих файлов для фотоплоттеров. 
Она корректно подготавливает управляющие файлы в формате Gerber и позво-
ляет их отредактировать и доработать перед созданием фотошаблонов на тех-
ноло чги еском оборудовании, заменяя аналогичную программу САМ350 фирмы 
Advanced CAM Technologies. 

PВ -CAD 2001 в состав программ автотрассировки включен бессеточный 
автотрассировщик Shape-Based Router, в котором применен алгоритм оптими-
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зации нейронных сетей, заимствованный из системы Protel (аналогичная про-
грам

 задания минимальной ширины линий (отсутствие этого в предыдущих 
верс

ми); 
ер-

тур ф

кирования, задающая 
режи

  

п д

ей:  

ма под названием SmartRoute используется и в системе OrCAD 9).  
Однако интерфейс с хорошо зарекомендовавшей себя программой 

SPECCTRA сохранен. 
Из менее значительных нововведений P-CAD 2001 отметим следующие: 
• перед выводом на печать чертежей схем и ПП предусмотрена возмож-

ность
иях P-CAD снижало качество схем, выводимых на лазерные печатающие 

устройства, — некоторые линии были слишком тонки
• в файл технологических параметров включена секция для хранения ап
отоплоттера; 

• в графический редактор ПП включена команда вставки точек изломов 
проводников, имевшаяся в OLD PCAD ; 

• в графический редактор ПП включена команда мас
м выделения наложенных друг на друга объектов; 
• в менеджере компонентов введена возможность одновременного про-

смотра состава нескольких библиотек. 
 
Требования к оборудованию 
Система P-CAD 2001 устанавливается на ПК: 

• процессор 486 и Pentium,  
• работает под управлением Microsoft Windows 95/98/2000/NT
• поставляется на компакт-диске вместе с электронной документаци-

ей в формате Adobe Acrobat Reader.  
• На жестком диске P-CAD 2001 вместе с библиотеками и утилитами 

занимает примерно 350 Мб (наибольший объем занимают библио-
теки).  

• Минимальный объем ОЗУ составляет 16 Мб, рекомендуется 32 Мб 
(при автотрассировке сложных ПП объем ОЗУ следует еще увели-
чить),  

• минимальное разрешение монитора 800х600. 
 

Для работы с P-CAD 2001 не требуется глубоких знаний в области вычис-
лительной техники, достаточно иметь общее представление о ПК, операцион-
ной системе Microsoft Windows и желательно знать основы английского языка. 
Главное — необходимо быть специалистом в области разработки ПП. 

 
 
8.2 Состав и структура системы P-CAD  
 

Система P-CAD 2001 редназначена ля проектирования многослойных 
печатных плат (ПП) электронных устройств в среде Windows. Она состоит из 
четырех основных модул

1. P-CAD Library Manager (или Library Executive),  
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2. P-CAD Schematic, P-CAD PCB,  
3. P-CAD Autorouters (рисунок 8.1) и  
4. ряда вспомогательных программ. 

 
  

Protel 
 

P-CAD 
 

Library 
Advanced Sim Schematic Manager 

 
P-CAD PCB 

 

Quick 
Route 

База 
данных 

.sch .eco
.lib 

.pcb .lib 

 

Транслятор 
SPECCTRA- 

P-CAD 

 

Транслятор  

 

 
SPECCTRA 

P-CAD 
Autoroute 

 
P-CAD Shape-Based 

Route 

.pcb 

P-CAD 
.dsn SPECCTRA 

.rte или .ses 

<имя>.pcb

r<имя>.pcb

 

 

 
Рисунок 8.1 – Структура системы P-CAD 

 
1) P-CAD Library Manager (Library Executive) — менеджер библиотек. 

Система Р-CAD имеет интегрированные библиотеки, которые содержат графи-
ческую и текстовую информацию о компонентах. В графическом виде пред-
ставлена информация о графике символов и корпусов компонентов; в тексто-
вом виде - число секций в корпусе компонента, номера и имена выводов, коды 
логической эквивалентности выводов и секций и т. п.  

(В old PCAD имелись отдельные библиотеки символов и корпусов, содер-
жащих повторяющуюся текстовую информацию.)  

Исключаются ошибки несогласованного ввода этих данных, возможные в 
old PCAD. Библиотеки символов и корпусов компонентов OLD PCAD 6.0—8.7 
через текстовый формат PDIF переносятся по отдельности в P-CAD 2001 и за-
тем объединяются в интегрированные библиотеки.  

Утилита Library Executive состоит из программы Library Manager, в ко-
торую включен ряд дополнительные команд, и редакторов символов компонен-
тов Symbol Editor и их корпусов Pattern Editor. 

2) P-CAD Schematic и P-CAD PCB — графические редакторы схем и ПП.  
В отличие от OLD PCAD для выполнения простейших операций переме-

щения, копирования, поворота или удаления объектов в P-CAD Schematic и P-
CAD PCB не нужно пробираться через последовательность разных меню, это
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дела

 редактированию объектов. 

документации

organ — обозначения логических функций, IEEE — обо-
знач

ме-
нени

 по терминологии OLD PCAD  
эта о

нтерактивном режиме с помощью 
SPECCTRA) размещаются компоненты и проводится трассировка проводников. 

х 
улуч .  

ых островков металли-
заци

 при про-
клад иков и простановке переходных от-
верс

ых проводни-
ков, 

 
неск

ется гораздо проще, в стиле Windows. Например, для перемещения объекта 
сначала курсором включают режим выбора, отмечают щелчком левой клавиши 
мыши нужный объект и затем перемещают его движением мыши; поворот объ-
екта при этом выполняется нажатием клавиши R, зеркальное отображение — 
клавиши F. Двойной щелчок левой клавишей мыши по выбранному объекту 
обеспечивает доступ к просмотру и

Копирование объектов в буфер обмена или в файл позволяет не только пе-
реносить их из одной базы данных в другую, но и помещать в другие програм-
мы Windows, например в MS Word для выпуска . 

В поставляемых вместе с системой библиотеках импортных цифровых ИС 
некоторые компоненты имеют три варианта графики: Normal — нормальный (в 
стандарте США), DeM

ения в стандарте Института инженеров по электротехнике и электронике 
(наиболее близком к отечественным стандартам).  

В P-CAD 2001 РСВ предусмотрена возможность создания альтернативной 
графики и для корпусов компонентов. Библиотеки отечественных компонентов 
выполняются по ЕСКД в среде P-CAD или переносятся из OLD PCAD . Средст-
вами Windows реализован многооконный интерфейс, что разрешает на одном 
экране просмотреть чертежи схем и ПП и провести идентификацию на ПП це-
пей, выделенных на схеме (реализуя так называемую «горячую» связь). При

е шрифтов TrueType позволяет наносить на схемы и ПП надписи по-
русски. 

Графический редактор ПП P-CAD РСВ вызывается автономно или из ре-
дактора схем P-CAD Schematic. В P-CAD Schematic составляется список соеди-
нений схемы (Netlist), который загружается в P-CAD РСВ, и на поле ПП пере-
носятся из библиотек изображения корпусов компонентов с указанием линий 
электрических соединений между их выводами —

перация называется упаковкой схемы на ПП. После этого вычерчивается 
контур ПП, внутри него (вручную или в и

В P-CAD РСВ появилось много новых возможностей, позволяющи
шить качество разработки ПП
– средства обнаружения и удаления изолированн
и,  

ов в областях металлизации– автоматическая очистка зазор
ке через занятые ими области проводн
тий (ПО),  
– возможность задания индивидуальных зазоров для разн
классов проводников и проводников, находящихся на различных слоях или 

в различных областях (комнатах),  
ласти для подключения– расщепления металлизированных слоев на об

ольких источников питания, отдельно аналоговой и цифровой «земли».  
– ПО допускается размещать в любой точке ПП, что облегчает разметку 

центров крепежных отверстий (в OLD PCAD  для этого создаются фиктивные 
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компоненты, состоящие из одного вывода).  
Еще одно отличие от OLD PCAD  — изображения стеков контактных пло-

щадок (КП) и ПО не хранятся в виде отдельных графических файлов, подклю-
чаемых на заключительной стадии проектирования ПП, теперь они создаются в 
текс

я возможность их оперативной заме-
ны). 

 через текстовый формат 
PDIF

с помощью стандартных 
атри

ровки,  
ной цепи. 

ь» алгоритмов трассировки Shape-
Base  Router усту-
пает ройки стратегии 
трас ожностями размещения ком-
поне

тельных команд для ав-
тома имой для 
доку

ия и дру-
гих т

aint Solver позволяет задать набор правил разме-
щени

апах создания принципиальной схемы и ранних этапах работы с печатны-
ми . Эти данные передаются в программы Shape-Based Router и 
SPEC авил разработки ПП допускается использовать ма-
тема

товом виде и хранятся вместе с базой данных ПП или в файле технологиче-
ских параметров проекта (при этом имеетс

Базы данных схем и ПП всех версии OLD PCAD 
 переносятся в P-CAD Schematic и P-CAD PCB. 
3) Autorouters. В состав P-CAD 2001 входят два автотрассировщика:  
1. простейшая программа QuickRoute и  
2. заимствованная из системы Protel программа Shape-Based Router (ана-

логичная программе SmartRoute из системы OrCAD 9.2).  
3. программой SPECCTRA (поставляется отдельно) 
Они вызываются из управляющей оболочки P-CAD PCB, в которой произ-

водится настройка стратегии трассировки. Очень удобно, что информацию об 
особ о енностях трассировки отдельных цепей можн

бутов ввести еще на этапах создания принципиальной схемы или ПП:  
– атрибуты ширины трассы,  
– типа ассоциируемых с ней ПО и их максимально допустимого количе-

ства, 
– признак запрета разрыва цепи в процессе автотрасси
– признак предварительно разведенной и зафиксирован 
Эффективность и «интеллектуальност
d Router гораздо выше, чем у OLD PCAD 8.7, но Shape-Based
 программе SPECCTRA по возможностям тонкой наст
сировки; к тому же SPECCTRA обладает возм
нтов в интерактивном и автоматическом режимах. 
4.1) P-CAD Document Toolbox — набор дополни
тизации создания графической и текстовой информации, необход
ментирования результатов проектирования (вызов этих команд встраивает-

ся в набор инструментов программ P-CAD Schematic и P-CAD PCB):  
для размещения на чертежах схем и ПП различных диаграмм, таблиц свер-

ловки, составления списков соединений, выводов подключения питан
екстовых отчетов, которые динамически обновляются. 
4.2) P-CAD InterPlace&PCS (Pametric Constraint Solver) — DBX-

утилита, данные в которую передаются из P-CAD Schematic или P-CAD PCB. 
Модуль Pametric Constr
я компонентов, трассировки проводников и других правил разработки ПП 

на эт
платами

CTRA. При задании пр
тические функции. 
Модуль InterPlace представляет собой интерактивное средство размещения 
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компонентов (базовая программа P-CAD PCB позволяет выполнить размещение 
компонентов только вручную, для автоматического размещения используется 
отдельная дорогостоящая программа SPECCTRA). Компоненты могут быть 
объединены в физические или логические группы и размещены на ПП в опре-
деленных областях (комнатах), выровнены, перемещены или повернуты. 

4.3) P-CAD InterRoute Gold — лицензия, обеспечивающая доступ в P-
CAD РСВ к дополнительным командам интерактивной трассировки проводни-
ков Route>Bus, Fanout, Multi Trace, Push Traces, Visible Routing Area и оп-
циям Maximum Hugging, Minimum Length (которые, однако, имеются и в про-
грам

.4) P-CAD Relay — средство для обеспечения коллективной работы над 
прое

ы.  

ких норм 
DRC

ан-
ных  у  P

роводников и размещения компонентов фирмы Cadence Design Sys-
tems

шой сложности (число слоев до 256) благодаря применению так называе-
мой логии. В отличие от разработанных ранее 
сеточных

 используются компактные способы их мате-
мати к

ожения компонентов и обеспечивается тонкая 
наст к

сем объектам ПП присваивается определенный уровень иерархии и вво-
дятс правила размещения и трассировки, составляющие их стратегию, преду-
сматривающую особенности разработки конкретной ПП. 

 
ме SPECCTRA). 
4
ктами ПП. Является аналогом графического редактора P-CAD РСВ с огра-

ниченными возможностями. Печатные платы можно просматривать, вручную 
редактировать и выполнять вывод на принтеры и плоттер

С ее помощью разработчик схем может выполнить общую расстановку 
компонентов на ПП, задать наиболее существенные атрибуты, которые будут 
использованы при трассировке (например, допустимые зазоры), и проложить 
наиболее критичные трассы. Затем эти результаты передаются конструктору 
для завершения разработки ПП с помощью P-CAD РСВ. Кроме того, с помо-
щью P-CAD Relay выполняется контроль соблюдения технологичес

 и запускаются утилиты DBX. 
Schematic Viewer, РСВ Viewer —средство просмотра схем и ПП. 
Protel Advanced Sim — программа моделирования аналоговых и смеш
аналого-цифровых стройств фирмы Protel, интегрируемая с -CAD Sche-

matic. 
P-CAD Signal Integrity — программа анализа электрических характери-

стик ПП с учетом паразитных параметров реальных конструкций (задержки 
сигналов в печатных проводниках, учет потерь в них, наличии индуктивностей 
и емкостей, взаимных индуктивностей, согласование печатных проводников с 
источниками сигналов и нагрузками). 

SPECCTRA — программа ручной, интерактивной и автоматической трас-
сировки п

 (www.cadence.com). Программа SPECCTRA успешно трассирует ПП 
боль

бессеточной (Shape-Based) техно
 трассировщиков, в которых графические объекты представлены в ви-

де набора координат точек, в ней
чес ого описания. За счет этого повышается эффективность трассировки 

ПП с высокой плотностью распол
рой а сложных стратегий размещения компонентов и трассировки провод-

ников. 
В
я 
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Помимо обычного контроля соблюдения технологических зазоров типа 
проводник — проводник, проводник — ПО и т. п. в системе SPECCTRA можно 
выпо по-
ложе -
вень уется также максимальное запазды-
вани

ф х

ов CAMtastic. Графический редактор 
P-CAD РСВ создает управляющие файлы для фотоплоттеров типа Gerber и 
сверлильных станко  для фотоплоттеров 
не всегда корректны блона целесообраз-
но п

не более 255 секций в компоненте; 
• не более 2000 символов в атрибуте  в текстовой строке; 
• не более 20 си зиционном обозна-

чении вывода (пробелы допускаются); 

лнить контроль максимальной длины параллельных проводников, рас
х слоях, что позволяет уменьшить уронных на одном или двух смежны

 перекрестных искажений. Контролир
е сигнала в отдельных цепях. 
SPECCTRA воспринимает информацию о ПП, подготовленных с помощью 

одного из гра ически  редакторов: OLD PCAD , P-CAD РСВ, MicroSim 
PCBoards, PADS, Protel, OrCAD Layout и многих др. Разработанная в 
SPECCTRA ПП транслируется обратно для выпуска документации. Процедура 
такой двусторонней трансляции встроена в P-CAD РСВ, но она может выпол-
няться и автономно. 

Вспомогательные утилиты. Система P-CAD поставляется совместно с 
большим количеством утилит, написанных на Visual Basic, Си или Си++ и об-
разующих интерфейс DBX (Data Base Exchange). Эти утилиты извлекают дан-
ные из открытых файлов схем или ПП, обрабатывают их, передают третьим 
программам и вносят коррективы в текущую базу данных. В частности, с их 
помощью можно производить изменение нумерации компонентов, создавать 
отчеты в заданном пользователем формате, автоматически создавать символы и 
конструктивы компонентов, рассчитывать паразитные параметры ПП и т. п. 

рограмма доработки фотошаблонП

в с ЧПУ, причем управляющие файлы
. Поэтому перед изготовлением фотоша

росмотреть и при необходимости отредактировать его изображение с по-
мощью программы CAMtastic, интерфейс с которой встроен в P-CAD РСВ (пе-
редача данных всегда производится корректно). 

Для изготовления фотошаблонов на отечественном оборудовании необхо-
димо перекодировать управляющие файлы.  

 
Основные характеристики системы P-CAD. Общие характеристики: 
• 32-разрядная база данных; 
• не более 20 000 компонентов в одной библиотеке; 
• неограниченное количество компонентов в проекте; 
• не более 64 000 цепей в проекте; 
• не более 999 выводов в компоненте; 
• 

 или
мволов в имени вывода, имени цепи, по

, знаки табуляции, точки и скобки не 
• не более 16 символов в имени типа компонента; 
• не более 30 символов в позиционном обозначении компонента (символы 

кириллицы допускаются, но не рекомендуется; символы двоеточия, пробелы, 

 95



знаки табуляции, точка и точка запятой не допускаются); 
• минимальный шаг сетки 0,1 мил в английской системе и 0,001 мм = 1 мкм 

в метрической системе (1 мил = 0,001 дюйма = 0,0254 мм). Систему единиц 
можно изменять на любой фазе работы с проектом; 

• автоматическая коррекция принципиальных схем по изменениям в ПП и 
наоб

 

анд  

составление списков соединений схем в форматах P-CAD ASCII, OLD 
PCAD , Tango, FutureNetEDIF 2 О О и PSpice, XSpice; 

• контроль ошибок в принципиальных схемах; 
• перекрестные связи между P-CAD Schematic и P-CAD PCB позволяют 

для выбранной на схеме цепи высветить на ПП соответствующий ей проводник 
и наоборот (так называемая горячая связь); 

 
Графический редактор печатных плат P-CAD PCB: 
• не более 99 слоев в базе данных ПП; 
• максимальный размер ПП 60х60 дюймов; 
• не более 64 000 типов контактных площадок в проекте; 
• ширина трассы не более 1 см (394 мил); 
• min дискретность угла поворота графических объектов и текста 0,1°; 
• неограниченное количество вершин в полигоне; 
• не более 64 000 стилей стеков контактных площадок в проекте; 
• контактные площадки 12 форм: эллипс, овал, прямоугольник, скруглен-

ный прямоугольник, полигон, непосредственное соединение со слоем металли-
зации, тепловой барьер с 2 или 4 перемычками 2-х ориентации каждое, пере-
крестье для сверления (Targ

• контроль соблюд П; 
т ( м

При работе в системе P-CAD приходится задавать значения разнообразных 
величин: ширины линий, зазоров, шагов сетки и т. п. Численное значение этих 

орот (коррекция «назад» и «вперед»). 
 
Графический редактор схем P-CAD Schematic:
• не более 99 листов схем в проекте, максимальный размер листа 60х60 

дюймов; 
• поддержка ст артных форматов А—Е, АО—А4 и форматов, задавае-

мых пользователями; 
• дискретность угла поворота графической информации и текста 90° (пово-

рачивать текст на 180° не допускается, для этого - специальные шрифты); 
• 

et), крепежное отверстие (Mounting Hole); 
ения зазоров и полноты разводки П

• поддержка управляющих файлов фотоплот еров Gerber фор аты RS-
274-D и RS-274-X), сверлильных станков с ЧПУ типа Excellon (формат на-
страивается пользователем); 

• передача данных программе анализа целостности сигналов Signal Integ-
rity. 

 
азмерности величин 

 

Р
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вели сом для обозначения единицы измере-
ния: ука-
зыва кс 
опущ еме единиц. Однако в связи с тем, 
что в ы с проек-
том, 

 
 схемы на печатную плату, интерактивного разме-

щения радиоэлектронных компонентов  на плате и автотрассировки соедине-
ний, вплоть до получ и и подготовки ин-
формации для производства плат на технологическом оборудовании. 

со а

мация об упаковке в корпус (подвод 
пита

чин может сопровождаться суффик
 mm — миллиметр, mil — мил (0,001 дюйма), inch — дюйм. Суффикс 

бела, например 40mil, 0.25mm. Если суффиется вслед за числом без про
ен, величина понимается в текущей сист
 P-CAD систему единиц можно изменить на любой стадии работ
для предотвращения ошибок рекомендуется всегда указывать суффиксы 

размерности. 
 
 
8.3 Создание библиотеки компонентов в САПР PCAD 
 

САПР PCAD  представляет собой пакет специализированных модулей, 
тесно связанных друг с другом и охватывающих все этапы разработки и изго-
товления однослойных и многослойных печатных плат. 

Программные средства системы позволяют автоматизировать весь процесс 
проектирования электронных средств, начиная с ввода принципиальной схемы, 
ее моделирования, упаковки

ения конструкторской документаци

Поставляемые с системой PCAD библиотеки не соответствуют белорус-
ским стандартам, поэтому для успешного проектирования печатных плат важно 
уметь зд вать новые библиотечные компоненты и редактировать старые.  

Интегрированные библиотеки PCAD 2001 содержат компоненты 
(components), корпуса (pattern) и символы (symbol). На схеме компонент пред-
ставлен символом, а на печатной плате корпусом. Кроме графики символа и 
корпуса в библиотеке содержится инфор

ния, подключение выводов и т.д.). Единство символа, графики корпуса и 
упаковочной информации и составляет понятие компонента. Преимущество 
интегрированных библиотек заключается в том, что упаковочная информация 
для каждого компонента хранится в одном месте и должна вводиться всего 
один раз. 

Поэтому при создании библиотеки компонентов в PCAD  2001 необходи-
мо: 

1) создать новую библиотеку; 
2) в редакторе Symbol Editor создать символ компонента и сохранить его 

в библиотеку под своим именем; 
3) в редакторе Pattern Editor создать корпус компонента и сохранить его 

в библиотеку под своим именем; 
4) в блоке Library Executive произвести объединение (упаковку) корпуса 

и символа в один компонент. 
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Редактор символов Symbol Editor 

лами библиотек (*.LIB) и отдельных символов 
(*.SYM). Система единиц, набор толщин линий и ряд других глобальных пара-
метров  
PCAD  Symbol Editor напри-
мер, 

 
Создавать символы компонентов можно тремя различными способами: 
1) в редакторе  PCAD  Schematic; 
2) в редакторе PCAD  Symbol Editor; 
3) путем редактирования существующего символа компонента. 
Наиболее удобно создавать символы компонентов в редакторе PCAD  

Symbol Editor. 
Редактор PCAD  Symbol Editor имеет аналогичный с основным редактором 

PCAD  Schematic экран (рисунок  8.2). Он имеет набор команд, необходимых 
для редактирования символов компонентов и аналогичных соответствующим 
командам PCAD  Schematic за исключением команд меню File. В PCAD  Sym-
bol Editor работают с фай

 

сохраняются в файле конфигурации SymEd.INI: 
система единиц устанавливается с помощью ключевого слова Units, при-

нимающего значения 0 — mil, 1 — inch, 2 — мм. По умолчанию устанавливает-
ся сетка 100 mil или 2,54 мм, поэтому необходимо предварительно настраивать 
параметры редактора в меню Options. 

 

 
Рисунок 8.2 – Диалоговое окно Symbol Editor 

 
При создании символов компонентов с большим количеством выводов 

удобен  «Мастер Символов», вызываемый по команде Symbol Wizard меню 
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Symbol или кнопкой . В его диалоговом окне (рисунок  8.3) указывается сле-
дующ n Spacing — рас-
стояние ина вывода (Short, Normal, 
Long ой (правой) 
стор  симво-
ла; L ; Display Pin Name (Pin Des) 
— н ь на чертеже символа имена (номера) выводов; De-
fault  по умолчанию (не более 
20 с

ая информация: Symbol Width — ширина символа; Pi
 между смежными выводами; Length — дл

, User); Number Pin Left (Right) — количество выводов на лев
оне символа; Symbol Outline — необходимость изображать контур
ine Width — ширина линии контура символа
еобходимость указыват
 Pin Name — имя первого вывода, принимаемое
имволов); Default Pin Designator — номер первого вывода, принимаемый 

по умолчанию; Current Pin Number — порядковый номер текущего вывода. 
 

 
Рисунок 8.3 – Диалоговое окно Symbol Wizard 

ж кл

 помощью PCAD  Symbol Editor вводятся атрибуты символов, сохраняе-
мые 

 
На атие на авишу Finish завершает создание символа и его изображе-

ние заносится в библиотеку по команде Symbol>Save или Symbol>Save As. В 
связи с тем, что Мастер всегда создает прямоугольный символ без разбиения на 
зоны, графику символа обычно требуется редактировать.  

При ручном рисовании символа полезна команда Place>Pin, диалоговое 
окно которой (рисунок 8.4) в удобной форме содержит всю информацию, необ-
ходимую для настройки режима размещения выводов символов, и окно для 
просмотра их графики. 

В меню Utils (см. рис. 8.2) включена команда Validate, предназначенная 
для проверки корректности создания символа компонента: при наличии ошибок 
такой символ не разрешается заносить в библиотеку. 

С
в библиотеках. Эти атрибуты вводятся и редактируются по команде 
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 Symbol>Attributes или по команде Place>Attribute . Удобнее вводить 
 с помощью PCAD  Symbol Editor, а не с помощью PCAD  Schematic, 

 при со
атрибуты
так как здании библиотеки компонентов с однотипными атрибутами 
проще их ввести один раз, копировать вместе с символом и затем редактиро-
вать. 

 
Рисунок 8.4 – Диалоговое окно Place Pin 

 
Для копирования символа он сначала загружается по команде  
ol>Open (если символ находится не в отдельном файле, а в библиотеке, Symb

пред
символ
цию Cr
без о

  Pattern Editor; 
о корпуса компонента. 

е PCAD   
Patte

о создается 
прое ае вид 
прое

варительно указывается ее имя). После внесения изменений в атрибуты 
 сохраняется по команде Symbol>Save As. Если отметить при этом оп-
eate Component, созданный символ можно сразу же наносить на схему 

писания корпуса и информации об упаковке элемента. 
 
Редактор корпусов Pattern Editor 
Создавать корпуса компонентов можно тремя различными способами: 
1) в редакторе  PCAD  РСВ; 
2) в редакторе PCAD
3) путем редактирования существующег
Наиболее удобно создавать символы компонентов в редактор
rn Editor.  
При создании корпуса компонента необходимо помнить, чт
кция корпуса на плату с формованными выводами. В общем случ
кции корпуса может значительно отличатся от внешнего вида корпуса 
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компон

м такой же, как экран основного редактора PCAD  PCB. PCAD  Pattern 
Edito еобходимых для редактирования корпусов компо-
нент

ента. 
Экран редактора корпусов компонентов PCAD  Pattern Editor (рисунок 8.5) 

в основно
r имеет набор команд, н
ов. В PCAD  Pattern Editor работают с файлами библиотек (*.LIB) и от-

дельных корпусов (*.РАТ). 
 

 
Рисунок 8.5 – Экран PCAD  Pattern Editor 

 
В PCAD  Pattern Editor параметры конфигурации сохраняются в файлах от-

дельных символов «*.РАТ». Поэтому можно установить необходимый набор 
сеток и сохранить «пустой» файл шаблона корпуса по команде
File>Copy To File As. Система единиц и ряд других глобальных параметров со-
храняются в файле конфигур

 

 ации PatEd.INI. Перед вызовом программы PCAD 
Pattern Editor устанавливается нужный файл конфигурации и по команде 
File>Open загружается шаблон корпуса. 

По команде Pattern Wizard или кнопкой  вызывается «Мастер создания 
корпусов компонентов». В его диалоговом окне (рисунок 8.6) указывается сле-
дующая информация: Pattern Type - тип корпуса (посадочного места) компо-
нента; Number of Pads Down - число строк выводов; Number of Pads Across - 
число столбцов в массиве выводов; Pad to Pad Spacing (On Center) - расстоя-
ние между центрами выводов; Pattern Width - расстояние между крайними 
столбцами выводов (для корпусов DIP, QUAD); Pattern Heigh - расстояние ме-
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жду крайними строками выводов (для корпуса QUAD); Pad 1 Position - распо-
ложение первого вывода (для корпусов DIP, QUAD); Pad Style - тип стека кон-
тактной площадки (КП) (отдельно для первого и остальных выводов); Silk 
Screen - необходимость изображения контура корпуса; Silk Line Width - шири-
на линий контура корпуса; Silk Rectangle Pattern Width - ширина корпуса 
компонента; Silk Rectangle Pattern Height - высота корпуса компонента; Rotate 
- признак поворота контактных площадок на 90°; Notch Type - тип скоса графи-
ки корпуса компонента (в верхнем левом углу, в нижнем левом углу и т.п.). 

 

 
Рисунок 8.6 – Диалоговое окно PCAD  Pattern Wizard 

 
Нажатие на клавишу Finish завершает создание корпуса компонента, после 

чего его изображение переносится на основной экран программы Pattern Editor. 
Здесь его графику можно обычным способом отредактировать и затем занести в 
библиотеку по команде Pattern>Save или Pattern>Save As. 

Одному символу компонента может соответствовать несколько корпусов 
(DIP, SMT, flat-pack и т.п.). По команде Pattern>Add Pattern Graphics  к ос-
новному изображению графики корпуса компонента (оно по умолчанию носит 
название Primary) добавляется альтернативное (рисунок 8.7). Назначение аль-
тернативных корпусов выполняется в программе Library Executive по команде  
Library>Pattern Graphics. 
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Рисунок 8.7 – Добавление альтернативного корпуса компонента 

 
При редактировании существующего корпуса в рабочее окно редактора 

помещают изображение корпуса, хранящееся в библиотеке как единый объект. 
Затем его преобразуют в набор графических примитивов, что дает возможность 
внесения изменений и дополнений. После модификации корпус заносится в 
библиотеку под новым именем и сохраняется как единое . Последова-
тельность действий

. Нажатием пиктограммы

 целое
 такова. 

  1 включают режим выбора объектов и указы-
вают

й корпус преобразуется 
в набор графических примитивов — если до выполнения этой команды корпус 
пред  все 
его с

всех изменений корпус заносят в библиотеку. Сначала 
выполняют операцию блочного выбора всех принадлежащих ему графических 
объектов, заключая их в прямоугольную рамку. Далее по команде 
Library>Pattern Sav иске Library выби-
рают имя одной из открытых библиотек и в графе Pattern вводят имя нового 
корп

 редактируемый корпус щелчком левой кнопки мыши. 
2. По команде Edit>Explode Component выбранны

ставлял собой единое целое, то теперь доступны для редактирования
оставные части (выводы, линии, надписи и т.п.). Если добавлены или уда-

лены выводы компонента, то нужно заново их пронумеровать по команде 
Utils>Renumber. Для этого перед выполнением команды включают режим вы-
бора объектов, а в меню команды указывают режим перенумерации выводов 
Pad Number. После закрытия меню команды все выводы, подлежащие перену-
мерации, по очереди помечают щелчком мыши в порядке возрастания их номе-
ров, начиная с первого (перенумерованные выводы окрашиваются). 

3. После внесения 

e As заносят корпус в библиотеку. В сп
 
уса. Если компонент в целом будет создаваться в дальнейшем с помощью 

Library Executive или Library Manager, не нужно включать опцию 
Create Component. 

 
Менеджер библиотек компонентов 
В системе PCAD  поддерживаются два типа библиотек:  
1) интегри еки компонентов; рованные библиот
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2) отдельные библиотеки символов и корпусов компонентов.  

ibrary Manager или Library Executive заносит эти данные в интегри-
рова

 между графическими редакторами; 

. 

omponent, а также в менеджере биб-
лиот

Component>Open и 
View>Source Browser

В интегрированную библиотеку заносятся данные трех типов:  
1) текстовая информация о компонентах;  
2) графика корпусов; 
3) графика символов компонентов.  
Способы создания графики корпусов и символов указаны выше. Менеджер 

библиотек L
нную библиотеку и добавляет текстовую информацию о компонентах. 
Использование интегрированные библиотеки при проектировании печат-

ных плат в PCAD  предпочтительнее, так как это позволяет выполнять: 
− “горячую связь”
− прямую и обратную корректировку проекта; 
− перестановку логически эквивалентных выводов и секций компонентов
Содержание загруженных библиотек просматривают в графических редак-

торах по команде Place>Part или Place>C
ек по команде Component>Open. 
Library Executive имеет ряд дополнительных средств по сравнению с  

Library Manage: 
− включена команда Query для поиска компонентов в библиотеках по за-

данному набору атрибутов; 
− при использовании Library Executive возможно применение редактора 

символов Symbol Editor и редактора корпусов Pattern Editor.  
Упаковка компонентов в Library Executive – самый трудоемкий и ответст-

венный этап в создании библиотечного компонента. Неправильное заполнение 
таблицы упаковки ведет к ошибочной трассировке печатной платы и даже к не-
возможности ее проектирования. 

После загрузки программы Library Executive на строке инструментов дос-
тупны только пиктограммы Component>New, 

  (недоступные пиктограммы и строки меню окрашены 
в серый цвет, при вызове Source Browser щелчком правой кнопки мыши от-
крывается выпадающее меню, содержание которого зависит от типа объекта, 
выбранного в окне). После загрузки существующего компонента или открытия 
нового по командам Component>Open, Component>New на экране появляется 
диалоговое окно Component Information, показанное в левом верхнем углу ри-
сунка 8.8.  

На трех остальных окнах этого рисунка представлена детальная информа-
ция о компоненте, позволяющая установить связь между выводами символа и 
корпуса компонента. Всего меню Library Executive имеет четыре основных 
окна. 

1. Окно Component Information. В этом окне представлена общая инфор-
мация о компоненте: 

− в строке Select Pattern выбирается тип корпуса компонента например 
SO 14; 

, 
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Рисунок 8.8 –Подробная информация о компоненте на экране Library Manager 

 
− в строке Number of Gates — задается число секций в компоненте; 
− в строке Number of Pads — указывается общее число выводов; 
− в строке Refdes Prefix — задается префикс позиционного обозначения 

ии 

ся в списки соединений для выполнения моделиро-
вани

альт

т  с

компонента; 
− в разделе Component Type выбирают тип компонента (который прини-

мается во внимание при составлении списков соединений и заполнен
граф отчетов о проекте): 

Normal — обычный компонент; Power— источник питания (компоненты 
такого типа, в частности, не включаются в списки соединений для «упаковки» 
схемы на ПП, но включают

я); Sheet Connector — соединитель листов схемы; Module — символ (мо-
дуль) иерархической структуры; Link — связь символа модуля иерархической 
структуры с его схемой;  

− в разделе Component Style выбирают: 
Homogeneous — однородный компонент (все секции однотипны); 
Heterogeneous — неоднородный компонент (секции разных типов); 
− в разделе Gate Numbering задают способ нумерации секций: 
Alphabetic — буквенный; Numeric — числовой (рекомендуется); 
− в разделе Alte rnate Views указывают ернативные изображения сим-

волов. 
В нижней части окна располагае ся таблица, где для каждого типа екций 

указаны: 
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Gate # — номер секции; 
ности секции (секции, имеющие 

один

: 
номер вывода компонента; 

Pin Des — физический номер вывода компонента в корпусе; 
Gate # — номер секции компонента; 
Sym Pin # — порядковый номер вывода символа компонента в пределах 

секции; 
Pin Name

ate Eq — код логической эквивалентности секции компонента; 
in Eq — код логической эквивалентности вывода секции; 

рки прин-
ципи

 вывод пассивного компонента; Input - 
вход

. 

Gate Eq — код логической эквивалент
аковый отличный от нуля код эквивалентности, могут переставляться при 

оптимизации цепей на печатной плате); 
Normal — имя символа в нормальном изображении. 
Альтернативные обозначения символов можно использовать для введения 

их изображений по ЕСКД. 
Вверху располагаются кнопки Pins View, Pattern View и Symbol View для 

открытия окон редактирования параметров выводов компонентов. 
2. Окно Symbol View. В нем приведено изображение символа текущего 

компонента и таблица с информацией о его выводах. Каждому выводу компо-
нент отведена одна строка. В столбцах указана следующая информацияа 

Pad # — 

 — имя вывода символа секции компонента; 
G
P
Elec. Type — электрический тип вывода, необходимый для прове
альной схемы: 
Unknown - неизвестный; Passive -
; Output - выход; Bidirectional - двунаправленный вывод; Ореп-Н - вывод 

секции с открытым эмиттером; Open-L - вывод секции с открытым коллекто-
ром; Passive-H - вывод пассивного компонента, подключенный к источнику вы-
сокого потенциала; Passive-L - вывод пассивного компонента, подключенный к 
источнику низкого потенциала; 3-State – 3-стабильный вывод; Power - вывод 
цепи питания. 

Нажатие на кнопку Select Symbol позволяет изменить символ, назначен-
ный текущему компоненту

3. Окно Pattern View. В нем приведено изображение корпуса текущего 
компонента и таблица с информацией о его выводах. Нажатие на кнопку  
Select Pattern позволяет изменить корпус, назначенный текущему компоненту. 

4. Окно Pins View. В нем приведена таблица с информацией о всех выво-
дах компонента, наиболее удобная для редактирования. После выбора курсором 
какой-либо ячейки выше таблицы появляется строка с информацией о занесен-
ных в нее данных и панель для их редактирования. 

 

Каждый компонент библиотеки состоит из одной или нескольких логиче-
ских секций (gates), которые упаковываются в корпус. Несколько разных ком-
понентов могут упаковываться в один и тот же типовой корпус 

Редактор PCAD  РСВ не может использовать информацию только о ком-
поненте (так как это только текстовая информация) или только о корпусе (так 
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как это только графическая информация), для него необходимы совместные 
данные компонент/корпус. Аналогично для редактора PCAD  Schematic необ-
ходимы совместные данные компонент/символ. Когда компонент размещается 
на ПП или на схеме, используется графика корпусов или символов, на которые 
сделаны ссыл т ссылаться 
на одну и ту же графику корпусов или символов. Корпуса и символы, на кото-
рые имеются ссылки в компонентах, должны находиться в одной и той же биб-
лиотеке. 

Ссылки в разных компонентах на одни и те же корпуса и символы значи-
тельно экономят память, занимаемую библиотекой. Кроме того, редактирова-
ние типовых корпусов и символов сразу вносит изменения в графику всех род-
ственных компонентов.  

При работе с библиотекой компонентов важно различать следующие ос-
новные понятия (рисунок 8.9): 

 

ки в описании компонента. Разные компоненты могу

 
а      б 

 
Рисунок 8.9 – Изображение компонента на схеме (а) и на ПП (б) ИС K155ЛАЗ 

Pad Number —  (обычно совпадает 
с физическим номер

 
порядковый номер ывода компонента
ом вывода, но это необязательно); 

 в

Pin Designator — физический номер вывода в корпусе; 
(Symbol) Pin Number — номер вывода в пределах секции компонента; 
Pin Name — имя вывода (в секции компонента). 
Работа с библиотеками значительно облегчается с помощью окна просмот-

ра Source Browser и команды поиска Query. 
Окно просмотра Source Browser (рисунок 8.10) открывается по команде 
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View по  
кома

а их изображения. Щелчок правой кнопки мыши по 
комп ащее две строки: Open и 
Plac

ностей редактирования параметров компонента. Выбор вари-
анта

еме или его корпус на ПП (для этого предварительно 
долж

>Source Browser. В нем отображается дерево библиотек, открытых 
нде Library>Setup. Каждая библиотека состоит из разделов Components, 

Patterns и Symbols. Двойной щелчок курсора мыши по символу или компоненту 
открывает окно просмотр

оненту открывает всплывающее меню, содерж
e. Выбор варианта Open открывает окно Component Information с предос-

тавлением возмож
 Place позволяет по дополнительному выбору (РСВ, Schematic) разместить 

символ компонента на сх
на быть открыта программа PCAD  РСВ или Schematic).  
 

 
Рисунок 8.10 – Окно просмотра Source Browser 

 
Изображение иконки компонента в окне просмотра свидетельствует о на-

личи

рывшемся 
окне

и у него присоединенного корпуса и/или символа. 
 
Создание компонента с помощью Library Executive  
После загрузки Library Executive выполняется команда Component>New, и 

в ее диалоговом окне указывают файл библиотеки, в который ранее занесены 
корпус и символ компонента. Затем на экран выводится окно Compo-
nent Information (рисунок 8.11). В нем сначала нажимают кнопку Se-
lect Pattern для подключения графики корпуса компонента. В отк

 Library Browse из списка корпусов, помещенных в открытую библиотеку, 
выбирают нужный - в рассматриваемом примере это SO 14. Затем вводят сле-
дующую информацию. 
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Рисунок 8.11 – Меню Component Information 

 
1. В строке Number of Gates указывают число секций, в данном приме-

ре - 4. Число выводов компонента проставляется на строке Number of Pads  
автоматически. В строке Refdes Prefix указывают префикс позиционного обо-
значения компонента, в данном примере - DD. После этого становится доступ-
ной панель Select Symbol, после нажатия на которую выбирают имя основного 
изображения символа компонента, в данном примере это 155ЛА3. 

2. В графе Component Type выбирают тип компонента Normal. 
3. В графе Component Style для однородного компонента выбирают стро-

ку Homogeneous. 
4. В графе Gate Numbering выбирают цифровой способ именования сек-

ций компонента Numeric (первая секция в графе Gate # в таблице на рис. 8.11 
получит номер 1, вторая - 2 и т.п.). Все секции однородных компонентов по 
умолчанию получают одинаковый код логической эквивалентности Gate Eq, 
что позволит их автоматически переставлять в процессе разм ения компонен-
тов на ПП. 

Редактирование таблицы выводов компонента. Создание компонента 
завершается заполнением таблицы выводов, которая выводится на экран нажа-
тием кно боты по 
созд

тветствует ИС серии К155, 

ещ

пки Pins View (рисунок 8.12, а). Это самая трудоемкая часть ра
анию компонента. 
Во-первых, нужно установить соответствие между номерами выводов всех 

секций Sym Pin # и позиционными обозначениями выводов корпуса Pin Des. 
В интегральной схеме серии К155 вывод 7 соединяется с «землей» (GND), 

а вывод 14 с источником питания (VСС). 
Сначала скопируем содержание столбца Pad # в столбец Pin Des. Видно, что 

информация о номерах выводов секций 2, 3 и 4 не соо
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и ее 

я 
одно

о записать единицы. Информация для остальных сек-
ций 

обходимо выводы 2-, 3- и 4-й секции тоже логически связать с реальны-
ми в

необходимо исправить, редактируя соответствующие строки таблицы. 
Таблица выводов компонентов Pins View заполняется следующим обра-

зом. В нашем случае (см. рис. 8.12, а) мы видим, что во многих столбцах табли-
цы отсутствуют записи. Столбцы Sym Pin # и Pin Name заполнены только дл

й 1-й секции, поэтому в столбце Gate # (туда заносятся номера секций) в 
строки 1, 2 и 3 необходим

заполняется в соответствии с секцией 1, т.е. если для секции 1 известно, 
какие выводы символа сопоставить с реальными выводами микросхемы, то те-
перь не

ыводами микросхемы, но на основе примера секции 1. Для этого нужно 
правильно заполнить столбцы Sym Pin #  и  Pin Name.  

 

 
а 

 
б 

Рисунок 8.12 – Таблица выводов компонента до (а) и после редактирования (б) 
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В соответствии с логической структурой компонента K155ЛАЗ 
(см. 
э

а
аб-

лица

етствующую ячейку и введем необходимую информацию, которая 
появ

рис. 8.9, а) ко второй секции относятся выводы 4, 5 и 6 микросхемы, по-
тому в строки 4, 5, 6 столбца Gate # занесем двойки. Далее аналогичным обра-
зом перенесем значения столбцов Sym Pin #  и  Pin Name из секции 1, т.е. в 
строку 4 в столбцы Sym Pin #  и  Pin Name запишем значения «1» и «in1» соот-
ветственно, в строку 5 в эти же столбцы запишем значения «2» и «in2», в стро-
ку 6 запишем значения «3» и «out». Аналогичным образом заполняются ос-
тальные ячейки таблицы.  

Вывод 7 должен получить имя GND, а вывод 14 - VCC,  в столбце - 
Elec. Type им необходимо присвоить тип Power. Полностью заполненная т

 представлена на рис. 8.12, б. 
В столбце Pin Name можно вводить (если при создании символа компо-

нента имя не задавалось) или изменять имена выводов. Для этого курсором вы-
делим соотв

ляется в строке над таблицей. Нажатием кнопки  или Enter введенные 
данные переносятся в выделенную ячейку. Нажатие  или Esc отменяет ввод. 
Копирование данных выделенной ячейки (или нескольких ячеек) производят 
нажа

ость секций. 
 нашем случае установка в любой ячейке любой секции единицы приве-

дет к автоматической расстановке единиц и в ячейках, относящихся к другим 
секциям, потому что секции у нас одинаковые (т.е. компонент однородный), а 
значит, они эквивалентны. 

Аналогичным образом необходимо заполнять и столбец Pin Eq. Для наше-
го случая необходимо занести единицы в строки с именами in1 и in2. Эквива-
лентность выводов действует только в пределах одной секции. 

В столбце Elec. Type указывается тип вывода, используемый при поиске 
ошибок в принципиальных электрических схемах. Нажатие на правую кнопку 
мыши (либо на кнопку 

тием клавиши Ctrl+C или Ctrl+Ins (либо правой кнопки мыши, выбирая 
пункт в выпадающем меню), затем выделяют ячейку (или ячейки), куда нужно 
эти данные скопировать, и нажимают комбинацию клавиш Ctrl+V или 
Shift+Ins (обычная техника для Windows). 

Эквивалентность секций (или выводов) подразумевает возможность ме-
нять местами секции (выводы) для удобства прокладки трасс автотрассировщи-
ком печатных плат. В столбце Gate Eq указывается эквивалентн

В

 с выпадающим списком) открывает выпадающий 
список типов выводов (Electrical Type). Для быстрого выбора типа вывода дос-
таточно напечат  символа I при-
сваи

вода

ать первый символ его имени. Например, ввод
вает тип Input.  
Примечание. Для простановки символа логической инверсии в имени вы-
 используется знак «∼». Так, имя G  следует ввести как ~G, имя AGC2  - как 

GC~2A. 
 
Сохранение компонента в библиотеке 
Перед сохранением в библиотеке компонента необходимо выполнить ко-
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манду проверки Component>Validate (кнопка ). При обнаружении ошибок 
выводятся соответствующие информационные сообщения. Если же ошибок не 
обнаружено, программа сообщает: No errors found! 

После исправления всех ошибок выполняется команда сохранения компо-
нента в текущей библиотеке Component>Save или Component>Save As. Одна-
ко перед выполнением этих команд обязательно проверяется наличие ошибок, 
и пока ошибки не исправлены, компонент сохранить нельзя. Имя нового ком-
понента указывают по дополнительному запросу (рисунок 8.13). 

 

 
Рисунок 8.13. Сохранение компонента в текущей библиотеке 

 
 
8.4 Создание модели схемы электрической принципиальной  

в редакторе SHEMATIC P-CAD 
 

Редактор PCAD SHEMATIC предназначен для построения схем электриче-
ских из библиотечных компонентов с последующей передачей информации об 
электрических связях между компонентами в PCAD PCB для проектирования 
печа

е пара-
метр

в

ввод ортогональных линий, 45/90 Line-Line — ввод диаго-
наль

тной платы. PCAD SHEMATIC можно использовать также для оформления 
конструкторской документации (схем электрических принципиальных, переч-
ней документов и т.п.). 

Внешний вид экрана монитора при запуске PCAD Schematic показан на 
рисунке 8.14. 

После запуска редактора схем PCAD Schematic рекомендуется настроить 
его конфигурацию: определить размер листа схемы и настроить други

ы в меню команд Options > Configure (рисунок 8.15).  
В графе Units ыбирают систему единиц - миллиметры. Изменить систему 

единиц можно на любой фазе работы со схемой без потери точности. О теку-
щей системе единиц можно судить по размерности ширины линий, указывае-
мой на строке состояний. 

Режим ввода цепей и линий устанавливают в графе Orthogonal Modes: 
90/90 Line-Line — 

ных линий. При включении режима 90/90 Line-Line линии проводятся по 
осям координат или под произвольным углом, при включении режима 45/90 
Line-Line — по диагоналям или под произвольным углом. Рекомендуется 
включить оба режима, тогда линии проводятся по осям координат, по диагона-
лям или под произвольным углом, что определяется дополнительным нажатием 
клавиши О. 
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Рисунок  8.14 – Экран PCAD Schematic с загруженной схемой 

 

 
Рисунок 8.15 – Настройка конфигурации PCAD Schematic 
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Переключатель DDE Hotlinks устанавливает режим взаимного выделения 
цепей между графическими редакторами PCAD Schematic и PCAD РСВ (так на-
зываемую горячую связь). 

Шаг сетки устанавливают в меню Option>Grids. Текущее значение шага 
сетки выбирают курсором в списке Grids или, что более удобно, непосредст-
венно на строке состояний. 

В меню Options>Display задают цвета различных объектов, стиль изобра-
жение шин и ряд других параметров (рисунок 8.16). 

 

 
Рисунок 8.16 – Настройка параметров дисплея 

 
В окне Bus Connection Mode указывают один из трех стилей изображения 

подсоединения цепей к шине. 
В окне Junction Size выбирают размер точки электрического соединения 

цепей (точки «пайки»): 
Small - малый (диаметр 20 mil); Large - большой (диаметр 30 mil); User - 

задаваемый пользователем (от 1 до 394 mil). 
На закладке Miscellaneous на поле ERC Errors выбираются параметры: 
Show - разрешение вывода на схем  маркеров ошибок ERC; Hide - запрет 

вывода на схему ма зменения на схеме 
маркеров ошибок ERC. 

На панели Cursor Style выбирают тип курсора: 
Arrow - стрелка; Small Cross - маленькое перекрестье; Large Cross - боль-

шое перекрестье. 

у
ркеров ошибок ERC; No Change - запрет и
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На панели Sheet Connector Cross Referencing устанавливаются параметры 
соединителей страниц. 

На панели Miscellaneous задают разнообразные параметры: 
Draft Mode - изображение контуров линий и полигонов; 
Display Default PinDes - отображение на экране номеров выводов символов 

компонентов, заданных по умолчанию; 
Display Open Ends - отображение неподсоединенных выводов или цепей; 
Display Overridden Errors - отображение на экране перекрывающихся мар-

керов ошибок; 
Display Part Gate Number - отображение на экране номеров секций компо-

нентов; 
Scroll Bars - размещение на экране линий прокрутки; 
Show Data Tips - вывод подсказок на рабочем поле (они не выводятся при 

использовании курсора большого размера и при выполнении команды 
View>Snap to Grid); 

Thin Stroke Text - установка тонких линий векторных шрифтов; 
Drag by Outline - изображение символов компонентов линиями контура 

при их перемещении или копировании (для ускорения перечерчивания экрана). 
Нажатие клавиши D  значения по умол-

чанию, OK - внесение изменений, Cancel - их отмена. 

кие соединения) и Line (гра-
фиче

ont (контурные шрифты), имя шрифта 
(Fon

нии и т. п.), и загружать их пе-
ред н

ьных цепей, вводятся по команде Op-

efaults назначает всем параметрам

В PCAD Schematic нет понятия слоев изображения, которые можно сде-
лать видимыми или невидимыми. Вся информация располагается на одном 
слое, и с помощью меню Options > Display можно любую информацию, на-
пример атрибуты компонентов (Part Attr), сделать невидимой — для этого ее 
нужно окрасить в цвет фона (Background). 

По командам Options > Current Wire и Options > Current Line определя-
ют ширину цепей Wire (осуществляют электричес

ские линии не обеспечивают электрического соединения). 
В меню Options > Text Style выбирают стиль текста, устанавливаемый по 

умолчанию, и при необходимости редактируют стили выполнения отдельных 
надписей. В меню редактирования шрифта  выбирают тип шрифта: Stroke Font 
(векторные шрифты) или TrueType F

t) и его размер. Все стили надписей сохраняются в файле схемы. 
Параметры настройки конфигурации программы PCAD Schematic заносят-

ся в файл SCH.INI и сохраняются при последующей работе с ней. Кроме того, 
параметры проекта (стили линий, стили шрифта и др.) заносятся в файл схемы. 
Поэтому целесообразно создать «шаблоны» пустых схем, например, в файлах 
template1.sch, template2.sch..., занося в них только параметры конфигурации 
(включая список шагов сетки, список стилей ли

ачалом создания новых схем. 
В PCAD имеется команда File>Design Technology Parameters для про-

смотра и загрузки набора технологических требований к печатной плате (ПП). 
Технологические правила, относящиеся к определению классов цепей и правил 
их трассировки и трассировки отдел
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tion>

 ввести 
зано

риступают к созданию 
прин

ем на схему символов компонен-
тов п

Design Rules как в редакторе PCAD Schematic, так и в редакторе  
PCAD РСВ. Данные об апертурах, о наборе слоев ПП и стилях контактных 
площадок (КП) и переходных отверстий (ПО) можно модифицировать и

во только в PCAD РСВ. 
 
 
Создание принципиальных схем 
После настройки конфигурации PCAD Schematic п
ципиальной схемы по следующему алгоритму. 
1. Загрузка библиотек. Перед нанесени
о команде Library>Setup обеспечивается доступ к необходимым библио-

текам (рисунок 8.17, а). Нажав клавишу Add, добавляют имена библиотек в 
список открытых библиотек (Open Libraries).  

 

 
а 

 
б 

бор символа коРисунок 8.17 –. Загрузка библиотек (а) и вы
 

мпонента (б) 
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2. Размещение компонентов на схеме. В режим размещения символов 
компонентов на схеме переходят по команде Place>Part . После этого щел-
чок курсором в любой точке схемы открывает меню выбора

. 8.17, б). 
 компонента 

(рис
иблиотек, список 

ее ко
 или вводят в верхней 

стро
е символа компонента (справа на рис. 8.17, б). При создании символа ком-

поне
 графе Num Parts указывается общее число секций компонента (изменять 

их н

та в от-
крыт

е характеристики най-
денн

о в библиотеке префикса позиционного 
обоз

кции, имя секции не проставляется. 
ри изображении многосекционных компонентов совмещенным способом 

(изо х секций примыкают друг к другу) позиционные обозна-
чения  пара-
метр ключить 
кнопку начение только первой 
секц

ют номинал компонента, например сопротивле-
ние р

ующее 
пози

вишу Р, а для увеличения позиционного обозначе-

На панели Library указывается имя одной из открытых б
мпонентов выводится в окне Component Name. 
Имя нужного компонента выбирают из этого списка
ке. Нажатие клавиши Browse позволяет просмотреть графическое изобра-

жени
нта в графе Alternate можно задать несколько альтернативных вариантов. 
В
а этом этапе нельзя).  
В окне Part Num по умолчанию указывается номер секции 1, но при необ-

ходимости его можно изменить перед размещением символа компонента на 
схеме. 

Нажатие клавиши Query активизирует средства поиска компонен
ых библиотеках. Сначала в диалоговом окне Query в столбцах Criteria за-

дают критерии поиска и в столбце Show отмечают, каки
ых компонентов нужно отображать в таблицах результатов поиска. 
Позиционные обозначения компонентов на схеме проставляются автома-

тически. Для изменения назначенног
начения его надо указать в поле RefDes в явном виде (см. рис. 8.17, б). Для 

компонентов, состоящих из одной се
П
бражения смежны

 отдельных секций обычно не указываются, для этого необходимо
ы RefDes всех секций, кроме первой, сделать невидимыми (вы

 Visibility), тогда будет видно позиционное обоз
ии.  
На строке Value проставля
езистора. 
После выбора в меню Place>Part нужного компонента и введения всех не-

обходимых параметров нажимают OK — курсор примет форму перекрестья с 
разрывом в центре для точного позиционирования в узлах сетки. Непосредст-
венное размещение символа компонента на схеме выполняется после щелчка 
курсором в любой точке рабочего окна. До тех пор, пока не отпущена левая 
кнопка мыши, символ перемещается по экрану. Он поворачивается на 90° в на-
правлении против часовой стрелки и зеркально отображается нажатием клавиш 
R и F соответственно. Повторный щелчок курсором размещает на схеме оче-
редную копию символа выбранного компонента, присваивая ему след

ционное обозначение, которое одновременно выводится в строке инфор-
мации. Для увеличения на единицу номера секции компонента перед размеще-
нием символа нажимают кла
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ния — клавишу D. Уменьшить эти значения можно одновременным нажатием 
клавиш Shift+P или Shift+D. Нажатие правой кнопки мыши или Esc прекраща-
ет ввод символов. 

В режиме Edit>Select щелчок курсора в любой точке внутри контура сим-
вола компонента производит его выбор с возможностью перемещения, поворо-
та и удаления символа вместе с принадлежащими ему атрибутами. Нажатие 
клавиши Shift и удерживание ее до щелчка курсора позволяет выбрать отдель-
ный элемент символа: вывод, элемент графики, позиционное обозначение и др. 

3. Размещение электрических цепей. После выбора команды Place>Wire 
 курсор принимает форму перекрестья. Щелчком мыши отмечается началь-

ная точка цепи. Каждое нажатие левой кнопки мыши фиксирует точку излома. 
Нажатие клавиши О до отпускания левой кнопки мыши изменяет угол ввода 
лини

епей 90/90  
Line

еподсоединенные выводы компонентов и открытые концы цепей, не под-
соединенных к другим цепям или к выводам компонентов, помечаются квадра-
тика ия. 

сли при перемещении цепи, имеющей присвоенное ей ранее имя (не сис-
темн

мени объединенной це-
пи и

и из числа разрешенных (задаваемых в меню Options>Configure), нажатие 
клавиши F изменяет ее ориентацию. В связи с тем, что на схеме обычно преоб-
ладают горизонтальные или вертикальные цепи, в меню Options>Configure 
достаточно включить только режим ввода ортогональных ц

-Line. Завершается ввод цепи нажатием правой кнопки мыши (или Esc). 
Ширина прокладываемой цепи (рекомендуется 0,25 мм) устанавливается 

по команде Options>Current Wire: Thick — широкая (0,381 мм = 15 mil), Thin - 
узкая (0,254 мм = 10 mil) и User - задаваемая пользователем (в пределах от 0,1 
до 100 mil). 

Н

ми, которые гаснут после выполнения электрического соединен
Е
ое имя типа NETxxxxx), она соприкоснулась с другой такой же цепью, от-

крывается диалоговое окно (рисунок 8.18) для выбора и
ли отказа от выполнения операции. При одновременном соединении не-

скольких цепей (это возможно при их перемещении в окне) выводится сообще-
ние об отказе от  их объединения, что позволяет продолжить перемещение этих 
цепей или вернуться к исходному состоянию по команде Undo. 

 

 
Рисунок 8.18 – Выбор имени соприкасающихся цепей 
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Включение в цепь дополнительной точки излома для последующего редак-
тирования выполняется по команде Rewire>Manual . 

В строке информации выводится присваиваемое автоматически имя раз-
мещаемой цепи, например Net: NET00003. Следующая цепь получит имя 

00004. 
Пр

NET
своить цепи другое имя можно двумя способами.  

каждую цепь и щелчком правой кнопки мыши 
откр ункт Properties и изменить имя цепи, заме-
нив назначенное системой имя другим, например заменить 
NET чить на закладке Wire

и
I. Индивидуально выбрать 
ыть в меню редактирования п
на строке Net Name 
00001 на А1. Это имя будет видимым, если вклю  пе-

рекл

me  Increment Name (режим 
прир  по первой 
цепи  нуме-
раци де, например 
DAT и т. д. 

а автоматиче-
ски 

ечения и затем продолжить 
ее по

ючатель Display.  
II. С помощью команды Utils>Rename Nets в открывшемся меню на строке 

Net Na  ввести префикс имени и выбрать параметр
ащения имени). После закрытия этого меню щелчком курсора
 ей присваивается имя Pref 0, по второй - Pref 1 и т. д. Чтобы начать
ю цепей не с нуля, нужно начальное имя ввести в явном ви
A5. Тогда первая цепь получит имя DATA5, вторая - DATA6 
Если к цепи подсоединить компонент заземления GND, то он
получит имя GND, так как выводу компонента заземления присвоен тип 

Power, что обеспечивает автоматическую замену имени цепи, к которому он 
подключен, на имя этого компонента. 

Электрическое соединение пересекающихся цепей обозначается точкой 
«пайки» (Junction), которая автоматически проставляется на Т-образных со-
единениях. 

Чтобы проставить точку соединения пересекающихся цепей, нужно при 
вводе второй цепи щелкнуть курсором в точке перес

строение. 
4. Размещение шин. Выбор команды Place>Bus  активизирует режим 

ввода шин. Щелчком курсора отмечают начало шины и точки ее излома. По-
стро

ения устанавливают в меню 
кома  на схеме лини-
ей ш ельзя. При необходимости можно 
пове

lace>Port 

ение шины завершается нажатием правой кнопки мыши или Esc. 
После этого по команде Place>Wire размещают цепи. При рисовании це-

пи, входящей в состав шины, ее начало или конец должны располагаться в лю-
бой точке шины. При этом при подключении к шине автоматически изобража-
ется излом цепи под углом 45° (стиль этого изображ

ина изображаетсянды Options>Display (см. рис. 8.16, а). Ш
ину нириной 0,76 мм и изменить ее шир

рх нее нарисовать линию нужной ширины по команде Place>Line. 
Имена цепей, образующих шину, задаются подключением к цепям по ко-

манде P  специальных портов. После выбора команды Place>Port 
щелч

ой вверху строке Net Name ука-
зыва

ком мыши на любой точке схемы открывается изображенное на рисун-
ке 8.19, а меню выбора порта. На расположенн

ют имя первой цепи, например D1. Если включить переключатель Incre-
ment Port Name, то при размещении портов они автоматически получат имена 
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D1, D2, D3 и т. п.  
Для обозначения цепей в шине в соответствии с ЕСКД необходимо вы-

брать тип порта без рамки (None) с одним выводом (One pin) и располагать его 
верт ожено над 
ней. 

и). Именованные таким образом цепи являются глобальными 
(Glo s и 
Utils

икально (Vertical). В результате имя цепи (порта) будет распол
После закрытия меню нажатием ОК порты подключаются последователь-

ными щелчками мыши по именуемым цепям (текущее имя цепи отображается в 
строке информаци

bal), их можно переименовывать по командам Edit>Net
>Rename Nets. Видимость имени шины устанавливается с помощью пере-

ключателя Display меню Bus Properties (рис. 8.19, б). 
 

 
а 

 
б 

Рисунок 8.19 – Диалоговые окна команд Place>Port (а) и Bus Properties (б) 
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5. Размещение проекта на нескольких листах. Для создания дополни-
тельных листов схемы по команде Options>Sheets на закладке Sheets в поле 
Sheet Name последовательно определяют имена второго и последующих листов 
схемы, каждый раз нажимая кнопку Add. Наиболее естественно именовать лис-
ты схемы Sheet1, Sheet2 и т. д. (при этом все листы находятся в одном файле). 
В да

на быть проложена на другой лист, подключить 
порт

льнейшем листы схемы переключаются в строке состояний.  
Перед переносом части схемы на другой лист необходимо к выводу ком-

понента, связь от которого долж
, имеющий один вывод (соединитель страниц), и присвоить ему имя цепи 

(рисунок 8.20). На другой странице должен быть размещен порт с тем же име-
нем для обеспечения электрического соединения. 

 
Рисунок 8.20 – Соединитель страниц 

 
6. Добавление атрибутов цепей и компонентов. Для добавления атрибу-

та ц

 будет принят 
во в

мым на схеме. Для управления 
види

обы он был 
не виден). Аналогично при выводе схемы на печать по команде 
File>Print>Print Options указывают цвета атрибутов и других объектов. Таким 
образом назначают цепям или компонентам индивидуальные атрибуты. Атри-
буты общего характера вводят по команде Place>Attribute. 

7. Поиск объектов. Выберем компонент и щелчком правой кнопкой мыши 
развернем всплывающее меню, в котором укажем команду Highlight Attached 
Nets — в результате высвечиваются все цепи, подключенные к этому компо-
ненту. Для поиска на схеме компонента выполняют команду Edit>Parts и в от-
крывшемся меню со списком всех компонентов курсором указывают имя кон-
кретного компонента. После нажатия на кнопку Jump этот компонент ярко вы-
свечиваетс схемы пе-
рекл
цепи

епи (или компонента) выбирается цепь (или компонент) и после открытия 
щелчком правой кнопки мыши меню редактирования указывают в нем пункт 
Properties. Затем по команде Add добавляют атрибуты, как показано на рисун-
ке 8.21, где введен атрибут ширины проводника Width, который

нимание автотрассировщиком. С помощью выключателя Visible каждый 
атрибут может быть сделан видимым или невиди

мостью на экране всех однотипных атрибутов по команде Option>Display 
атрибуту можно назначить индивидуальный цвет или цвет фона (чт

я, даже если он находится на другом листе схемы (листы 
ючаются автоматически). Аналогичную процедуру выполняют при выборе 
 в меню команды Edit>Nets (рисунок 8.22).  
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В списке цепей можно вывести имена всех цепей (All Nets) или только 
глобальных цепей (Global Nets Only), а также имена шин (Bus). По команде 
Jump to Node курсор указывает на схеме узел данной цепи, предварительно 
выбранный в списке Nodes, в котором приняты обозначения: U3-1 - это вывод 1 
компонента U3. 

 
Рисунок 8.21 – Редактирование атрибутов цепей 

 

 
Рисунок 8.22 – Меню выбора цепей 

 
8. Редактирование схемы. Для перемещения компонента или цепи необ-

ходимо выбрать их щелчком курсора и затем перемещать движением мыши. 
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Если
чком курсора выбирают отдельный сегмент и перемещают его 

верш , 
пози

жатии кнопки Shift. 

м относятся цепи, к которым подключены 
порт -
имен

е размещения символов нескольких одинаковых компонентов всем им 
сраз

значений. Перед завершением создания 
схем к

ную или с помощью специальной утилиты DBX. При пе-
рену

 требования ЕСКД.  

 исходном файле, по команде File>Save As проект сохраняет-
ся в 

формат (расширение имени *.SCH); 

 более компактен и является основным, текстовый формат ис-
поль

ых 
схем

 ящика», а его принципиальная схема размеща-
ется

 после перемещения сегментов цепей часть из них будет расположена не-
аккуратно, щел

ину. Выбор для редактирования элемента сложного объекта (например
ционного обозначения компонента) производится щелчком левой клавиши 

мыши при одновременном на
Перед перемещением группы объектов полезно щелчком правой кнопкой 

мыши выбрать команду Select Point для нанесения точки привязки (имеет фор-
му перекрестья, заключенного в квадрат). При перемещении объектов в строке 
информации выводятся значения смещения точки привязки dX, dY относитель-
но ее первоначального расположения. 

Скопировать выделенную группу объектов можно удерживанием клавиши 
Alt при перемещении мыши. При этом входящие в группу глобальные цепи не 
изменяют своих имен (к глобальны

ы или выводы компонентов, имеющие тип Power), остальные цепи пере
овываются. Компонентам присваиваются новые позиционные обозначе-

ния. Посл
у можно присвоить одинаковые атрибуты.  
9. Изменение позиционных обо
ы целесообразно переименовать позиционные обозначения омпонентов 

согласно ЕСКД вруч
мерации позиционных обозначений по команде Utils>Renumber невоз-

можно соблюдать
10. Сохранение проекта. По команде File>Save отредактированный про-

ект сохраняется в
другом файле, причем предварительно можно выбрать его формат: 
Binary Files - бинарный 
ASCII Files - текстовый формат (расширение имени *.SCH).  
Файлы обоих форматов имеют одно и то же расширение имени *.SCH. Би-

нарный формат
зуют для обмена данными с другими программами. 
В файле схемы хранятся следующие параметры: система единиц; набор 

шагов сетки; стили текста; шаблоны отчетов. 
Чтобы не вводить эти данные всякий раз для каждой новой схемы, реко-

мендуется завести один или несколько отдельных файлов, не имеющих графи-
ческой информации, ввести типичные параметры и сохранить эти шаблоны 
схем под уникальными именами, например TEMPLATE_1.SCH и т.п.  

Иерархические структуры. PCAD Schematic поддерживает иерархиче-
ские или модульные структуры, что удобно для изображения принципиальн

, состоящих из однотипных элементов, и для упрощения изображения 
сложных схем. На верхнем уровне иерархии помещается изображение модуля в 
виде прямоугольного «черного

 на более низком уровне иерархии (схемы всех уровней иерархии записы-
ваются на разных листах одного и того же проекта). Модуль представляется в 
виде компонента, имя которого (Module name) задает пользователь. Модуль 
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имеет выводы (Pin), к которым подключают внешние цепи. Связь между изо-
бражением

 
в ви

емы ЕСО и составлением списка электрических 
связ

я принципиальной электрической схемы целесообразно вы-
явит

ый узел; 

точника питания); 
nconnected Pins - неподключенные выводы компонентов; 

es - неподключенные (плавающие) цепи; 

ng или Ignored) на-
знач е нажатия на панель Severity 
Leve

схемы>.ЕRС, изменение 
этог

чинается после 
нажа ибках помечается на схеме индикато-
рами

 

 модуля и его принципиальной схемой осуществляется с помощью 
понятия Link. Информация об этой связи (т. е. о схеме модуля) представляется

де отдельного компонента, имя которого (Link name) также задает  
пользователь. Модуль иерархической структуры создают по команде 
Utils>Module Wizard. После размещения на схеме символов модулей необхо-
димо выполнить команду Utils>Resolve Hierarchy для простановки сквозных 
позиционных обозначений компонентов и именования цепей проекта с учетом 
схем, входящих в него иерархических структур. Эта команда должна выпол-
няться перед корректировкой сх

ей (поэтому, в частности, при «упаковке» схемы на ПП на нее переносятся 
и компоненты, входящие в состав иерархических структур). 

 
 
Проверка схем с помощью утилиты ERC 
После создани
ь синтаксические ошибки, исправить их и только после этого перейти к 

разработке ПП. Проверку схемы выполняют по команде Utils>ERC (Electrical 
Rules Check). В основном меню этой команды задают перечень проверок, ре-
зультаты которых приводятся в текстовом отчете: 

Single Node Nets - цепи, имеющие единственн
No Node Nets - цепи, не имеющие узлов; 
Electrical Rules - электрические ошибки, когда соединяются выводы несо-

вместимых типов (например, соединяются два выходных вывода или выходной 
вывод подключается к выводу ис

U
Unconnected Wir
Bus/Net Errors - входящие в состав шины цепи, встречающиеся только 

один раз (т. е. они входят в шины, но не выходят из них); 
Component Rules - компоненты, расположенные поверх других компонен-

тов; 
Net Connectivity Rules - неправильное подключение цепей земли и пита-

ния; 
Hierarchy Rules - ошибки иерархической структуры. 

rror, WarniСтепень серьезности отдельных ошибок (E
ваемом послается в диалоговом окне, откры

l. Там же необходимо включить опции View Report (Просмотр отчета со-
общений об ошибках) и Annotate Errors (Индикация ошибок на схеме). 

Сообщения об ошибках заносятся в файл <имя 
о имени производят после выбора панели Filename. 

нной конфигурацией наПоиск ошибок в соответствии с зада
 оштия панели ОК. Информация об

 и выводится в текстовый отчет. 
Координаты ошибок приводятся в той системе единиц, которая выбрана в
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меню

иде: 

ь  п  п и о

зрешающей способно-
сти, 

ходимо.  

 
схем  компонентов с 
указанием их электрических связей согласно принципиальной схеме. Для соз-
дани tils>Generate Netlist от-
крыт Netlist Format выбирать 
форм Netlist, FutureNet 
Pinli

атия кла-
виш

SCII) информацию, необходимую 
для с ов компонен-
тов, 

кстовые отче-
ты о схеме. Дополнительно выбирается содержание и форма отчета, а также 
устройство выво ета удобно ана-
лизи

 команды Options>Configure. 
 
 
Вывод данных 
Результаты проектирования выводятся в PCAD Schematic в в
− схемы, напечатанной на принтере или плоттере; 
− списка соединений схемы (в частности, для упаковки схемы на ПП или 

выполнения моделирования);  
− текстовых отчетов. 
Вывод схемы на печат . Для одготовки к ечати электр ческ й схемы 

на принтере или плоттере выполняют команду File>Print Setup и в развернув-
шемся меню выбирают тип устройства вывода, предварительно установленного 
средствами Windows. Нажатием панели Setup открывают меню выбора размера 
и ориентации бумаги, характера передачи полутонов, ра

качества печати (высокое, черновое). На строке Minimum Line Width for 
printing (pixels) устанавливают минимальную ширину прямых линий в пиксе-
лях (на дуги это не распространяется). При подготовке к печати указывается 
также масштабный фактор и поворот чертежа на 90 0, если необ

Непосредственный вывод на печать выбранных листов начинается после 
нажатия клавиши Generate Printouts, предварительный просмотр - после нажа-
тия клавиши Print Preview. 

Создание списка соединений. Список соединений включает в себя список 
компонентов и цепей с указанием номеров выводов компонентов, к которым 
они подключены. Он используется для так называемой процедуры «упаковки

ы на печатную плату» - размещения на поле ПП корпусов

я списка соединений необходимо по команде U
ь меню настройки параметров и в пункте меню 
ат списка соединений: PCAD ASCII, Tango, FutureNet 

st, Master Designer, EDIF 2.0.0, PSpice, XSpice.  
Для разработки ПП с помощью графического редактора PCAD PCB реко-

мендуется выбирать формат Tango или PCAD ASCII (последний передает ат-
рибуты схем на ПП). Имя файла списка соединений задают после наж

и Netlist Filename. 
Нажатием кнопки Include Library Information включают в файл списка 

соединений (только для формата PCAD A
оставления с помощью Library Manager библиотеки символ
находящихся в данной схеме (по команде Library>Translate).  
Составление отчетов. По команде File>Reports создают те

 
да: консоль, принтер или файл. С помощью отч

ровать спроектированную схему и контролировать ошибки, внесенные 
оператором при создании библиотечных компонентов и вводе информации. 
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8.5 Проектирование печатной платы в РСВ P-CAD 
 

Для размещения компонентов на печатной плате и ручной трассировки в 
САП

р печатных плат так же, как и редактор схем - отличие 
лиш

ся новые кнопки, а в меню - новые команды, необходимые 
для 

ослойную организацию проекта. 

 

Р PCAD используется графический редактор РСВ. 
Построен редакто
ь в объектах, с которыми он работает. Поэтому на инструментальных пане-

лях редактора имеют
создания печатных плат. PCAD PCB в отличие от PCAD SHEMATIC под-

держивает мног
 
Настройка конфигурации P-CAD PCB
Перед началом работы в PCAD PCB необходимо настроить его конфигу-

рацию по команде Options>Configure. Настройки PCAD PCB в основном сов-
падают с настройками редактора PCAD SHEMATIC. Дополнительно в графе 
Workspace Size указывают размеры рабочей области, немного превышающие 
габаритные размеры ПП (по умолчанию устанавливается 254х254 мм, макси-
мальные размеры ПП 60х60 дюймов или 1524х1524 мм). 

На закладке Route отмечают опцию T-Route by Default для разрешения 
образования Т-образных соединений проводников, в графе Orthogonal Modes 
включают все режимы (остальные параметры принимают значения по умолча-
нию, их настраивают позже по мере надобности). 

На закладке Manufacturing  задают значения глобальных технологических 
параметров: отступы масок пайки, зазоры между областью металлизации, на-
правление пайки волной припоя и т.п. 

При создании новой ПП по умолчанию устанавливаются 11 стандартных 
слоев: 

Тор - верхняя сторона ПП; 
Bottom - нижняя сторона ПП; 
Board - контур ПП; 
Top Mask - маска пайки на верхней стороне ПП; 
Bot Mask - маска пайки на нижней стороне ПП; 
Top Silk - шелкография на верхней стороне ПП (контуры компонентов и 

т.п.); 
Bot Silk - шелкография на нижней стороне ПП; 
Top Paste - маска для паяльной пасты на верхней стороне ПП; 
Bot Paste - маска для паяльной пасты на нижней стороне ПП; 
Top Assy - вспомогательные данные на верхней стороне ПП; 
Bot Assy - вспомогательные данные на нижней стороне ПП.  
Слои Тор и Bottom, Top Silk и Bot Silk и т.п. являются парными. Понятие 

парности слоев используется при переносе компонента на другую сторону ПП 
нажатием на клавишу F (Flip - зеркальное отображение), при этом вся графиче-
ская и текстовая информация переносится на ответствующие парные слои (при 
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зерк

ers. Выделяют три типа слоев: 

кой трассировке: 

и на которых не содержится информация; стандартные слои удалять 
нель

анде Options>Pad Style открывают список стеков КП, по команде 
Opti

Pad, Place>Vie. Нажатием на панель Modify открывают меню редакти-
рования стеков КП (рисунок 8.23). 

В PCAD PCB  выделяют два вида стеков контактных площадок: 
1) простые (Simple) - выводы штыревых компонентов, имеющие одина-

ковую форму КП на всех слоях, и планарных компонентов, имеющие КП толь-
ко на одном слое; 

2) сложные (Complex) - имеют различные КП на нескольких слоях.  
Для стеков КП планарных компонентов задаются их геометрические раз-

меры на том слое (Тор или Bottom), на котором наносится графика корпуса 
(при последующей пайке планарных компонентов волной припоя их стеки КП 
необходимо размещать на слое Bottom). 

альном отображении простых графических объектов - линий, полигонов и 
т. п. - они остаются на первоначальном слое). 

Всего в PCAD PCB может быть до 99 слоев. Слои создают и удаляют по 
команде Options Lay

Signal - слои разводки проводников сигналов, помечают символом S; 
Plane - слой металлизации для подключения цепей «земли» и «питания», 

помечают символом Р; 
Non Signal - вспомогательные слои, помечают символом N. 
Каждый слой может быть включен (Enable, символ Е) или выключен (Dis-

able, символ D).  
В графе Routing Bias указывают приоритетную ориентацию проводников 

на каждом слое при автоматичес
Auto - выбирается автоматически, символ А;  
Horizontal - горизонтальная, символ Н;  
Vertical - вертикальная, символ V. 
Удалять можно только слои, введенные пользователем, не являющиеся те-

кущими 
зя. 
Список значений ширины трасс проводников и геометрических линий со-

ставляется по команде Options>Current Line. 
По ком
ons>Vie Style - список стеков ПО. Выбранные курсором в этих списках 

стеки являются текущими и помещаются на ПП при выполнении команд 
Place>

 
Рисунок 8.23 – Редактирование планарного стека 
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Перед размещением на ПП компонентов вручную или с помощью проце-
дуры упаковки принципиальной схемы необходимо обеспечить доступ к биб-
лиот

 PCAD PCB 

 

коман

 по ко-
манд оздает-
ся в ). 

арительно разме-
щен

ы

 

екам, в которых находятся эти компоненты. Библиотеки подключают по 
команде Library>Setup.  

 
Разработка печатных плат в
Разработку новой ПП начинают с выполнения команды File>New и на-

стройки конфигурации или загрузки шаблона. Затем на слое Board по команде
Place>Line наносится контур ПП в виде замкнутой линейно-ломаной линии 
(дуги не разрешаются). 

1. Упаковка схемы на печатную плату. При отсутствии принципиальной 
схемы проекта компоненты расставляют на ПП по де Place>Component и 
по команде Place>Connection вводят электрические связи между их выводами. 
При наличии принципиальной схемы для переноса (упаковки) ее на ПП

е Utils>Load Netlist загружают файл списка соединений (который с
редакторе PCAD Schematic в форматах Tango или PCAD ASCII
Обычно схема упаковывается на ПП, на которой предв
ы: разъемы; крепежные отверстия; другие компоненты, имеющие фиксиро-

ванное положение (в диалоговом окне Properties этих компонентов необходи-
мо отметить опцию Fixed), и проложен ряд трасс.  

В этом случае после загрузки команды Utils>Load Netlist выводится со-
общение, информирующее о необходимости соблюдения следующих ограниче-
ний: 

— компоненты с совпадающими на ПП и на схеме позиционн ми обозна-
чениями (RefDes) должны иметь одинаковые типы корпуса (Type). При обнару-
жении конфликтов упаковка не производится; 

— все присутствующие на ПП компоненты, не входящие в список соеди-
нений, будут сохранены; 

— на ПП переносятся все компоненты из списка соединений, которые не 
установлены на ней предварительно; 

—электрические связи, проложенные предварительно на ПП и отсутст-
вующие в списке соединений, удаляются (обновляется вся информация об 
электрических связях), однако все проложенные ранее проводники сохраняют-
ся, даже если они отсутствуют в списке соединений; 

— после выполнения команды нельзя восстановить первоначальный вид 
ПП с предварительно размещенными компонентами, поэтому ее рекомендуется
сохранить в отдельном файле. 

2. Размещение компонентов на плате. После загрузки списка соединений 
(упаковки схемы) на ПП приступают к размещению компонентов внутри кон-
тура ПП (если он есть). Размещение компонентов на ПП обычно производят 
вручную. Линии электрических связей, перемещаемые вместе с компонентами, 
помогают правильно их разместить. 

Нажатием клавиши R поворачиваем выбранный объект против часовой 
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стрелки на 90°, одновременным нажатием Shift+R поворачиваем его на угол, 
зада

об выравнивания. 

лом трассировки в меню 
Options>

s устанавливают 
допустимые зазоры для кажд унок 8

нный в меню Options>Configure на закладке General (параметр Rotation 
Increment), нажатием клавиши F зеркально отображаем объекты относительно 
оси Y и переносим компоненты на противоположную сторону ПП. 

При размещении однотипных компонентов удобно их автоматически вы-
равнивать. Для этого выравниваемые компоненты по очереди выбираются 
щелчком курсора (при выборе второго и последующих компонентов нажимают 
и удерживают клавишу Ctrl). Затем выбирают опцию Align (Выравнивание) и в 
открывшемся меню отмечают спос

После завершения размещения компонентов полезно выполнить миними-
зацию длин соединений путем перестановки логически эквивалентных секций 
компонентов и их выводов по команде Utils>Optimize Nets (перестановка воз-
можна, если в ней не участвуют уже проложенные проводники). 

3. Задание правил проектирования. Перед нача
Grids задают необходимый шаг сетки.  

Затем по команде Options>Design Rules на закладке Layer
ого слоя трассировки (рис .24). 

 
Рисунок 8.24 – Пример задания правил и ограничений трассировки 

 
Перед началом ручной трассировки целесообразно включить режим теку-

щей проверки допустимых зазоров, пометив на закладке Online DRC команды 
Options>Configure строку Enable Online DRC. 

Для управления размещением компонентов и трассировки соединений в 
автоматическом или интерактивном режиме и проверки DRC цепям и компо-
нент

eepout устанавливают па-
раме

ам присваивают атрибуты по команде Edit>Nets. 
4. Барьеры трассировки. Графический редактор PCAD РСВ имеет воз-

можность создавать на ПП барьеры трассировки. Расположение на ПП по ко-
манде Р1асе>Keepout сегмента линии или замкнутой области в виде полигона 
запрещает Quick Route пересекать их трассами проводников на одном выбран-
ном или на всех доступных слоях (места размещения крепежных отверстий, за-
прещенные для трассировки по конструкционным соображениям области и 
т.п.). Предварительно по команде Options>Current K

тров барьеров трассировки: линия (Line) или полигон (Polygon), распола-
гаемые на текущем (Current) или на всех доступных слоях (All). 
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Контур ПП, рисуемый на слое Board по команде Place>Line, воспринима-
ется Quick Route как барьер, который нельзя пересекать проводниками на всех 
слоях. Поэтому трассы будут проведены как внутри этого контура, так и вне его 
(но н

 ширину и выбирают нужный слой. Трассу про-
водн

efault. 

ь
. 

Нарушение зазора между трассой проводника и выводом компонента, ПО 
или трассой друг де круга с пере-
крес

й площадке пункта назначения обо-
значается ромбом с перекрестьем. 

В процессе трассировки полезно обращать внимание а строку информа-
ции, в которой выводятся следующие данные: 

— приращения координат dX, dY каждого сегмента, пока нажата левая 
кнопка мыши; 

— общая длина трассы до точки излома Total length (с учетом длин дуг); 
— число ошибок при прокладке трассы «<n> error(s) during routing» (выво-

дится после ее завершения). 
6. Интерактивная трассировка соединений. Трассу прокладывают по 

команде Route>Interactive движением курсора при нажатой левой кнопке, при 
этом автоматически огибаются препятствия (проводники, КП, ПО и области 
металлизации), соблюдаются допустимые зазоры. Нажатием правой кнопки 
мыши в процессе прокладки трассы открывают следующее меню: 

Complete - завершение прокладки трассы (если это возможно) с соблюде-
нием установленного ранее режима ввода проводников (ортогонально или по 
диагонали) и допустимых зазоров; 

Push Traces  - включение режима отталкивания мешающих проводников; 

е пересекая). 
5. Ручная трассировка соединений. Перед началом трассировки какого-

нибудь проводника задают его
ика можно начать только от тех КП, которые имеют электрические связи. 

При необходимости электрические связи устанавливают вручную по команде 
Р1аce>Connection. 

Ручную трассировку проводников выполняют по команде Route>Manual.  
Для облегчения создания Т-образного соединения трасс выполняют его 

при нажатой клавише Shift или заранее на закладке Route диалогового окна ко-
манды Options>Configure включают опцию T-Route by D

При смене в процессе прокладки трассы текущего слоя нажатием клавиш 
L, Shift+L или с помощью строки состояний трасса продолжается на другом 
слое, при этом автоматически вставляется ПО текущего типа (заданного зара-
нее по команде Options>Via Style). 

Не прерывая прокладку трассы, можно изменит  ширину проводника по 
команде Options>Current Line или с помощью строки состояний

ой цепи отмечается индикаторами ошибок в ви
тием, если включен режим Online DRC. 
Нажатие правой кнопки мыши или выбор любой команды завершает трас-

сировку проводника по кратчайшему расстоянию до контактной площадки вы-
вода компонента. Нажатием косой черты «/» или «\» прекращают прокладку 
трассы без ее завершения. 

авершение трассы точно на контактноЗ

н
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Suspend - прекращение прокладки трассы с сохранением проложенного 
участка; 

Cansel - прекращение прокладки трассы с отменой ввода последнего сег-
мента (аналог нажатия клавиши Esc); 

Options — изменение параметров конфигурации проекта по команде  
Options>Configure; 

Layers — открытие окна команды Options>Layers для изменения структу-
ры слоев платы; 

Via Style — открытие окна Options>Via Style для выбора типа ПО или его 
редактирования; 

Unwind — отмена прокладки последнего сегмента проводника (аналог на-
жатия клавиши Backspace). 

Клавиши О, F, «/», «\» и стрелки имеют такие же назначения, как и при 
ручной прокладке трасс. Единственное личие — не производится скругление 
трасс п

Когда в процес и отпускают в точ-
ке окончания  

 создают в два 
этап

 

одключена. 
Здес  КП с тепловыми барьерами 
(The  

ладке General команды Options>Configure вклю-
чена rs. 

оманде File>Save либо File>Save As отредак-

 от
о дуге.  

се прокладки трассы левую кнопку мыш
 линии электрической связи, прокладка трассы завершается и

можно переходить к прокладке следующей. 
7. Сглаживание прямоугольных изгибов проводников. Прямоугольные 

изгибы проводников скашиваются под углом 45° или сглаживаются дугами по 
команде Route>Miter. Режим сглаживания устанавливают на панели Miter 
Mode закладки Route команды Options>Configure. Сглаживание начинают 
щелчком курсора в точке излома трассы, не отпуская левую клавишу мыши, 
перемещают курсор и устанавливают необходимые размеры изгиба трассы. 

По завершении ручной трассировки проводников полезно выполнить ко-
манду Utils>Trace Clean-up для удаления наложенных друг на друга сегментов 
трасс и лишних точек излома. 

8. Области металлизации. На слоях сигналов могут располагаться облас-
ти металлизации, электрически подсоединяемые к одной из цепей и автомати-
чески отделяемые зазорами от других цепей и КП. Эти области

а: 
1) по команде Place>Copper Pour рисуют внешний контур области  

металлизации в виде полигона (пересечения сторон полигона не допускаются); 
2) область выбирают щелчком курсора, в выпадающем меню выбирают

строку Properties и затем на закладке Connectivity открывшегося меню Copper 
Pour Properties указывают имя цепи, к которой она должна быть п

ь же выбирают необходимость использования
nnals) или непосредственного соединения (Direct Connection) и задают

ширину теплового барьера. После этого на закладке Style указывают особенно-
сти выполнения металлизации. 

При прокладке проводников через область металлизации зазоры образуют-
ся автоматически, если на зак

 опция Auto Plow Copper Pou
9. Сохранение проекта. По к
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тиро

ом фотошаблонов необходимо по команде 
Utils

ла проверок. 

с-
та ош

 автоматически удаляется. 

 

ктированной ПП извлекается ин-
формация о координ равляющий файл в 
формате станка с ЧПУ  Numerically 
Cont

ванный проект сохраняется в файле, причем предварительно можно вы-
брать его формат. 

10. Проверка печатной платы с помощью утилиты DRC. Перед завер-
шением разработки ПП и выпуск

>DRC (Design Rule Checking) проверить ПП на соответствие принципиаль-
ной схеме и проверить соблюдение технологических ограничений. В меню этой 
команды выбирают различные прави

После выполнения проверок перечень ошибок заносится в файл с расши-
рением имени *.DRC. Включение опции Annotate Errors помечает на ПП ме

ибок специальными индикаторами. После исправления ошибки ее инди-
катор

 
Вывод данных 
Результаты разработки ПП выводят на принтеры и плоттеры различных 

типов, используя средства Windows. В меню команды FiIe>Print в поле  
Minimum Line Width (pixels) устанавливают минимальную ширину линий, за-
тем нажимают кнопку Setup Print Jobs и переходят в меню составления зада-
ний. В этом меню сначала каждому заданию в графе Print Name присваивают 
имя. Затем в списке слоев Layers указывают нужные (второй и последующие 
слои выбирают щелчком курсора при нажатой кнопке Ctrl). 

В заключение устанавливают опции печати: 
Scale — масштаб изображения; 
Х и Y offset — смещение изображения по горизонтали и вертикали от края 

бумаги; 
Drill Symbols Size — размер символов отверстий; 

изображRotate — поворот ения на 90° по часовой стрелке; 
Mirror — зеркальное отображение; 
Draft — вывод контуров линий; 
Thin Striked Text — изображение векторных шрифтов тонкими линиями; 
RefDes, Type, Value, Pads, Vias, Pad/Via Holes, Pick and Place, Glue Dot, 

Test Point, Keepout, Cutout, Connections, Mt Hole, Titles - печать соответст-
вующих объектов. 

Нажатие на кнопку Print Preview позволяет просмотреть изображение, пе-
чать производится после нажатия на кнопку Generate Printouts. 

Создание и просмотр Gerber-файлов. PCAD РСВ обеспечивает создание 
управляющих файлов в стандартном формате фотоплоттера Gerber по команде 
File>Export>Gerber и загрузку изображения фотошаблона для контроля оши-
бок по команде File>Import>Gerber. 

Вывод информации для сверления отверстий. По команде 
File>Export>N/C Drill из базы данных спрое

атах отверстий и создается текстовый уп
 типа Excellon ( ббревиатура N/C означаета

rolled — числовое программное управление (ЧПУ)). 
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Составление списков соединений. Список соединений включает в себя 
спис в компонентов, к ко-
торы ые области металлизации, а также непод-
соед т список не заносятся. 

ibrary Information вклю-
чают

манде Route>Autorouters (рисунок 8.25) из списка: 
uick Route – трассировщик Quick Route; 

 Quick Route является наиболее простым трассировщи-
ком, н пригоден для быстрой разработки не очень сложных ПП. 

ок компонентов и цепей с указанием номеров выводо
м они подключены. Изолированн
иненные выводы компонентов в это
По команде Utils>Generate Netlist открывается меню настройки парамет-

ров. В пункте меню Netlist Format выбирают формат списка соединений: 
PCAD ASCII или Tango. Нажатием кнопки Include L

 в файл списка соединений (только для формата Р-CAD ASCII) информа-
цию, необходимую для составления с помощью Library библиотеки корпусов 
компонентов, находящихся в данном проекте (по команде Library>Translate). 

По команде FiIe>Reports создают текстовые отчеты о ПП. 
 
 
8.6 Автоматическая трассировка проводников 
 

Программа автоматической трассировки Quick Route 
Программа автотрассировки Quick Route (файл QROUTE.EXE) поставля-

ется совместно с PCAD РСВ. Вызывают Quick Route из управляющей оболочки 
PCAD РСВ по ко

Q
PCAD Shape Route – трассировщик бессеточного типа, использующий ал-

горитмы оптимизации нейронных структур; 
SPECCTRA – программа SPECCTRA в режиме трассировки.  
Из этих программ
о

 
Рисунок 8.25 – Выбор автотрассировщика Quick Route 

 
Подготовка к трассировке. Quick Route трассирует текущую ПП, загру-
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женн ть размещены все компоненты и ука-
заны электрические связи между выводами. Предварительно на ПП можно раз-
мест . Quick Route не 
изменяет  и не прокладывает трассы 
заново

бранного 
ипа трассировщика. 

В меню Quick Route (см. рис. 8.25) в нижней части экрана расположены 
следующие кнопки: 

Layers – конфигурация слоев. Quick Route поддерживает до четырех слоев 
металлизации; 

Net Attrs – редактирование атрибутов цепей; 
Passes – выбор проходов трассировки; 
Via Style – выбор типа ПО. 
На строке Line Width выбирают ширину проводника от 0,1 mil (0,01 мм) 

до некоторого значения, зависящего от выбранного шага сетки. Например, для 
шага сетки 25 mil оно составляет 12 mil в английской системе или 0,305 мм в 
метрической системе, не более. Ширину индивидуального проводника назна-
чают с помощью атрибута WIDTH, который может принимать любое значение. 

В меню редактирования стратегии трассировки Pass Selection выбирают 
типы прох

ide рибуты 
ALITOROUTEWIDE и WIDTH перед выполнением других проходов. На этом 
проходе прокладывают только горизонтальные и вертикальные трассы. На-
клонные широкие трассы приходится прокладывать предварительно вручную – 
Quick Route их ширину не изменит; 

Horizontal – выполнение простейших соединений по горизонтали на лю-
бом слое без использования ПО и с минимальным отклонением от прямых ли-
ний; 

Vertical – выполнение простейших соединений по вертикали на любом 
слое без использовании ПО и с минимальным отклонением от прямых линий; 

'L' Routes (1 via) – формирование пересечения двух проводников и одного 
ПО, имеющего форму буквы L. Проводники располагаются на двух активных 
слоях и имеют противоположную ориентацию (горизонтальную или вертикаль-
ную); 

'Z' Routes (2 vias) – формирование пересечения трех проводников и двух 
ПО, имеющего форму буквы Z. Проводники располагаются на двух активных 
слоях и имеют противоположную ориентацию (горизонтальную или вертикаль-
ную); 

'С' Routes (2 vias) – формирование пересечения трех проводников и двух 
ПО, имеющего форму буквы С. Проводники располагаются на двух активных 
слоях и имеют противоположную ориентацию (горизонтальную или вертикаль-
ную). Трассировка так  
проводни е прямо-

ую в PCAD РСВ. На ней должны бы
 
ить барьеры трассировки Keepout и некоторые проводники

 предварительно размещенные проводники
 по более короткому пути. 

Характер меню настройки стратегии трассировки зависит от вы
т

одов трассировки, выполняемых в следующем порядке: 
 Line Routing – разводка всех широких цепей, имеющих атW

 типа С более гибкая, чем трассировки типа L и Z, 
кам разрешается размещаться на расстоянии более 100 mil вн

 как
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угольника, вершины которого находятся в соединяемых выводах; 
ny Node (2 vias) – попытка провести проводники между любыми узлами 

цепи полной разводки при простановке не более 
двух ПО (на предыдущих проходах проводники разводились из условия мини-
миза

если это физически возможно. Макси-
мальное число ПО в каждой цепи назначают с помощью атрибута MAXVIAS, 
кото трассировка заблокирует 
разводку ряда цепей, то поступают следующим образом: 1) выключают алго-
ритм oute разводят ПП; 2) разводят ряд проводников 
вруч

ny Node (maze) – попытка провести проводники между любыми узлами 
цепи ьным образом); 

oute Cleanup – улучшение внешнего вида ПП (manufacturing). На этом 
прох ятся заново для их спрямления, где это воз-
мож

 эти ПО выводами со штыревыми от-
верс

Т с  Start в меню Quick 
Route ся вид экрана, как показано на рисунке 
8.26.  

A
 для обеспечения наиболее 
 
ции их длины); 
Maze Routes – трассировка типа «лабиринт», способная найти путь для 

оптимальной прокладки проводника, 

рый по умолчанию равен 10. Если лабиринтная 

 Maze и с помощью Quick R
ную с помощью PCAD РСВ; 3) завершают трассировку с помощью Quick 

Route, включив алгоритм Maze; 
A
 с помощью алгоритма «лабиринт» (необязательно оптимал
R
оде часть проводников развод
но; 
Via Minimization – минимизация количества ПО. Если необходимо сохра-

нить расположение ряда предварительно размещенных ПО, следует или не ис-
пользовать данный проход, или заменить

тиями. 
ра сировка начинается после нажатия на клавишу

. При этом одновременно изменяет

 
Рисунок 8.26 – Экран трассировщика Quick Route 

 
По команде Route>Info выводится текущая информация о результатах 

трас  Route>Cancel трассировка прекращается. 

 экране. Сообщение Route 

сировки. По команде
В рабочем окне на экране приводится изображение ПП. После прокладки 

проводника его изображение сразу же появляется на
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com завершении трассировки. Одновременно выводятся дан-
ные бках приведено число 
разв  число цепей, отделенное косой чертой. 

ровки и итоговые данные помещаются в файл протокола, имеющий 
расш LOG.  

 КП и ПО (имеют одну и ту же форму на всех 
слоя

атрибута AUTOROUTEWIDE, допускается толь-
ко од

ущий шаг сетки 
трассировки; 

il, 
20 m

 больше половины шага сетки; 

- 
- лизации. 
Р п ов вне сетки трассировки. Если вывод компонента 

не со а  сетки, то трасса проводника подводится к 
ближа жен короткий сегмент до центра КП. 
Поэт онентов способствуют 
блок уется так располагать 
комп нты ыводы совпадали с узлами сетки. 

мпонентов с планарными выводами. 
Quic oute очтительную ориентацию проводников на 
кажд ыбирается горизон-
таль и вертикальная на 
нижнем (Bottom). Однако это соглашение препятствует трассировке компонен-
тов с планарными выводами. Например, если на верхней стороне ПП размещен 
планарный разъем, ориентированный параллельно нижнему краю ПП, к его 
средним выводам будет очень трудно подвести проводники. Для облегчения 
автоматической разводки компонентов с планарными выводами Quick Route 
генерирует рядом с каждым планарным выводом сквозное ПО (стрингер) и со-
единяет его с ним коротким проводником. После завершения разводки неис-
пользованные ПО автоматически удаляются. 

По умолчан ии КП с тепло-
вым  барьерами. Если же двусторонняя ПП имеет металлизированный нижний 
слой, то на нем применяется непосредственное соединение контактных площа-
док (Direct Connect). 

Выбор сетки трассировки. В Quick Route можно выбрать одну из четырех 
сеток трассировки: регулярные сетки с шагом 25, 20, 12,5 mil и нерегулярная 
сетка 16,7-16,6–16,7 mil. Перед выбором шага сетки и ширины проводников не-

pleted указывает о 
о проценте разведенных цепей. Кроме того, в ско
еденных цепей и общее
Информация о стратегии трассировки, результатах выполнения отдельных 

фаз трасси
ирение имени .
Ограничения Quick Route:  
- разрешены только простые
х), глухие межслойные ПО не допускаются; 
- для цепей, не имеющих 
ин стиль ПО; 
- диаметр ПО не может более чем в два раза превышать тек

- разрешенные размеры сетки трассировки: 12,5 mil, 16,7–16,6–16,7 m
il и 25 mil. Метрическая сетка не разрешается; 
- ширина проводника не может быть
- для ПО нельзя создать специальную сетку; 
выводы компонентов можно повернуть только на 90°; 
допускается не более 4 слоев метал
ас оложение объект
вп дает с узлом выбранной
йшему пути и от него будет проло

ому не совпадающие с узлами сетки выводы комп
ван ассировки. Поэтому рекомендиро ию каналов тр

оне , чтобы все их в
Особенности трассировки ко
 R  позволяет выбрать предпk
ом слое трассировки. Для двусторонних ПП обычно в
ая ориентация проводников на верхнем слое (Тор) н

ию ПО имеют на внутреннем слое металлизац
и
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обходимо выяснить на предприятии, где будет изготавливаться ПП, принятые 
техн

ыполнение предварительных расчетов по выбору сетки и расположение 
комп Если разместить компоненты в сетке с 
шаго  25, 16,7-16,6–16,7 
или 

te сеток разводки, составляет 100 mil. При 
несо
нентов  в узлы сетки разводки, что не позволит достичь наи-
боле

В
шага сетк
обеспечи  нескольких проводников между соседними 
выво ведены рекомендуемые значения максимальных раз-
меров 

 
Табли

Рекомендуемый диаметр, mil 

ологические нормы. 
В
онентов абсолютно необходимо. 
м 50 mil, то возможен выбор шага сетки трассировки
12,5 mil. Наименьший шаг сетки размещения, при которой возможно при-

менение всех имеющихся в Quick Rou
гласованном выбор сеток размещения и разводки многие выводы компо-

 не будут попадать
е высокой степени разводки. 
ыбор размеров контактных площадок. Кроме выбора оптимального 

и размещения компонентов необходимо выбрать размеры КП, чтобы 
ть возможность прокладки

дами. В табл. 3.1 при
КП и ПО для каждого шага сетки трассировки. 

ца 8.1 – Рекомендуемые размеры контактных площадок и ПО 

КП штыревых  

Ширина  
планарных  
выводов, mil 

Шаг сетки, mil 

выводов ПО 

25 62 40 – 
20 50 40 – 

16,7-16,6-16,7 40 40 – 
12,5 54 32 30 

 

оматическом, ин-
тера  наличии пла-
нарн  и 
англий о

К
бессет
совокупн
гон  В от уе-
мым и, в PCAD Quick Route, при бессеточной технологии каждый 
объе

 бессеточной 
технологии – меньшие затраты памяти компьютера. 

Программа Shape-Based Router нацелена на решение глобальных проблем 

 
Бессеточный трассировщик Shape-Based Router 
В программе Shape-Based Router используются принципы оптимизации 

нейронных сетей, и она в основном предназначена для трассировки многослой-
ных ПП с высокой плотностью размещения компонентов в авт

ктивном и ручном режимах; особые преимущества имеет при
ых о х единиц (метрической к мпонентов, выполненных в разных система
ск й). 
роме того, эта программа основана на так называемой Shape-Based, или 
очной технологии. Согласно ей все объекты ПП моделируются в виде 
ости геометрических фигур (прямоугольник, круг, дуга, трасса, поли-
личие от привязанных к сеткам технологиям (Grid-Based), использ).

, в частност
кт моделируется не набором узлов сетки, а геометрически точно, за счет 

чего достигается более плотный монтаж. Характерная особенность
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(100  не позволяет вы-
полнить  трассировки (например, определенную 
цепь ференциальную пару проводников, про-
ложить индивидуальную цепь заданной длины и т. п.).  

 30 слоев, до 4000 ком-
понентов, до 5000 выводов в одном компоненте, до 10 000 цепей и до 16 000 
элек

 и файл исходного проекта, но в 
начале имени выходных файлов добавляется префикс R. 

оенные цепям с помощью атрибутов Width, и тип ПО, установленный по 
умол earance принимается зазор 
Line нейшем изменить). 
Трас ений по команде 
Edit исунке 8.27. 

 %-ная трассировка, минимизация количества ПО и др.) и
 тонкую настройку стратегии

 заключить в экран, провести диф

Shape-Based Router обрабатывает ПП, имеющие до

трических соединений. 
Программа Shape-Based Router может быть вызвана автономно из среды 

Windows (файл SR.EXE) или из меню Route PCAD PCB (команда Autorouters). 
В диалоговом окне вызова этой программы можно только указать имена фай-
лов: исходной ПП в формате PCAD Route File (*.PRF), выходной (оттрассиро-
ванной) ПП в формате PCAD PCB (*.pcb), протокол команд (*.LOG). По умол-
чанию эти файлы получают те же имена, что

В Shape-Based Router передаются из PCAD PCB значения ширины трасс, 
присв

чанию. В качестве глобального зазора Primary Cl
 to Line, заданный для слоя Bottom (его можно в даль

т изменсы, проложенные вручную, защищаются о
 на р>Fix. Экран Shape-Based Router изображен

 
Рисунок 8.27 – Экран программы Shape-Based Router 

 
Настройка стратегии трассировки. По команде Options>Auto-Router 

открывается диалоговое окно настройки стратегии трассировки (рисунок 8.28), 
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имеющее 3 закладки. На закладке Routing Passes в полях Router Passes и Manu-
facturing Passes выбирается тип трассировки: 

Memory – трассировка типа «память»; 
 

а б 

 
в 

Рисунок 8.28 – Диалоговое окно Autorouter Setup: a – закладка Routing Passes,  

ных компонентов; 

 и удаление 

б – закладка Parameters, в – закладка Testpoints 
 

Fan Out User SMD Pins – генерация веерообразно расположенных стрин-
геров для выводов планар

Pattern – трассировка фрагментов ПП с использованием типовых образцов, 
имеющихся в программе (рекомендуется включать всегда); 

Shape Router – Push And Shove – раздвигание и отталкивание ранее про-
ложенных мешающих трасс; 

Shape Router – Rip Up – разрыв и повторная трассировка трасс, проложен-
ных на предыдущих проходах с нарушениями (превышение допустимых зазо-
ров или пересечение на одном слое); 

Clean During Routing – уменьшение количества изгибов трасс
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лиш
Clean A  уменьшение количества  и удаление 

лишних и; 
е 

зги  Routed Corners: под углом 90 
и

uter 
р р

ог
; 

рация веерообразно с вы-
вод кими отрезками трасс (стрингерами); 

ля использования в качестве слоя металли-
заци

ль Analyze Directions выбирает предпочтительное направ-
ление трассировки слоев, имеющих признак Auto. Кроме того, назначаются 
следующие параметры (рис. 3.6, б): 

Units – система единиц величин, отображаемых на экране дисплея (Mils, 
Inches, Centimeters, Millimeters, Microns; на точность трассировки не влияет); 

Via Type – запрет (No Vias), разрешение (Thruhole Only) использования 
ПО; 

Via under SMD – запрет (No), разрешение (Yes) размещения ПО под КП 
планарных компонентов; 

Channel Size – размер канала трассировки, равный сумме ширины трассы 
Primary Trace Width и допустимого зазора Primary Clearance. Это значение мо-
жет быть изменено; для выполнения бессеточной трассировки назначается 
1 mil и менее. 

Primary Pad Size – диаметр большинства КП выводов штыревых компо-
нентов. Если штыревых компонентов нет, то этот параметр равен наибольшему 
размеру КП планарных компонентов (используется при расчете Channel Size); 

Primary Via Width – диаметр ПО, выбранного в PCAD РСВ в качестве ПО 
по умолчанию; 

Primary Trace Width – ширина большинства трасс ПП (устанавливается 
программой на основе анализа таблицы цепей меню команды Edit>Net; исполь-
зуется при расчете Channel Size и прокладке трасс, которым в PCAD  не 
был назначен атрибут Wi

Primary Clearance –  между любыми объек-

них ПО в процессе трассировки; 
fter Routing – изгибов трасс

 ПО после трассировк
Evenly Space Traces – равномерно
Add Testpoints – вставка контрольных

распределение трасс; 
 точек. 

бов трассВ поле Options выбирается тип и
ли 45°. 

На закладке Parameters в поле Ro
ают предпочтительную ориентацию т

Direction для каждого слоя ПП выби-
асс из следующего перечня: 
рамме; Auto – предоставление выбора пр

Disable – запрет для трассировки
Fan Out – гене расположенных ПО, соединенных 
ами планарных компонентов корот

Plane – резервирование слоя д
и; 
Vertical – вертикальная; 
Horizontal – горизонтальная; 
1 o'clock, 2 o'clock, 4 o'clock, 5 o'clock, 45/, 45\\ – выбор одной из ориента-

ции (разрешается для многослойных ПП); 
Any Direction – отказ от прокладки трасс определенной ориентации (раз-

решается для многослойных ПП). 
ажатие на панеН

 РСВ
dth); 
минимально допустимый зазор
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тами

ной трассировки.  

 опция Add Testspoints. 

, т.е. Track to Track, Track to Pad, Track to Via, Via to Pad (устанавливается в 
PCAD PCВ, но может быть изменен). 

Для облегчения доработки ПП после ее трассировки рекомендуется не из-
менять значение Channel Size, рассчитанное программой. Бессеточная трасси-
ровка (с шагом сетки 1 mil и менее) целесообразна в проектах, имеющих боль-
шое разнообразие значений ширины трасс и зазоров. При использовании значе-
ния Cannel Size, установленного программой, нет разницы между качеством се-
точной и бессеточ

На закладке Testpoints (рисунок 8.28, в) устанавливается приоритет разме-
щения контрольных точек (КТ), размещаемых на ПП, если на закладке Routing 
Passes отмечена

По команде Edit>Net Attributes открывается диалоговое окно (рисунок 
8.29) задания атрибутов всем цепям проекта: 

 
Рисунок 8.29 – Диалоговое окно Net Attributes 

 
Display – разрешение (True) или запрет (False) отображения цепи; 
Routing Priority – приоритет трассировки (Default, 1, 2, ..., 20); 
Length Minimize (минимизация длины трассы цепи); 
Route Action (тип трассировки); 
Routing Layer (слой трассировки); 
Width – ширина трассы. По умолчанию указывается значение, равное па-

раметру Primary Trace Width; однако оно может быть изменено (выбрано из 
предлагаемого набора или введено самостоятельно). 

Перед выпо  статистически-
ми данными о ПП по команде Reports>Pre-Route Synopsis для внесения при 
необ

лнением трассировки полезно ознакомиться со

ходимости коррекции в исходную ПП или стратегию трассировки. Полез-
ная информация о плотности связей ПП может быть получена также по коман-
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де View>Density. 
Автотрассировка всей ПП начинается по команде Tools>Start Autorouter 

. Интерактивная трассировка выполняется по другим командам меню Tools: 
AutoRoute Connection , AutoRoute Net , AutoRoute Component , 
AutoRoute Area . Ручная прокладка трассы выполняется по команде Manual 
Route . С помощью команды Tools>Sketch Route курсором рисуется при-
мерное расположение трассы выбранной цепи, которая прокладывается затем 
автоматически. 

 

По завершении трассировки по командам Reports>Routing Statistics,  
Reports>Reports можно просмотреть итоговые отчеты. 

Возвращение в PCAD РСВ после трассировки производится по команде 
File>Save and Return. 
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ЧАСТЬ 2. ВЕСЕННИЙ СЕМЕСТР 
 
1 ГЕО  
 
1.1 К торского проектирования 

 

 
Рисунок 1.2 – Классификация задач геомаетрического проектирования 

МЕТРИЧЕСКОЕ МОДЕЛИРОВАНИЕ В САПР

лассификация задач конструк

 
Рисунок 1.1 – Классификация задач конструкторского проектирования 

 

Задачи  
конструкторского 
проектирования 

 
Топологическое  
проектирование 

 
Геометрическое  
проектирование 

 
Топологический  

синтез 

 
Топологический  

анализ 

 
Геометрический 

синтез 

 
Оформление 

КД 

 
Геометрическое  
моделирование 

Геометрическое  
проектирование  

 
Геометрический  

синтез  
 

Оформление  
КД  Геометрическое  

моделирование  

Синтез геомет-
рических объек-  тов

Синтез  
формы   изделия

Позиционные 
задачи  Метрические 

задачи  

Текстовые 
документы  

 

Графические
документы  
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1.2 Геометрический синтез 
 

1) Синтез геометрических объектов: 
Формирование (компоновка) сложных геометрических объектов (ГО) и 

элементарных ГО заданной структуры 
 
Основной критерий – точность воспроизведения 
 
2) Синтез формы изделия: 
Получение рациональной или оптимальной формы деталей, узлов и т.п., 

влияющей на качество функционирования объектов конструирования 
 
Используется на ранних стадиях проектирования изделий 
 
 
1.3 Геометрические модели 
 

Геометрическая модель – совокупность сведений, однозначно  опреде-
ляющих форму геометрического объекта 

• Списки; 

мление КД 

жающих

 

Формы представления: 
• Совокупность уравнений линий и поверхностей; 
• Алгебраические соотношения; 
• Графы; 

• Таблицы; 
• Описания на специальных графических языках 

 

Применение геометрических моделей: 
• Описание геометрических свойств объекта (форма, расположение в 

пространстве); 
• Решение геометрических задач (позиционных и метрических); 
• Преобразования формы и положения геометрических объектов; 
• Ввод графической информации; 
• Офор

 

Виды геометрических моделей 
1. Аналитические  
Представляются уравнениями, описывающими контуры или поверхности 
Служат для описания примитивов и составных объектов 
2. Алгебраические 
Геометрический объект описывается логической функцией условий, выра-

 принадлежность точки какой-либо области 
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3. Канонические 
Представляются уравнениями в каноническом виде 
4. Рецепторные 
Приближенное представление объекта в плоскости или пространстве ре-

цепторов 
5. Каркасные 
Представляются каркасами геометрических  фигур 
6. Кинематические 
Параметрическая  форма записи для описания объектов (простые модели – 

пове вр

 
Жизненный цикл изделий производства (рисунок 1.3): 
 

рхности ащения и т.п.) 
7. Макромодели 
Математическое описание типовых геометрических фигур 
 
 
1.4 Комплексный подход к автоматизированному проектированию 
 

Принципы системного подхода:  
• Рассмотрение частей сложной системы с учетом их взаимодействия 
• Выявление структуры системы 
• Типизация связей 
• Определение атрибутов 
• Анализ влияния внешней среды 

 

По комплексности автоматизации проектирования.  
1) одноэтапные; 
2) многоэтапные; 
3) комплексные (все этапы) 

Проектирование

Конструирование
Изготовление Эксплуатация

Потребность

Ремонт

Утилизация

 
Рисунок 1.3 – Жизненный цикл изделий производства 
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1.5 Автоматизированные CAD/CAM/CAE/PDM комплексы 
 

Классификация пакетов САПР: 
1) САПР нижнего уровня (CAD) (AutoCAD, Компас ..) 
2) САПР среднего уровня (CAD/CAM)(T-FLEX CAD, SolidWorks, Техно-

Про, Autodesk Mechanical Desktop ..) 
3) САПР высокого уровня (CAD/CAM/CAE/PDM) (Pro/Engineer, T-FLEX..) 
 

1. Программы CAD: 
• программное обеспечение для создания чертежей и трехмерных моде-

лей, а также программы для инженеров-технологов (составление тех-
нологических процессов) 

 

2. Программы CAM: 
• программное обеспечение для  автоматического и полуавтоматиче-

ского создания и редактирования управляющих программ для станков 
с ЧПУ, а также ПО для передачи управляющих программ на станки с 
ЧПУ. 

 

3. Программы CAE: 
• программное обеспечение для  инженерных расчетов. ПО для общих 

и специализированных расчетов. 
 

4. Программы PDM: 
• программное обеспечение для  ведения документооборота, создания и 

управления архивами чертежей, а также ПО для работы со сканиро-
ванными документами технического назначения.. 

 

CIM (COMPUTER INTEGRATED MANUFACTURING) –  системы, обес-
печивающие  автоматизацию всего жизненного цикла изделия, начиная с задач 
маркетинга, продолжая проектированием и производством, завершая сбытом 
продукции, сервисным обслуживания и утилизацией изделий 

 

CALS-технологии – путь к комплексной автоматизации  
• Объединение в едином комплексе задач 1-4 
• «поддержка жизненного цикла» изделия 
• «повышение конкурентоспособности за счет сокращения затрат, со-

кращения сроков вывода новых образцов на рынок, повышения каче-
ства продукции за счет сквозной поддержки ее жизненного цикла» 

 

Например 
 T-FLEX CAD 2D, T-FLEX CAD 3D, T-FLEX DOCs, T-FLEX Технология, 

T-FLEX ЧПУ 2D, T-FLEX ЧПУ 3D, T-FLEX Анализ – одно целое. 
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2 СИСТЕМА АВТОМАТИЗИРОВАННОГО ПРОЕКТИРОВАНИЯ  

AUTOCAD 2000/2000I/2002/2004 
 
 

2.1 Назначение и возможности САПР AutoCAD 
 

AutoCAD (Automated Computer Aided Design - автоматизированное компь-
ютерное проектирование) – универсальная система автоматизированного про-
ектирования (САПР) фирмы Autodesk (США), предназначенная для разработки 
двухмерных чертежей и рисунков, а также разработки и моделирования каркас-
ных, полигональных (поверхностных) и объемных (твердотельных) конструк-
ций в различных областях человеческой деятельности (техника, строительство 
и архитектура, швейное производство и т.п.). 

 

Чертежи (рисунки) системы AutoCAD хранятся в файлах с расширением: 
dwg. 

 

Основные функции графического редактора  
1.  Создание новых чертежей и сохранение их на диск. 
2.  Редактирова
3.  Вывод чертежей на плоттер, принтер. 

дства, 
позволяющих управлять слоями, стилями и т.п. (Начиная с AutoCAD 2002) 

8.  Возможность расширения и специализации системы: 
            - встроенный компилятор языка AutoLISP; 
            - средства разработки приложений на языке программирования СИ 
9.  Использоваться в локальном или сетевом варианте (Начиная с 

AutoCAD 2002) 
10. Работать с двумя мониторами: один — для выдачи запросов на ввод 

команд и вывод текстов, а второй — для выполнения линий построения и ре-
дактирования чертежей 

 

Основные особенности САПР AutoCAD 2004 
- Выполнена внешняя и внутренняя интеграция системы AutoCAD с опе-

рационной системой Windows XP (Professional Edition и Home Edition). 
- Введен новый, более компактный DWG-формат, который позволяет про-

сматривать растровые образцы DWG-файлов в проводнике Windows, а также 
защищать пар

- Появился  инстру-
мент з

ние существующих чертежей. 

4.  Преобразование чертежей, созданных предыдущими версиями редак-
тора. 

5.  Восстановление испорченных чертежей. 
6.  Формирование электронного архива чертежей и "библиотек стандарт-

ных элементов" 
7.  Контроль стандартов предприятий с помощью специальных сре

олем и цифровой подписью файлы рисунков. 
 новый элемент интерф йса — Tool Palettes (Палитрые

ов), который дает возможность быстрого доступа к часто исполь уемым 
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элементам пользователя (блокам, штриховкам и заливкам). 
- Появилась немодальная форма окон Properties (Свойства), Design Center 

(Центр управления), которые сворачиваются и легко раскрываются. 
- Добавлена возможность расширения графического экрана. 
- Введены новые панели Styles (Стили) и Draw Order (Порядок следова-

ния). 
- Список Layers (Слои) и кнопки операций над слоями выделены из панели 

инструментов Properties (Свойства) и стали самостоятельной панелью. 
- Количество используемых цветов увеличилось с 256 до 16 миллионов. 
- Появилась возможность печати раскрашенных и тонированных видовых 

экранов. 
- Введена возможность настройки строки режимов (убирать ненужные 

кнопки и восстанавливать нужные).  
- Значительно улучшены средства создания и редактирования многостроч-

ных текстов (в частности, введены позиции табуляции). 
- Появились градиентные заливки. 
- Улучшился механизм работы с файлами внешних ссылок. 
- Появилась возможность более тонкой настройки функций правой кнопки 

мыши, в зависимости от продолжительности щелчка. 
- Для инсталляции AutoCAD 2004 не требуется удалять с компьютера пре-

дыдущую версию Au
- Система AutoCAD 2004 не может быть установлена в среде операцион-

ной 

 рассчитан на них. Дилеры Autodesk не принимают по ним вопросов. 
Начи

ания к ком-
пьют

а стала очень удобным "элек-
трон

ого тва  A  ф

toCAD (2002 или более раннюю). 

системы Windows 95. 
- AutoCAD 2004 работает в операционной системе Windows 98 с предвари-

тельно установленным Internet Explorer 6.0 и, видимо, в Windows Me, хотя офи-
циально не

ная с AutoCAD 2004 фирма Autodesk полностью прекращает поддержи-
вать в своих продуктах платформу Windows 98, 98SE, Me. 

- AutoCAD 2004 работает в операционных системах: Windows 2000;  
Windows XP (Professional Edition);  Windows XP (Home Edition); Windows NT 
4.0 (с обновлением Service Pack 6a или более поздним). 

 

Требования к компьютеру 
Требования к компьютеру различны в зависимости от версии программно-

го обеспечения. Для каждой более поздней версии AutoCAD требов
еру ужесточаются.  
Система AutoCAD 2004 может использоваться в локальном или сетевом ва-

рианте. Для ее нормального функционирования требуется получить специаль-
ный код авторизации от фирмы Autodesk. Первые версии AutoCAD содержали в 
основном инструменты для простого двумерного рисования, которые постепен-
но дополнялись и развивались. В результате систем

ным кульманом". На рисунке 2.1 приведен пример двумерного чертежа, 
сделанн  сравнительно простыми средс ми utoCAD. Для ормирования 
такого чертежа не требуется работа с трехмерной моделью изделия.  
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Таблица 2.1 – Требования к компьютеру 

AutoCAD 2000 AutoCAD 2004 

- процессор не хуже Р 133,  
- рекомендуемый объем памяти – 64 

Мб (минимальный – 32 Мб),  
- жесткий диск – не менее 130 Мб сво-

бодного пространства,  
(50 Мб свободного дискового про-

странства в системном каталоге, не ме

- компьютер н же Pentium III с процес-
сором 500 МГц,  

-  рекомендуемый объем памяти – 256 
Мб,  

-  жесткий диск –  2 Гб;  
на винчестере надо иметь свободными 

нее 
б в файле подкачки) 

Система проектирования занимает по-
рядка 150–190 Мб (в зависимости от ва-
рианта установки).  
Необходимо наличие мыши, монитор 

SVG

350Мб под программное обеспечение и не 
менее 250 Мб для временных файлов 

 
Необходимо наличие мыши, монитор 

SVGA с разрешением не хуже 800x600 

64 М

е ни

A с разрешением не хуже 800x600 
 

Большим преимуществом системы AutoCAD, как средства рисования, яв-
ляется возможность последующего формирования электронного архива черте-
жей. Каждый из созданных таким образом файлов рисунков легко редактирует-
ся, что позволяет быстро получать чертежи-аналоги по чертежам-прототипам. 
В качестве средств защиты от несанкционированного доступа в файлах рисун-
ков, созданных системой AutoCAD 2004, предусмотрены пароли и электронные 
цифровые подписи.  

 

 
 

Рисунок 2.1 – Двумерный чертеж 
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Для облегчения процесса выпуска проектной документации можно разра-
батывать "библиотеки стандартных элементов". В качестве стандартных эле-
ментов могут выступать как целые файлы, так и их отдельные части. Эта идея 
стала хорошим стимулом для создания на базе системы AutoCAD локальных 
рабочих мест по различным конструкторским, архитектурным и другим на-
правлениям, а также для разработки новых специализированных систем. Мощ-
ным дополнением к этому является возможность использования языков про-
грам

включены специальные средства для 
конт

любой плоскости пространства и отобразить их на 
разных видовых экранах с различных точек зрения. Поэтому она стала также 
инст ия. Механизм пространства листа и 
видо тывать чертежи с проекциями трех-
мерных

мирования.  
Начиная с AutoCAD 2002, в систему 
ролирования стандартов предприятий, позволяющих управлять слоями, 

стилями и т. п.  
Уже десятая версия AutoCAD позволяла выполнить достаточно сложные 

трехмерные построения в 

рументом и трехмерного моделирован
вых экранов дал возможность разраба

 объектов или сооружений. В системе AutoCAD по одной модели можно 
получить несколько листов чертежного документа. На рисунке 2.2 приведен 
пример чертежа, сформированного как отображение проекций и сечений трех-
мерного объекта.  

 
 

Рисунок 2.2 – Чертеж части устройства дверного замка 

Н дна, являющаяся основой для 
пос е ирования чертежа и построения контуров деталей. Степень 

 
 показана модель корпуса суа рисунке 2.3

л дующего форм
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про а ожность и насыщенность такой модели могут быть 
раз на будет в дальнейшем использована.  

 

р ботанности, а также сл
ными и определяются тем, как о

 
 

Рисунок 2.3 – Трехмерная модель платформы 
 
 

2.2 Пользовательский интерфейс 
 

Итак, вы установили систему AutoCAD 2004 и готовы начать работу. За-
пуск системы осуществляется с помощью двойного щелчка левой кнопки мыши 
по ярлыку , расположенному на рабочем столе. Другой способ запуска — 
использование меню Пуск (Start) рабочего стола Windows (Пуск | Программы | 
Autodesk | AutoCAD 2004 | AutoCAD 2004).  

Сразу после старта системы открывается стандартное диалоговое окно 
Startup (Начало работы), ь режим работы. В сис-
темах AutoCAD 2000i и AutoCAD 2002 ыл другой вариант начала — диалого-
вое 

в котором необходимо выбрат
б

окно AutoCAD Today (Проектный центр), который был доступен помимо 
стандартного. В рассматриваемую версию системы AutoCAD этот вариант не 
включен.  

В диалоговом окне Startup (Начало работы) пользователю необходимо 
подвести указатель мыши к одной из больших кнопок с режимами начала рабо-
ты, изображенных в верхней части окна:  
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• Open a Drawing (Открытие рисунка); 

• Start from Scratch (Простейший шаблон); 

• Use a Template (По шаблону); 

• Use a Wizard (Вызов мастера). 
Затем следует щелкнуть левой кнопкой мыши. После этого выбранная ва-

ми большая кнопка изменит свое состояние на "нажатая", а содержимое текста 
надписи, расположенной в правой верхней части , модифицируется на на-
звание кнопки. Для за ном остается только 
щелкнуть левой кнопкой мыши по кнопке К.  

лон). Этот режим предлагается по умолчанию. В нем создается новый 
пустой чертеж с минимумом установок. Пользователю только нужно отметить, 
в каких единицах измерения он будет работать: Imperial (feet and inches) (Анг-
лийские (футы и дюймы)) или Metric (Метрические). Второй вариант, конечно, 
в этом случае для нас предпочтительнее.  

При выборе режима Use a Template (По шаблону) пользователь имеет воз-
можность начать работу не с нуля, а с каким-то наполнением нового рисунка 
(это могут быть рамки, штампы и какие-то другие линии или установки).  

Режим Use a Wizard (Вызов мастера) дает возможность вызвать одну из про-
грамм-мастеров настройки нового рисунка. Будем считать, что студент для перво-
го раза воспользуется режимом по умолчанию Start from Scratch. В открывшемся 
окне (рисунок 2.4) разберем элементы оформления рабочего окна AutoCAD.  

Центральная часть экрана — это основная рабочая зона, в которой нахо-
дится видимая часть рисунка (остальные его части могут находиться выше, 
правее, ниже и левее). При движении курсора по этой части, которую мы будем 
называть далее графическим экраном, он (курсор) имеет вид перекрестия с 
квадратной мишенью в точке пересечения (на рис. 2.4 — обозначен номером 
12). Длина линий перекрестия настраивается с помощью системной переменной 
CURSORSIZE. 

В левом нижнем углу графического экрана находится знак осей системы 
координат (обозначенный цифрой 4). При необходимости знак может ь на-
строен или 

Верхнюю ), Edit 
(Пра t )

строка содержит 
наим

 окна
вершения работы с диалоговым ок

 О
Если вам необходимо создать новый пустой рисунок, то в окне Startup 

(Начало работы) нужно воспользоваться кнопкой Start from Scratch (Простей-
ший шаб

быт
приведен к виду, который он имел в AutoCAD 2000.  

 строку экрана (1), состоящую из надписей: File (Файл
вка), View (Вид), Insert (Вставка), Forma  (Формат), Tools (Сервис , Draw 

(Рисование), Dimension (Размеры), Modify (Редакт), Express (Экспресс), Window 
(Окно), Help (Справка) — будем называть строкой меню. Эта 

енования падающих меню, раскрыть любое из которых можно, выбрав с 
помощью мыши соответствующее имя меню.  
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Рисунок 2.4 – Элементы пользовательского интерфейса: 1 —строка меню, 2 — панели инст-
рументов, 3 — панель Tool Palettes, 4 — пиктограмма осей координат, 5 — кнопки показа 
списка вкладок, 6 — вкладка пространства модели, 7 — вкладки листов, 8 — строка состоя-
ния со счетчиком координат, 9 — кнопки режимов, 10 — Communication Center, 11 — зона 
командных строк, 12 — курсор, 13 — линейки прокрутки, 14 — кнопки управления окном 

документа 
 

Графический экран снизу обрамляют кнопки вкладок Model (Модель) (эле-
мент 6), Layout 1 (Лист!) и Layout 2 (Лист2) (элементы 7). Вкладки используются 
при переключении между пространствами модели и листа (см. гл. 10). По умол-
чанию активной является вкладка Model (Модель). Треугольные кнопки (5) слева 
от имен вкладок позволяют передвигаться по списку вкладок в обоих направле-
ниях (аналогично движению по списку листов в книге Microsoft Excel). 

Справа от вкладок расположена горизонтальная линейка прокрутки для 
графического экрана. Вертикальная линейка прокрутки расположена по правой 
границе графического экрана. Обе линейки прокрутки на рис. 2.4 обозначены 
номером 13.  

Нижняя часть экрана (11), в которой вы на рис. 2.4 видите приглашение в 
форме Command: (Команда:) — это область, через которую в основном с-
ходит диалог пользователя с системой, десь отображаются вводимые вами ко-
манды и ответы ( зывать зоной ко-
мандных строк. Последняя строка, содержащая приглашение Command: (Ко-
манд

прои
з

или вопросы) AutoCAD. Эту часть будем на

а:), называется командной строкой.  
Ниже от зоны командных строк находится строка состояния (8), в которой 
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расположены счетчик координат и прямоугольные кнопки режимов (9): SNAP 
(ШАГ), GRID (СЕТКА), ORTHO (OPTO), POLAR (OTC-ПОЛЯР), OSNAP 
(ПРИВЯЗКА), OTRACK (ОТС-ПРИВ), LWT (ВЕС), MODEL (МОДЕЛЬ). Счет-
чик координат служит для ориентировки на поле чертежа — он изменяет свое 
трехкоординатное значение при движении указателя мыши по графическому 
экрану. Счетчик может быть отключен с помощью функциональной клавиши 
<F6>. Нажатием на ту же клавишу счетчик можно снова включить. Другой спо-
соб включения и выключения счетчика — щелчок левой кнопкой мыши по 
строке счетчика.  

Кнопка (10), появившаяся только в версии AutoCAD 2004, предназначе-
на для вызова диалогового окна Communication Center (Центр связи), которое 
дает

Все панели инструментов в системе AutoCAD 2004 оформлены в стиле 
Windows XP (с использованием серо-голубой гаммы цветов). Если вы подведе-
те курсор к какой-нибудь пиктограмме любой панели, то пиктограмма сразу 
примет форму прямоугольной кнопки, а через несколько мгновений под указа-
телем появится всплывающая подсказка с наименованием команды или функ-
ции AutoCAD, выполняемой с помощью этой кнопки. На рис. 2.5 показана под-
сказка, появляющаяся при положении верхней точки указателя мыши над 
кнопкой команды LINE (ОТРЕЗОК).  

 возможность при наличии соединения с Интернетом оперативно получать 
сведения об обновлениях, выпущенных фирмой Autodesk. Работа с этим окном 
рассматривается в приложении 3.  

Основным элементом пользовательского интерфейса являются кнопки па-
нелей инструментов. Четыре горизонтальные панели на рис. 2.4 находятся ниже 
строки меню. Еще две вертикальные панели находятся слева от графического 
экрана. 

 
 

Рисунок 2.5 – Всплывающая подсказка 
 
Одновременно  информация к 

команде Creates s нейные отрезки: 
ОТРЕЗОК). 

Шесть панелей, которые показаны на рис. 2.4, находятся в фиксированном 
положении. При желании можно перенести их внутрь графического экрана, где 
они займут "плавающее" положение, принимая одновременно форму окон 
Windows (рисунок 2.6). Для этого нужно аккуратно подвести указатель мыши к 
краю панели (но не задевая кнопок инструментов!), нажать левую кнопку мы-
ши и, не отпуская ее, перетащить панель на свободное место экрана, после чего 
отпустить левую кнопку.  

В плавающем положении панели могут принимать разную форму, которую 

 в строку состояния выводится справочная
traight line segments: LINE (Создает прямоли
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можно изменять, растягивая их за углы. Для перемещения панели на новое место 
следует перетащить ее с помощью мыши за синюю область с наименованием. 
Перемещение панели на один из четырех краев графического экрана позволяет 
вернуть ее к фиксированному положению. Таким образом, пользователь может 
сам найти для себя наиболее удобный способ расположения и формы панелей.  

На рисунках 2.4, 2.6 под строкой меню видны четыре горизонтальные па-
нели с наименованиями: Standard (Стандартная) (в первом ряду сверху), Layers 
(Слои) и Styles (Стили) (во втором ряду сверху) и Properties (Свойства) (в 
третьем ряду сверху). Эти панели желательно не трогать, не удалять и не пере-
мещать, поскольку они постоянно нужны для работы. По сравнению с преды-
дущими версиями в системе AutoCAD 2004 появилась новая панель Styles 
(Стили), а панель Object Properties (Свойства объектов) разделилась на панели 
Layers (Слои) и Properties (Свойства).  

Две панели, вертикально расположенные на рисунке 2.4, называются Draw 
(Рисование) и Modify (Редактирование). 

Для вызова панелей на экран и удаления их с экрана имеются специальные 
средства. Подведите курсор к имени падающего меню View (Вид) и нажмите 
левую кнопку адет) внутрь 
графического экрана (рисунок 2.7). Затем опустите указатель мыши на нижнюю 
строку Toolbars (Панели) и нажмите левую кнопку мыши (в дальнейшем выбор 
любых элементов экрана будем делать только с помощью щелчка левой кнопки 
мыши, правая же кнопка обычно вызывает какое-нибудь контекстное меню, о 
которых речь пойдет дальше). Многоточие после наименования пункта Toolbars 
(Панели) означает, что после выбора этого пункта меню будет вызвано диало-
говое окно, в котором следует ввести какие-то параметры и ответить на пред-
ложенные вопросы.  

 мыши. Выбранное падающее меню откроется (вып

 
 

Рисунок 2.6 – Плавающее положение панели инструментов Modify 
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Рисунок 2.7 – Вызов падающего меню View 
 

Появившееся диалоговое окно Customize (Адаптация) (рисунок 2.8) при вы-
боре вкладки Toolbars (Панели) показывает в левом вертикальном списке все име-
на панелей, которые доступны в данной версии системы AutoCAD. Пролистыва-
ние всего списка осуществляется с помощью вертикальной линейки прокрутки. 
При установленном флажке в квадрате перед именем панели, панель будет нахо-
диться на экране, при отсутствии этого флажка панели на экране не будет.  

 
Рисунок 2.8 – Диалоговое окно Customize (вкладка Toolbars) 

 
Установите с помощью левой кнопки мыши флажок возле панели 
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Dim Размеры) и снимите его около панели Draw (Рисование). После это-
го в raw (Рисование) исчезнет, а панель 
Dim

ension (
ертикально расположенная панель D
ension (Размеры) появится на экране (рисунок 2.9).  

 
 

Рисунок 2.9 – Добавленная панель Dimension 
 

Закройте диалоговое окно Customize (Адаптация) с помощью кнопки Close 
(Закрыть). Далее новую панель можно известным нам способом перетащить на 
удобное место экрана. Аналогично добавляются любые другие панели инстру-
ментов.  

Если нужно вызвать на экран только одну панель или только одну панель 
убрать с экрана, то следует воспользоваться контекстным меню. Контекстные 
меню вызываются ние контекстного 
меню зависит от двух  какая-нибудь ко-
манд

текстное меню содержит перечень всех панелей, а также 
пунк

по щелчку правой кнопки мыши. Содержа
 условий: работае  ли в данный моментт

а системы AutoCAD и где в данный момент находится курсор мыши. Под-
ведите указатель мыши к какой-нибудь из находящихся на экране панелей ин-
струментов, например, к расположенной горизонтально панели Standard (Стан-
дартная), и щелкните правой кнопкой мыши. В том месте, где находится кур-
сор, у вас должно появиться контекстное меню работы с панелями.  

Появившееся кон
т Customize (Адаптация) для вызова диалогового окна, приведенного на 

рис. 2.8. Если слева от имени панели стоит символ "галочка", то эта панель уже 
находится на экране. Щелчок левой кнопки мыши по наименованию панели 
изменяет ее состояние на противоположное (т. е. убирает, если она была на эк-
ране, или выводит на экран, если ее там не было).  

Удалить панель с экрана можно также щелчком по кнопке (эта кнопка 
видна, когда панель находится в плавающем положении).  
Новым элементом пользовательского интерфейса в системе AutoCAD 2004 яв-
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ляется панель Tool Palettes (Палитры инструментов), которая на рисунке 2.4 
обозначена цифрой 3. Вызов этой панели на экран и убирание ее с экрана осу-
ществляется щелчком левой кнопки мыши по кнопке панели инструментов 
Standard (Стандартная), а также с помощью комбинации клавиш <Ctrl>+<3> (т. 
е. при нажатой клавише <Ctrl> нажать клавишу с цифрой 3 и затем обе клави-
ши отпустить). Панель Tool Palette  (Палитры инструментов) предназначена
для быстрого вызова таких наиболее употребительных элементов оформления 
чертежа, как штриховки и блоки.  

s  

Операциям расширения и восстановления экрана соответствуют новые ко-
манды CLEANSCREENON и CLEANSCREENOFF (в момент написания данной 
книги русские аналоги этих команд были не известны). 

 
 
2.3 Способы ввода команд 
 

Система AutoCAD создана для интерактивной работы пользователя. Весь 
диалог с системой идет на языке команд. Самый простой способ ввода команд 
— это набор их на клавиатуре в командной строке в ответ на приглашение 
Command: (Команда:). Наименования команд в англоязычной версии вы можете 
вводить в латинском регистре (верхнем или нижнем). Если же вы работаете в 
русскоязычной версии, то можно пользоваться русскими именами команд или 
английскими, но предваренными знаком подчеркивания (так, например, в рус-
скоязычной версии команду ОТРЕЗОК можно заменить командой _LINE). 

Команда LINE (ОТРЕЗОК) для рисования отрезков может быть введена в 
английской версии AutoCAD с клавиатуры любым из следующих пособов.  

•  LIN
•  Line  
• 

На рис. 2.4 номером 14 обозначены кнопки управления окнами докумен-
тов. Для системы AutoCAD каждый рисунок является графическим докумен-
том. Каждый документ имеет собственное окно, которое размещается внутри 
графического экрана. Упомянутые кнопки позволяют выполнять с активным 
документом такие операции, как сворачивание, восстановление и закрытие.  

Еще одним новым интересным инструментом управления пользователь-
ским интерфейсом является пункт Clean Screen (Очистка экрана) падающего 
меню View (Вид). С помощью этого пункта можно увеличить рабочую зону 
графического экрана за счет временного удаления панелей, заголовка окна 
AutoCAD и лотка рабочего стола Windows. В таком состоянии пользователю 
остаются доступными падающие меню.  

Повторный выбор пункта Clean Screen (Очистка экрана) возвращает окно 
системы AutoCAD к обычному виду (с панелями). Для быстрого переключения 
между этими состояниями графического экрана можно пользоваться комбина-
цией клавиш <Ctrl>+<0>.  

 с
E 

 line 
•  liNE 
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Кроме того, в английской версии обычно допускается и форма команды с 
символом подчеркивания (_LINE, _line). После набора команды на клавиатуре 
не з

 на-
жата

el> (удаляет символ справа от курсора), 
<Bac

оту, мож-
но, н

 и ни в коем случае не записы-
вать их в основные и вспомогательные папки AutoCAD, иначе такие файлы бу-
дут не только засорять программное обеспечение, но и при смене версии или 
при

 
File 

•  Partial Load (Частичная загрузка) 
•  Save (Сохранить) 
• 
•  комплект) 
• Публикация в Интернете) 
• 

• 

абудьте нажать клавишу <Enter>, поскольку она является для системы 
AutoCAD указанием начать обработку команды. Пока клавиша <Enter> не

, вы можете отредактировать набранный в командной строке текст, ис-
пользуя клавиши <->>, <<->, <D

kspace> (удаляет символ слева от курсора).  
Другим способом ввода команд является выбор соответствующих пунктов 

меню или кнопок панелей инструментов.  
Если в ответ на запрос Command: (Команда:) нажать клавишу <Enter>, то 

AutoCAD повторит вызов предыдущей команды.  
Прервать выполнение любой команды, уже начавшую свою раб
ажав клавишу <Esc>. 
 
 
2.4 Операции с файлами рисунков  
 

Чертежи (рисунки) системы AutoCAD хранятся в файлах с расширением 
dwg (формат, в котором записывается графическая информация в этих файлах, 
называется DWG-форматом). Имена файлов могут содержать русские и латин-
ские буквы, цифры, специальные знаки (@, #, $, &, _, -), а также пробелы. Ос-
тальные символы (точки, запятые и т. п.), как правило, не допускаются, по-
скольку являются служебными и могут быть неправильно интерпретированы 
операционной системой Windows. Для удобства работы желательно пользова-
тельские чертежи хранить в отдельных папках

 переинсталляции системы AutoCAD могут быть потеряны.  
Операции над файлами и некоторые другие собраны в падающем меню
(Файл) 

•  New (Новый) 
•  Open (Открыть) 
•  Close (Закрыть) 

 Save As (Сохранить как) 
 eTransmit (Сформировать
 Publish to Web (
 Export (Экспорт) 

•  Page Setup (Параметры листа) 
 Plotter Manager (Диспетчер плоттеров) 

•  Plot Style Manager (Диспетчер стилей печати) 
•  Plot Preview (Предварительный просмотр) 
•  Plot (Печать) 
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•  Publish (Публикация) 
•  Drawing Utilities (Утилиты) 
• 

) 

 рисунок по простейшему 
шабл

е похоже на окно Startup (Начало работы), но в нем 
недо

не будет, а 
сист

 Send (Переслать) 
•  Drawing Properties (Свойства рисунка) 
•  Exit (Выход
Пункт New (Новый) падающего меню выполняет команду AutoCAD NEW 

(НОВЫЙ), которая создает в рабочей области новый
ону или по специальному шаблону — согласно выбору пользователя. При 

этом вызывается диалоговое окно Create New Drawing (Создание нового рисун-
ка) (рисунок 2.10), которо

ступна кнопка открытия существующего файла. Следует заметить, что 
можно настроить AutoCAD таким образом, что это окно вызываться 

ема сразу же создаст новый рисунок с простейшими установками.  
Такую же операцию создания нового рисунка выполняет кнопка панели ин-
струментов Standard (Стандартная), которая соответствует команде QNEW 
(БНОВЫЙ).  

 
 

Рисунок 2.10. Падающее меню File 
 

Система AutoCAD 2004 поддерживает многодокументный режим, поэтому 
в одном сеансе работы с AutoCAD можно иметь открытыми сразу несколько 
рисунков. Каждый из них оформляется как отдельное окно Windows.  
Используя кнопки сворачивания и восстановления окон (элемент, обозначен-
ный номером 14 на рис. 2.4), которые находятся в правой верхней части, вы 
можете расположить рисунки так, как вам будет удобно. В этом вам помогут 
также команды операций над окнами, включенные в падающее меню Window 
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(Окно) (рисунок 2.11):  

 
 

Рисунок 2.11 – Падающее меню Window 
 

На рисунке 2.12 показаны четыре одновременно открытых рисунка, раз-
мещенн ow 
(Окно). 

ые согласно пункту Arrange Icons (Упорядочить значки) меню Wind
 

 
 

Рисунок 2.12 – Пример четырех одновременно открытых рисунков 
 

AutoCAD 2004 имеет DWG-формат, отличный от формата систем 
AutoCAD 2000, 20001 и 2002. Поэтому файлы, созданные системой AutoCAD 
2004, не могут открываться предыдущими версиями системы.  

В рассматриваемой нами версии AutoCAD возможен экспорт файлов в 
следующие форматы: WMF, SAT, STL, EPS, DXX, BMP, 3DS. 

 

 161



 
2.5 Единицы измерения 
 
AutoCAD может работать в двух линейных единицах измерения: в милли-

метрах и дюймах и различных угловых единицах, причем единицы в процессе
работы могут меняться. В разделе Default Settings (Единицы по умолчанию) ок-
на Startup (Начало работы) включение переключателя Metric (Метрические) оз-
начает, что в качестве еди

 

  ниц измерения при создании рисунка выбраны мил-
лиметры. Переход к подробной установке единиц осуществляется в окне Startup 
(Начало работы) или в окне Create New Drawing (Создание нового рисунка) с 
помощью кнопки , которая п еводит начальное окно в режим вызова про-
граммы-мастера создания нового чертежа. 

Мастер начальных установок может работать в одном из двух вариантов 
дальнейшей работы:  

•  Quick Setup (Быстрая подготовка); 
• vanced Setup (Детальная подготовка). 

ер

 Ad
В режиме быстрой подготовки будут запрошены только тип линейных 

единиц и размеры зоны рисования. Более подробная настройка выполняется в 
режиме детальной подготовки, которым мы и продолжаем дальнейшее освое-
ние системы AutoCAD. Выберите мышью режим Advanced Setup (Детальная 
подготовка) и нажмите кнопку ОК. У вас откроется первая страница окна 
Advanced Setup (Детальная подготовка) (рисунок 2.13).  

 
 

Рисунок 2.13 – Страница Units окна Advanced Setup 
 

Выберите десятичные единицы (включите переключатель Decimal (Деся-
тичные)). Рисунок справа иллюстрирует те единицы, которые вы выбрали. За-
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тем с помощью раскрывающегося списка Precision (Точность) установите точ-
ность, с которой вы будете оперировать с вещественными числами (щелкните 
левой кнопкой мыши, поместив ее указатель на треугольнике раскрывающегося 
списка, и отметьте подходящий для вас вариант; по умолчанию это четыре зна-
ка по

системы, 
а не   Back, 
Next C

ц и точности углов (рису-
нок 

 э е Д

кот
ется очередная страница 

наст

сле десятичной точки), и нажмите на кнопку Далее (Next).  
На рис. 2.13 и других рисунках некоторые стандартные кнопки имеют рус-

ские названия, поскольку эти названия зависят от языка операционной 
от языка системы AutoCAD. Поэтому, например, на рис. 2.13 кнопки
 и ancel приведены с наименованиями Назад, Далее и Отмена.  
Появится очередная страница для задания едини

2.14).  
Выберите Decimal Degrees (Десятичные градусы). Рисунок справа опять 

покажет иллюстрацию к избранному вами способу. Установите точность изме-
рения углов (обычно то округление до ц лого) и нажмите кнопку алее (Next). 
Переходим к следующей странице (рисунок 2.15). В этом окне надо выбрать то 
направление, орое будет соответствовать нулевому углу (обычно это East 
(Восток)), и снова нажать кнопку Далее (Next). Откро

ройки, задающая ориентацию отсчета углов (рисунок 2.16).  

 
 

Рисунок 2.14 – Страница Angle окна Advanced Setup 
 

 163



 
 

а Angle MeasuРисунок 2.15 – Страниц re окна Advanced Setup 

 
 

Рисунок 2.16 – Страница Angle Direction окна Advanced Setup 
 

Здесь нужно определиться с направлением отсчета углов, т. е. отсчета по 
часовой стрелке или против нее. Обычный вариант — это Counter-Clockwise 
(Против часовой стрелки). Нажмите кнопку Далее (Next), в результате чего от-
кроется заключительная страница, устанавливающая размеры области рисова-
ния (рисунок 2.17).  
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Рисунок 2.17 – Страница Area окна Advanced Setup 
 

В новом окне вам надо определить начальные размеры зоны рисования, 
которая называется зоной лимитов. Как правило, левый нижний угол этой пря-
моугольной зоны имеет нулевые координаты как по горизонтальной, так и по 
вертикальной осям, а верхний правый угол определяется пользователем. По 
умолчанию это зона формата A3 (420 мм х 297 мм), но пользователь может вы-
брат

ы AutoCAD направлена от плоскости экрана к вам (конеч-
но, э

в левом нижнем углу в статусной строке.  
Хотя заданы размеры зоны лимитов, вы не обязаны строго придерживаться 
этих ограничений. Выход за пределы лимитов допустим (а когда вы с помощью 
AutoCAD создаете двумерную или трехмерную модель большого объекта, то 
тогда вам обяз

ь и другие размеры, пользуясь двумя специальными полями: Width (Шири-
на) и Length (Длина) (для активизации поля нужно щелкнуть левой кнопкой 
мыши по этому полю, в котором после этого появится мерцающий вертикаль-
ный курсор, и ввести или отредактировать значение размера). После установки 
размеров остается нажать на кнопку Готово (Finish). Ваш чертеж после этого 
будет настроен в соответствии с выбранными вами линейными и угловыми 
единицами измерения. В левом нижнем углу графического экрана обычно изо-
бражается пиктограмма осей координат. Ось X экрана направлена вдоль гори-
зонтальной кромки экрана, ось Y— вдоль вертикальной кромки. Основная сис-
тема координат, в которой вы по умолчанию начинаете работу, называется ми-
ровой. Ось Z систем

то важно, только если вы работаете не на плоскости, а в пространстве). 
При движении указателя мыши по графическому экрану счетчик координат, ес-
ли он не отключен функциональной клавишей <F6>, считывает текущие коор-
динаты и выводит их 

ательно придется выйти за границы лимитов). 
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2.6 Средства организации чертежа 

Задание координат в AutoCAD. В AutoCAD ввод координат возможен в 
виде абсолютных и относительных координат. Ввод абсолютных координат 
возможен в следующих форматах: прямоугольных (декартовых) координат (X, 
Y); полярных координат r < А, где r — радиус, а А — угол от предыдущей точ-
ки, з в  коо

<A — для полярных. 

икуляра к плоскости XY) и сферические (точка оп-
реде

ижнем углу появляется пикто-
грам

 сл

аданный  градусах против часовой стрелки. Относительные рдинаты 
задают смещение от последней введенной точки. При вводе точек в относи-
тельных координатах можно использовать любой формат записи в абсолютных 
координатах: @ds, dy — для прямоугольных; @r

В трехмерном пространстве вместо полярных координат двухмерного про-
странства используются цилиндрические (точка определяется расстоянием от 
начала координат вдоль направления, заданного углом относительно оси Х, и 
значением Z вдоль перпенд

ляется расстоянием от начала координат вдоль направления, заданного уг-
лом относительно оси X, и углом относительно плоскости XY) координаты. 

После первой загрузки системы в левом н
ма WCS (World Coordinate System – мировая система координат) (рисунок 

2.18). Она направлена едующим образом: ось OX — слева направо, ось OY — 
снизу вверх, ось OZ — перпендикулярно экрану. 

 
Рисунок 2.18 – Пиктограмма системы координат 

 
Для удобства работы может быть определена UCS (User Coordinate System 

– пользовательская система координат), которую можно сдвинуть и / или по-
вернуть под любым углом относительно WCS. Таких систем координат одно-
временно может существовать несколько, и в любой момент возможен переход 
из одной в другую. Переключение между режимами отображения значений ко-
ординат – Control–D. 

В AutoCAD имеется возможность установить полярный (POLAR) и орто-
гональный (ORTHO) режимы работы. Ортогональный режим является част-
ным случаем полярного, при о установке линии направлены вдоль осей коор-
динат под углом 0, 90, 180 или 270 °. Это бывает удобно использовать при ре-
дактировании, создании новых видов, параллельном переносе и т.п. Если зна-
чения координат точки вводятся с клавиатуры, то они получают более высокий 
приоритет и воспринимаются системой независимо от установки этого режима. 

Существует два вида привязки коорд

 ег

инат: шаговая привязка (SNAP) – 
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прив

 

язка координат к узлам невидимой сетки; объектная привязка (OSNAP) – 
привязка координат к различным точкам уже созданных объектов. Переход ме-
жду активными режимами привязки осуществляется с помощью клавиши Tab. 
Невидимую сетку можно сделать видимой при помощи команды GRID. Шаг 
видимой на экране вспомогательной сетки не обязательно должен совпасть с 
сеткой шаговой привязки. 

Объектная привязка (OSNAP) позволяет задавать новые точки относи-
тельно характерных точек уже существующих геометрических объектов. 

Управление объектной привязкой осуществляется из диалогового окна 
Drafting Settings, закладка Object Snap, которое вызывается одним из следую-
щих способов: используя меню Tools => Drafting Settings;  с помощью мыши
подвести курсор на кнопку OSNAP или OTRACK, находящуюся в статусной 
строке, и по нажатии правой кнопки выбрать Settings,  используя контекстное 
меню, которое вызывается щелчком правой кнопки мыши при нажатой клави-
ше Shift. 

В AutoCAD возможно использование многослойной организации чертежа. 
Каждый слой имеет свое имя (имя слоя может содержать до 255 символов) и 
характеризуется цветом, типом и толщиной линий, которые устанавливаются 
для всех объектов, принадлежащих слою. Слои используются для размеще-
ния на них отдельных объектов чертежа. Так как слои можно вклю-
чать / выключать, то тем самым можно легко управлять содержимым чертежа. 
Созданием, удалением и редактированием свойств слоев управляет Layer 
Properties Manager (Диспетчер свойств слоев) (рисунок 2.19). 

 

 
Рисунок 2.19 – Диспетчер свойств слоев (Layer Properties Manager) 

 
У слоев различают следующие свойства: состояние включе-

ния / выключения; состояние замороженности на всех видовых экранах; со-
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стояние блокировки; цвет графических объектов; тип линий графических объ-
ектов; вес линий (толщина в мм); признак печатаемости / непечатаемости.  

Включение / выключение слоя производится в том случае, если необходи-
мо временно убрать с чертежа все объекты, содержащиеся на данном слое. 

Признак замороженности на всех видовых экранах применяется при 
оформлении бумажных чертежей.  

Блокировка слоя применяется для того, чтобы защитить объекты, принад-
лежащие этому слою, от случайного удаления. При попытке удалить объект 
выдается сообщение о том, что слой заблокирован и удаление невозможно. 

Цвет назнач  разных слоев. 
 печати такого черте иальными установками 

печа

мацию (например видовые экраны), которая 
не должна присутствовать на печати. 

Информация о текущем слое представлена на панели Object Properties 
(Свойства объектов) (рисунок 2.20). Пиктограмма 1 служит для вызова «Дис-
петчера свойств слоев» и запускает команду возврата к предыдущему состоя-
нию слоев. Справа от панели «Слои» (2) находится панель «Свойства», кото-
рая содержит три раскрывающихся екта (3), «Тип линии» 
бъекта (4) и «Толщина

ается обычно для того, чтобы различать линии
жа, если не пользоваться спецПри

ти, цвет будет выводиться на печать, что недопустимо по ЕСКД.  
Вес линий в мм характеризует толщину графических объектов при выводе 

на печать. При создании новых слоев в поле «Вес линий» может стоять значе-
ние «Обычный». Это значит, что толщина равна 0,25 мм. 

Печатаемость / непечатаемость слоя применяется в случае, если данный 
слой содержит служебную инфор

 списка: «Цвет» бъ
 линии» объекта (5).  

о
о

 
Рисунок 2.20 – Вид инструментальной панели Object Properties (Свойства объектов) 

 
В раскрывающемся списке 2 представлен текущий слой (если не выбрано ни 

одного объекта). Если в данный момент выбраны объекты, содержащиеся на 
друг жат. Если вы-
бранные объекты принадлежат двум и более слоям, то список 2 будет чистым.  

 
 
2.7 Создание и оф для двухмерного 

моделирования 

ом слое, то это поле покажет тот слой, которому они принадле

ормление графических объектов 

Примитив – заранее определенный основной геометрический элемент, при 
помощи которого строятся более сложные модели. 

Примитивы могут быть простыми и сложными. К простым примитивам 
относятся следующие объекты: точка, отрезок, круг (окружность), дуга, прямая, 
луч, эллипс, сплайн, однострочный текст. К сложным примитивам относятся: 
полилиния, мультилиния, мультитекст (многострочный текст), размер, выноска, 
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допуск, штриховка, вхождение блока или внешней ссылки, атрибут, растровое 
изображение. 

Общими свойствами, которыми обладают все примитивы, являются при-
надлежность к слою, цвет и тип линии. Многие примитивы обладают также 
толщиной. 

Отдельные примитивы (текст, блок) имеют специальные свойства, такие как 
гарнитура, угол наклона, точка вставки и т. д. 

Принадлежность к слою обеспечивает размещение примитивов только на 
этом слое. Свойства создаваемых в нем примитивов можно определить в соответ-
ствии со свойствами слоя. 

Цвет линии кодируется числом от 1 до 255. Использование цвета улучшает 
вид чертежа на экране монитора и полезно при его выводе на плоттер. 

Тип линии – это специальная последовательность чередующихся линейных 
сегментов и пробелов. Начертание и назначение линий на чертежах всех отраслей 
промышленности и строительства устанавливается стандартом ГОСТ 2.303-81. 

Толщина линий на чертеже устанавливается по отношению к толщине ос-
новной линии. Используя цвет, тип и толщину линий, можно выделить на черте-
же важные детали, последние модификации или визуально отметить взаимосвязь 
отдельных фрагментов чертежа. 

Операции построения большей части примитивов могут быть выполнены с 
помощью кнопок панели инструментов Draw (Рисование) (рисунок 2.21). Созда-
вать примитивы можно также с помощью пунктов падающего меню Draw. 

 
Рисунок 2.21 – Панель инструментов Draw (Рисование) 

 

Рисование отрезков. Введите на клавиатуре LINE и нажмите клавишу 
<Enter> (любой ввод с клавиатуры должен завершаться этой клавишей). Тем са-
мым будет вызвана команда LINE (ОТРЕЗОК). Данную команду можно вызвать 
также, воспользовавшись мышью, либо из падающего меню Draw с помощью ко-
манды LINE, либо из панели инструментов   Draw, нажав кнопку . В завершение 
кома

трь графического экрана и нажать правую кнопку мыши. При этом на 
мест

 пункта Cancel контекстного меню 
такж

нды LINE необходимо нажать клавишу <Enter> или поместить указатель 
мыши вну

е, где находился конец указателя, появится контекстное меню, содержание 
которого зависит от выполняемой в данный момент команды. 

Одной командой LINE можно нарисовать один или несколько последова-
тельно расположенных отрезков. Признаком окончания команды является на-
жатие клавиши <Enter> или ввод опции замыкания – символа С. Прерывание 
команды с помощью клавиши <Esc> или

е завершит эту команду. По любому из построенных отрезков можно с по-
мощью команды LIST (СПИСОК) получить справочную информацию: коорди-
наты концов, угол наклона и т.п. 

Способы ввода координат точек. В AutoCAD возможен ввод координат 
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точки с клавиатуры (первый способ) и с помощью мыши (второй способ). При 
вводе координат с клавиатуры запятая является разделителем между абсциссой 
и ординатой, а точка используется как разделитель между целой и дробной ча-
стью числа. Третий способ ввода точек – это относительный ввод с клавиатуры 
в декартовых или полярны 50,25. Четвертый спо-
соб ввода точек – это указание  привязки. Дос-
туп 

х координатах, например: @
 с помощью функций объектной

к функциям объектной привязки осуществляется либо через панель Object 
Snap (Объектная привязка) (рисунок 2.22), либо через контекстное меню. 

 
Рисунок 2.22 – Панель Object Snap (Объектная привязка) 

 

В этой панели собраны следующие кнопки:  
 – использование отслеживания с помощью промежуточной точки;  
 – смещение от другой (вспомогательной) точки;  
 – конечная точка;  
 – средняя точка;  
 – точка пересечения двух объектов или их продолжений;  
 – точка мнимого пересечения двух объектов или их продолжений;  
 – точка продолжения;  
 – центр дуги, окружности или эллипса;  
 – точка квадранта дуги, окружности или эллипса (это точки, располо-

женные на 0, 90, 180 и 270 °);  
 – точка касания;  
 – перпендикулярно объекту;  
 – параллельно объекту;  

 – точка вставки текста, блока, внешней ссылки;  

 – узловая точка;  

 – ближайшая к объекту точка;  

 – без использования объектной привязки;  

 – настройка постоянных режимов привязки.  
Примитив точка. Для построения точки используется команда POINT 

(ТОЧКА), которая, помимо набора на клавиатуре, может быть вызвана из панели 
Draw (Рисование) с помощью кнопки  или из падающего меню, если приме-
нить команду Draw Одиночная). По-
стро нные заранее точки могут затем быть использованы другими командами. 

 | Point | Single Point (Рисование | Точка | 
е
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Если системные переменные PDMODE = 0 и PDSIZE = 0, то точка отобра-
жается в виде одного пиксела (т.е. одной точки экрана), что чаще всего неудоб-
но. Поэтому в падающем меню Format (Формат) есть пункт Point Style (Ото-
бражение точек), который вызывает диалоговое окно Point Style (Отображение 
точек), в котором выбирается условное обозначение точки. 

Точки могут быть использованы для построений новых объектов с помо-
щью функции объектной привязки Node (Узел), при этом сами точки очень час-
то называются узловыми. 

р, Наприме пусть необходимо построить отрезок, у которого концы явля-
ются ранее созданными узловыми точками. Для этого вызовем команду LINE 
(ОТРЕЗОК) и на запрос Specify first point (Первая точка) с помощью левой 
кнопки мыши выберем кнопку (SNAP TO NODE (Привязать к узлу)) панели 
Object Snap (Объектная привязка). Затем устанавливаем указатель мыши на 
перв

о меню Draw (Рисование) или 

ую узловую точку (обнаружив ее, AutoCAD обводит точку кружком). По-
сле этого опять обращаемся к функции объектной привязки Node (Узел) и ука-
зываем вторую узловую точку. Отрезок между заданными узлами построен. 

Луч – это примитив, бесконечный в одну сторону и начинающийся в неко-
торой точке. Для его построения служит команда RAY (ЛУЧ). Команда может 
быть введена с клавиатуры или вызвана с помощью пункта Ray падающего ме-
ню Draw (Рисование). Применяется для дополнительных построений. 

Прямая, в отличие от отрезков и лучей, – это бесконечные в обе стороны 
линии. Для их построения используется команда XLINE (ПРЯМАЯ), которая 
может быть введена с клавиатуры, из падающег
кнопкой . Также применяется для дополнительных построений. 

Окружность. Рисование окружностей (кругов) выполняется командой 
CIRCLE (КРУГ). Команду можно вызвать из панели Draw (Рисование) кноп-

кой  или из падающего меню Draw (Рисование). 
Дуга. Дл остроения дуги используется команда ARC (ДУГА). Команда 

может быть введена с клавиатуры, вызвана из панели инструментов Draw (Ри-
сование) с помощью кнопки 

я п

  или из падающего меню Draw (Рисование), в 
котором подменю Arc (Дуга) имеет одиннадцать пунктов для уточнения спосо-
бов построения дуги. 

Полилиния – это сложный примитив, состоящий из одного или нескольких 
связанных между собой прямолинейных и дуговых сегментов. Полилиния об-
рабатывается как единое целое (например при редактировании или удалении). 
Для рисования полилинии служит команда PLINE (ПОЛИНИЯ), которая, по-
мимо ввода с клавиатуры, может быть вызвана с помощью кнопки  или 
пункта Polyline (Полилиния) падающего меню Draw (Рисование). 

Полилиния – один из немногих объектов, которые могут иметь ненулевую 
ширину. Ширина, заданная для предыдущей полилинии, запоминается и пред-
лагается в качестве ширины по умолчанию для следующей полилинии. Поэто-
му AutoCAD информирует вас о том, с какой шириной система будет строить 
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новую полилинию. В любой момент можно от режима рисования прямолиней-
ных сегментов перейти к режиму рисования дуговых сегментов и наоборот. 
Также в любой момент можно задать новую ширину или полуширину для сле-
дующего сегмента полилинии. 

Особенности полилинии по сравнению с простыми примитивами:  
– полилиния является единым объектом, что удобно для операций удале-

ния или редактирования (например построения параллельной линии);  
– полилиния удобна для рисования жирных линий чертежа;  
– переменная ширина сегментов полилинии может быть использована для 

графических эффектов (построения стрелок и т. п.).  
Полилинии специального вида. В системе AutoCAD есть несколько команд 

рисования таких объектов, как прямоугольники, правильные многоугольники, 
кольца и линии правки, каждый из которых на самом деле является полилини-
ей. Вычерчивание прямоугольников осуществляет команд  RECTANG 
(ПРЯМО-УГ). Команда  или вызвана с помо-
щью кнопки 

а
 может быть введена с клавиатуры

п пункта Rectangle 
(Пря ик

анели Draw (Рисование) или с помощью 
моугольн ) падающего меню Draw (Рисование). 
Команда POLYGON (МН-УГОЛ) рисует правильный многоугольник либо 

по конечным точкам одной стороны, либо по точке центра и радиусу вписанной 
или описанной окружности. Команда может быть вызвана с помощью кнопки 

 панели Draw (Рисование) или с помощью пункта Polygon (Многоугольник) 
пада

ьца. 
Ком им

жет быть вызвана кнопкой 

ющего меню Draw (Рисование). 
Кольцо рисуется командой DONUT (КОЛЬЦО) и представляется полили-

нией с шириной, подобранной по внутреннему и внешнему диаметрам кол
анда, пом о ввода с клавиатуры, может быть вызвана с помощью пункта 

Donut (Кольцо) падающего меню Draw (Рисование). 
Новая команда, появившаяся в системе AutoCAD 2004, - REVCLOUD. Эта 

команда рисует замкнутую полилинию в форме облака.  
Мультилиния – это объект, состоящий из пучка ломаных, параллельных 

друг другу линий. Количество линий, входящих в мультилинию, составляет от 
2 до 16. Мультилиния может обладать дополнительными свойствами, к кото-
рым относятся промежуточные стыки, торцы, скругления и заливка. Построе-
ние мультилиний выполняется командой MLINE (МЛИНИЯ). Команда может 
быть введена с клавиатуры или вызвана с помощью пункта Multiline (Мульти-
линия) падающего меню Draw (Рисование).  

Эллипс – это геометрическое место точек, сумма расстояний до которых от 
двух фиксированных точек (фокусов) постоянна. Создание эллипсов и эллип-
тических дуг выполняется в системе AutoCAD с помощью команды ELLIPSE 
(ЭЛЛИПС), которая, помимо ввода с клавиатуры, мо

 панели Draw (Рисование) или пунктом падающего меню Draw | Ellipse | 
Axis, End (Рисование | Эллипс | Ось, Конец). 

Сплайн. Команда SPLINE (СПЛАЙН) позволяет чертить сплайн – гладкую 
линию, которая точно проходит через заданные точки или отклоняется от них в 
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рамках допуска и может удовлетворять условиям касания в начальной, конеч-
ной или обеих точках. Команда, помимо ввода с клавиатуры, может быть вы-
звана с помощью кнопки  панели Draw (Рисование) или пункта Spline 
(Сплайн) падающего меню Draw (Рисование). Сплайны могут применятся при 
оформлении чертежа в качестве линий разрыва, определения границ местных 
разрезов и сечений и т.п. 

Надписи могут быть созданы с помощью команд TEXT (ТЕКСТ) или 
МТЕ

м

ХТ (МТЕКСТ). В первом случае создается однострочный текст, во втором 
– мультитекст (многострочный текст). У команды TEXT есть синоним –
команда DTEXT (ДТЕКСТ). Команда ТЕКСТ, создающая простые надписи, 
помимо клавиатуры, ожет быть вызвана кнопкой  панели инструментов 
Text (Текст) (рисунок 2.23), а также из падающего меню Draw (Рисование), где 
в подменю Text (Текст) есть пункт Single Line Text (Однострочный текст).  

 
Рисунок 2.23 – Панель инструментов  

Text (Текст) 
 

Если в текст нужно вставить специальные знаки (например диаметр) или 
получить подчеркнутые или надчеркнутые символы, то при вводе текста можно 
использовать следующие управляющие коды, начинающиеся с двух символов 
процента:  

−  %%nnn — вставка символа с номером nnn (nnn заменяет три цифры) в 
щей таблице кодировки символов, используемой как основной в графиче-

ских приложениях для Windows (например, %%193 — это символ с номером 
193, т. е. "Б");  

−  %%о — включение / отключение над

теку

черкивания;  
— в л

ностям таких текстовых про-
цесс

−  %%u к ючение / отключение подчеркивания;  
−  %%d — вставка символа градуса "°";  
−  %%р — вставка символа плюс-минус "±";  
−  %%с — вставка символа диаметра;  
−  %%% — вставка символа процента "%".  
Режимы надчеркивания и подчеркивания могут действовать в надписи од-

новременно. 
Команда МТЕХТ (МТЕКСТ) позволяет нанести на чертеж целые абзацы 

достаточно длинного текста (образующийся при этом примитив называется 
мультитекстом, или многострочным текстом), с возможностями выравнивания 
и редактирования, приближающимися к возмож

оров, как Microsoft Word. Команде соответствуют кнопка  в панелях 
Draw (Рисование) и Text (Текст), а также пункт падающего меню Draw | Text | 
Multiline Text (Рисование | Текст | Многострочный текст). Команда МТЕХТ 
(МТ ри ЕКСТ) п старте информирует об имени действующего текстового стиля 
и просит указать первую из двух точек, определяющих границы зоны мульти-
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текста по ширине. Нижний предел по высоте ри этом не фиксируется и сдви-
гается автоматически по ере ввода текста После ук  точек раскрывается 
окно редактора мультитекста. 

Перед вводом текста необходимо установить нужный стиль или задать 
внестилевое оформление с помощью име

п
 м . азания

ни шрифта и размера букв, а также 
выбр мяать цвет букв. Если в процессе ввода понадобится сменить настройки (и  
шрифта, цвет и т. д.), то можно выделить левой кнопкой мыши участок текста и 
изменить его форматирование. Имена шрифтов имеют слева пометки в виде 
значка  (это стандартные SHX-шрифты AutoCAD) или  (шрифты Windows 
типа True Type). Не все шрифты могут воспроизводить русские буквы, поэтому 
требуется предварительный анализ шрифтов перед их практическим использо-
ванием. Шрифты, имена которых заканчиваются на Суr, всегда подходят для 
русского текста.  

Кнопка  позволяет управлять написанием дробей и индексов. Числи-
тель и знаменатель дроби могут либо разделяться горизонтальной чертой, либо 
ниче

ие
 

о  х

м не разделяться (по типу допуска), либо разделяться наклонной чертой. 
Перед тем как воспользоваться кнопкой дробей, нужно выделить мышью уча-
сток текста, в котором будущ  числитель и знаменатель разделены одним из 
символов: /, ^ или #. Затем нужно щелкнуть по указанной кнопке. Применение
данной кнопки ому участку текста, уже имеющем к выделенн у вид дроби, воз-
вращает этот участок к неформатированному виду. Для получения верхнего 
или нижнего индекса можно воспользоваться средством форматирования дроби 
с помощью специального символа А. 

При создании многострочного текста задается межстрочный интервал 
фиксированным численным значением или в долях от одинарного интервала. 
Величина одинарного межстрочного интервала обозначается буквой х и равна 
высоте символов, умноженной на 1,66. Поэтому значение межстрочного интер-
вала можно ввести как число с суффикс м  (например, 1,5 x, что соответствует 
полуторному интервалу) или просто как число (например 2,25, что соответству-
ет 2,25 от высоты символов). Значения должны находиться в диапазоне от 
0,0833 (0,25х) до 1,3333 (4х). Сочетание правильно подобранного межстрочного 
интервала и позиций табуляции позволяет эффективно использовать мульти-
текст для заполнения таблиц (например таблицы спецификации, располагаю-
щейся на чертеже). 

Размеры. Операции установки размеров, допусков и выносных линий (вы-
носок) выполняются с помощью команд, которым соответствуют пункты па-
дающего меню Dimension (Размеры) и кнопки панели инструментов Dimension 
(Размеры) (рисунок 2.24).  

 
Рисунок 2.24 – Панель инструментов Dimension (Размеры) 

По умолчанию AutoCAD 2004 и AutoCAD 2002 в отличие от предыдущих 
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версий
 при редактировании основ-

ного
ена для установки линейных размеров. 

Ей с

 все размеры создают ассоциативными, т.е. зависимыми от объектов, к ко-
торым данные размеры привязаны. Это означает, что

 объекта будут автоматически изменяться и все связанные с ним размеры. 
Команда DIMLINEAR предназнач
оответствуют кнопка  панели Dimension (Размеры) и пункт Linear (Ли-

нейный) падающег еню Dimension (Размеры).  
Команда DIMALIGNED, которой соответствуют кнопка 

о м
 панели 

Dimension (Размеры) и пункт Aligned (Параллельный) падающего меню 
Dimension (Размеры), позволяет проставить линейный размер параллельно вы-
бранному отрезку или двум указанным точкам. 

Команда DIMORDINATE позволяет строить выноску с установкой значе-
ния абсциссы или ординаты указываемой точки. Данной команде соответству-
ют кнопка  панели Dimension (Размеры) и пункт Ordinate (Ординатный) па-
дающего меню Dimension. 

Команде DIMRADIUS соответствуют кнопка  панели инструментов 
Dimension (Размеры) и пункт Radius (Радиус) падающего меню Dimension. Ко-
манда предназначена для простановки радиуса. 

Команда DIMDIAMETER предназначена для нанесения диаметра. Ей со-
ответствуют кнопка  панели инструментов Dimension (Размеры) и пункт 
Diameter (Диаметр) падающего меню Dimension. 

Команда DIMANGULAR предназначена для простановки угловых разме-
ров между отрезками или углового размера дуги (или части окружности). Ей 
соответствуют кнопка  панели инструментов Dimension (Размеры) и пункт 
Angular (Угловой) падающего меню Dimension. 

Команда QDIM предназначена для быстрого создания группы однотипных 
размеров или для бы ерных цепей.  

а DIMBASELINE п ой и той же базовой точки по-
стро

строго построения базовых размеров и разм
озволяет от однКоманд

ить несколько линейных размеров. Эта команда помимо ввода с клавиату-
ры может быть вызвана с помощью кнопки  панели инструментов или пунк-
та Baseline (Базовый) падающего меню Dimension. Команда не запрашивает по-
ложе нии, а сразу начинает с запроса второй. В качестве 
базы едыдущий линейный размер, 
и его

ния первой выносной ли
 группы базовых размеров обычно служит пр
 первая точка становится первой точкой для следующих линейных (базо-

вых) размеров. 
Команда DIMCONTINUE позволяет построить группу продолжающих друг 

друга линейных размеров.  Эта команда помимо ввода с клавиатуры может быть 
вызвана с помощью кнопки  панели инструментов или пункта Continue (Цепь) 
пада  
запр

озволяет выбрать другой линейный размер в ка-
честв

ющего меню Dimension (Размеры). Команда DIMCONTINUE начинает сразу с
оса положения второй выносной линии. Эти выносные линии можно пооче-

редно указать в цикле. Опция Undo (Отменить) отменяет предыдущий шаг этой ко-
манды, а опция Select (Выбрать) п

е базы для построения размерной цепи. 
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Команда QLEADER строит одноименный примитив выноски, который со-
стоит из ломаной либо гладкой выносной линии или из нескольких сегментов, 
начи  с инающихся стрелкой (или другим настраиваемым имволом)  заканчи-
вающихся одной либо несколькими строками текста или мультитекста. Коман-
да вызывается кнопкой  панели Dimension (Размеры) или пунктом Leader 
(Выно

о Leader Settings (Параметры выноски) (рисунок 2.25). 

ска) падающего меню Dimension (Размеры). Окончание текста выноски – 
нажатие клавиши <Enter>.  

В последних версиях системы AutoCAD выноска имеет развитый режим 
настройки, в который можно войти, выбрав вместо первой точки выноски 
пункт Settings (Параметры) или нажав клавишу <Enter>. В этом случае появля-
ется диалоговое окн

Команда TOLERANCE (ДОПУСК) формирует обозначение допуска в ви-
де нескольких рядов прямоугольников (от одного до четырех). Команде соот-
ветствует кнопка  панели Dimension (Размеры) и пункт Tolerance (Допуск) 
падающего меню Dimension (Размеры). Эта команда открывает диалоговое окно 
Geometric Tolerance (Допуски формы и расположения) (рисунок 2.26). Обо-
значение допуска строится с помощью этого диалогового окна, четыре строки 
которого соответствуют четырем строкам допуска. Если создаваемое обозначе-
ние допуска должно иметь меньшее количество строк, то соответствующая стро-
ка диалогового окна не заполняется. Каждая строка диалогового окна рассчитана 
на максимальную длину (до 13 элементов). Поэтому если реальное обозначение 
допуска будет иметь меньшую длину, то ненужные элементы не заполняются, и 
они не включаются программой в формируемый примитив допуска.  

 
Рисунок 2.25 – Диалоговое окно Leader Settings, вкладка Annotation 
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Рисунок 2.26 – Диалоговое окно Geometric Tolerance  

(Допуски формы и расположения) 
 

Заполнение полей в диалоговом окне выполняется следующим образом. 
Черные поля являются полями выбора символов из специальных окон, а белые 
поля – текстовые, содержимое которых заполняет пользователь. Если щелкнуть 
левой кнопки мыши по полю первой или второй строки раздела Sym (Симв), то 
раскроется окно Symbol (Символ) (рисунок 2.27), в котором нужно выбрать 
один из предлагаемых вариантов. 

 
Рисунок 2.27 – Окно Symbol (Символ) 

 

Если щелкнуть левой кнопкой мыши по верхнему левому или нижнему ле-
вому черному полю, являющемуся первой частью разделов Tolerance 1 (До-
пуск 1) или Tolerance 2 (Допуск 2), то в квадрате появится символ диаметра. Та-
кой же щелчок удаляет ли это поле ранее уже было заполне-
но. Верхнее правое поле Tolerance 1 (Допуск 1) либо 
Tolerance 2 (Допуск м ним из символов зависимого до-
пуск

 символ диаметра, ес
или нижнее правое черное 
 2) ожет быть заполнено од

а с помощью окна Material Condition (Зависимый допуск) (рисунок 2.28). 
Аналогично заполняются или пропускаются остальные поля. 

 
Рисунок 2.28 – Окно Material Condition  

(Зависимый допуск) 

Штриховка. Для штрихования замкнутых областей рисунка служит ко-
манда ВНАТСН, которая вызывается либо с помощью кнопки 

 

 панели Draw 
(Рисование), либо с помощью пункта Hatch (Штриховка) падающего меню 
Draw (Рисование). Эта команда позволяет создать штриховку или заливку об-
ласти, ограниченной замкнутой линией (линиями), как путем простого указания 
точек внутри контура, так и путем выбора объектов. Эта команда автоматиче-
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ски определяет контур и игнорирует примитивы, которые не имеют отношения 
к контуру. Она вызывает диалоговое окно Boundary Hatch and Fill (Штриховка 
и заливка по контуру) с тремя вкладками в левой части (рисунок 2.29). 

 

 
а 

 
б 

исунок 2.29 – Диалоговое окно Boundary Hatch and Fill вкладки Hatch AutoCAD 2004 (а)  
и Advanced AutoCAD 2000i (б) 

 

Диалоговое окно имеет три сменяющих друг друга вкладки в левой части. 
Вкладка Hatch (Штриховка) (в версиях до AutoCAD 2004 она называлась Quick 
(Основные)) задает пара

Р

метры штриховки. Заполняемая штриховкой область 
зада

ки 
увел

 2004 впервые появилось целое множество за-
ливо

Г

е. Фигуры, построенные с помощью одной коман-
ды S

й информации о создаваемых объектах. На рисун-
ке 2.30 показана панель инструментов Inquiry (Справки), содержащая кнопки 
следующих операций (в порядке их расположения в панели слева направо): 

ется с помощью параметров в правой части этого окна. Выбирается тип 
штриховки, угол наклона и масштаб штриховки относительно эталонного изо-
бражения. При увеличении масштаба расстояние между линиями штрихов

ичивается, при уменьшении масштаба — уменьшается. Та кже должны 
быть заданы параметры заполняемого контура. 

В версии системы AutoCAD
к – градиентные заливки. Для работы с ними предназначена вкладка 

Gradient ( радиентные). В данной версии вставка нужной штриховки или за-
ливки может быть выполнена простым перетаскиванием образца внутрь той 
области, которую необходимо заполнить. 

Редкие примитивы. К редким примитивам могут быть отнесены полосы и 
фигуры.  

Команда TRACE (ПОЛОСА) вводится только с клавиатуры и предназна-
чена для построения полос – ломаных линий с постоянной шириной. 

Команда SOLID (ФИГУРА) строит последовательно расположенные за-
крашенные четырехугольники или треугольники. Вершины фигур задаются 
точками в диалоговом режим

OLID, не образуют единого объекта. 
Получение справок. В процессе работы очень полезными оказываются ко-

манды получения справочно
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Dista Об-
ласт динаты).  

nce (Расстояние); Area (Площадь); Region | Mass Properties (
ь | Масса); List (Список); Locate Point (Коор

 
Рисунок 2.30 – Панель Inquiry  

(

К этим о о  Inquiry 
падающего ме

 
2.8 Редак ических объектов 

ъ
ова к

У разных при метки
т метки (нажатие на ле

должна сменить цвет на красный и система AutoCAD ение о воз-
йс

Наприме римитива LINE (отрезок) характе и являются 
 и ср

У прими LINE (прямая) высвечиваются базо точка и две точки на 
не зовой. Если пе

ку, т о
 точ л

На окруж чивается пять меток: в центре и квадрантах (т.е. в 
ерх р

центральной е случае редак-
тирования окр к окружность растягивается 

с
ми н
тив
ак  

Примити лько у овых точек, но и на 
ос  

положение вы бщее оформление 
размера как е  

ктов (копирование, перенос, уд-
лине ирование) (рисунок 2.31).  

Справки) 

перациям можно также обратиться с пом
ню Tools (Сервис).  

 

щью подменю

 

тирование граф

Наиболее быстрым способом редактирования об ектов в AutoCAD являет-
ся использ ние меток – небольших квадратов в хара

митивов высвечиваются различные 
терных точках объектов. 
. 

При ак ивации текущей вую кнопку мыши) она 
выдает сообщ

можных де твиях при редактировании объекта. 
р, для п рными точкам

конечные едние точки.  
тива X вая 

прямой на большом расстоянии от ба реносить базовую (сред-
нюю) точ
то базовая

о перемещается вся линия, а если перен
ка остается на месте, но изменяется нак
ности высве

сить точки других ручек, 
он прямой. 

крайней в ней, нижней, левой и правой точках). П
метки окружность перемещается на ново
ужности за любую из остальных мето

и попытке перемещения 
 место, а в 

или сжимает я, меняя радиус. 
У при

не. Прими
тива ARC (дуга) высвечиваются три метк
ы TEXT (текст) и МТЕХТ (мультитекст) и

и: на ко цах и в середи-
меют метки в тех точках, 

которые хар теризуют положение или выравнивание
в DIMENSION имеет метки не то

текста. 
 баз

концах вын ных линий и у размерного текста. Эти
носной линии и размерного текста (при
диного целого сохраняется).

метки позволяют менять 
 этом о

Команды общего редактирования.  
Кнопки команд общего редактирования объе
ние и т. п.) расположены в панели Modify (Редакт

 
вание) Рисунок 2.31 – Панель Modify (Редактиро
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Каждую из команд, рассмотренных в данном разделе, можно ввести с кла-
виат а-
ние) оманды данной группы работают либо с набором предваритель-
но в абора выдают запрос 
Select objects (Выберите ые команды запраши -

 объекты момент  

уры, а также вызвать с помощью падающего меню Modify (Редактиров
. Многие к
ыбранных объектов, либо при отсутствии такого н

 объекты). Остальн вают редакти
руемые  в соответствующий . Кнопка , соответствующая

е объекты и удаляе
 

де ER ы т их 
из рисунка.  

ка 

коман ASE (СТЕРЕТЬ), стирает с экрана выбранн

Кноп  команды COPY (КОПИРОВАТЬ) копи к-
ь  

 задается вопрос о выборе 
. По ш а-
nter

Кнопка

рует выбранные объе
ты параллел но вектору, который задается начальной и 

 команды выбранных объектов нет, то
конечной точками. Если

при запуске
объектов
виши <E

сле выбора объектов нужно завер ить вы
>, либо щелчком правой кнопкой мыши.  

 

бор либо нажатием кл

 команды MIRROR (ЗЕРКАЛО) позволяет зеркально отразить 
риро осительно ос ся 

ам н
р  тексты, то в некоторых услови-
е  что приво . 

Для того чтобы тексты при отражении не переворачивались, нужно установить 
для системной переменной MIRRTEXT значение 0 (вместо другого возможного 
значения 1). Тогда точки привязки текста симметрируются, а сам текст останет-
ся повернутым в ту же сторону, что и исходный. 

Кнопка 

(симмет вать) выбранные объекты отн и, которая определяет
двумя точк и. Рекомендуется применять при включен

еди симметрируемых объек
ом режиме ORTHO. 

Если с
ях они тож

тов есть
 отражаются относительно оси, дит к их нечитаемости

 в панели Draw (Рисование) соответствует команде OFFSET 
(ПОДОБИЕ). Команду можно также вызвать из падающего меню Modify (Ре-
дактирование) с помощью пункта Offset (Подобие). Команда предназначена для 
рисования подобных (параллельных) линий к линейным объектам (отрезкам, 
лучам, прямым, полилиниям, дугам, окружностям, эллипсам и сплайнам). 

Кнопка  команды ARRAY (МАССИВ) предназначена для создания 
группы копий одних и тех же объектов, причем копии располагаются по опреде-
ленному закону в гнездах прямоугольного или кругового массива. Команду, 
кроме того, можно также вызвать из падающего меню Modify с помощью пункта 
Array. В любом случае команда вызывает диалоговое окно Array, которое в ле-
вой части имеет изменяемую область. Содержимое этой области зависит от со-
стояния двух переключателей Rectangular Array (Прямоугольный массив) и Polar 
Array (Круговой массив), расположенных в верхней части окна (рисунок 2.32).  
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Рисунок 2.32 – Диалоговое окно Array  

с включенным переключателем Rectangular Ar
 

 

ray 

Кнопка  соответствует команде MOVE (ПЕРЕНЕСТИ
тить выбранные объекты параллельно вект
анду можно также вызвать из падающего ме
(Перенести). Запросы и действия э

), которая позво
ру, заданному двум
ю Mod

-
о я 

точками. Ком н ify с помощью 
пункта Move той команды очень похожи на 

й
Кнопка

ляет перемес

запросы и де ствия команды COPY.  
  команды ROTATE (ПОВЕРНУТЬ) дает возможность повернуть 

е о а у 
можно также dify с помощь нкта Rotate. 

нопка 

выбранны бъекты относительно базовой точки на зад
вызвать из падающего меню Mo

нный угол. Команд
ю пу

К , соответствующая команде SCALE (МАСШТАБ), позволяет 
масш . Команду 
мож

табировать выбранные объекты относительно базовой точки
но также вызвать из падающего меню Modify с помощью пункта Scale. 
Команда STRETCH (РАСТЯНУТЬ), которой соответствует кнопка  па-

нели Modify, предназначена для изменения формы объекта методом растяже-
ния. Команду можно также вызвать из падающего меню Modify с помощью 
пункта Stretch (Растянуть). Команда обычно выполняется над полилинией (хотя 
она может растягивать и дуги, эллиптические дуги, сплайны и другие линейные 
примитивы), когда надо переместить несколько ее вершин параллельно векто-
р емому двум ьные вершины поли надо оста-
вить на месте и соответствующим образом преобразовать геометрию объекта. 

T п х 
объектов, по ть полилинии выбрать с помо-

у, задава я точками, а остал линии 

Команда S RETCH не применяется для набора 
скольку в данном случае важно час

редварительно выбранны

щью секущей рамки или секущего многоугольника. 
Кнопка  соответствует команде TRIM (ОБ

т (объекты) с пом
Р -

резать объек ощью пересекающих  
инит д з 

падающего м . П резке может происхо-

ЕЗАТЬ), позволяющей об
 его (их) других объектов

или удл ь его (их) до нужного объекта. Коман
еню Modify с помощью пункта Trim

у можно также вызвать и
ри об
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дить преобразование типов примитивов. Например, окружность может стать 
дугой, луч – отрезком, прямая – лучом или отрезком. 

Команда EXTEND (УДЛИНИТЬ), которой соответствует кнопка , позво-
ляет выбрать набор "граничных кромок", а затем указать объекты, которые уд-
линяются до этих кромок. Команду можно также вызвать из падающего меню 
Mod

Команду можно вызвать из падающего меню Modify  помо-
щью

ify с помощью пункта Extend. Последовательность указания объектов очень 
важна, так как системе нужно различать граничные и удлиняемые объекты. 

Команда BREAK (РАЗОРВАТЬ) предназначена для разрыва объекта в двух 
указываемых точках. 

 пункта Break. Кроме того, ей в панели инструментов Modify  соответствуют 
две кнопки. Кнопка  вызывает команду BREAK в самом общем варианте. 
Кнопка  BREAK AT POINT (Разорвать в точке) позволяет воспользоваться ва-
риантом команды BREAK в том случае, когда первая и вторая точки разрыва сов-
падают, но точка указания объекта не является точкой разрыва. 

Кнопка  вызывает команду CHAMFER (ФАСКА), которая выполняет 
операцию подрезки двух пересекающихся прямолинейных сегментов (отрезков, 
лучей, прямых) на заданных расстояниях от точки их пересечения (снятие фас-
ки), дрезки. Команду, 
кром

ьными отрезками (при этом отрезки сначала удли-
няются до пересечения). 

Команда FILLET (СОПРЯЖЕНИЕ) сопрягает объекты (например отрезки, 
дуги и окружности) дугой заданного радиуса. Ей соответствует кнопка 

строя при этом новый отрезок, соединяющий точки по
е того, можно вызвать из падающего меню Modify с помощью пункта 

Chamfer. Команда выполняется как над пересекающимися, так и над непересе-
кающимися, но непараллел

па-
нели Modify и пункт Fillet падающего меню Modify. Команда по своим режимам 
аналогична команде CHAMFER (ФАСКА). 

Кнопка  панели Modify, соответствующая команде EXPLODE 
(РАСЧЛЕНИТЬ), расчленяет на более простые объекты полилинии, вхождения 
блоков, размеры и другие сложные объекты. 

Операции редактирования текстов собраны в панели инструментов Text 
(Текст) (см. рис. 8). Для редактирования надписей предусмотрены кнопка 
панели и пункт падающего меню Modify | Object | Text | Edit (Редактирование | 
Объект | Текст | Редактировать). Они вызывают команду DDEDIT. Другой, бо-
лее простой способ вызова этой команды – двойной щелчок по однострочному 
тексту (при этом в рисунке не должны быть выделены другие объекты). Коман-
да DDEDIT предназначена не только для редактирования текста, но и размер-
ного текста, допусков и определений атрибутов. 

Редактирование мультитекста выполняется по тем же правилам, что и соз-
дание мультитекста. Кроме того, можно выделить любой участок текста и вы-
звать правой кнопкой мыши контекстное меню. 

Кнопка  панели  вызывает команду (НАЙТИ), 
ации поиска и замены в текстовых примитивах всего че

Text FIND которая вы-
олняет опер ртежа или п

 182 



выделенного набора объектов. Кнопка  соответствует команде STYLE 
(СТИЛЬ), создающей стили текста. Кнопка  вызывает команду 
SCALETEXT, которая позволяет масштабировать текст. Команду можно также 
вызв

Масштаб). 
етствует кнопка 

ать с помощью пункта падающего меню Modify | Object | Text | Scale (Ре-
дактирование | Объект | Текст | 

 Команда JUSTIFYTEXT (ВЫРТЕКСТ), которой соотв
позв  надписи, изменить способ ее выравнивания 
(нап те, чтобы 
надп
вызв его меню Modify | Object | Text | Justify 
(Ред | Выравнивание). Изменение способа вырав-
нива шем редактировать надпись (даже с помощью ме-
ток),

оляет, не меняя внешнего вида
ример, надпись привязана за нижнюю правую точку, а вы хоти
ись была пересоздана с опцией Fit (По ширине)). Команду можно также 
ать с помощью пункта падающ
актирование | Объект | Текст 
ния позволяет в дальней
 но с сохранением новых свойств. 

 соответствует команКнопка де SPACETRANS, которая предназначена
ересчета длин между пространствами модели и листа. 

 
для п

оманда DIMEDIT позволяет поменять раз-
мерн ожение, а также наклонить выносные линии. Ко-
манд

Редактирование размеров. К
ый текст и его местопол

 панели Dimension (Размеры) и пункты подме-е соответствуют кнопка 
ню A ющего меню Dimension. 

опка 
lign Text (Размерный текст) пада
Команде DIMSTYLE соответствует кн , которая входит как в па-

нель  панель Styles (Стили). Этой же коман-
де с падающего меню Dimension и пункт 
Dime ormat. Команда позволяет 
созд

в). Эту кнопку удобно использовать еще и 
для в ение размеров, не редактируя раз-
мерн . 

ого окна 
Dim
дой рмления размеров записываются в так на-
зыва  сохраняются вместе с рисунком. 
Посм  можно, щелкнув мышью по кнопке 
COM

 процесса разработки черте-
жей лок – это 
слож  
любо ; 
мож любое место чертежа, причем в процессе 
вста ициен-
тами , 
зада

 и автономные. 

 Dimension (Размеры), так и в новую
оответствуют пункт Style (Стиль) 
nsion Style (Размерные стили) падающего меню F
авать и редактировать размерные стили (совокупность установок, описы-

вающих форму размерных примитиво
несения отдельных изменений в оформл
ого стиля и не создавая нового
Размеры можно корректировать с использованием диалогов
ension Style Manager (Диспетчер размерных стилей), открываемое коман-
DIMSTYLE. Все установки офо
емые размерные переменные, которые
отреть их действующие значения
PARE (Сравнить).  

 автоматизацииБлоки. Важным инструментом
и моделей является использование блоков и внешних ссылок. Б
ный именованный объект, для которого создается описание, включающее

щего рисунка. Блок имеет базовую точкуе количество примитивов теку
в ет применяться для вставки 

вки возможен его поворот и масштабирование с различными коэфф
 по разным осям. Блок может содержать атрибуты – переменные надписи
ваемые пользователем.  
Применяются два типа блоков: локальные
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Локальные блоки входят в состав того чертежа, в котором они были соз-
даны теж. 

т команду BLOCK (БЛОК). Команде соот-
ветс

, и не могут быть перенесены в другой чер
Автономные блоки хранятся в виде отдельного файла чертежа и могут 

быть использованы в других чертежах. 
Для создания блока применяю

 панели инструментов Draw (Рисотвуют кнопка вание) и пункт падаю-
щего
вызы inition (Описание блока) (рисунок 2.33). 

 меню Draw | Block | Make (Рисование | Блок | Создать). Команда BLOCK 
вает диалоговое окно Block Def

 
Рисунок 2.33 – Диалоговое окно Block Definition 

(Описание блока) 
 

Для создания блока необходимо определить на изображении базовую точку 
и выбрать объекты чертежа, подлежащие включению в блок. Базовой называется 
точка, используемая для вставки блока.  

Способы ввода данных:  
1) выбрать объекты на экране (Select Object); 
2) выбрать объекты с помощью функций быстрого отбора AutoCAD по 

свойствам (Quick Object). 
Возможные варианты выбора: с сохранением примитивов в текущем со-

стоянии; с заменой в существующем чертеже блоком; с удалением из текущего 
чертежа при записи в базу данных. 

Возможен предварительный просмотр процесса создания изображения блока. 
При создании автономного блока дополнительно задается имя и располо-

жение файла автономного блока, а также единицы измерения, которые будут ис-
пользоваться

Для вставки бло ВСТАВИТЬ), кото-
 при вставке блока. 

ков  используется команда INSERT (
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рой соответствуют кнопка  панели инструментов Draw и пункт Block па-
дающ

деология создания чертежей 
в Au ов. Существуют два принципиально 
разл utoCAD. 

ие со старыми версиями (до 14-й включительно), 
прив цию в масштабе, необходимом для размещения 
на ли внутрь штам-
па тр При этом, если в чертеже содержа-
лось странстве произвольно относи-
тель

нятен и прост, но неудобен тем, что в разных чер-
тежн  и приходится производить пере-
счет . 

 выше, в AutoCAD был введен новый 
меха ие понятия, как 
прос ой экран, ассо-
циат

 разделить на следую-
щие 

На данном этапе проектируется конструкция и строится необхо-
димое число видов без нанесения на  них пояснительной информации и размеров. 
Чертежные виды могут располагаться в пространстве модели произвольно.  

2. Из шаблона создается необходимое число новых листов необходимого 
формата с штампом и основной надписью.  

3. На каждом из листов создаются видовые экраны, представляющие собой 
чертежные виды. Для каждого видового экрана настраивается масштаб отобра-
жения и другие параметры.  

4. Видовые экраны размещаются на листе и закрепляются.  
5. В пространстве листа на виды наносятся ассоциативные размеры, а так-

же наносятся все остальные элементы оформления.  
К достоинствам данного способа оформления стоит отнести:  
− удобство проектирования (нет необходимости чертить в масштабе; нет 

необходимости точно размещать чертежные виды);  
− 
− один 

лист  одна закладка);  

Пространство модели и пространство листа. Пространством модели на-
зывается чертежная область, предназначенная для проектирования изделия. Ее 
размеры во всех направлениях не ограничены. Рекомендуется в пространстве 

его меню Insert (Вставка). 
Подготовка и выпуск чертежей. И
toCAD с применением видовых экран
ичных подхода к оформлению чертежей в A
Пользователи, работавш
ыкли чертить конструк
сте. Затем виды компоновались в пространстве, помещались 
ебуемого формата и распечатывались. 

 несколько листов, они размещались в про
но друг друга. 
Этот путь интуитивно по
ых видах применяется разный масштаб

бирование фрагментов размеров и масшта
Начиная с версии 2000 (релиз 15) и
низм оформления чертежей. Этот механизм использует так

странство листа, видовтранство модели (или модель), про
ивные размеры. 
Процесс проектирования и оформления КД можно
этапы:  
1. Проектирование (вычерчивание) в пространстве модели конструкции 

в масштабе 1:1. 

легкость размещения чертежных видов на листе;  
более «аккуратное» пр раничных документов (едставление многост

 –
− возможность сохранения для каждого листа уникальных настроек выво-

да на печать. 
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моде  
этом  дополнительные (местные) виды чертятся также в масштабе 1:1, при-
чем 

значенная 
для ю чт

н
водились на печать, их следует поме-

щать

ли чертить конструкцию в масштабе 1:1 независимо от ее габаритов. При
 все
их взаимное расположение может быть произвольным. 
Пространством листа называется чертежная область, предна
вывода изображения на печать. Ее особенность  является то, о 

1 мм пространства листа теоретически должен быть равен 1 мм на бумаге печа-
тающего устройства. На практике получается, что почти все малоформатные 
принтеры имеют поля печати. Поэтому при выводе на печать имеется некото-
рая погрешность (уменьшение). Обычно она не превышает 5–8 %. 

Видовые экраны. Видовой экран (ВЭ) представляет собой фрагмент мо-
дели, находящийся на листе. При этом для каждого видового экрана отдельно 
можно настроить масштаб отображения. В сущности, ВЭ является границей 
чертежного вида на листе. Видовые экраны бывают двух типов: прямоугольные 
и произвольной формы. Создание и управление ВЭ производится при помощи 
инструментов, представленных на панели Viewports. На этой панели есть также 
поле, отображающее масштаб для выделенного ВЭ. 

Видовые экраны могут накладываться друг а друга полностью или час-
тично. Для того чтобы границы ВЭ не вы

 на непечатаемый слой. 
 
 
2.9 Трехмерное моделирование в системе AutoCAD 

Система AutoCAD 2000 / 2002 / 2004 включает в себя достаточно широкий 
спектр средств трехмерного моделирования. Она позволяет работать как с про-
стейшими, примитивами, так и со сложными поверхностями и твердыми тела-
ми. Базовые типы пространственных моделей, используемых в AutoCAD, мож-
но условно разделить на три группы: 

− каркасные модели; 
− модели поверхностей; 
− твердотельные модели. 

Каркасная модель – это совокупность отрезков и кривых, определяющих 
ребра фигуры. В каркасном моделировании используются трехмерные отрезки, 
сплайны и полилинии, которые позволяют в общих чертах определить конфи-
гурацию изделия – построить его каркас. Данный вид работы следует рассмат-
ривать главным образом как этап вспомогательных построений для трехмерно-
го проектирования более высокого уровня. 

Поверхностная модель – это совокупность поверхностей, ограничиваю-
щих и определяющих трехмерный объект в пространстве. Моделирование по-
верхностей применяется для детальной отработки внешнего облика изделия. 
Создаваемые при этом объекты характеризуются лишь конфигурацией своей 
поверхности и поэтому непригодны для решения таких задач, как определение 
инерционно-массовых характеристик изделия или получение необходимых 
изображений для оформления чертежей. Область применения данного вида мо-
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делирования – дизайн, решение задач компоновки сложных изделий. 
Набор средств моделирования поверхностей системы AutoCAD 2002 весь-

ма широк и позволяет создавать пространственные объекты практически любой 
формы. Имеется возможность создавать следующие основные типы поверхно-
стей: линейчатые поверхности, поверхности Кунса, поверхности Безье. 

Твердотельное моделирование является основным видом трехмерного 
проектирования изделий машиностроения. Создаваемые в ходе такого модели-
рова

 
осущ

орм. Серьезные сложности воз-
ника

 создания пространственных объектов, блок трехмерного 
моде  Aut себя 

S
с

де всего для каркасного моделирования, являются отрезки, 
спла

 

р
 п

строения и редактирования поверхностей указаны в 
табл

, 2.5.  
 

ния тела воспринимаются системой как некие единые объекты, имеющие 
определенный объем. Твердотельное моделирование позволяет не только эф-
фективно решать компоновочные задачи, но и определять инерционно-
массовые характеристики, а также получать с пространственного объекта необ-
ходимые виды, разрезы и сечения для оформления рабочей документации. 
Твердотельное модели могут подвергаться различным расчетам, в том числе 
методом конечных элементов.  

Средства твердотельного моделирования системы AutoCAD не позволяют
ествлять параметрическое моделирование. Поэтому возможности этой 

системы в данной области уступают возможностям таких систем, как Autodesk 
Mechanical Desktop, Inventor или Solid Works. Тем не менее AutоCAD вполне 
позволяет создавать твердотельные модели деталей и узлов, конфигурация ко-
торых представляет собой набор простейших ф

ют лишь при моделировании изделий сложной неправильной формы, на-
пример литых деталей.  

Помимо средств
лирования системы oCAD включает в средства просмотра объемного 

изображения, визуализации и средства редактирования трехмерных объектов.  
Необходимо открыть следующие панели инструментов перед началом рабо-

ты: View→Toolbars→3D Orbit, View→Toolbars→Shade, View→Toolbars→Solids, 
View→ Toolbars→ olids Editing.  

Элементарными трехмерными объектами истемы AutoCAD, предназна-
ченными преж

йны и полилинии. Первые два типа объектов создаются при помощи тех же 
команд LINE и SPLINE, которые используются при плоском черчении. Осо-
бенностью при их использовании в трехмерном пространстве является то, что 
при задании координат точек следует указывать и координату оси Z (при плос-
ком черчении эта координата опускается). При указании точек г афическим 
курсором следует пользоваться объектной привязкой, так как в ротивном слу-
чае система воспринимает указанные точки, лежащие на плоскости XY теку-
щей системы координат. Трехмерные полилинии создаются при помощи специ-
альной команды 3DPOLY.  

Некоторые средства по
ицах 2.2, 2.3, а средства построения и редактирования твердотельных объ-

ектов – в таблицах 2.4
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Моделирование поверхностей. Средства построения поверхностей 
Таблица 2.2 – Команды построения поверхностей 

Команда Назначение команды Вызов команды 
 

1 2 3 
3DFACE Построение пространственных трех- и четы-

рехугольных граней 
Draw → Surfaces → 3D Face 

AI_BOX Построение поверхности прямоугольного па-
раллелепипеда, основания которого параллель-
ны плоскости XY текущей системы координат 

Draw → Surfaces → 3D Sur-
faces → Box3D 

AI_WEDGE Построение поверхности прямой призмы 
(«клина») с основанием в виде прямоуголь-
ного треугольника 

Draw → Surfaces → 3D Sur-
faces → Wedge 

AI_PYRAMID Построение поверхности треугольной или че-
тырехугольной пирамиды или обелиска 

Draw → Surfaces → 3D Sur-
faces → Pyramid 

AI_CONE Построение боковой поверхности кругового 
прямого конуса, в том числе усеченного 

Draw → Surfaces → 3D Sur-
faces → Cone 

AI_SPHERE Построение сферы Draw → Surfaces → 3D Sur-
faces → Sphere 

AI_DOМЕ Построение верхней полусферы (поверхности 
ку

Draw → Surfaces → 3D Sur-
 пола) faces → Dome

AI_DISH П s→3D Surfaces→ остроение нижней полусферы (поверхности Draw→ Surface
чаши) Dish 

AI_TORUS Построение поверхности тора Выпадающее меню: Draw → 
Surfaces → 3DSurfaces →Torus 

3DMES  в ви-
ящей из четырехуголь-

Draw → Surfaces → 3D Mesh H Построение произвольной поверхности
де трехмерной, состо
ных сегментов 

AI_ME  били-
 набора 

Draw → Surfaces → 3D Sur-
face → Mesh 

SH Построение четырехугольного участка
нейной поверхности, состоящего из
элементарных четырехугольных сегментов 

REVSU ние произвольной поверхности вра- Draw → Surfaces → Revolved 
Surface 

RF Построе
щения 

TABSURF Построение поверхности, получаемой перемеще-
нием образующей вдоль направляющего вектора 

Draw → Surfac
lated Surface 

es → Tabu-

RULES ой поверхности, заданной Draw → Surfaces → Ruled Sur-
face 

URF Построение линейчат
двумя произвольными направляющими  

EDGES

й контур 

urfaces → Edge URF Построение нелинейчатой поверхности, за-
данной двумя парами произвольных линий, 

Draw → S
Surface 

образующих замкнуты
 

ерхностей Средства редактирования пов
Таблица 2.3 – Команды редактирования поверхностей 

Команда Назначение команды Вызов команды 
EDGE Позволяет управлять видимостью отдельных 

реб
Draw → Surfaces → Edge 

ер элементарных сегментов поверхностей 
PEDIT Позволяет редактировать свойства сложных 

поверхностей 
Modify → Object → Polyline 

PROPERTIES Редактирование свойств поверхностей Modify → Properties 
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Твердотельное моделирование. Средства построения твердотельных 
объектов 
Таблица 2.4 – Команды построения твердотельных объектов 

Команда Назначение команды Вызов 
 команды 

B  →OX Построение твердотельного прямоугольного 
параллелепипеда с ребрами, параллельными 
осям текущей системы координат 

Draw  Solids → Box 

SPHERE Построение твердотельного шара Draw → Solids → Sphere 
CYLINDER Построение прямого твердотельного цилиндра с 

осью, параллельной оси Z системы координат 
Draw → Solids → Cylinder 

CONE Построение твердотельного конуса Draw → Solids → Cone 
WEDGE Построение твердотельной прямой призмы 

(«клина») с основанием в виде прямоугольного 
треугольника, параллельным плоскости XZ  

Draw → Solids → Wedge 

TORUS Построени  → Solids → Torus е твердотельного тора Draw
EXTRUDE Построение твердотельного объекта путем "вы-

давливания" плоского контура 
Draw → Solids → Extrude 

REVOLVE Построение твердого тела вращения Draw → Solids → Revolve 
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Средства редактирования твердотельных объектов 

Назначение команды Вызов 
Таблица 2.5 – Команды редактирования твердотельных объектов 

Команда 
 команды 

CHAMFER Позволяет создавать фаску (скошенную честь 
кромки) твердого тела 

Modify → Chamfer 

FILLET Позволяет скруглять внутренние и внешние углы 
твердого тела 

Modify → Fillet 

SLICE Позволяет разрезать набор тел плоскостью и при 
необходимости удалить отсеченные части объектов 

Draw → Solids → Slice 

UNION Позволяет создать новый твердотельный объект Modify →
путем объединения нескольких объектов ing → Union 

 Solids Edit-

SUBTRACT Позволяет создать новые область или твердо-
тельный объект путем исключения (вычитания) 
аналогичных объектов 

Modify → Solids Edit-
ing → Subtract 

INTERSECT Позволяет создать новый твердотельный объект, 
который является общей частью всех указанных 
объектов 

Modify → Solids Edit-
ing → Intersect 

INTERFERE Позволяет проверить, пересекаются ли тела од-
ного набора с телами другого набора, и в случае 
наличия пересечения создать новые объекты, яв-

Modify → Solids → In-
terfere 

ляющиеся общей частью обеих наборов 
SOLIDEDIT Обеспечивает редактирование твердотельных 

объектов 
Modify → Solids Edit-
ing 

SECTION Позволяет построить сечения (в виде замкнутых 
областей) твердотельных объектов 

Draw → Solids → Sec-
tion 

 
 
Общие средства редактирования трехмерных объектов 
Для редактирования любых трехмерных объектов могут применяться та-

кие универсальные команды, как PROPERTIES, COPY, ERASE, EXPLODE, 
MOVE, OOPS, REDO, SCALE, UNDO, а также средство редактирования 
Grips (таблица 2.6). Работа со всеми этими средствами ведется так же, как и 
при 2D черчении. Использование ряда других команд редактирования имеет 
ряд особенностей. 
Таблица 2.6 – Команды редактирования трехмерных объектов 
Команда Назначение команды Вызов 

 команды 
3DARRAY Создает в пространстве копии объектов в ви- Modify → 3D Operation → 3D 

де прямоугольного или полярного массива Array 
MIRROR3D Создает зеркальную копию объектов отно-

сительно плоскости 
Modify → 3D Operation → 
Mirror 3D 

ROTATE3D Поворот объектов относительно произволь- Modify → 3D Operation 
но направленной оси Rotate 3D 

→ 

ALIGN Задает положение и ориентацию объекта вы-
равнива его относительно другого объекта 

Modify → 3D Operation → 
Align 
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При использовании команды ARRAY применительно к трехмерным объ-
ектам создается массив объектов, все соответствующие точки которых распо-
ложены на одной плоскости, параллельной плоскости XY текущей системы ко-
ординат. Поэтому с помощью данной команды нельзя создать массив, элементы 
кото

 координат. 

рез заданную 
точк

рого имеют различное расположение относительно оси Z. 
При использовании команды MIRROR применительно к трехмерным объ-

ектам создается их зеркальное отражение относительно плоскости, проходящей 
через заданную ось симметрии и перпендикулярной плоскости XY текущей 
системы

При использовании команды ROTATE применительно к трехмерным объ-
ектам производится их поворот относительно оси, проходящей че

у и перпендикулярной плоскости XY текущей системы координат. 
При использовании команды STRETCH применительно к поверхностям 

производится изменение положения их узловых точек. Изменение формы твер-
дотельных объектов с помощью данной команды невозможно (действие коман-
ды сводится к перемещению объекта). 

 
 
2.10 Пример трехмерного моделирования в AutoCAD 

Пример создания твердотельной модели крышки пульта управления в 
AutoCAD (рисунок 2. 34).  

 
Рисунок 2.34 – Двухмерный чертеж крышки пульта управления 
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2.10.1 Построение внешней формы детали 

вести: 

X ввести: 

Внимание! При вводе промежуточных данных для всех команд трехмер-
ного моделирования необходимо его заканчивать нажатием клавиши <Ввод>. 

1. Создать и сделать текущим новый слой для построения внешнего конту-
ра детали по команде LAYER. 

2. Построить прямоугольную внешнюю часть пульта.  
2.1. По команде BOX в
− координаты нижней левой вершины параллелепипеда (0, 0, 0); 
− координаты нижней противоположной грани параллелепипеда (198, 48, 0); 
− высоту параллелепипеда (8). 
2.2. По команде BOX ввести: 
− координаты (2, 2, 8); 
− координаты нижней противоположной грани параллелепипеда (196, 46, 8); 
− высоту параллелепипеда (4). 
2.3. По команде UNION выбрать два ранее созданных объекта. 
2.4. По команде BOX ввести: 
− координаты (66, 0, 0); 
− координаты нижней противоположной грани параллелепипеда (172, 48, 0); 
− высоту параллелепипеда (2). 
2.5. По команде SUBTRACT выбрать: 
− большую фигуру; 
− фигуру, созданную в пункте 2.4. 
2.10.2 Построение внутренней формы детали 
1. Создать и сделать текущим новый слой для построения внутреннего 

контура детали по команде LAYER. 
2. Построить внутреннюю часть пульта. 
2.1. По команде BOX ввести: 
− координаты нижней левой вершины параллелепипеда (4, 4, 4); 
− координаты нижней противоположной грани параллелепипеда (194, 44, 4); 
− высоту параллелепипеда (8). 
2.2. По команде SUBTRACT выбрать: 
− внешний контур детали; 
− фигуру, созданную в пункте 4.2.1. 
2.3. По команде BO
− координаты нижней левой вершины параллелепипеда (4, 4, 2); 
− координаты нижней противоположной грани параллелепипеда (64, 44, 2); 
− высоту параллелепипеда (2). 
2.4. По команде BOX ввести: 
− координаты нижней левой вершины параллелепипеда (174, 4, 2); 
− координаты  нижней противоположной грани параллелепипеда (194, 44, 2); 
− высоту параллелепипеда (2). 
2.5. По команде SUBTRACT выбрать: 
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− внешний контур детали; 
− фигуры, созданные в пунктах 2.3 и 2.4. 
После промежуточных построений получился вид крышки пульта управ-

ления без отверстий под кнопки (рисунок 2.35). 
2.6. По команде BOX ввести: 
− координаты вершины параллелепипеда (98, 9, 2); 
− координаты нижней противоположной грани параллелепипеда (102, 13, 2); 
− высоту параллелепипеда (2). 

 
Рисунок 2.35 – Вид крышки пульта управления после промежуточных построений 
 

2.7. По команде ARRAY открыть окно и установить указанные на рисун-
ке 2.36 параметры. 

 
Рисунок 2.36 – Вид окна команды ARRAY при моделировании  

всех отверстий крышки пульта управления 
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2.8. По команде SUBTRACT выбрать: 
− внешний контур детали; 
− фигуры, созданные в пунктах 2.6 и 2.7. 

− ввести необходимый радиус скругления; 
− выбрать угол, который необходимо скруглить. 
Трехмерная твердотельная модель крышки пульта управления построена 

(рисунок 2.37). 

2.9. По команде CYLINDER ввести: 
− координаты центра цилиндра (82, 24, 4); 
− радиус цилиндра (10); 
− высоту цилиндра (2). 
2.10. По команде UNION выбрать ранее созданные объекты. 
2.11. По команде CYLINDER ввести: 
− координаты центра цилиндра (82, 24, 2); 
− радиус цилиндра (7); 
− высоту цилиндра (4). 
2.12. По команде SUBTRACT выбрать: 
− контур детали; 
− фигуру, созданную в пункте 2.11. 
3. Провести скругление углов детали по команде FILLET: 
− нажать клавиши <R> и <Ввод>; 

 
Рисунок 2.37 – Трехмерная твердотельная модель крышки пульта управления 

со скругленными углами 
 
Аналогичным образом строятся и другие трехмерные твердотельные моде-

ли в AutoCAD. 
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3 СИСТЕМА АВТОМАТИЗИРОВАННОГО ПРОЕКТИРОВАНИЯ T-FLEX CAD 

 
3.1 Общие сведения о программном комплексе T-FLEX CAD 

Система T-FLEX CAD (автоматизированного проектирования и 
моделирования  применяется в вании (проектирование 
различного оборудования, инструмента; проектирование готовых изделий и т. 
д.), 

 

 

очий чертеж). T-

 

ое использование чер-

скую

) успешно конструиро

для решения технологических задач (оформление технологических карт, 
спецификаций; подготовка данных для разработки технологических процессов; 
подготовка информации для систем программирования оборудования с ЧПУ), в
задачах строительства и архитектуры, при разработке различных типов схем, 
при динамическом графическом моделировании процессов и механизмов, в
задачах художественного оформления и дизайна. Наиболее эффективно T-
FLEX CAD применяется в тех областях, где наиболее полно реализуется идея 
параметрического проектирования, а также, где необходимо охватить все этапы 
конструирования (эскизный проект, черновой чертеж, раб
FLEX CAD позволяет значительно ускорить процесс проектирования и 
подготовки графической документации. 

Параметрическое проектирование, возможность назначения геометриче-
ских параметров через переменные и изменение этих параметров - это будущее
всех систем автоматизированного проектирования и черчения. Эффективность 
системы T-FLEX CAD базируется в первую очередь на новой геометрической 
модели. Эта модель позволяет наполнить понятие "параметризация" более глу-
боким, чем это принято в других системах, содержанием. Идея параметризации 
уже прочно завоевала свое место в компьютерном проектировании. Под пара-
метризацией подразумевается, прежде всего, многократн
тежа с возможностью изменения его параметров. T-FLEX CAD использует при-
вычные для конструктора элементы и параметры проектирования. При этом со-
вершенно не обязательно ставить элементы чертежа на точные позиции. Воз-
можности по модификации размеров элементов и их положения на чертеже не 
имеют аналогов в других CAD-системах. Уникальными по своим возможно-
стям являются средства создания сборочных параметрических чертежей. T-
FLEX CAD позволяет получать сложные чертежи, в которых его отдельные 
части могут быть взаимосвязаны. Связь можно задавать как через геометриче-

 зависимость, так и через значения параметров. При этом обеспечивается 
удаление невидимых линий в случае, если отдельные части чертежа перекры-
вают друг друга. Меняя параметры сборочного чертежа, можно за считанные 
секунды получить готовые чертежи нового проектируемого изделия. Одновре-
менно с измененным сборочным чертежом получаются и чертежи его состав-
ных частей (деталей), а также другие сопутствующие документы. 

Одним из обычных атрибутов параметрических CAD-систем является язык 
программирования, который используется для задания параметрических связей. 
В этой связи проявляется еще одна существенное достоинство программы T-
FLEX CAD. От разработчика не требуется никаких специальных знаний в об-
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ласти программирования. Параметрам чертежа могут назначаться переменные. 
С по

менных можно получать из 
друг

атически приводит к изменению 
соот

ль позволяет наполнить понятие 
"пар

ств для оформления 
техн

 элементы 
офор

ежа автоматически приводит к изменению 
соответствующих элементов оформления. Чертежи могут создаваться в 
соответствии с требованиями ЕСКД или международных стандартов. T-FLEX 
CAD  из одного стандарта в 
друг

мощью простых математических формул можно связывать переменные 
между собой. При этом не нужно изучать какой-либо язык программирования. 
Назначение переменных может происходить и при создании элемента, и при 
его последующем редактировании. Значение пере

их чертежей или автоматически выбирать из баз данных. Всё это делает 
возможности по модификации чертежа безграничными. 

T-FLEX CAD предлагает полный набор средств для оформления техниче-
ских чертежей: нанесение линий различных типов, штриховок, размеров, тек-
стов, шероховатостей, специальных символов и т.д. Важно отметить, что все 
элементы оформления могут быть связаны с параметрами чертежа. Это означа-
ет, что изменение параметров чертежа автом

ветствующих элементов оформления. Чертежи могут создаваться в соот-
ветствии с требованиями ЕСКД или международных стандартов. T-FLEX CAD 
позволяет мгновенно перевести готовый чертеж из одного стандарта в другой.  

Трёхмерная версия T-FLEX CAD 3D позволяет получать параметрические 
трёхмерные модели. Созданные в системе трёхмерные твёрдотельные модели 
легко модифицируются, так как T-FLEX CAD 3D базируется на двумерной вер-
сии пакета. При параметрическом изменении двумерного чертежа автоматиче-
ски изменяется его трёхмерное представление. 

Работа с системой понятна даже начинающему пользователю. Каждая ко-
манда системы реализована так, чтобы при разработке не возникало никаких 
затруднений.  

Параметрическое проектирование, возможность назначения 
геометрических параметров через переменные и изменение этих параметров – 
это будущее всех систем автоматизированного проектирования и черчения. 
Эффективность системы T-FLEX CAD базируется в первую очередь на новой 
геометрической модели. Эта моде

аметризация" более глубоким, чем это принято в других системах, 
содержанием.  

T-FLEX CAD предлагает полный набор сред
ических чертежей: нанесение линий различных типов, штриховок, 

размеров, текстов, шероховатостей, специальных символов и т. д. Все
мления могут быть связаны с параметрами чертежа. Это означает, что 

изменение параметров черт

 позволяет мгновенно перевести готовый чертеж
ой. T-FLEX CAD автоматически присваивает созданным документам имя с 

расширением файла *.grb. 
На рисунке 3.1 представлено окно системы T-FLEX CAD с указанием его 

основных элементов. 
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Рисунок 3.1 – Элементы интерфейса системы T-FLEX CAD 

Панель «Вид» позволяет выполнить следующие действия по управлению 
изображением: 

 

Определить размер изображения рамкой; 
 

Увеличить изображение; 
 

Уменьшить изображение; 
 

общего вида инверсная область показы-

Вписать в рабочее окно лист чертежа; 
 

Вписать в рабочее окно все элементы изображения (элементы построения не 
учитываются); 

 

Отобразить в натуральную величину; 
 

Вернуться к предыдущим границам экрана (до десяти шагов); 
 

Обновить изображение; 
 

Скрыть / показать элементы построения; 
 

Спрятать / показать элементы, задаваемые пользователем; 
 

Открыть чертежный вид; 
 

Работа с листами документа. 
 
Линейки рабочего окна можно использовать для сдвига изображения (ри-

сунок 3.2, а) или для его плавного масштабирования (рисунок 3.2, б). Переклю-
чение режимов осуществляется щелчком мыши на кнопке, показанной на ри-
сунке стрелкой. 

Окно общего вида (рисунок 3.2, г) отображает часть чертежа, расположен-
ную в пределах рамки формата. В окне 
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вает текущие границы рабочего окна. С помощью мы  здесь можно задать 
новые границы отображения. 

 

ши

     
 а  б  в 

  
д 

Рисунок 3.2 – Элементы рабочего окна 

Показанная группа команд меню Правка (рисунок 3.2, в) предназначена 
для отмены ошибочно выполненных действий или для возврата отмененных. 

Команды отката представлены кнопками  в панели «Стандартная». По 
умолчанию система помнит 50 последних команд. Длину очереди команд мож-
но изменить через меню Настройка/Установки/Разное. 

Система T-FLEX CAD использует при создании чертежа несколько типов 
элементов. 

1. Элементы построения формируют каркас чертежа. С ними связаны 
элементы изображения, которые и являются тем реальным изображением, ко-
торое мы хотим в итоге

роения и узлы
 получить. К элементам построения относятся линии 

пост  построения и узлы – основные элементы, форми-
рующ черчением их можно 
срав м обводятся тушью. 
С по ения и узлов устанавливает-
ся вз  порядок расчета их поло-
жени

. Линии
ие параметрическую модель чертежа. По аналогии с 

ые затенить с тонкими карандашными линиями, котор
мощью задания различных типов линий постро
аимосвязь элементов построения и определяется
я при параметрическом изменении чертежа. Они присутствуют только на 

экране и не выводятся на принтер или плоттер. 
Линии построения – это прямые, окружности, эллипсы, кривые (сплай-

ны), эквидистанты и кривые, заданные функцией. Это базовые элементы пара-
метрической модели в T-FLEX CAD. Они представляют собой тонкие конст-
рукционные линии, с помощью которых вы создаете параметрический каркас 
вашего чертежа. 

Узлы – точки пересечения линий построения. Узлы являются базовым 
элементом создания параметрической модели в T-FLEX CAD. Узлы напрямую 
участвуют в построении параметрической модели при задании типов линий по-
строения. 
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“Свободный” узел – узел, положение которого определяется абсолютны-
ми координатами.  

“Узел с фрагмента” – узел, который определяется положением фрагмента 
на чертеже. 

2. Элементы изображения формируют чертеж. К элементам изображения 
относятся линии изображения, размеры, тексты, штриховки, допуски формы и 
расположения поверхностей, надписи, шероховатости. Они могут “привязы-
ваться” к элементам построения. В этом случае, при изменении положения ли-
ний построения и узлов, элементы изображения изменяют свое положение, что 
и является основной идеей параметризации в T-FLEX CAD. Эти элементы со-
став

овные, 
спло

ются к узлам и линиям построения. При изменении 
поло

рестраиваются при параметрическом измене-
нии 

ции. 

ляют изображение чертежа при выводе на принтер и плоттер. 
Линии изображения – отрезки, дуги окружностей, окружности, дуги эл-

липсов, эллипсы, кривые. Могут быть различных типов (сплошные осн
шные тонкие, штриховые, штрихпунктирные и т.д.). Они привязываются к 

узлам и линиям построения. 
Штриховки, заливки, штриховки по образцу – замкнутые одноконтур-

ные или многоконтурные области заполненные различными способами. Конту-
ры штриховок привязыва

жения узлов изменяются контуры штриховок. При этом автоматически из-
меняется заполнение штриховок в соответствии с изменением контуров. 

Тексты – однострочная и многострочная текстовая информация, задавае-
мая в текстовом редакторе и отображаемая на экране различными шрифтами. 
Положение текстов может быть задано в абсолютных координатах, то есть не-
зависимо от элементов построения. Тексты могут быть привязаны к линиям по-
строения и узлам. 

Размеры – стандартный элемент оформления чертежей. Размер состоит из 
совокупности линий и текстовой информации. Он может быть построен только 
при наличии линий построения и узлов. Система T-FLEX CAD поддерживает 
простановку размеров нескольких стандартов: ЕСКД, ANSI, архитектурный 
ANSI. Размеры автоматически пе

чертежа. 
Шероховатости – стандартный элемент оформления чертежей. Состоит из 

совокупности линий и текстовой информации. Шероховатость может быть при-
вязана к абсолютным координатам, к узлу, к линии построения и к размеру. 

Допуски формы и расположения поверхностей – стандартный элемент 
оформления чертежей. Состоит из совокупности линий и текстовой информа-

Привязывается только к узлу. 
Надписи – стандартный элемент оформления чертежей. Состоит из сово-

купности линий и текстовой информации. Надпись может быть привязана к аб-
солютным координатам, к узлу, к линии построения. 

К сложным элементам изображения относятся фрагменты и картинки. 
Фрагменты – чертежи системы T-FLEX CAD, которые могут использо-

ваться в других чертежах, для получения составных (сборочных) чертежей. 
Фрагментом может быть любой чертеж системы T-FLEX CAD. Под параметри-
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ческим фрагментом системы T-FLEX CAD понимается чертеж, при нанесении 
которого на другой чертеж, вы можете задать его положение и параметры, от 
которых зависит его изображение. При создании параметрических фрагментов 
необходимо соблюдать определенные правила. 

Картинки –графические изображения чертежей системы T-FLEX CAD и 
других систем, сохраненные в различных форматах. Картинки, как и фрагмен-
ты, можно использовать в других чертежах. При этом изображение картинок 
будет неизменным, вы можете только задать его положение и масштаб изобра-
жения. 

3. К вспомогательным элементам относятся переменные, поля, базы 
данных, отчеты, а также некоторые другие служебные данные. 

Переменные – элементы системы, имеющие имя и значение. Значения пе-
ременных можно изменять. Основное назначение переменных – это использо-
вание их значений в качестве параметров линий построения. Например, в каче-
стве параметра прямой, параллельной заданной и расположенной от нее на каком-
то расстоянии, можно использовать не только число, но и переменную. 

Базы данных – таблицы, содержащие информацию в упорядоченном виде. 
Базы данных используются для хранения информации, необходимой для чер-
тежа

 двумерного проектирования конструкций  

тежа наностися на основе пред-
вари см. руководство пользователя). 
Элем

. 
Отчеты – текстовые документы, которые создаются с помощью текстово-

го редактора системы T-FLEX CAD и могут включать в себя переменные сис-
темы. Служат для создания разнообразных текстовых документов. 

 
 
.2 Особенности3

в T-FLEX CAD 

В системе T-FLEX CAD изображение чер
тельно созданных элементов построения (
енты построения, формирующие каркас чертежа, представляют собой бес-

конечные прямые и окружности, связанные между собой различными геомет-
рическими отношениями. Этими отношениями могут быть параллельность, ка-
сание, симметрия, угол наклона и т.д. По аналогии с черчением на бумаге эле-
менты построения можно сравнить с тонкими карандашными линиями, кото-
рые потом обводятся тушью. 

 Таким образом, прежде чем нарисовать линии чертежа, необходимо с по-
мощью линий построения создать каркас чертежа. Линии изображения чертежа 
оказываются "привязанными" к линиям построения, и при изменении их поло-
жения будут следовать за ним. При этом сохраняются все геометрические от-
ношения, которые были заданы для элементов построения. 

В системе T-FLEX CAD чертеж может быть построен одним из следующих 
способов: параметрически и непараметрически. 
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Принципы параметризации чертежа 
Параметрический способ построения чертежей – это основной режим ра-

боты системы T-FLEX CAD. Используя преимущества параметрического про-
ектирования T-FLEX CAD, возможно создать чертеж, который будет легко из-
меняться при дальнейшем проектировании. Этот чертеж можно включить в ка-
честве элемента параметрической библиотеки для использования его в других, 
более сложных, чертежах.  

В отличие от эскизного черчения, при создании параметрической модели 
сначала выполняется разметка чертежа «в тонких линиях». Для этого исполь-
зуются элементы построения: прямые, узлы, окружности и др. 

При вводе элемента построения задаются геометрические взаимосвязи, на-
пример, параллельность существующему элементу, и числовые параметры (для 
параллельной прямой – расстояние между элементами). В дальнейшем число-
вые параметры можно изменять, тем самым, модифицируя модель. 

Значение параметра можно задать вводом константы, или связав параметр 
с переменной. В последнем случае управление моделью становится более
удобным, так как доступ ко всем переменным осуществляется из специального 
редактора. Кроме того, наличие переменных дает возможность вводить в мо-
дель различные расчеты. 

Ввод значения параметра осуществляется в окне свойств элемента (в дан-
ном случае элементом является прямая, параллельная другой прямой, и пара-
метром, соответственно, будет расстояние между ними). Вместо значения в 
данном окне можно указать имя переменной. Если такой переменной не суще-
ствует, будет запущен диалог создания переменной. Переменные могут быть 
пред

 

 

во 

я

е прямые. Далее происходит построение прямых или окружно-

варительно созданы в Редакторе переменных. Не все элементы построе-
ния имеют числовые параметры. Так, прямая, проходящая через два узла, пол-
ностью определена геометрическими связями. 

При создании параметрического чертежа очень важно заранее определить
последовательность построения и взаимосвязи между отдельными элементами. 
Здесь может помочь представление о последовательности изготовления детали 
– выбираются технологические базы, от них задаются общие габариты и от-
дельные элементы детали, часть размеров задается от полученных элементов и 
т.д. Аналогично надо действовать и при создании модели. Грамотно простав-
ленные на чертеже детали размеры несут в себе информацию о последователь-
ности ее изготовления. 

Так как одну и ту же задачу можно решить множеством способов, искусст-
инженера-проектировщика электронной аппаратуры заключается в построе-

нии наиболее простой и понятной модели. 
Построение чертежа в T-FLEX CAD начинается с задания элементов по-

строения. Элементы построения могут быть созданы различными способами. 
Сначала задаются базовые линии построени , от которых в дальнейшем стро-
ится новые линии построения. Базовыми линиями могут быть вертикальные и 
горизонтальны
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стей, зависимых от базовых. Например, параллельные прямые, окружности ка-
сательные прямым. Тем самым определяется способ построения новых линий, 
который запоминается в системе. На пересечении построенных прямых созда-
ются узлы, которые требуются для проведения дальнейших построений. Затем 
продолжается построение прямых и окружностей, заданием их различными 
способами относительно построенных ранее. Например: прямая, проходящая 
через два узла, окружность касательная к прямой и проходящая через узел и т.д. 
Все эти способы сохраняются, и в дальнейшем при изменении базовых или 
других элементов построения положение зависимых прямых, окружностей и 
узлов будет определяться исходя из способа их задания.  

 

   

  
 

Рисунок 3.3 – Иллюстрация последовательности построения чертежа 
 

Таким образом, на начальном этапе построения чертежа определяются па-
раметрические зависимости элементов построения чертежа, то есть строится 
параметрический каркас чертежа. 

После задания вспомогательных линий осуществляется нанесение элемен-
тов, формирующих изображение чертежа. Наносятся линии изображения - от-
резк х 

бы их заполне-
ния. Наносится текстовая информация. При нанесении текстов можно задать 
привязку текстов к элементам построения - узлам, линиям построения. Это не-
обходимо сделать, если текст должен перемещаться вместе с изменением изо-
бражения чертежа. Далее, если это необходимо, наносятся допуски, шерохова-
тости, надписи. После этого получается параметрический чертеж с жможно-
стью его модификаци Существует возможность изменять параметры элемен-
тов построения. Напр инии от базовой, угол 
накл

и, дуги, окружности. При их нанесении происходит привязывание и к соз-
данным элементам построения - узлам и линиям построения.  

После нанесения основного изображения осуществляется  переход к 
оформлению чертежа. Наносятся размеры, которые привязываются к линиям 
построения и узлам. Определяются контуры штриховок и спосо

во
и. 
имер, расстояние параллельной л

она прямой относительно другой, радиусы окружностей. 
При этом все элементы нанесения будут изменять свое положение вслед за 

изменением положения элементов построения, с которыми они связаны. Таким 
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образом, будут получаться различные варианты одного и того же чертежа. При 
этом

ал-
лель

у  

 для создания параметрических сборочных чертежей. 
Непарамметрический чертеж строится аналогично большинству известных 

систем, когда сразу наносятся линии изображения. 
 

 все оформление чертежа будет соответственно изменяться. И все это за 
очень короткое время.  

Линии построения могут иметь числовой параметр (расстояние от пар
ной прямой, угол, радиус окружности и т.д.). Значение параметра задается 

во время создания элемента построения. Некоторые из конструктивных элемен-
тов могут не иметь параметра, например, прямая, проходящая через два узла. В 
качестве параметра элемента построения может использоваться переменная. 
Значение переменной может быть задано константой или выражением. В выра-
жении мог т присутствовать другие переменные, различные арифметические и
логические операции, условные операции, обращения к стандартным матема-
тическим функциям, а также обращения к внешним базам данных. 

Любой чертеж системы T-FLEX CAD может быть использован при работе 
с другим чертежом в качестве фрагмента, с соответствующими параметрами. 
Фрагменты используются

 
 

Рисунок 3.4 – Пример непараметрического чертежа 
 

В системе T-FLEX изображение чертежа наносится на предварительно 
созданные элементы построения. Элементы построения, формирующие каркас 
чертежа, представляют собой бесконечные прямые, окружности, сплайны, эл-
липсы, эквидистанты, с ыми геометрическими 
отношениями. Этими отношениями могут быть параллельность, касание, сим-
метр

вязанные между собой различн

ия, угол наклона и т.д. По аналогии с черчением на бумаге элементы по-
строения можно сравнить с тонкими линиями, которые затем обводятся тушью. 
Прежде чем нарисовать линии чертежа, необходимо с помощью линий по-
строения задать каркас чертежа. Линии изображения чертежа затем наносятся 
на этот каркас. Линии изображения чертежа оказываются "привязанными" к 
линиям построения, и при изменении их положения будут следовать за ними. 
При этом сохраняются все геометрические отношения, которые были заданы 
для элементов построения. 
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Рисунок 3.5 Рисунок 3.6 

 
Как видно на рисунке выше перемещение правой линии построения и уве-

личение радиуса окружности сопряжения никак не отразились на геометриче-
ских связях чертежа. 

Такой подход, когда элементы чертежа взаимосвязаны друг с другом, по-
зволяет получить полностью организованный чертеж. 

Элементами построения в T-FLEX являются линии построения - прямые, 
окружности, эллипсы, сплайны, а также узлы. Узлы - это точки пересечения

й построения. Элементы построения не выводятся на принтер или плоттер
 

лини . 
Кром

ать элементы построения вашего 
черт

 хотите задать. Ведь именно от этого будут зависеть возможности ва-
шего

а фактически параметрам линий построения (рас-
стоя

щего 
реда

. 

 с теми геометриче-
скими отношениями, которые были заложены при его создании, а также, исходя 
из математических связей между переменными, если они были заданы. Как 
правило, грамотно созданный параметрический чертеж содержит несколько 
ключевых (внешних) переменных, в зависимости от которых производится пе-
рерасчет остальных переменных и всего чертежа. 

Методика и разнообразные примеры построения прямых, окружностей, 
эллипсов, сплайнов, эквидистант, кривых, путей, узлов, а также возможных ва-
риантов расположения их относительно друг друга приведены раделе «Руково-
дство пользователя».  

Чертежи системы T-FLEX можно объединять друг с другом. Например, 
можно к чертежу детали добавить чертеж бланка форматки. Или можно вклю-
чить чертеж болта в какой-нибудь сборочный чертеж. Более того, T-FLEX по-
зволяет менять параметры включаемого чертежа. Так, если при включении бол-
та задать ему необходимый диаметр, то на сборочном чертеже вы получите со-

е того, в любой момент их можно сделать невидимыми. 
Важно отметить, что прежде чем создав
ежа, необходимо проанализировать, какие именно отношения между ли-

ниями вы
 чертежа к параметрическим изменениям. 
Параметрам чертежа, 
ниям, диаметрам и т.д.), можно назначать переменные. Это можно осуще-

ствлять и во время создания линии построения, и во время ее последую
ктирования. Затем, задавая значения переменных, можно получать новые 

варианты чертежа. С помощью простых математических формул в редакторе 
переменных переменные можно связывать между собой

При изменении положения какого-либо элемента построения или значения 
какой-либо переменной система производит пересчет чертежа и его последую-
щую перерисовку. Пересчет производится в соответствии

 204 



отве аметра. 
 в свой чертеж, называются фраг-

мент рующих чертеж, для фрагментов 
существует команда создания (то есть включения в текущий чертеж) - 
FRagment и команда редактирования - EFRagment. 

м 
назы  со-
держ жи. 
Это п ти 
и на д е 
черт менения и в 
тех чертежах, в которых он был использован. 

Создание чертежей с помощью фрагментов в ряде случаев позволяет до-
биться ряда преимуществ. Во-первых, для сложных чертежей упрощается про-
цесс создания, так как можно сначала создать отдельные части этого чертежа, а 
затем объединить их. Во-вторых, если создавать параметрический чертеж на 
основе деталей, составляющих его, то при изменении каких-либо параметров 
сборочного чертежа вы сможете одновременно получить и полный набор соот-
ветствующих этим параметрам чертежей-деталей. В-третьих, в качестве фраг-
ментов удобно создавать часто повторяющиеся элементы чертежей. 

Одним из преимуществ системы T-FLEX перед другими CAD-системами 
является возможность создания параметрических сборочных чертежей

тствующее изображение болта, рассчитанное на основе этого ди
Чертежи T-FLEX, которые вы включаете
ами. Как и для других элементов, форми

Чертежи, полученные с использованием чертежей-фрагментов, мы буде
вать сборочными чертежами. Сборочные чертежи непосредственно не
а . Они хранят лишь ссылки на эти чертет в себе данных фрагментов
озволяет добиться максимально компактного хранения чертежей в памя

в различныиске. Кроме того, если один и тот же чертеж был включен 
и, то при его модификации произойдут соответствующие изеж

, в кото-
рых отдельные части-детали связаны между собой. При модификации чертежа 
сохраняются все основные зависимости между параметрами отдельных дета-
лей. Более того, одновременно с модифицированным сборочным чертежом вы 
получите полный набор чертежей-деталей, которые участвовали в сборочном 
чертеже. При э учились в ре-
зультат

том они будут иметь те параметры, которые пол
е пересчета сборочного чертежа.

Чертежи-фрагменты, которые участвуют в сборочном чертеже, могут быть 
переменными, то есть в зависимости от каких-либо условий в сборочном чер-
теже будет участвовать тот или иной чертеж-фрагмент. 

Каждый фрагмент может в свою очередь также состоять из фрагментов, 
причем 

 

уровень вложенности фрагментов практически не ограничен. 
На основе фрагментов, входящих в состав сборочного чертежа, можно соз-

дать деталировочный чертеж. 
 
 
3.3 Трехмерное твердотельное проектирование

Система T-FLEX CAD позволяет создавать трехмерные (3 D) модели как 
на основе уже существующих двухмерных чертежей, так и непосредственно в 
трехмерном пространстве. Для отображения трехмерной модели используется 
Окно 3D вида. Окно 3D вида вместе со всеми трехмерными объектами образу-
ет 3D сцену. 
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Основными видами представления трехмерных объектов являются: ребер-
ная ставление о форме 
тела  операций требуется 
указ е отображение с 
учетом  учиты-
вает , а также 
свой

тывающего указанные эффекты, используется програм-
ма «

их плоскостей, предназначенных для задания в пространстве поло-
жени

ресечение). Кроме того, имеется 
ряд о

томатически 
сген дами. После указания на 
этом

етров позволяет управлять моде-
лью. снове трехмерной модели сохра-
няют связь с последней, и также будут изменяться. 

 и окно 
диаг виде де-
рева

ментов. Через дерево модели можно получить доступ к 
сво особенно полезно, если со-
отв бора в окне 3D вида. Например, по-
сле торое тело пропадает с экрана. 

модель и рендеринг. Реберная модель дает слабое пред
, однако полезна в тех случаях, когда при выполнении
ание элементов внутри тела. Рендеринг дает реалистическо

 характеристик материала и углов отражения. При рендеренге не
ся взаимное влияние тел друг на друга – тени, переотражения
ства среды – рассеяние света, туман и т.п. Для получения фотореалистиче-

ского изображения, учи
POV-Ray for Windows», поставляемая вместе с системой T-FLEX CAD. 
Для создания трехмерной модели необходимо наличие одной или несколь-

ких рабоч
я вспомогательных элементов и самой трехмерной модели. 
Первоначально трехмерные тела получают перемещением в пространстве 

плоского или пространственного контура (3D профиля) по заданной траектории 
(операции: выталкивание, вращение, тело по траектории, спираль). 3D про-
филь создается на основе его проекций на двухмерном чертеже, или чертится 
непосредственно на рабочей плоскости после ее активизации. При наличии ранее 
созданных тел 3D профиль можно построить, используя элементы этих тел. 

Созданные тела могут быть модифицированы (операции: сглаживание, 
отсечение, уклон, оболочка). Над несколькими телами возможно выполнение 
булевых операций (сложение, вычитание, пе

пераций для получения одиночных копий и их массивов. 
 трехмерной модели авСистема позволяет на основе созданной

ерировать проекционный чертеж с заданными ви
 е чертеже линий разреза можно получить тр буемые сечения и разрезы. 

Получаемая трехмерная модель является параметрической, поскольку, как 
двухмерные построения на рабочих плоскостях, так и сами операции создания 
и модификации тел могут управляться заданием константных значений или пе-
ременных. Таким образом, изменение парам

Проекционные чертежи, созданные на о 
 
При работе с трехмерной моделью используются: окно 3D модели
ностики (рисунок 3.7 а, б). Структура 3D модели, отображаемая в 
 в окне 3D модель, позволяет получить информацию о составе модели и 

взаимодействии ее эле
йствам тех, или иных элементов и операций. Это 
етствующий элемент недоступен для вы
 выполнения булевой операции вычитания в
В дереве 3D модели можно выбирать элементы, участвующие в выполне-

нии операций. Это полезно при высокой плотности элементов в 3D окне, когда 
визуальный выбор затруднен. В окне диагностики выводятся сообщения при 
некорректных действиях пользователя или при невозможности выполнения 
действий в силу ограничений системы. 
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а б 
Рисунок 3.7 – Окно 3D модели (а) и окно диагностики (б) 

В силу того, что при выполнении команд создания трехмерных моделей 
последовательность действий и набор используемых опций выбирает пользова-
тель, выполнение всех этих команд заканчиваются нажатием кнопки   Ав-
томеню. Следует учитывать, что при вызове новой команды 3D, предыдущая 
не закрывается. Поэтому перед вызовом очередной команды следует полностью 
закрыть ранее выполняемую. 

Рабочая плоскость является базовым элементом 3D модели. Относительно 
рабочих плоскостей задаётся положение в пространстве вспомогательных 3D 
элементов и трехмерных моделей. Схожий с рабочими плоскостями функцио-
нальный смысл имеют специальные системы координат, которые в качестве 
геометрической основы используют не плоскость, а цилиндр, сферу или тор. 

Рабочие плоскости - плоскости, ориентированные определенным образом в 
трехмерном пространстве. Без создания рабочих плоскостей в T-FLEX CAD 3D 
невозможно построить трехмерную модель. Рабочие плоскости могут быть за-
даны в 2D окне или в 3D окне. Существуют следующие типы рабочих плоско-
стей: 

- стандартные; 
- вспомогательные; 

и. 

аекторий и т.д. 

На на  это может быть перемещение замкнутого 
конт ктором выталкива-
ни
ремещ
верхн

вых о

- заданные на основе проекции элементов 3D модели; 
- заданные посредством 3D систем координат; 
- заданные на основе грани трёхмерного тела; 
- заданные на основе другой рабочей плоскост
Вспомогательные элементы (3D узлы, 3D профили, 3D пути и т.д.) служат 

для задания формы будущего тела, ориентации в пространстве, определения 
направлений, векторов, осей, тр

 Твердое тело образуется при выполнении одной из команд "Операции|...". 
чальном этапе проектирования
ура по заданной траектории. Перемещение задаётся ве

я, осью вращения, пространственной траекторией (тело по траектории). Пе-
аемый контур может быть плоским или иметь форму трёхмерной по-
ости.  
Исходными инструментами для создания твёрдых тел является набор базо-
пераций. Базовые операции использует вспомогательные элементы (3D 
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профили, 3D узлы, 3D пути и т.д). В дальнейшем изложении фраза 'выбор опе-
рации' подразумевает указание твёрдого тела, созданного с помощью этой опе-
рации. Твёрдое тело обладает такими атрибутами как масса, объём, площадь 
поверхности и т.д.. 

 Работая с 3D моделью пользователь может использовать разные методы 
проектирования, либо их комбинацию. Создание 3D модели в окне 3D вида 
описано в разделе "Создание 3D модели в трёхмерном пространстве", проекти-
рование на основе двумерного чертежа - в разделе "Создание 3D модели по 2D 
элементам". Для работы первым методом необходимо ввести понятие режима 
активной рабочей плоскости. 

Режим активной рабочей плоскости позволяет пользователю работать в 3D 
окне на рабочей плоскости с любыми 2D командами, создавая элементы по-
строения и изображения так же как при работе с двумерным чертежом.  

Элементами 3D модели являются рёбра, грани, вершины тела. Операции 
над твердыми телами используют элементы 3D модели для создания более 
сложных тел на основе уже существующих. Таким образом формируется ие-
рархическая структура модели, отражающая исходные 3D элементы и тела и, 
созданные на их основе.  

Создание сборочных конструкций предполагает использование 3D фраг-
ментов или создание в документе нескольких твё дых тел. В системе T-FLEX 
CAD любой документ ться как сборкой, так 
и 3D фрагментом (смотри раздел "Создание сборочных трёхмерных моделей"). 
Ги
указат анные 
отдельно в дальнейшем будем называть "про-
ектирова  в создании 3D модели, 
содержащ  их (операций) сохранением в от-
дельных  управлять наличием и типом 
связи по ходным документов. Такой способ называется 
"проекти

В н вает полезно просмотреть сборочную конструк-
цию в ра  элементы сборки отделены друг от 
друг

я (смещение, повороты) относительно системы коорди-
нат, к которой он привязан. При выполнении команды "Разборка - 3VX " сбо-
рочная конструкция будет отображена с учетом заданных параметров разборки. 

В системе параметрического твердотельного проектирования T-FLEX CAD 
3D существует два оригинальных способа создания трехмерной модели. Пер-
вый способ основан на использовании уже имеющегося 2D чертежа конструк-
ции. Для того ертеж 
детали, со одиться 
в пр

 является создание рабо-

р
, содержащий 3D модели может явля

бкий механизм определения привязки элементов 3D сборки позволяет точно 
ь их положение в сборочной конструкции. Метод, в котором созд

 элементы включаются в сборку, 
нием снизу-вверх". Другой путь заключается
ей набор операций, и последующим
документах. Причем пользователь может
лученных деталей с ис
рованием сверху-вниз". 
екоторых случаях бы
зобранном состоянии. Т.е. когда

а. Для этого у каждого элемента сборки предусмотрены параметры, за-
дающие преобразовани

, чтобы начать создавать 3D модель, необходимо иметь 2D 
держащей необходимое количество видов. Виды должны нах

ч

оекционной связи между собою. Если вы хотите получить параметриче-
скую трехмерную модель, то нужно задавать параметрические свойства в дву-
мерном чертеже. Первым шагом по созданию модели
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чих 

 виду спереди, сверху и слева. Затем создаются необходимые 3D 
элем

о создать на 2D виде соответст-
вующ

е невидимой, чтобы не загромождать чертеж. Создается 3D профиль сле-
дующ

еделяющие 
высоту и направление выталкивания. Для вращения выбирается контур и два 
узла  ось вращения. Булева операция позволяет объединить соз-
данные тела в единое целое. Описанные метод - это, можно сказать, классиче-
ский способ создания параметрических трехмерных моделей в T-FLEX. Но есть 
и другие методы. 

Второй способ основан только на использовании окна 3D вида. Построе-
ние модели начинается с создания рабочих плоскостей с последующим созда-
нием на них необходимых 2D элементов. Затем выполняются все необходимые 
трехмерные операции, после чего можно создать проекции необходимых видов, 
которые можно дооформить в 2D окне, проставить размеры и т.д. (см. Руково-
дство пользователя). 

 
 
3.4 Создание трехмерной сборки электронного блока 

с использованием пакета T-FLEX CAD 

В пакете T-FLEX CAD возможно создание двух- и трехмерных сборок. 
Одним из главных преимуществ T-FLEX CAD перед другими CAD-системами 
является возможность параметризации элементов, составляющих сборочные 
чертежи, а также использования ее при создании сборочных чертежей конст-
рукций и модификации проектировочных заданий, когда необходимо часто из-
менять конструкторские размеры, заменять стандартные изделия и т.д. 

При объединении нескольких чертежей друг с другом применяют наложе-
ние или совмещение элементов одного чертежа или элемента модели с элемен-
тами другого. Такие элементы называются фрагментами. Создание чертежей с 
помощью фрагментов в ряде случаев позволяет добиться ряда преимуществ. 
Во-первых, для сложных чертежей упрощается процесс создания, так как можно 
сначала создать отдельные части этого чертежа, а затем объединить их. Во-
вторых, если создавать параметрический чертеж на основе деталей, состав-
ляющих его, то при изменении каких-либо параметров сборочного чертежа вы 
сможете одновременно получить и полный набор соответствующих этим пара-

плоскостей. Зачастую бывает достаточно создать три взаимно перпендику-
лярные рабочие плоскости (фронтальную, горизонтальную и профильную), со-
ответствующие

енты построений: 3D узлы и 3D профили. 3D узлы используются для при-
вязки 3D профилей, задания векторов выталкивания и осей вращения. Для соз-
дания 3D профиля необходимо предварительн

ие контуры, используя команду "Создать штриховку". Если предполага-
ется использовать штриховку только для 3D построений, то рекомендуется де-
лать е

им образом: выбирается штриховка на 2D виде, указывается какой рабо-
чей плоскости она принадлежит, и с помощью 3D узла задается высота ее рас-
положения над рабочей плоскостью. После этого можно переходить к выпол-
нению операций. Для выталкивания задается контур и два узла, опр

, определяющие
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метр вать 
часто  чертежей. 

мирования чертежей из фрагментов заключается в 
том, ы использовать единожды построенный параметрический чертеж и 
вста е элемен-
ты ( на основе 
фраг ии одного из фрагментов, 
при бразовываются. При этом можно по-
лучи твовали в сборочном чер-
теже ились в результате пере-
счет

мости от каких-либо условий в сборочном чертеже будет участвовать тот 
или 

тов (резьбы, отверстия, стандартные элементы), причем 
уров

 фрагмента не являются частью чертежа, в кото-
рый 

о чтобы решить эту про-
блему, в системе был создан специальный тип узлов и линий построения. По-
ложе

ения 
фраг

нт 
чертежа.  

Под параметрическим фрагментом системы T-FLEX CAD понимается чер-
теж, при нанесении которого на другой чертеж, можно задать его положение и 
параметры, от которых зависит его изображение. 

Вставка фрагментов подразумевает использование системы координат фраг-
мента, называемой локальной системой координат (ЛСК). Локальные системы 
координат можно создать с помощью векторов привязки или точек привязки. 

Вектор привязки определяет способ привязки чертежа и ориентацию чер-
тежа при вставке его на другой чертеж в качестве фрагмента. При этом векто-
ром привязки задается положительное направление оси X локальной системы 
координат чертежа. Векторов привязки может быть не более 20. 

Векторов при ектор привязки 

ам чертежей-деталей. В-третьих, в качестве фрагментов удобно созда
 повторяющиеся элементы
Основной принцип фор
чтоб
влять его в сборочный чертеж, погасив при этом вспомогательны

чные чертежи размеры, некоторые штриховки и т.п.). Сборо
 модификацментов легко преобразовываются при

ем зависимые элементы также преоч
ть полный набор чертежей-деталей, которые учас
. Они будут иметь те параметры, которые получ
а сборочного чертежа. 
Фрагменты, участвующие в сборке, могут быть переменными, то есть в за-

виси
иной фрагмент. Каждый фрагмент может в свою очередь также состоять из 

отдельных фрагмен
ень вложенности фрагментов практически не ограничен. 
Линии и другие элементы
он включен. Это означает, что на их основе нельзя обычным способом соз-

давать другие элементы, например, размеры. Для тог

ние узла с фрагмента определяется узлом чертежа, на основе которого он 
был создан. Положение линии построения определяется линией изображ

мента. Узлы и линии построения, созданные на основе фрагмента могут 
быть использованы для необходимых операций, как и любой другой элеме

вязки создается по команде  Построения / В
. 

 

После вызова команды необходимо указать направление вектора привязки, 
отметив мышью необходимые точки, задающие направление вектора привязки 
при вставке в сборку (в сборке ориентацию фрагмента можно изменить). Если
для вектора привязки нужно совпадение с осью Х, то после указания начала 
вектора нажмите «Enter» или пиктограмму  в автоменю. После указания на-
чала  конца вектора привязки появляется меню параметров вектора и  привязки 
(рисунок 3.8). 
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Рисунок 3.8 –  Параметры вектора привязки 

Как правило, в сборке размеры не требуются, поэтому их «погашают». Од-
ним из способов «погашения» размеров является использование векторов при-
вязки. На рис. 3.1 в поле «Список слоев» выделен слой «Размерный», а в поле 
связь со слоями указан параметр «Рисовать все, кроме помеченных». Т.о. этот 
слой не будет отображён на сборке. Существуют и другие способы «погаше-
ния» элементов чертежа: с помощью уровней видимости и слоев. 

Точки привязки задаются переменными. При этом вертикальным 
ал ров задаются зарезервированны

и гори-
зонт е имена 
перем еляет точку пересечения таких линий 
как то  может быть несколько. 

Ф и при вставке в сборку или непо-
вора й точкой или несколькими. 

цию

ьным линиям в качестве парамет
енных. В дальнейшем система опред
чку привязки фрагмента. Точек привязки
рагменты могут быть поворачиваемым
иваемыми, а также привязываться одноч

 Построить точку привязки можно используя специальную оп . Она 
становится активной после вызова команды Построить прямую (рисунок 3.9, 
а). При этом переменные создаются автоматически (они по умолчанию являют-
ся внешними переменными), а на пересечении линий появляется цифра, соот-
ветствующая порядковому номеру переменной (рисунок 3.9, б). 

  
а б 
Рисунок 3.9 – Создание точек привязки 

В зависимости от назначения фрагмента можно создать от 0 до 9 точек 
привязки. Обычно у фрагмента бывают одна точка привязки или две. Первая 
точка, как правило, задает положение фрагмента на чертеже, вторая – ориента-
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цию или размер, либо и то, и другое. 
Создание сборки заключается в последовательном нанесении фрагментов. 

Для еж

вого изменения какого-либо параметра, заданного переменной. Од-
новр

того чтобы сборочный черт  можно было параметрически изменять, необхо-
димо «привязывать» фрагменты к узлам и задавать связи между переменными. 

Система T-FLEX CAD позволяет создавать анимацию чертежей, посредст-
вом пошаго

еменно происходит перерисовка чертежа на каждом шаге. Анимация чер-
тежей выполняется по команде Пара имация метры / Ан . При входе в ко-
манду на экране появляется диало параметров команды (рису-
нок 3.10). 

говое окно 

При установке параметра Создать мультимедиа файл можно создавать 
файлы формата (*.avi), здесь же задается «Имя файла» и «Количество кадров 
в секунду». В данном диалоговом окне возможно определение параметров сжа-
тия созданного файла. 

 
Рисунок 3.10 – Параметры анимации 

Аналогично двухмерному проектированию, где из плоских чертежей дета-
лей создаются сборочные чертежи, при трехмерном моделировании в качестве 
фраг

. при вставке 3D 
фраг

ных, а также некоторые 
установки – имя, флаг использования в спецификации, флаг статуса. На основе 
одного 2D фрагмента можно создать тольк  3D фрагмент. Кроме того, нель-
зя удалить 2D фрагмент, если на его основе л создан 3D фрагмент. 

теж с помощью команды 
3D /  Фрагмент 

мента для создания сборки можно использовать трехмерные модели дета-
лей. 3D фрагменты находятся в прямой связи с двумерным фрагментом, данные 
которого были использованы для создания 3D фрагмента, т.е

мента в чертеж добавляется 2D фрагмент, соответствующий ему. Оба 
фрагмента используют общие данные значений перемен

о один
 бы

3D фрагмент может быть вставлен на текущий чер
Создать / 3D . Редактируют 3D фрагмент по команде 

3D / Изменить операции / 3D фрагмент . 
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Для привязки 3D объектов к пространству и друг к другу используются ло-
кальны
исх нта 
начало е-
мент

елевую. Кроме того, в 
трехмерной модели всегда присутствует мировая система координат, имеющая 
начало в точке пер  использована для 
прив

в привязки). 

ию 
их п адка Преобразования в па-
раме

 основных способа построения локальных систем координат: 

о грани, где начало координат и оси X и Y располагаются на указанной 
грани

− по оси цили  направление 
оси Z

. 
и, а можно 

стро

ью «Руково-
дств ециальных обучающих программ, 
представленн н FLEX_CAD». 

 

е системы координат. На вставляемом в сборку фрагменте должна быть 
одная ЛСК, а в сборочной модели – целевая ЛСК. При вставке фрагме

координат и оси исходной ЛСК совмещаются с соответствующими эл
ами целевой ЛСК. Если в модели имеется несколько исходных и целевых 

ЛСК, то необходимо выбрать одну исходную и одну ц

есечения рабочих плоскостей. Она будет
язки при отсутствии в модели ЛСК (аналогом в двухмерном проектировании 

является вставка фрагмента без элементо
При помещении фрагмента на сборку можно задать сдвиги и повороты ис-

ходной системы координат относительно целевой по отношению к состоян
олного совпадения. Для этого существует закл
трах фрагмента. 
Имеется три
− по узлам, где с помощью 3D узлов задается положение начала коорди-

нат и, при необходимости, направление осей; 
− п
; 

ндра, где этой осью задается расположение и
 системы координат. 
Реально имеется очень большое количество опций для определения и даль-

нейшего преобразования положения начала координат и направления осей
ЛСК можно построить заранее, при создании модели детал
ить непосредственно при вставке фрагмента. Для этого в Автоменю встав-

ки фрагмента имеется набор соответствующих опций. 
Более подробно пакет T-FLEX CAD можно изучить с помощ
а пользователя», а также с помощью сп

ых а диске в папке «Demo_T
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4 ИЧЕСКОЕ ОБЕСПЕЧЕНИЕ  АВТОМАТИЗИРОВАННОГО 

Т

 
 
4

Н

2. 

 

 
Рисунок 4.1 – Структура комплексной автоматизации ТП 

Технологическая подготовка производства (ТПП) — это совокупность 
орган

ическую готовность предприятия к выпуску изделий 
заданн ня качества при установленных сроках, объемах выпуска и за-
тратах. 

Значительный вклад в решение проблемы сокращения сроков подготовки 
производства внесла Единая система технологической подготовки произ-
водства, которая обобщила и регламентировала (в стандартах) с научных и ме-
тодических позиций передовые инженерные решения в области ТПП. Достиже-
нию этой же цели способствует применение экономико-математических мето-
дов и средств вычислительной техники. 

ЕСТПП - установленная государственными стандартами система органи-
зации и управления процессом ТПП, предусматривающая широкое применение 
прогрессивных унифицированных ТП, стандартной технологической оснастки 
и оборудования, средств механиза атизации производственных про-
цессов, инженерно-технических и управленческих работ.  

 МАТЕМАТ

ЕХ ОЛОГИЧЕСКОГО ПРОЕКТИРОВАНИЯ Н

.1 Комплексная  автоматизация технологического проектирования 

еобходимость комплексной автоматизации – это сокращение сроков: 
1. проектирования изделия; 

технологической подготовки производства (ТПП) его изготовления; 
3. настройки технологического оборудования (рисунок 4.1). 

   
САПР АС ТПП ГАП 

- КД на изделие - проектирование ТП; 
- проектирование (вы-

бор) оснастки и ин-
струмента; 

- проектирование 
управляющих про-
грамм для техноло-
гического оборудо-
вания 

- выбор заготовок; 
- выбор инструмента; 
- выбор автоматическо-

го оборудования 

 

изационно–технических мероприятий и инженерно-технических работ, 
обеспечивающих технолог

ого уров

ции и автом
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Система предусматривает решение следующих основных задач:  

 оснащения; 
, участков и цехов основного производства; 

 базе типовой схемы и типовых положений, а также 
ее со

 функциональны-
ми подсистемами автомати в о ис ы правления производством 
(АСУП). 

 

Автоматизированная  ПП (АСТПП) — это человеко-
машинная система ТПП, в ов ко ро положен комплекс экономико-
математических методов и де , га зационных форм, электронно-
вычислительной и организаци но ех ки  оборудовани-
ем и программно-математическим обеспечением. 

Разработка ТП осуществл тс а о ов С П, которая в свою очередь 
включает комплекс работ, свя ны с т и ко отовностью предприятия к 
выпуску нового изделия заданной гр мы  номенклатуры. Исходные дан-
ные для разработки ТП: 

– технические условия (Т н зд е; 
– комплект конструкторской документации ( на изделие; 
– программа выпуска изделия , ш ; 
 плановые сроки освоения производства (Tпл); 

иалы (РТМ); 

ды автоматизации технологического проектирования 

 30 %-40 % ию 
с мн ользуются 
для А -
дётс т-
венно к параметрической настройке отдельных типовых операций. Применяет-

– обеспечение технологичности конструкции изделия; 
– разработка технологических процессов; 
– конструирование средств технологического оснащения; 

дрение ТП и средств технологического– отладка и вне
 линии– организация

– организация ТПП на
вершенствование; 
– управление процессом ТПП во взаимосвязи с другими 

зиро анн й с тем у

система Т  
осн у то й 
мо лей ор ни
он й т ни  с соответствующим

яе я н сн е Е ТП
гзан х ехн чес й 

про ам  и

У) а и ели
КД) 

 (N т.)
–
– отраслевые, внутризаводские типовые ТП, руководящие технические 

матер
– технологические классификаторы деталей, каталоги оборудования и ос-

настки; 
– материальные и трудовые нормативы. 
 
 
4.2 Мето

Можно выделить следующие методы автоматизированного проектирова-
ния ТП (рисунок 4.2): 

1) на основе типизации и групповой технологии; 
2) преобразование процессов аналогов; 
3) многоуровневый итерационный метод. 
Метод 1. Программы, реализующие метод типизации, характеризуются 

меньшим на объёмом и затратами машинного времени по сравнен
огоуровневым интеграционным методом. Эти программы исп
П ТП деталей типовых форм (для остальных деталей проектирование ве
я вторым и третьим методами). Проектирование сводиться преимущес
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ся, например, при изготовлении деталей типовых форм, отличающихся только 
размерами. 

 
  

Методы АТП 

 

(1) Алгоритмический 
а

 

(2) Преобразование 
 

 

(3) Многоуровневый 
процессов аналогов нализ типовых и 

групповых ТП 
итерационный 

 

Параметрическая 

 

Синтез на основе 
типовых ТП 

настройка ТП 

 

Исключение 
структурных 

компонентов из ТП 

 

Синтез на основе 
оригинальных ТП 

 

Комбинированный 
синтез ТП  

Добавле6ние 
структурных 

компонентов в ТП 

 

Комбинированный 
способ 

преобразования ТП 
 

ественном отличии формы и большего разнообразия обрабатываемых 
пове

общим является многоуровневый интеграционный ме-
тод, ость метода основана 
на пр

ующих уровнях. 
3. На всех уровнях, кроме послед ду недостаточной детализации 

проектных решений, критерии отбора вариантов носят эвристический 
характер. 

Рисунок 4.2 – Методы автоматизации ТП 
 

Метод 2. Использование типового ТП, как процесса-аналога возникает 
при сущ

рхностей. При этом проектирование использует в первую очередь струк-
турное преобразование типовых и групповых ТП. 

Метод 3. Наиболее 
теоретически разработанный В.Д. Цветковым. Сущн
инципах (утверждениях): 

1. Проектирование ТП можно разделить на четыре последовательно выпол-
няемых уровня (рисунок 4.3).  
Степень детализации возрастает от 1-го к 4-му уровню. 

2. Процесс проектирования развивается сверху вниз – от синтеза общих 
принципиальных моделей на первом уровне к проектным решения тре-
буемой степени детализации на след

него, вви
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Урони 
проектирования ТП

 

Операционная 
технология 

 

Принципиальная 
схема ТП 

 

Маршрут 
изготовления  

 

Управляющие 
программы СЧПУ 

 
Рисунок 4.3 – Уровни проектирования ТП 

3) синтез различных вариантов (С); 
4) имитационно моделирование (М); 
5) анализ модели (А); 
6) оценка результатов моделирования (Е); 
7) оптимизация (Q); 
8) отбор лучших вариантов (W); 

Алгоритм проектирования можно представить следующей операторной 
схемой (рисунок 4.4): 

 

роектирования ТП по итерационному методу 
 

Процесс проектирования начинается с операц  поиска П

 
4. Проектирование на каждом уровне разделяется на совокупность проект-

ных интеграционно взаимосвязанных операций осуществляющих: 
1) поиск решений аналогов (П); 
2) преобразование процессов аналогов (Н); 

 
Рисунок 4.4 – Алгоритм п

ии 1 и нескольких 
деталей аналогов и ТП аналогов в банке данных.  

П1р2
С4

Н М (i) A E p W3 5 6 7 8 10

Q9
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Если аналогов нет, то логическим блоком р2 управление передаётся на син-
тез С4 (синтез нового ТП), в противном случае - на преобразование процессов 
аналогов Н3.  

Операция имитационного моделирования М5 позволяет прогнозировать 
хара и по i-му варианту, определять возникающие погреш-
ност

ктер обработки детал
 и и технико-экономические параметры.  

ерации анализа АС помощью оп 6 устанавливаются причины отклонений, 
а операция оценки Е7 проверяет выполнение заданных технических требова-
ний.

р8 осуществляет итерационное посторенние цикла опера-
ций,  включая Q

  
лок Логический б

начиная с пятой операции (имитационное моделирование) и 9 - 
оптимизацию. Этим подготавливается ножество вариантов длям  выбора одно-
го из ТП с помощью оператора W10 (Выбор лучшего варианта ТП). 
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5 ТИПОВЫЕ МАТЕМАТИЧЕСКИЕ МОДЕЛИ И АЛГОРИТМЫ ДИАЛОГОВОГО 

При проектиров  

тические модели 

Для современных техни х терно: 
разных факторов, влияющих на 

ТС; 

 влияние; 

выходные данные; 

именения современных методик моделирования процессов на ЭВМ. 
-

вать

ПРОЕК ТП ТИРОВАНИЯ 

 
 

ании технологических процессов применяются: 
1) функциональные математические модели; 
2) структурно-логические модели. 
 
5.1 Функциональные матема

чески  систем (ТС) харак
– наличие значительного числа разнооб

– большое число внутренних связей между параметрами ТС и их сложное 
взаимное

– наличие нескольких конкурирующих направлений процессов, имеющих 
различные 

– воздействие на ТС большого числа внешних неконтролируемых и не-
управляемых факторов, играющих роль возмущений. 

 
Проектирование и оптимизация структуры таких сложных ТС невозможны 

без пр
Совокупность физико-химических процессов внутри ТС можно рассматри
 как преобразование вводимых потоков энергии и вещества (рисунок 5.1). 

 
                                                                                                               
 
                                      
      Техническая 

система 

Материал Х1 

Энерги Х2 

Y1 

К
Y2 

омплектующие Х3 

Информация Хn 

Y3 

Yn 

Изделия

Система 
управления 

Возмущения

• • •  • • • 

 
Рисунок 5.1 – Схема сложной технической системы 

 
Для обеспечения требуемых физико-химических превращений в ходе про-

ектирования  ТС этими потоками необходимо управлять с помощью матема-
тического моделирования.  

рез параметры оптимизацииВыраженные че  целевая функция и ограниче-
ния рассматриваемой задачи. составляют математическую модель 
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 Выбор 
целевой 
функции 

Обработка результа-
тов моделирования  

на ЭВМ 

Проверка 
адекватности 

модели 

Математическое 
моделирование 

процесса 

Выбор модели, 
создание  
алгоритма 

Использование  
модели для 

оптимизации ТС 
 

Рисунок 5.2 – Стратегия построения математической модели 

атемати-
ческой модели, т. е. представление в математической форме взаимосвязи целе-
вой функции с параметрами задачи.  

Решается данная задача методами математического программирования. 
Под математическим программированием понимается совокупность мето-

дов решения задач оптимизации, связанных с нахождением наилучшего (с точ-
ки зрения выбранных критериев качества) значения некоторой целевой функ-
ции F(Х) многих переменных Х = {х1, х2, ... xп} на заданном множестве точек 
L(Х) евклидова пространства Еn, а также плана X* == {х*1,  х*2, ..., х*п}, 
X* ∈ L(Х), при котором достигается соответствующее оптимальное значение 
F(Х*). 

Основные классы зад раммирования: 
1. Линейного программирования 

 программирования 
аммирования 

ния 

оделей 
одимо преобразовать 

физи ости объекта в мате-
мати ьной задачи с формулировкой критериев 
опти

ет целевая функция F. 
представить в следующем виде: 

F = ΣαS . XS, (5.1) 

где αS - коэффициент влияния; XS – относительное значение критериев. 
Тогда оптимизация заключается в максимизации либо минимизации целе-

вой функции. 
При проведении оптимизации удобно геометрически  представлять целе-

в

 
Поиск оптимального решения всегда предполагает построение м

ач математического прог

2. Нелинейного
3. Целочисленного прогр
4. Динамического программирова

 
Оптимизация функциональных математических м
При постановке задачи оптимизации в САПР необх
е  о назначении и степень сложнч ские представления
еч скую формулировку экстремал
ам льности. 

ставляОснову критерия оптимальности со
кцию системы можно Целевую фун

 

ую функцию F (Х). При этом множество векторов Х рассматривается как про-
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странство управляющих параметров. 
→

X  является точка, в коОптимальным вектором торой целевая функция 
F(X) я. 

-
го ур

ти: 
F(X) = a,  

скости выражаются в линии равного 
выхо

яемых параметров в постановку задачи 
опти я типа равенств: 

⎝ , 

о равенств: 
⎞

⎜
⎛ →

Xϕ … 

Ч нств являются рям  ограни-
чения ющие вид: 

г о допустимые физически технологические или 
выби лесообразности знач  пар метр  xi. 

О авляемых параметров,  выполняются 
задан аничения называется допустимой областью

П ии ограничений задача оптимизации ест дач сло ой -
мизации  – безусловной. 

очка, характеризующаяся max или min значением целевой функции при 
выполнении ся условным максимумом (миниму-
мом) стремум безусловный. 

 Если хотя бы одна из функций F, ξ, ϕ - нелинейная, то эта задача не-

  достигает max при максимизации, либо min при минимизации значени
рплоскости равноВ пространстве управляемых параметров выделяют гипе

овня. 
В точках конкретной гиперплоскости равного уровня целевая функция 

равна некоторой постоянной величине. Уравнение гиперплоскос

где a = const 
В случае двумерного лучая гиперплс о
да. 
Кроме целевой функции и управл

имизации могут входить ограничен

0=⎟
⎞

⎜
⎛ →

Xξ
⎠

граничения типа не

0>⎟
⎠⎝

астным случаем ограничений типа нераве  п ые
 на управляемые параметры, име

maxmin ii XXX ≤≤ , 

де Хimim, Хimax – предельн е,  
раемые по конструктивной це ения а а
бласть пространства упр в которой
ные огр . 

 зари налич
, при отсутствии

ь а у вн опти

Т
 всех ограничений называет

. При отсутствии ограничений – эк
Формулировка задачи поиска экстремума целевой функции F(X) в области 

допустимых значений Х, которые имеют ограничения  

0=⎟
⎞

⎜
⎛ →

Xξ , 0>⎟
⎞

⎜
⎛ →

Xϕ  ⎠⎝ ⎠⎝
есть задача математического программирования. 
Виды задач: 

–
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л

Если линейны все функции – задача линейного программирования. 

я 
ходной параметр. 

2. Максиминный критерий – обобщенный критерий. При этом критерии 
вводят оценки степени выполнения каждого из условий работоспособности. 

3. Статистический критерий оптимизации. 
Целевая функция – вероятность выполнения всех заданных условий рабо-

тоспособности. 
Предполагают проведение статистических испытаний методами Монте-

Карло, граничных испытаний или исследования образца по методу наихудшег  
случая. 

 
СПОСОБЫ ПОИСКА ОПТИМАЛЬНЫХ РЕШЕНИЙ 

перебора путей на дереве решений. 
адача Q0 разбивается на ряд подзадач Q1, Q2, … Qn. После раз-

егче решаются, либо имеют меньшую размерность. 
ь, каждая подзадача может разбиваться далее… 

ение находится на основе перебора путей на дереве ре-
 называются поисковыми.  

а связан с исследованием графовых структур. 
 три основных вида поиска: 

о решения невоз-
можно – происходит возврат к предыдущему частичному решению и предпри-
нима ытки снова его продолжить. Процесс идет до тех пор, пока это 
возм

ый алгоритм относят к классу экспоненциальных. 
 исследуемой вер-

шин  путей и исследовать его до конца. 
Друг этом не рассматриваются до тех пор, 
пока чный результат, исследуя выбранное 
напр

инейного программирования. 
– Если все или часть параметров Х являются дискретными величинами, 

то эта задача дискретного или частично-дискретного программирования. 
– 

Дискретное программирование называется целочисленным если управляе-
мые параметры Х принадлежат множеству целых чисел. 

 
ОСНОВНЫЕ КРИТЕРИИ ОПТИМАЛЬНОСТИ 

1. Частный критерий – когда в качестве целевой функции выбираетс
наиболее важный вы

о

На основе 
Некая подз

биения подзадачи л
В свою очеред
Оптимальное реш

го типашений. Задачи тако
скПроцесс пои

етСуществу
1. Поиск с возвращением, 
2. Поиск в глубину, 
3. Поиск в ширину. 

 

Поиск с возвращением заключается в расширении частного решения на 
каждом шаге поиска. Если расширение частичного текущег

ются поп
ожно. 
По времени решения данн
Поиск в глубину: идея метода – необходимо в каждой

е дерева выбрать один из возможных
ие существующие пути решений при 
 имеется возможность получить коне
авление. 
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Пример. 
Алгоритм просмотра графа G на основе поиска в глубину: 
1. Выбираем произвольно начальную вершину Xi. 
2. Выбираем ребро (XiXj), которое инцидентно вершине Xi и просматри-

вает вершину Xj. 
3. Если в вершине Xj нет решения, то выбираем следующую вершину 

графа, инцидентную текущей вершине. 
4. Просматриваем все пути, начинающиеся в вершине. Если решений 

нет, то возвращаемся назад к вершине Xj и рассматриваем очередное 
ребро. Если решение найдено – вычисления прекращаются. 

5. Если ни на одном пути из вершины Xj нет решения, то выбирается но-

 
Недостаток: п ьшой вероятностью 

можно пройти мимо той ветви, на которой раньше всего появляется оконча-
тельное решение. 

Пример: 

вая вершина Xj инцидентная Xi и далее с п. 2. 

ри исследовании дерева решений с бол

 

- решение задачи  

Xi

Xj

X8X3
X4 X5

X6 X7

X9

X10

 
Рису  5.3 

 
Поиск в ш  задачи уровня 

1. За

нок

ирину. При этом методе вначале исследуются
тем задачи уровня 2  
Пример: 

 Xi

Xj 
X9 -уровень 1  

- решение задачи   

X8X3 

Рисунок 5.4 
 

X10 -уровень 2  

X4 X5 -уровень 3 … 

X6 X7
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5.2 Структурно-логические модели ТП. Общие сведения 

Согласно ГОСТ 24.416-83, структурно-логические модели при технологи-
ческом проектировании подразделяют на: 

1. табличные,  
2. сетевые и  
3. перестановочные.  
Причем они определяются строками булевой матрицы: 

 

FG Fn Fλ Fa  
1 1 1 1 S1
1 1 1 0 S2
1 1 0 1 S3
1 1 0 0 S4
1 0 1 0 S5
1 0 0 0 S6
0 1 1 1 S7
0 1 1 0 S8
0 1 0 1 S9
0 1 0 0 S10
0 0 1 0 S11
0 0 0 0 S12

 
Si – класс моделей, который характеризуется набором контуров Fi (усло-

вия)
и переходов технологи-

ческ дставленным в виде графа, 
буде

ношение порядка элементов (операций пере-
ходо  не ме-
няет

 условие, учитывающее состав операций и переходов технологического 
проц

λ  последовательность реализации операции. 

. 
 маршрут операции илFG – условие, определяющее

ого процесса: Ak (FG=1), маршрут, будучи пре
т являться простой цепью (F =0 - в противном G случае). 
Fn - условие, определяющее маршрут операции и переходов технологиче-

ского процесса. Если Fn = 1,то количество элементов в маршруте постоянное. Fn 
= 0 – иначе. 

Fλ – условие, учитывающее от
в в технологическом процессе). Если Fλ = 1, то отношение порядка
ся, Fλ = 0 – иначе. 
Fa –
есса. Если Fa = 1, то состав операций одинаковый, если Fa = 0 – иначе. 
Контуры Fi характеризуют разные стороны унификации технологического 

процесса: 
- при Fa = 1 унифицируется состав технологических операций. 
- при Fn = 1 унифицируется количество операций. 
при F = 1 унифицируется- 
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- при FG = 1 унифицируется характер смежности операций в техноло-
гическом

 

сса (это модели класса S1). В табличной модели одному 
на

 с этим эти модели используют для описания 
ст

етевая модель – описывает множество структур технологического 
проц уры при не-
изме
мо
не 

гич п тов струк-
туры пр , S6, S9, S10, 
S12). 

гического процесса. 
лений можно  сделать вывод, что 

моде висимости от условий налагаемых 
на Т

ской системы 
испо

1.  

ное 
вный единице), т.е  

k . 

 процессе. 

Структурно-логические модели подразделяются на: 
1. Табличная модель – описывает одну конкретную структуру тех-

нологического проце
бору условий или контуров соответствует единственный вариант техно-

логического процесса. В связи
андартных и типовых проектных решений. 
2. С
есса, отличающихся количеством и составом элементов структ
нно ом тношении порядка (это модели классов S2, S5, S7, S8, S11). В сетевой 

дели структура элементов описывается ориентировочным графом, который 
имеет ориентировочных циклов. 

3. Перестановачная модель – описывает множество структур техноло-
еского роцесса, отличающихся количеством и составом элемен

и изменении отношения порядка (это модели классов S 3, S4
Отношение порядка в перестановочных моделях задается с помощью гра-

фа, содержащего перестановочные циклы. 
Эти модели называются структурно-логическими, так как они задают 

состав и взаимосвязь операций технологического процесса. 
Они представляются в виде графа, который определяет состав и последо-

вательность (маршрут) выполнения этапов, операций, переходов при выполне-
нии обработки или сборки изделия. 

Вершины графа соответствуют элементам технологического процесса 
(этапам, операциям, переходам), а рёбра или дуги графа характеризуют после-
довательность элементов техноло

Таким образом, исходя из этих опреде
ль относится к той или иной группе в за
П. 

 
При описании взаимосвязи контуров изделий технологиче
льзуют  
дизъюнктивную и  
конъюнктивную форму представления этих связей. 
При дизъюнктивной форме исходное состояние контуров Fi(А) изделия 

обозначается равным нулю. Оконечное состояние после реализации соответст-
вующей операции F (А)=i

Т. е. Дизъюнктивная форма описывает переход контура F  в реализован-i
состояние, под воздействием конкретной технологической операции τk. 

(конечный контур, ра
Fi(τ )=1
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Состав контуров изделия после выполнения k-й операции в дизъюнктив-
ной 

) U

форме можно записать так: 

F(AF(A) )F(τk1-ki =  

При конъюнктивной форме исходные состояния контуров изделия 
Fi(А)=1, контура, подлежащего реализации Fi(A) принимает единичное значе-
ние 

нктивной. 
Сост  опре-
деля ся по формуле: 

Fi(A)=1. Состояние контура Fi(Ak) технологической операции, участвующей 
в реализации Fi(A) также обозначается Fi(τk)=1. 

Матрица контуров операций в этом случае называется конъю
ав контуров изделия  F(Ak), реализуемых при участии к-ой операции
ет

)F(τF(A)F(A) kk I=  

 
 
5.3 Табличная модель ТП 

Пусть дана группа деталей а1, а2, а3, описание которых объединено в одно 
множество А.  

Aaaa 321 =UU  

Детали имеют форму тел вращения и обрабатываются на токарном автома-
те с помощью табличной модели (рисунок 5.5). Каждая деталь имеет поверхно-
сти с определенными свойствами. 

Устанавливается последовательность обработки этих деталей. 

 
Рисунок 5.5 – Чертежи деталей – тел вращения 

 

Для реализации свойств изделия используются технологические операции 
и переходы τk, в нашем случае: 

{ }811 ...FF)F(a = , 
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{ }8512 F,F...,F)F(a = , 

{ }85213 F,F,F,F)F(a = , 

7

8 – отрезка. 
иде матриц и графов: 

τ1 – подрезка торца; 
стей; τ2,3,4 – точение цилиндрических поверхно

τ5 – сверление; 
τ6 – коническое растачивание; 

 – зенкование; τ
τ
Табличные модели представляются в в

 

τ1 τ2 τ3 τ4 τ5 τ6 τ7 τ8 
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Рисунок 5.6 – Графы взаимосвязей переходов для деталей а1, а2, а3
 

Дизъюнктивная матрица 
  F1 F2 F3 F4 F5 F6 F7 F8
Подрезка торца τ 1        1
Точение цил. пов-тей τ2  1       
Точение цил. пов-тей τ3   1      
Точение цил. пов-тей τ4    1     
Сверление τ5     1    
Растачивание τ 6      1   
Зенкерование τ     7   1  
Отрезка τ8        1 

 
Конъюнктивная матрица 

 F(а1) F(а2) F(а3) 
τ1 1 1 1 
τ2 1 1 1 
τ 1 1  3
τ4 1 1  
τ5 1 1 1 
τ 6 1   
τ7 1   
τ8 1 1 1 

 

τ1 τ2 τ3

 τ1 τ2 τ3 τ4 τ5

τ τ ττ1 2 3 4 τ5 τ8 τ1 τ2 τ3

 τ1 τ2 τ3 τ4 τ5

τ1 τ2 τ5 τ8 τ1 τ2 τ3

 τ1 τ2 τ3 τ4 τ5



Алгоритм проектирования с использованием дизъюнктивной модели 
деталь описывается набором свойств F1) 
проверяется достаточн

i и на основании этого описания 
 детали. 

 

на 
в ре

F(A ) 1 = F(A)  ∩ F(τ ) 

 k

ка исходных данных описания контуров (свойств) деталей 
F(A)

оверка, все ли операции просмотрены (т.е. строки матри-
цы о

1 личных): 

 

2) ость контуров модели для реализации

F(A) ⊆ F(τ)  (контур F(A) содержится в F(τ))

3) рассматривают очередную строку матрицы и проверяют, участвует о
вализации контуров изделия, т.е. отыскивается «1»  строке матрицы. Это 

выражается следующим образом: 

 k k-1 k

(перемножают строку τk на столбец Fk-1) 
1 4) если F(A k) ≠ 0, то операция τk включается в технологический процесс, 

если F(A )1 = 0, то операция не включается и происходит анализ следующей 
строки.  
Необходимо отметить, что порядок следования операций в этом случае не 
меняется. 

5) Определяются все контуры, над которыми выполняются операции и 
проверяются, все ли контуры из заданной системы обработаны. 

6) После включения операции в ТП проверяется, все ли контуры изделия 
реализованы. Если да – проектирование завершено, если нет – возвращаемся к 
п. 3.  

 

Алгоритм проектирования с использованием конъюнктивной модели 
1. Подготов
. 
2. Проверяют составы контуров модели F(τ) для изготовления данного из-

делия F(A) ⊆ F(τ). Если достаточно - переходят к дальнейшему анализу, иначе 
проектирование прекращается. 

3. Рассматривают к-ую строку матрицы контуров и проверяют, участвует 
ли данная операция в изготовлении изделия F(A)k = F(A)  ∩ F(τk)  

4. по формуле F(A) = F(A) k  ∩ F(A) проверяется все ли контуры, которые 
реализуются с помощью τk,  включены в модель. При положительных ответах 
на оба вопроса операция включается в состав ТП, иначе – нет. 

5. Проводится пр
тношений контуров и операций). Если да – конец проектирования. Иначе – 

переход к п. 3. 
В табличных моделях - постоянный порядок операций, определённый мат-

рицей отношения операций и контуров.  
лей класса S (табСвойства моде

1) нет циклов;  
2) количество элементов постоянно;  
3) порядок постоянен;  
4) состав операций неизменен. 
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5.4 Сетевая модель ТП 

одели S2, S5, S7, S8, S11 – сетевые модели, которые отличаются количест-
вом  F(λ). В модели 
мож  ТП, однако, во 
всех

етевая модель включает в себя матрицу свойств детали, описания логиче-
ских

ии; С={C1, C2… Cn } – дуги графа) по возможной их 
последовательности.  

ние зубчатого колеса (рисунок 5.7). 

М
и составом операций при неизменном отношении порядка
ет содержаться несколько вариантов Ак проектируемого
 будет неизменным отношение порядка. 
С
 отношений между свойствами и граф G(T, C) взаимосвязи операторов 

(T={ τ  ,τ  …τ } – операц1 2 n 

Рассмотрим модель сетевую S5 (отсутствие циклов FG = 1, неизменное от-
ношение порядок F  = 1) изготовлеλ

 
Рисунок 5.7 – Зубчатое колесо 

 

Множество Т:  
τ1 – получение заготовки; 
τ 2 – сверление базового отверстия; 
τ 3 – черновое обтачивание контура зубчатого колеса; 
τ 4 – чистовое обтачивание контура зубчатого колеса; 

ообработка; 

 
Рисун  возможной последовательности их реализации 

 

τ 5 – черновая маркировка зубчатого колеса; 
τ 6 - чистовая черновая маркировка зубчатого колеса; 
τ 7 – терм
τ 8 – отделка базового отверстия; 
τ 9 – шлифование зубчатого профиля; 
τ 10 – притирка зубчатого профиля; 

 11 – мойка; τ
τ 12 – контроль. 

τ1 τ2 τ3 τ4 τ5 τ6 τ7 τ8 τ1 τ2 τ3

 τ1 τ2 τ3 τ4 τ5

τ9 τ10 τ11 τ12

ок 5.8 – Граф взаимосвязи операторов по
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А о сетевым моделям включает:  

τi

лгоритм проектирования п
- операторы построения путей на графе G=(T, C),  
- операторы проектирования по табличной модели для каждого пути и 
- операторы выбора оптимальных проектных решений.  
В рассматриваемом примере max ТП состоит из 12 технологических опе-

раций (на графе). Представлено 4 возможных варианта технологического про-
цесса и составления матрицы отношений контуров и операций. 

1 путь – все операции. 
ого2 путь - исключена чистовая нарезка зубчат  профиля (τ6). 

3 путь – исключены операции τ7 - τ9 . 
4 путь – исключена τ9  шлифование. 
Выделив один путь, проектируем ТП по табличной модели,  
- затем просматриваем все пути и  
- находим оптимальное решение. 
Матрица взаимосвязи операции и контуров: 
    Fi F1 F2 F3

Получение заготовки τ1 1 1  
Протягивание базового отверстия τ2 1   
Черновое обтачивание контура зубчатого колеса τ3  1  
Черновое обтачивание контура зубчатого колеса τ4  1  
Черновая нарезка зубчатого профиля τ5   1 
Черновая нарезка зубчатого профиля τ6   1 
Термообработка τ7 1 1 1 
Отделка базового отверстия τ8 1   
Шлифование базового отверстия τ9   1 
Притирка зубчатого профиля τ10   1 
Мойка τ11 1 1 1 
Контроль τ12 1 1 1 

 
 
.5 Перестановоч5 ная модель ТП 

личн раций. Отношение порядка между элементами задаётся с 
помо

естановочным моделям необходимо: 
 данные описания детали. 
одели для проектирования ТП для данной 

дета

Модели S3, S4, S6, S9, S10 , S12 – перестановочные. Эти модели имеют раз-
й порядок опеы

щью графа, содержащего ориентированные циклы. Получается n вариан-
тов ТП и в каждом варианте различается отношение порядка. 

 При проектировании по пер
 а) подготовить математические
 б) проверить применяемость м
ли. 
 в) вычислить набор перестановок. 
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 г) определить, удовлетворяют ли они ограничениям, накладываемым на 
реал ва-
риан

числ
) выбрать оптимальный процесс. 

 граф следую-
щи

 

Р  – 

огических 

изацию ТП и включить только удовлетворяющие в состав проверяемых 
тов. 
 д) с помощью табличных моделей спроектировать ТП, согласно всем вы-
енным путям и всем возможным наборам операций. 
 е
 

Пример: Рассмотрим модель при построении расцеховки её
й (рисунок 5.9): 

Р1

Р3

Р2

Р4 Р5 Р6 Р7 Р8

Рисунок 5.9 – Граф расцеховки изделия 
 

Где : 
Р1 – литейной  
Р2 – кузнечной 
Р3 – механической 
Р4 – нормической 
Р5 – механосборочной 
Р6 – общей сборки 

7 испытаний 
Р8 – упаковки 

Для каждого изделия, очевидно, есть много вариантов прохождения це-
хов и изготовления деталей. Эта модель типа S10 модель с переменным поряд-
ком операций. 

Данная модель очень часто используется для описания технол
процессов сборки, т.к. в них нарушается отношение порядка. 

 
Пример. 
Необходимо синтезировать ТП сборки редуктора (рисунок 5.10). 
Сборочные операции (τ ): 
τ  – установка вала в сборочное приспособление; 

 – установка

i

 1
τ 2  стопорного кольца (2); 
τ 3 – посадка шарика-подшипника(3); 
τ 4 – посадка шарика-подшипника(4); 
τ 5 – установка конического колеса (5); 
τ  – установка стопорного кольца (6);  6
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 5 
3 4 

6 
2 1 

 
ал; 2 – стопорное кольцо; 4, 3 – подшипник; 5 – коническое зубчатое колесо; 6 – стопор-

ное кольцо 
Рисунок 5.10 – Сборочный ч

1 – в

ертеж редуктора 
 

 

τ5τ4τ3τ2 τ1 τ6 

 
а 

 

τ5τ4τ3τ2 τ1 τ6 

 
б 

Рисунок 5.11 – Графы вариантов ТП сборки редуктора 

ве контуров изделия, которые долж-
ны б

) Рассматривается очередная k-я строка дизъюнктивной матрицы конту-
ров. 

нологически процесс Т , очередность вы-
полн

я τk в Тi. 
) Определяется состав контуров, которые могут быть реализованы набо-

ром i операций. 

 
Алгоритм проектирования технологического процесса по дизъюнктивной 

табличной модели: 
1) Готовятся исходные данные о соста
ыть реализованы в этой модели. 
2) Проверяется достоверность состава контуров модели для изготовления 

конкретного изделия. 
3

4) Проверяется, участвует ли операция τk в реализации контуров изделия. 
Если да, то переходим к п. 5, если нет, то возвращаемся в п. 3. 

5) Операцию τ  включают в техk i
ения операций τk в технологическом процессе определяется очередностью 

включени
6
Т
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7) Проверяется достоверность этих контуров для реализации изделия. Ес-
ли д

Способ построения графа вариантов маршрута сборки изделия 

е всего это корпус). 
е элементы конструкции кроме корнево-

го, и

ченных в 
граф

е-
ны п ие последним элементам сбо-
рочн

дится п кому-то опреде-
ленн их условий (чаще всего это 
временные ). 

оцессов 

х процессов: 
роектных решений. 

технологического процесса. 
снова формализации для решения задач нефор-

маль тировании технологических процессов с помо-
щью

х решений 

а, то проектирование закончено, если нет, то переходим к п. 3. 
 

1) Выбирается элемент конструкции, который называется базовой деталью 
и он принимается за корневую вершину графа (чащ

2) Рассматриваются все остальны
 проверяется выполнение условий базирования и доступа. Отобранные та-

ким образом вершины образуют второй ярус в графе. 
3) Рассматриваются остальные вершины за исключением вклю
 и т.д.  
4) Построение графа заканчивается тогда, когда для каждой ветви получ
оследние висячие вершины, соответствующ
ой единицы. 
Выбор наилучшего варианта маршрута пров о као
ому критерию в зависимости от конструкторск

 параметры – трудоемкость изготовления
 
 
5.6 Типовые решения в САПР технологических пр

Особенности проектирования технологически
1. Многовариантность п
2. Слабая формализация многих проектных задач. 
 

Задачи формального расчетного характера при проектировании ТП: 
- расчет припусков и межпереходных размеров; 
- расчет режимов резания; 
- нормирование 
Типовые решения – это о
г ри проекно о характера п

 ЭВМ. 
 

Алгоритм выбора решений 
1) каким-либо образом описывается весь набор типовых решений,  
2) описывается набор условий, при которых может быть применено каждое 

из них.  
3) Эти данные описываются заранее в виде базы данных и вводятся в ЭВМ.  
4) При разработке ТП в ЭВМ вводятся некоторые исходные данные по де-

тали.  
5) Проверяется соответствие исходных данных условиям применимости 

типовых решений.  
 
Виды типовы
1) локальные типовые решения (ЛТР) и  
2) полные типовые решения (ПТР). 
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Локальные типовые решения относятся к частным технологическим за-
дачам, определяющим лишь некоторую часть (элемент) проектируемого техно-
логического процесса. 

олные типовые решения охватывают весь (полный, логически заверП -
шенн

является типовой технологический 
проц

 технологического проектирования 
ского процесса (по-

сл
гического маршрута сборки или обработ-

к
Разработка управляющих программ для станков и ИПУ. 

 изготовления объекта и его особенностей  ТП 
деля

т на изделия одного 
наим

 устанавливаются на группу изделий 
с об

м признакам: форме, размерам, точности и т.д.  
надлежности детали к 

опре щих в данных произ-
водс

али получается из 
типо

оработка типового технологического процесса включает в себя также: 

ый) круг решаемых задач.  
Примером полного типового решения 
есс.  
 

Иерархические уровни
1. Разработка принципиальной схемы технологиче

едовательность этапов укрупненных операций). 
2. Проектирование техноло

и. 
3. 

 
В зависимости от условий
т на единичные,  типовые и  групповые. 
Единичные технологические процессы устанавливаю
енования, типоразмера и исполнения, независимо от типа производства. 
Типовые технологические процессы
щими конструктивными признаками (например, изготовление печатных 

плат). 
Групповые технологические процессы устанавливают на конструктивно и 

технологически схожие изделия. 
 
Типовые технологические процессы  
(по профессору А.А.Соколовскому) 
Идея типизации заключается в классификации деталей по конструктивно 

– технологически
Конечная цель классификации – установление при
еленному типу, т.е. к совокупности деталей, имеюд
твенных условиях общую структуру операций и переходов. 
Технологический процесс обработки конкретной дет
вого путем исключения лишних операций и переходов обработки отсутст-

вующих поверхностей. 
Д
– уточнение технологического оснащения (оборудования, приспособле-

ний, инструментов); 
– перерасчет межпереходных размеров; 
– выбор (расчет) режимов резания; 
– выбор и расчет норм времени. 
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Групповые технологические процессы  
(по профессору С.П.Митрофанову) 
1) Классификация, заканчивающаяся формированием группы, т.е. сово-

купности деталей, характеризующихся общностью оборудования и оснащения, 
необходимых для обработки детали в целом или отдельных ее поверхностей. 

2) Уточнения общих поверхностей с комплексной деталью группы и выбо-
ра из группового технологического процесса только тех операций и переходов, 
которые необходимы для обработки поверхностей заданной детали. 

3) Доработка индивидуального технологического процесса. 
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6 МЕТОДЫ АВТОМАТИЗИРОВАННОГО ПРОЕКТИРОВАНИЯ 

ТЕХНОЛОГИЧЕСКИХ ПРОЦЕССОВ 

и синтеза и анализа выделяют: 
нтированного). 

Метод прямого проектирования 

Суть: подготовка проектного документа (технологической карты) возла-
гается на самого пользователя, выбирающего типовые решения различного 
уровня из базы данных в диалоговом режиме. 

 
Алгоритм проектирования 
1) Заранее создается и заполняется технологическая база данных, вклю-

чающая в себя информацию об имеющихся на предприятии заготовках, стан-
ках, приспособлениях, инструментах и т.д.  

2) Пользователю представляются меню на разных уровнях проектирования 
для выбора заготовок, операций, станков, приспособлений, переходов, инстру-
ментов и т.д.  

Выбранная информация автоматически заносится в графы и строки шаб-
лона технологической карты. 

3) В режиме редактирования информация при необходимости может ре-
дактироваться,  

4) Печать ТД в ф им ГОСТом. 
 

 

е  типовые решения.  
видуального технологического процесса не создает-

ся за твии с составом и структурой одного из 
униф цессов, т.е. соответствующего типового 
или п

 осуществляется путем анализа необходимости каждой операции и 
пере д

.  

 
В зависимости от степени полноты реализаци
1. Метод прямого проектирования (докуме
2. Метод анализа (адресации, аналога). 
3. Метод синтеза. 
4. Комбинированные методы. 
 
 
6.1 

орме, предусмотренной соответствующ

 
6.2 Метод анализа 

В го основе лежат полные
Суть: структура инди
ново. Она определяется в соответс
ицированных технологических про
гру пового технологического процесса.  
Это
хо а с последующим уточнением всех решений на уровнях декомпозиции 

«сверху – вниз»
Метод воплощает идею «от общего к частному». 
 

Алгоритм проектирования 
1) ввод описания чертежа детали  
2) определение конструктивно – технологического кода детали  
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3) поиск по коду в базе данных приемлемого унифицированного (типового 
или группового) технологического процесса  

4) анализ структуры ТП 
5) доработка ТП в соответствии с описанием чертежа детали  

ии и пе-
реходы.  

- Иногда, что гораздо реже, недостающие операции и переходы могут до-
бавляться в режиме ручного редактирования технологического процесса.  

- Далее уточняется оборудование, технологическая оснастка, выбираются 
или рассчитываются режимы резания, рассчитываются нормы времени. 

 

2. Для каждой группы формируется обобщенная модель всех деталей – 
комплексная деталь. Она включает все многообразие поверхностей рассматри-
ваемой группы.  

- Для комплексной детали разрабатывается унифицированный (групповой) 
технологический процесс. Он заведомо является избыточным, т.е. содержит 
операции и переходы по обработке всех деталей группы. Разработка ндивиду-
ального имости 
включения в него оп его группового тех-
нологического

ых и 
типо

6) оформление индивидуального технологического процесса. 
 

Особенность применения метода –большая подготовительная работа. 
Из множества деталей заводской номенклатуры формируются группы, 

имеющие общие конструктивно – технологические признаки, способы обработки.  
Два подхода: 
1. В каждой группе выбирается деталь – представитель и для нее разраба-

тывается типовой технологический процесс.  
- Все типовые технологические процессы для всех групп деталей заносятся 

в ЭВ  М. 
- При разработке индивидуального технологического процесса из типового 

технологического процесса, как правило, исключаются лишние операц

и
технологического процесса заключается в анализе необход

ераций и переходов из соответствующ
 процесса. Или, другими словами, из группового технологиче-

ского процесса исключаются лишние операции и переходы (см. рис.8.3). Затем 
выполняется, как и в первом случае, так называемая параметрическая настрой-
ка: уточнение оборудования, технологической оснастки, выбор или расчет ре-
жимов резания и т.д. 

 

Метод анализа является основным методом проектирования технологиче-
ских процессов при эксплуатации гибких производственных систем. Его при-
менение дает наибольший эффект при внедрении на производстве группов

 

вых технологических процессов. 
Достоинства:  
1) метод не нарушает существующей специализации и традиций производ-

ственных подразделений,  
2) упрощает процесс проектирования,  
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3) не требует трудноформализуемых процедур синтеза новых технологи-
ческих процессов. 

 
 
6.3 Метод синтеза в САПР технологических процессов 

В основе метода синтеза лежат локальные типовые решения.  
 

Алгоритмы построения САПР на основе метода синтеза существенно от-
личаются друг от друга.  

Причины: 
1. Процедуры разработки (синтеза) технологических процессов относятся 

к раз

ределенного класса (например, «тел 
вращ

технологических процессов  

 чертежа детали. 
. Синтез маршрутов (планов) обработки для всех поверхностей детали. 

. 

структуры операций технологического процесса. 
 процесса (расчет режимов резания, нор-

миро

ами являются:  
• 
• 
• шероховатость; 

ряду трудноформализуемых. 
2. Ряд САПР, построенных по методу синтеза, ориентированы на проек-

тирование ТП изготовления деталей оп
ения»). 
3. С целью исключения циклов при разработке технологии и обеспечения 

линейной стратегии проектирования некоторые разработчики САПР отошли от 
классической схемы проектирования ТП «маршрут–операция–переход» и т.д. 

 
Реализация линейной стратегии проектирования  
в САПР 
Версия стратегии разработана на кафедре «Технология машиностроения» 

Ярославского государственного технического университета. 
 

Алгоритм проектирования 
1. Ввод описания
2
3. Синтез принципиальной схемы технологического процесса
4. Синтез маршрута обработки детали. 
5. Синтез состава и 
6. Доработка технологического
вание). 
7. Оформление документации. 
 

Ввод описания чертежа детали и оформление документации являются об-
щими этапами для всех методик проектирования ТП в САПР. 

 

Синтез маршрутов обработки поверхностей 
Маршрут обработки поверхности (МОП) – это последовательность ме-

тодов (видов, переходов одного метода) обработки, необходимых для достиже-
ния требуемых чертежом детали параметров поверхности.  

акими параметрТ
геометрический тип поверхности; 
точность размера; 
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• вид термообработки и т.д. 
 

Синтез принципиальной схемы технологического процесса 
базеВ  данных хранится принципиальная схема, разбивающая будущий 

технологический процесс на последовательность отдельных этапов обработки.  
Наличие принципиальной схемы позволяет вести проектирование техноло-

гического процесса в порядке, обратном изготовлению детали, т.е. от заклю-
чительных этапов с известных из чертежа параметров детали, к черновым эта-
пам, заканчивая выбором размеров и формы заготовки. 

Принципиальная схема технологического процесса построена на основе 
анализа обработки деталей различных классов с учетом возможных комбина-
ций термической и последующей механической обработки. 

 по достигаемым параметрам методы обработки различных поверх-
ност

резерование и тонкое (тор-
цово тода обеспечивают одинаковые параметры точ-
ност

 из вы-
бран ы на данном 
этап

огического процесса производится путем 
срав ечиваемых пере-
ходо

лизкий этап).  

оды одного или разных методов обработки с одинаковыми (или 
близ

1.

 из номера получаемой поверх-
ност

ежуточное состояние этой (третьей поверхности); 

Этап – часть технологического процесса обработки детали, включающая 
однородные

ей и детали в целом.  
К одному этапу относятся, например, тонкое ф
е) точение, т.к. оба этих ме
и и шероховатости поверхности. 
С помощью условий принципиальной схемы анализируется необходимость 

при обработке детали каждого из 13 этапов, и выявляются те переходы
ных ранее в каждом МОП, которые должны быть выполнен
е.  
Отнесение переходов МОП и самих промежуточных поверхностей к эта-

пам принципиальной схемы технол
нения параметров поверхности заготовки и детали, обесп
м МОП, с параметрами, характеризующими один из 13 этапов схемы (вы-

бирается самый б
В результате распределения переходов по этапам каждый этап будет со-

держать перех
кими) параметрами точности, шероховатости и т.д. 
 

Синтез маршрута обработки детали 
Исходные данные: 
 Полученная ранее структура принципиальной схемы этапов технологиче-
ского процесса. 

2. Сформированный набор методов – переходов одного или разных МОП в 
каждом этапе. 

 

Каждый переход записан в памяти компьютера в промежуточные массивы 
в виде многоразрядного кода. Этот код состоит

и и кода метода обработки.  
Например, код 31101 означает: 
3 – третья поверхность детали; 
1 – первое пром
101 – метод обработки (получистовое точение), в результате которого дан-
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ное промежуточное состояние достигнуто. 
Код метода обработки определяет код применяемого оборудования. 
Переходы одного метода обработки, коды которых имеют одинаковый код 

оборудования (или метода обработки), образуют укрупненную операцию этапа. 

2.

 решения: 
. Расчленение исходного набора переходов этапа на укрупненные опера-

ции ыполняются программным модулем, представляющим собой процедуру 
сорт  типа оборудова-
ния. 

хность расположена на другой и поэтому не 
мож

 только затем поверхности, точности 
взаи

льности операций выполняется путем выяв-
лени

1. Структурную оптимизацию – создание оптимальной структуры опе-

При формировании маршрута обработки детали решаются следующие за-
дачи: 

1. Определяется состав операций. 
 Укрупненные операции дифференцируются на простые. 

3. Формируется последовательность операций на каждом этапе. 
4. Выбирается тип оборудования для каждой операции. 

 
Способы
1
в
ировки кодов отобранных в этап переходов по признаку

2. Дифференциация операций осуществляется путем определения их ра-
ционального состава и последовательности обработки. Алгоритмы основаны на 
анализе отношений между поверхностями детали: 

- наложения, когда одна повер
ет быть обработана раньше; 
- точности взаимного расположения, когда в первую очередь должна 

быть обработана базовая поверхность, и
много расположения которых заданы относительно данной базовой по-

верхности и т.д. 
3. Формирование последовате
я признаков технологической совместимости и предшествования.  
 

Две операции попарно совместимы, если состояние детали на выходе од-
ной операции может быть исходной для другой. Так фрезерованию шпоночной 
канавки должна предшествовать токарная обработка цилиндрической поверх-
ности, сверлению центрового отверстия – фрезерование торца и т.д.  

Источником информации для выбора оборудования являются техноло-
гические признаки кода перехода.  

Конкретная модель станка определяется по таблицам соответствий или об-
ращением к базе данных с учетом габаритных размеров детали (сопоставляется 
с размерами рабочей зоны станка), требований точности, величины партии и 
других факторов. 

 

Синтез состава и структуры операций 
Задача данного уровня декомпозиции проектирования состоит в том, что-

бы определить оптимальную последовательность переходов, рациональную 
форму, окончательные и промежуточные размеры заготовки. 

Поиск (синтез) оптимальной операции включает в себя две задачи: 
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рации (элементов системы СПИД, порядка выполнения переходов). 
2. Параметрическую оптимизацию – определение оптимальных пара-

метров (припусков и межпереходных размеров, режимов резания). 
 

В основе решения задач структурной оптимизации заложен перебор ко-
нечного множества вариантов, состоящий из трех этапов: 

1. Собственно синтез очередного варианта. 
2. Анализ (оценка) варианта. 
3. Принятие решения о замене ранее выбранного варианта на новый вари-

ант или о прекращении синтеза новых вариантов. 
 

Для оценки уровня создаваемых вариантов вводится целевая функция, вы-
ражающая качество варианта. Она формируется на основе критерия оптималь-
ности, в качестве которого могут выступать: 

– технологическая себестоимость детали (операции); 
– производительность операции и т.д. 
 

Примеры шагов алгоритма : 
– выбор вариантов технологических баз и схемы базирования (одна из 

трудноформализуемых процедур, выполняется, как правило, в диалоговом ре-
жиме); 

– определение последовательности обработки поверхностей и т.д. 
 

Доработка технологического процесса 
На данном этапе определяют режимы резания и производят нормиро-

вание технологического
Способы определе
. Выбор нормативных значений режимов резания из базы данных по из-

вестному набору исходных данных (точности, шероховатости, материала заго-
товки и т.д.). 

2. Решение задачи параметрической оптимизации режимов резания мето-
дом линейного программирования для случая использования степенных зави-
симостей (в историческом плане – это один из первых примеров использования 
ЭВМ в технологическом проектировании). 

3. Решение задачи параметрической оптимизации режимов резания мето-
дами нелинейного программирования (в случае прямого использования нели-
нейных зависимостей для ограничений и целевых функций). 

 

Оформление документации 
Вся рассчитанная и хранящаяся в разных промежуточных массивах техно-

логическая информация сводится в единый документ – маршрутную или опе-
рационную технологическую карту.  

Шаблоны этих карт содержатся в составе постоянной информации базы 
данных. 

 
 

 процесса.  
ния: 

1
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6.4 Оптимизация технологических процессов в САПР ТП 

Технологический процесс называется оптимальным, если он обеспечива-
ет: 

1. Выполнение системы ограничений, отражающих условия протекания 
ТП и требования, предъявляемые к нему и детали. 

2. Экстремум целевой функции. 
 

ТП, оптимальный по одному критерию, может быть далеко не опти-
мальным по другому. 

Важным является правильный выбор критерия оптимальности. 
Наиболее часто используются следующие критерии оптимальности ТП: 

1. Штучное время – (целевая функция ). 

2. Производительность (целевая функция ).  
3. Себестоимость детали (целевая функция ). 
 
Для постановки задачи оптимизации ТП  сформировать 

математическую  изделия). 
Математическая модель должна вк ючать в себя: 
1. Критерий (критерии) оптимальности ТП. 
2. Целевую функцию. 
3. Систему ограничений. 
4. Четко определенные входные, выходные и внутренние параметры. 
5. Управляемый (варьируемый) параметр или управляемые (варьируемые) 

параметры, которые выделяются из числа внутренних параметров. 
Затем необходимо определить (выбрать, разработать) метод решения за-

дачи оптимизации. 
 

Виды оптимизации ТП: 
1. Структурная. 
2. Параметрическая.  
3. Структурно – параметрическая. 
 

Структурная оптимизация – это определение оптимальной структуры 
ТП (вида заготовки, технологического маршрута, модели оборудования, типо-
размера инструмента и т.д.). 

Параметрическая оптимизация ТП заключается в расчете оптимальных 
припусков и межпе . 

труктурно – параметрическая оптимизация представляет собой комби-
наци

 

необходимо
модель процесса обработки детали (сборки

л

реходных размеров, режимов резания и т.д
С
ю двух первых. 
 

Отличие между параметризациями состоит в сущности оптимизируе-
мых параметров. 

При структурной оптимизации оптимизируемые параметры по своей 
природе являются неупорядоченными переменными. В структурной же опти-
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мизации эти параметры не являются по существу числовыми. 
В параметрической оптимизации параметры представляют собой пере-

менные, для которых существует понятие больше или меньше и которые 
естественным образом могут быть размещены в координатной системе.  

 
Структурная оптимизация ТП 
Параметры структурной оптимизации: 
– модели станков,  
– типы инструментов,  
– схемы базирования, т.е. варианты типовых решений. 
Структурная оптимизация рассматривает последовательно каждую задачу 

технологического проектирования.  
Весь процесс проектирования расчленяется на несколько взаимосвязанных 

уровней.  
Процесс проектирования на каждом уровне представляет собой многова-

риантную процедуру.  
В результате проектирования на всех уровнях образуется граф допусти-

мых вариантов ТП, отвечающих заданным ограничениям. 
Задача структурной ске ветви графа, обеспе-

чивающей

 деталей даже средней сложности таких 
вариантов может быть огромное множество. Перебор всех вариантов даже 
при помощи современных быстродействующих компьютеров занимает очень 
большое время. 

 
Способы уменьшения времени проектирования: 
 

Прием 1. Необходимо организовать отбор рациональных вариантов 
проектных решений на каждом уровне проектирования.  

Однако при этом возникает проблема формирования критериев проме-
жуточного отбора наиболее рациональных вариантов на различных уров-
нях.  

Целесообразно, поэтому, использовать в качестве критерия суммарную 
стоимость заготовки и механической обработки. Однако стоимость меха-
нической обработки можно рассчитать только после разработки всего ТП. Сле-
довательно, пропадает смысл «поэтапной оптимизации». 

Но если удачно назначить критерии на каждом уровне проектирования, та-
кой подход имеет смысл. При его применении может оказаться несколько рав-
нозначных вариантов ТП  выбрать оптималь-

 оптимизации состоит в пои
 экстремум целевой функции.  

В силу неупорядоченности параметров основной метод структурной опти-
мизации состоит в последовательном переборе возможных вариантов.  

Чтобы выбрать один оптимальный вариант, необходимо до конца спро-
ектировать очень большое количество допустимых техническими и технологи-
ческими ограничениями вариантов ТП. 

Для реального ТП изготовления

, но среди них уже гораздо легче
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ный 

ечивающей наименьшую сумму затрат для данного 
усло

дных разме-
ров, режимов резания и т.д. 

 

вариант.  
Прием 2. «Предпроектная оптимизация».  
Прием 3. Следующим шагом в развитии предпроектной оптимизации яв-

ляется переход от булевых матриц соответствий к оценочным матрицам. 
Алгоритм поиска оптимального решения по оценочной матрице состоит в 

поиске одноименной строки в оценочных матрицах для всех диапазонов усло-
вий применимости, обесп

вия задачи. 
Рассмотренная процедура повторяется для каждого уровня проектирова-

ния, приводя в конечном итоге к варианту с оптимальной структурой. 
 

Параметрическая оптимизация ТП  
Заключается в расчете оптимальных припусков и межперехо
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7 СИСТЕМА АВТОМАТИЗИРОВАННОГО ПРОЕКТИРОВАНИЯ МАРШРУТНОЙ 

ТЕХНОЛОГИИ ТЕХНОПРО 
 
 
7.1 Общие сведения о системе ТехноПро 

Система ТехноПро предназначена для ручного, диалогового полуавтома-
тического и автоматического проектирования операционной технологии, вклю-
чая операции: заготовительные, механической и термической обработки, нане-
сения покрытий, слесарные, технического контроля, сборки и другие (рисунок 
7.1). 

 
Рисунок 7.1 – Укрупненная схема комплекса 

 
Система выдает в технологические процессы:  
− наименования операций,  
− оборудование,  
− приспособления,  
− вспомогательные материалы,  
− формирует тексты переходов,  
− рассчитывает технологические размеры с учетом припусков на обра-

ботку,  
− обеспечивает подбор режущего, измерительного и вспомогательного 

инструментов. 
Основным принципом работы ТехноПро является накопление знаний 

опытных технологов конкретного предприятия с последующим использованием 
этого опыта независимо  аккумулировать 
опыт наиболее ква я, использовать и 

 от них. То есть система позволяет
лифицированных специалистов предприяти
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тиражировать его, обучать на его основе молодых специалистов. Это свойство 
системы особенно важно в настоящее время, когда опыт проектирования тех-
нологии, накопленный за десятилетия работы, уходит с предприятий вместе с 
технологами пенсионного возраста. 

В ТехноПро заложена возможность ее обучения пользователями и само-
обучения системы в процессе работы. Обучение системы ведется на основе 
технологических понятий без какого-либо формализованного языка програм-
мирования. Интерфейс ТехноПро с пользователем реализован в стиле Microsoft 
Office. 

Исходной информацией для обучения системы являются ТП изготовления 
конкретных изделий, которые уже отлажены на производстве. По мере напол-
нения баз данных система обретает возможность проектирования технологии 
изготовления совершенно новых изделий, которых еще не было в производстве.  

На рисунке 7.2. представлены основные виды информации, которыми 
пользователь может оперировать при диалоговом проектировании ТП. 

 
Рисунок 7.2 – Информация, используемая пользователем при диалоговом  

проектировании технологических процессов 
 

Наряду с оригинальным методом проектирования по “общим технологиче-
ским процессам” в ТехноПро реализованы и традиционные методы: по типово-
му, групповому, технологическому процессу-аналогу. Технолог сам выбирает 
метод проектирования, наиболее подходящий в конкретном случае, а также 
способ его использования: автоматический, полуавтоматический, диалоговый 
или их сочетание. Например, сборочные технологические процессы можно 
проектировать в диалоге, изготовление корпусных деталей - в полуавтоматиче-
ском режиме, а процессы изготовления тел вращения - в автоматическом.  

В отличие от других систем ТехноПро позволяет опытному технологу один 
раз внести правила выбора того или иного маршрута, операции, перехода, ин-
струмента или другого компонента ТП и далее система будет использовать их 
автоматически. При этом технолог полностью уверен, что система спроектиру-
ет ТП, точно соот ского проектиро-
вания ТП составля  от длительного 

ветствующий его опыту. Время автоматиче
ет секунды, что освобождает специалистов
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форм

ы-
ми т

олнение техноло-
гиче

темами 
авто

олненные в системе T-FLEX CAD, посту-
пают

 техноло-
гиче

 её автоматическая реакция на изме-
нение в конструкции детали или в требованиях к качеству поверхностей. В за-
висимости от требования к качеству изготовления поверхностей детали система 
автоматически подбирает необходимые операции и рассчитывает технологиче-
ские размерные цепи. 

 
 
7.2 Методика автоматизированного проектирования ТП  

в САПР ТехноПро 

А) Предварительный этап 
Необходимо создать базу данных. Для этого нужно сгруппировать дета-

ли, в основном по сходству технологии их изготовления. При этом для каждой 
группы создается общий технологический процесс, который содержит весь пе-
речень операций изготовления всех деталей группы. Для создания общего тех-
нологического процесса используются технологические процессы, уже освоен-
ные в производстве. Можно использовать «бумажные» варианты технологиче-
ских процессов с последующим их «превращением» в электронный вариант или 
конкретные техн ы с ТехноПро в 
диалоговом режиме. 

Б) Создание общего технологического процесса 
1) Один из технологических процессов группы принимается за базовый и 

ирования ТП и заполнения карт. Менее опытные специалисты могут огра-
ничиться освоением только "проектной" части системы, не изучая средства 
формирования баз данных, и использовать в своей работе заложенные опытн

ехнологами решения и правила. 
ТехноПро формирует операционные, маршрутно-операционные и мар-

шрутные технологические карты, карты контроля, ведомости оснастки или ма-
териалов, титульные листы и другие технологические документы. На многих 
предприятиях используемые технологические карты отличаются от карт, при-
нятых по ГОСТ. ТехноПро обеспечивает автоматическое зап

ских документов произвольных форм, созданных в текстовом редакторе 
Microsoft Word. 

Система ТехноПро может использоваться автономно (с  вводом информа-
ции о конструкции деталей с чертежей на бумаге), либо совместно с сис

матизированного конструирования.  
В этом комплексе чертежи, вып
 через интерфейс OLE Automation в ТехноПро для проектирования техно-

логии. По спроектированным технологическим процессам могут быть сформи-
рованы заказы на конструирование оснастки, технологию изготовления которой 
также можно разработать в ТехноПро. Получаемая конструкторская и

ская документация хранится в системе электронного документооборота T-
FLEX DOCs. 

Важным свойством системы является

ологические процессы, созданные в ходе работ
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вводится в виде общего технологического процесса (можно скопировать один 
из конкретных технологических процессов, созданных в ходе работы в Техно-
Про в диалоговом режиме).  

2) В него добавляются недостающие операции и переходы из других тех-
нологических процессов (конкретных технологических процессов). 

При добавлении выявляются признаки, в зависимости от которых необхо-
димо выбирать ту или иную операцию, переход или маршрут. Проверка каждо-
го из признаков вносится в виде условий в базу ТехноПро.  

Примерами таких условий являются проверки: вида заготовки, марки или 
твердости материала детали, габаритов детали, наличия определенных элемен-
тов конструкции (поверхностей), их размеров и т.д. 

 

В) Автоматическое проектирование индивидуальных технологических 
процессов 

3) создается описание конструкции детали, для которой необходимо спро-
ектировать технологический процесс ее обработки.  

Описание можно создать: 
– (считать рического чер-

тежа детали, созданного посредством системы геометрического моделирования 
T – FLEX (разработка уже упомянутой ранее фирмы «Топ Системы»).  

– (интерактивно) вводя необходимые данные с клавиатуры.  
– (по шаблону) можно скопировать подобную деталь из уже имеющихся в 

базе системы конкретных технологических процессов или скопировать макет 
общего технологического процесса. 

Описание чертежа детали заключается в заполнении: 
–общих сведений о детали (данные из штампа и технические требова-

ния чертежа) и  
– параметров элементов конструкции (поверхностей), имеющихся на чер-

теже детали. 
4) Детали назначается общий технологический процесс соответствующей 

группы деталей и запускается процесс автоматического формирования техно-
логического процесса.  

В течение этого процесса ТехноПро  
– выбирает из назначенного общего технологического процесса операции 

и переходы, необходимые для изготовления каждого элемента конструкции де-
тали и переносит их в конкретный технологический процесс.  

– Затем переходы
беспечив  по срав-
ению с указанными требованиями на чертеже. 

5) Система отбрасывает из конкретного технологического процесса опера-
ции и переходы, в которых условия их выбора не выполнены.  

6) ТехноПро производит расчеты, имеющиеся в условиях оставшихся опе-
раций и переходов. 

7) Система рассчитывает технологические размерные цепи с учетом значе-

 автоматически) с электронной версии парамет

 из выбранного перечня система отбрасывает операции и 
ающие лучшее качество изготовления поверхностей детали

, 
о
н
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ний припусков, указанных в переходах общего технологического процесса. 
8) Система выполняет условия подбора технологического оснащения опе-

раций и переходов и выполняет имеющиеся в этих условиях расчеты режимов 
обработки и норм изготовления. 

9) Система формирует тексты переходов, заменяя имеющиеся в них пара-
метры на конкретные значения. Значения параметров выбираются в зависимо-
сти от типа выполняемой обработки – предварительной или окончательной. 

Создавая общие технологические процессы и условия, технолог «обучает» 
ТехноПро проектированию технологии конкретного (своего) производства. Од-
нажды обучив систему, технолог может быть уверен, что ТехноПро никогда не 
забудет производственных нюансов проектирования технологических процес-
сов. 

 
 
7.3 Алгоритм проектирования ТП в САПР ТехноПро 

Система ТехноПро позволяет проектировать как технологию изготовления 
механоо лнен е 
баз системы  
покрытий, термообработки, штамповки, сварки, сборки, электромонтажа, изго-
товления печатных плат и других. 

При проектировании техпроцесса в диалоговом режиме наименование 
операций, нормировочные данные, составление переходов и т.д. производится 
путем ввода информации с клавиатуры.  

База данных хранения технологических операций, переходов и т.д. разбита 
на две составляющие: общие технологические процессы (ОТП) и конкретные 
технологические процессы (КТП). 

При проектировании ТП технолог оперирует знакомыми ему понятиями – 
Спецификация, Деталь, Операции, Переходы, Оснащение, Таблицы, Карты, Эс-
кизы, Комментарии. Заполняя сведения о детали, можно вводить с клавиатуры 
или считывать с электронного чертежа: наименование, обозначение детали, ма-
териал, профиль и размеры заготовки, другие сведения (рисунок 7.3). Формиро-
вание сборочного ТП производится на основе спецификации (рисунок 7.4). 

Представление маршрута операций и переходов в виде «дерева» существен-
но упрощает формирование ТП. При указании курсором на операцию или пере-
ход справа открывается форма для их заполнения (рисуно  7.5, 7.6). Порядок 
следов ел-
ками вверх или вниз, при этом номера операций или переходов пересчитываются 
автоматически. 

В «ТехноПро» проектирование ТП может проводиться в различных режи-
мах. Технолог сам выбирает оптимальный режим или их сочетание. Например, 
первоначальное наполнение баз системы производится в режиме диалога, затем 
можно перейти к проектированию с использованием техпроцесса-аналога. 

В базе данных Конкретных технологических процессов (КТП) для каждого 

брабатываемых деталей, так и другие виды технологий. Напо
 определяет вид проектируемой технологии, например, нанесения

и

к
ания операций или переходов можно изменить нажатием кнопок со стр
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технологического процесса имеются поля ссылок на чертежи или модели дета-
лей. Используя средства классификации и поиска, просматривая чертеж или 
трехмерную модель, технолог находит требуемый техпроцесс-аналог. 

Найденный техпроцесс-аналог копируется с новым именем и обозначением, 
а затем просматривается и корректируется. Корректировка заключается в добав-
лении, удалении, редактировании или изменении положения в маршруте опера-
ций и переходов. 

 
Рисунок 7.3 – Общие сведения о детали 

 

 
Рисунок 7.4 – Спецификация 
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Рисунок 7.5 – Заполнение содержания операции 

 

 
Рисунок 7.6 – Заполнение содержания перехода 

 
При корректировке ТП выбор оснащения (оборудования, приспособлений, 

инст алов) производится по технологическому классификатору 
из И

аметры для автоматического подбора или поиска в 

рументов, матери
нформационной базе системы. Записи оснащения могут иметь различную 

структуру, которая легко может быть перенастроена пользователем. Каждая за-
пись может содержать пар 
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диалоге, а также может быть снабжена иллюстрацией (рисунок 7.7). Каждое обо-
рудование снабжается паспортными данными. 

 
Рисунок 7.7 – Выбор оснащения 

 

«ТехноПро» обеспечивает гибкость настройки выбора данных из справоч-
ных баз, таблиц и проведение расчетов. Пользователь может сформировать 
«Сценарии», юбому полю 
опер

состоящие из набора процедур и подключить их к л
ации, перехода, оснащения или группам Информационной базы. При этом 

нет необходимости заполнения никаких промежуточных таблиц – достаточно 
указать связи курсором (рисунок 7.8). 

 
Рисунок 7.8 – Создание сценария 
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Такой подход позволяет определять последовательность проектирования, 
при которой предлагаемые технологу варианты зависят от выбора, выполненного 
на предыдущем шаге проектирования. Например, в зависимости от наименова-
ния операции, пользователю предлагается список оборудования, на котором 
возможно ее выполнение. Далее выбираются цех и профессия работника. В опе-
рацию автоматически вносятся номер инструкции по охране труда, необходимые 
приспособления и прочее. 

Технологические операционные эскизы и карты наладки могут выполняться 
в любом графическом редакторе. В разрабатываемом ТП эти графические доку-
менты подключаются к переходам операций с возможностью их просмотра (рису-
нок 7.9). При необходимости пользователь может отредактировать изображение, а 
также просмотреть его в увеличенном виде. Изображение эскизов и карт наладки 
автоматически вставляются в формируемые технологические карты. 

 
Рисунок 7.9 – Подключение и просмотр эскизов 

 

Для ускорения формирования ТП пользователь может создавать наборы 
операций или типовых, групповых, единичных технологических процессов. 
Можно использовать принцип дублирования технологий (рисунок 7.10). 

При использовании на предприятии типовых или групповых технологиче-
ских процессов «ТехноПро» обеспечивает возможность их параметризации. Та-
кие параметрические ТП могут автоматически пересчитываться. Причем инфор-
мация для пересче чена из кон ук-
торских САПР или введена вручную с че жа на бумаге.  

ми с

мы «ТехноПро» на сотнях 

та (описание конструкции) может быть полу стр
рте

«ТехноПро» органично включается в интегрированные комплексы с любы-
овременными конструкторскими САПР, так как может поставляться с ин-

терфейсами к множеству систем. Например, SolidWorks, Компас-График, 
Pro/ENGINEER и другими. Опыт эксплуатации систе
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предприятий также показал высокую степень готовности базы данных этой сис-
темы к интеграции с многими АСУП и системами PDM. 

 
Рисунок 7.10 – Дублирование технологии 

 

Входными данными для систем управления предприятиями являются тру-
довые и материальные нормативы. Для их расчета в «ТехноПро» реализованы 
методы укрупненного табличного и точного аналитического расчетов, а также 
возможность их сочетания. Система позволяет пользователю ввести любые таб-
лицы с данными (рисунок 7.11), расчетные формулы (рисунок 7.12) и правила их 
взаимодействия. При этом участия программистов не требуется. 

 
Рисунок 7.11 – Данные и иллюстрации в таблицах 
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Рисунок  7.12 – Формулы, логика и их построитель 

«ТехноПро» поставляется с множеством форм выходных документов. Формы 
выполнены в MS Word (рисунок 7.13). Поэтому новые формы (горизонтальные и 
вертикальные) создаются пользователями без участия программистов. Поддержи-
вается использование специальных символов: угол, градус и другие. В поставку 
системы входят тысячи информационных групп данных более чем по 300 ГОСТ. 
Состав и структура баз может расширяться пользователями самостоятельно. 

 
Рисунок 7.13 – Пример сформированной карты ТП 
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При разработке нового ОТП в ветви «Наборы операций» добавляется но-
вый ункт, например «Технология РЭС» (рисунок 12.14), в макете технологи-
ческого процесса последовательно добавляются технологические операции.  

ным оборудованием, оснасткой, технологическими переходами. Если ана-
логичной операции в информационной базе нет, то в поле «Операция» вводится 
наименование операции, ставится номер цеха, участка и рабочего места. Затем 
производится выбор оборудования из информационной базы. 

аличие технологических переходов в операции и про-
изводится быстрый поиск соответствующего перехода в информационной базе. 
Если необходимого технологического перехода в информационной базе нет, его 
пред одят в нее (рисунок 7.15) и затем выбирают операцию. 

торяются до тех пор, пока все технологические операции 
не бу

ищутся все технологические операции в 
ОТП ого формируются все 
оста

ты (рисунок 7.18, 7.19).  

п

Если в информационной базе имеется аналогичная операция, программа 
автоматически найдет ее и предложит пользователю ее использовать с уже вы-
бран

Далее определяется н

варительно вв
Все эти этапы пов
дут сформированы полностью. 
При разработке КТП вначале 
, которые копируются в КТП (рисунок 7.16). После эт
льные операции и технологические переходы (рисунок 7.17) аналогично 

ОТП. Нумерация операций и переходов производится автоматически. 
После просмотра и, при необходимости, редактирования спроектированно-

го ТП, его можно выдать на печать, выбрав необходимый шаблон маршрутно-
операционной кар

 

 
Рисунок 7.14 – Проектирование ОТП. Формирование  

технологической операции 
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Рисунок 7.15 – Ввод нового технологического перехода 

 

 
Рисунок 7.16 – Вид диалогового окна копирования операций из ОТП 
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Рисунок 7.17 – Ввод технологического перехода при проектировании КТП 

 
 
 
 

 
Рисунок 7.18 – Вид панели при выводе технологических документов на печать 
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Рисунок 7.19 – Сформированная маршрутно-операционная карта 

 
В основе принципа автоматического проектирования технологического 

процесса , мате-
риал отавли-
вать  операции в ОТП, в которые затем включаются разрабо-
танн  выбираются предварительно разра-
ботанные

ю построителя условий в диа-
лого

 печатной платы выглядит так: 
припойных паст;Bmax] <= [B] 
И 

[Нанесение адгезива припойных паст;Lmax] <= [L]. 
е условия написаны и сохранены, производится их под-

ключ

 лежит подготовка условий для выбора режимов, оборудования
ов и т.д.. Для автоматического проектирования необходимо подг
 технологические
ые условия и уже при разработке КТП

 операции из ОТП. 
Разработка условий производится с помощь
вом режиме, в котором можно построить любое расчетное или логическое 

условие для определенного действия в момент проектирования технологиче-
ского процесса. 

Например, подбор оборудования для операции дозированного нанесения 
адгезива и условие для геометрических размеров

Подобрать [Нанесение адгезива 

После того как вс
ения в операции и переходы в ОТП (рисунок 7.20).  
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Рисунок 7.20 – Подключение условий в операциях и переходах 

 

оизводится выбор соответствующих операций 
и пе  вво-
дятс  изделия 
(рис

я и выполняются со-
отве в

При формирования КТП пр
реходов из ОТП. После подготовки всего технологического процесса
я все необходимые параметры на разрабатываемую технологию
унок 7.21). После нажатием кнопки «Пересчитать ТП» производится счи-

тывание условий, по которым рассчитываются все значени
тст ующие действия: подбор оборудования, оснастки режимов и т.д. 

 
Рисунок 7.21 – Ввод параметров на окончательном этапе разработки технологии 

 
 

ского процесса  

 соответствующем диа-
логовом окне в полях Имя и Пароль: SA (System Administrator) (рисунок 7.22)  

2  КТП 

 (рисунок 7.23) 

 

Проверив правильность всех расчетов и действий можно выводить доку-
мент на печать.

 

Инструкция по созданию конкретного технологиче
в САПР ТехноПро 
1 Вход в систему 
По умолчанию войти в программу можно, набрав в

Создание
Для создания КТП в Основном меню выбираем пункт «Конкретные Тех. 

Процессы»
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Рисунок 7.22 – Вход в программу 

 
 

 
Рисунок 7.23 – Вход в конкретные технологические процессы 

 
Затем в окне «Конкретные технологические процессы» правой клавишей 

мыши жмем на «Конкретные ТП» и выбираем «Добавить СБ» (рисунок 7.24). 

 
Рисунок 7.24 – Добавление техпроцесса для сборочного изделия 

 

Далее в появившемся окне обязательно заполняем поля «Обозначение 
сборки» и «Наименование сборки» (рисунок 7.25). 
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Рисунок 7.25 – Заполнение полей КТП. 

 
Необходимо заполнить поля под закладкой «В карту». Следующим шагом 

нужно правой клавишей мыши кликнуть на «ТП Сборка» и выбрать из выпа-
дающего меню пункт «Копировать из ОТП» (рисунок 7.26) 
 

 
Рисунок 7.26 – Переход в «Общие тех. процессы» 

ную операцию и нажать клавишу «ОК». 

вления выйти из ОТП, 
нажа  к и ).

 
В появившемся окне выбрать нуж
Выполнять это действие до тех пор, пока все нужные операции не будут 

добавлены в проектируемый КТП. По окончании доба
в специальную лавишу выхода (р сунок 7.27  
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Рисунок 7.27 – Добавление операций из ОТП в проектируемый КТП 

 
Потом в каждой операции редактируем необходимые для заполнения поля 

в заклад ах «Нормы», «Работы», а такж  полей «Цех», «Участок» и «Раб. ме-
сто» (рисунок 7.28). 

к е

 
Рисунок 7.28 – Заполнение полей 

 
Также редактируем Шифры инструкций (если это необходимо). Новы

Шифры инструкций занесутся в Информационную базу программы. 
Д

е 

ля генерации Маршрутно-операционной карты нужно нажать клавишу 
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, а затем клавишу  напротив «КТП ф1. Маршрутно-операционный ТП». 
Маршрутно-операционная карта сформируется в программе MS Word в ав-

томатическом режиме. После формирования  карта будет доступна к редакти-
рованию (если это необходимо). 

 

Для автоматизированного проектирования технологических процессов из-
готовления электронной аппаратуры  нашли применение ряд других  пакетов 
прикладных программ. Например, ТехАС, TECHCARD, Pro/ENGINEER и др. 
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8 ИНФОРМАЦИОННОЕ ОБЕСПЕЧЕНИЕ САПР 
 
 
Информационное обеспечение САПР - совокупность сведений, необхо-

димых для выполнения автоматизированного проектирования в заданной фор-
ме.  

Основная функция ИО - обеспечение создания, поддержки и организации 
доступа к данным. 

 
8.1 Модели данных 

1. иерархическая,  
2. сетевая,  
3. реляционная. 
 

Иерархическая модель данных 
Граф со следующим условиям: 
- граф должен начинаться с одной вершины (корня); 
- каждая вершина может иметь одну или несколько атрибутов (описывает 

конкретное свойство объекта); 
- каждая вершина может быть связана с одним или несколькими порож-

денными узлами. 
 

Сетевая модель данных 
Отношение между данными представляются в виде сетей (сетевого графа). 

В отличие от иерархической модели каждая запись (совокупность атрибутов) 
может находиться на любом уровне и вход в нее может быть реализован из лю-
бого узла. 

 

Реляционная модель данных 
Представляет собой набор двухмерных таблиц и связей между ними (в на-

стоящее время наиболее часто встречается) 
 
Типы таблиц и ключей в реляционных базах данных 
Базовая таблица – это таблица, которая включает один или несколько 

столбцов свойств объекта и которая содержит первичный ключ. 
Первичный ключ состоит из набора значений атрибутов и однозначно оп-

ределяет каждую строку или запись базовой таблицы. Ключ может быть про-
стым и составным. Составной ключ включает в себя несколько атрибутов. 

Внешний ключ – это столбец таблицы, значения которого соответствуют 
значениям первичного ключа, другой базовой таблицы. 

Промежуточная таблица – это таблица, которая не объединяет свойств 
объекта или не содержит поле первичного ключа, служит для установки связей 
с другими таблицами. 
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Условия, накладываемые на реляционную модель: 
1. Не должно быть одинаковых первичных ключей. 
2. Все записи (строки) должны иметь одинаковую структуру в таблице. 
3. Имена полей должны быть различимы, т.е. отличаться друг от друга. 
4. Должна соблюдаться ссылочная целостность данных (т.е. каждому 

внешнему ключу должна соответствовать одна запись в базовой таблице).  
5. Отношения в качестве компонентов не должны иметь другие отноше-

ния. 
 
 
8.2 Нормализация данных 

Нормализацией называется формальная процедура, в ходе которой атри-
буты данных группируются в таблице, а таблицы группируются в базе данных. 

Задачи нормализации: 
- исключение повторений данных в таблицах и таблиц; 
- создание структуры таблицы, которая предусматривает возможность 

дальнейшего изменения содержимого этой таблицы. 
Нормализация выполняется по этапам (по нормальным формам). 
 

Первая нормальная форма 
Для нее требуется, чтобы таблица была двухмерной и не содержала повто-

ряющихся групп данных.  
Таблица 8.1 не приведена к первой нормальной форме, т.к. содержит по-

вторяющиеся группы данных. Для приведения к первой нормальной форме, по-
вторяющиеся группы данных нужно извлечь в новые таблицы 8.2 и 8.3. 

Таблица 8.1 
Судно Название №  

маршрута 
Отправ-
ление 

Порт Пункт Прибытие Отплытие Пункт 

137 Россия 2 18:10 Одесса Севастополь 23:00 23:30 Керчь 

 
 
Таблица 8.2 – Маршруты 

Судно Название №  
маршрута 

Отправление Порт 

137 Россия 2 18:10 Одесса 

 
Таблица 8.3 – Пункты 

Пункт Прибытие Отплытие 

Севастополь 23:00 23:30 

 
Например, в Access атрибуты (столбцы) называются полями, а строчки на-

зываются записями. 
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Связи в реляционной модели 
Информация представляется в виде таблиц и связей между таблицами. 
Тип 1. Связь или отношение один к одному, в таком отношении одной 

строке первой таблицы соответствует одна строка второй таблицы. Обычно та-
кая связь используется для 

− разбиения больших таблиц и  
− предоставления различных прав доступа. 

Тип 2. Связь или отношение один ко многим, одной строке первой таб-
лицы соответствует несколько строк второй. Связь устанавливается с помощью 
первичного ключа первой таблицы, которая является базовой и внешнего ключа 
второй таблицы. Это наиболее распространенный тип связи. 

Тип 3. Связь или отношение многие к одному. Этот тип противоположен 
типу 2. 

Тип 4. Связь или отношение многие ко многим. Такое отношение нельзя 
представить в виде отношения между двумя записями двух таблиц. Это отно-
шение задается с помощью промежуточной таблицы, связанной отношениями 
(многие к одному) с двумя базовыми таблицами. С помощью этой таблицы ба-
зовые таблицы будут связаны отношением многие ко многим. 

 

Вторая нормальная форма 
Требуется, чтобы данные во всех неключевых полях полностью зависели 

от значений первичного ключа и каждого поля первичного ключа, если ключ 
является составным. Для приведения ко второй нормальной форме производит-
ся дальнейшее разбиение. 

 

Третья нормальная форма 
Требуется, чтобы все неключевые поля таблицы зависели от первичного 

ключа, но не зависели друг от друга. Они предварительно должны быть приве-
дены ко второй нормальной форме. 

Обычно достаточно третьей нормальной формы для разработки эффектив-
ной структуры базы данных, хотя существуют еще четвертая и пятая нормаль-
ные формы. 

 
8.3 Использование индексации таблиц 

Индексы используются  в СУБД для привязки полей таблиц к их физиче-
скому положению на диске.  

Основное назначение индекса - ускорение доступа при выполнении за-
просов к таблице. Запрос позволяет извлекать или изменять информацию из 
таблиц или в таблице в соответствии с введенными критериями. 

Общие рекомендации по использованию индексов. 
1. Индексируйте поля, которые часто используются в запросах на выборку 

данных. 
2. Не индексируйте поля в таблицах, которые часто используются для до-
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бавления и обновления записей. 
 
Целостность базы данных складывается их двух элементов: 
- целостность данных; 
- ссылочная целостность. 
 

Для обеспечения целостности данных требуется, чтобы значения пер-
вичного ключа таблицы были уникальны.  

Для обеспечения ссылочной целостности требуется, чтобы каждому зна-
чению внешнего ключа соответствовало значение первичного ключа в базовой 
таблице. 

 

Для обеспечения целостности данных в Access используются следующее: 
1. Тип данных – счетчик, устанавливаемый для ключевого поля. Этот тип 

может иметь приращение на единицу для каждой следующей записи. 
2. Индексирование поля первичного ключа со свойством ”да, совпадения 

не допускаются”. 
Поддержание ссылочной целостности должно исключать следующие 

транзакции (последовательность действий для изложения данных): 
1. Добавление записи в таблицу со стороны «многие» в случае, если для 

данного внешнего ключа отсутствует запись со стороны «один». 
2. Удаление таких же записей (нельзя удалять записи со стороны «один», 

если в связанной таблице со стороны «многие», есть соответствующие ей запи-
си.). 

3. .Удаление записей в таблицах связанных отношением один к одному 
без соответствующих изменений в другой таблице. 

4. Изменение значения поля внешнего ключа назначение таблицы. 
 
 
8.4 Этапы разработки базы данных 

1. Определить объекты (будущие таблицы). 
2. Выявить связи между этими объектами. 
3. На основе анализа свойств объекта установить перечень полей таблицы 

для соответствующего объекта. 
4. Определить состав таблиц и связь между этими таблицами в базе дан-

ных. 
5. Провести нормализацию таблиц. 
6. Разработать структуру таблицы. 
 
 
8.5 СУБД Access 

Назначение: разработка базы данных и создание приложений базы данных 
с архитектурой «клиент-сервер». 

Режимы работы 
1. Режим запуска, позволяет осуществить  
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– сжатие базы данных,  
– преобразование и  
– шифрование/дешифрование без открытия базы данных. 

2. Конструктор, позволяет  
– создавать и  
– модифицировать структуру таблиц запросов, форм отчетов, макро-

сов и модулей. 
3. Выполнение, сама работа. 
 

Основные объекты Access 
База данных Access содержит до 32756 следующих объектов: 
1. Таблица. Одновременно может быть открыто до 1024 таблиц 
2. Запросы. Запрос/Выборка может производиться одновременно не бо-

лее чем из 16 таблиц, число полей в запросе не более 255. 
3. Формы. Позволяет отображать и изменять данные в таблице или за-

просе в бале удобной для пользователя виде. 
4. Отчеты. Используются для печати данных. 
5. Макросы. Для автоматизации повторяющихся действий. 
6. Модули. Содержат VBA код и предназначены для реакции на события 

в формах и отчетах, а также для реализации функций содержащихся в Access. 
 

Отличие Access от большинства других СУБД состоит в том, что все хра-
нится в одном файле. 

 
Таблицы 
В режиме конструктора можно  

– создавать и  
– модифицировать структуру существующих таблиц.  

Структура таблицы создается с помощью свойств полей, таких как 
- ключевое поле предназначено для назначения первичного ключа таблицы 

и для выделения соответствующего поля; 
- имя поля должно удовлетворять следующим требованиям: не более 64 

символов включающих буквы, цифры, специальные символы, за исключением 
« . » « ! » « ’ »; 

- тип данных выбирается из раскрывающегося списка; 
- описание является необязательным комментарием. 
Остальные свойства полей приводятся на вкладке общие: 
- размер поля; 
- формат поля (задается формат вывода данных); 
- число десятичных знаков после запятой; 
- маска ввода 
- подпись (псевдоним имени поля), если не писать, то в заголовке будет 

имя поля; 
- значение по умолчанию; 
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- условия назначения; 
- обязательное поле, указывает, требуется ли в данном поле обязательный 

ввод значений; 
- пустые строки, определяет, допускается ли в данном поле пустая строка; 
- индексированное поле; 
 
Типы данных 
MEMO – ограничение на длину текстового поля (255 символов). Исполь-

зуется для длинного текста, длина 65535 символов. Поле с типом данных 
MEMO не может быть  

– ключевым и  
– индексироваться. 

 

Числовой – для проведения вычислений, имеет подтипы данных: 
- Дата/Время. 
- Денежный – знак $, RUB,DM. 
- Логический – для обозначения факта. 
- Счетчик – для соблюдения целостности данных. 
- Поле объектов OLE – любой объект OLE. 
- Гиперссылка. 
- Мастер подстановок.  
 

Установка связей между таблицами производится через схему данных 
(Сервис/Схема данных). 

 

Запросы 
1. Запрос на выборку. Содержит данные из одной или нескольких таблиц, 

отображающиеся в связи с введенными критериями. Данные отображаются то-
же в виде таблиц. 

2. Перекрестный запрос. Отбирает данные из таблиц и представляет их в 
форме похожей на электронную таблицу. 

3. Запрос на изменение. Позволяет объединить данные из разных таблиц. 
4. Запрос с параметрами. Это запрос, свойства которого изменяются 

пользователем при каждом запуске. 
 

Формы 
1. простая,  
2. ленточная,  
3. табличная. 
Более подробно про СУБД Access будет рассмотрено в дисциплине «Ав-

томатизированные системы обработки биомедицинской информации». 
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